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Dlaczego napisałem tę książkę? 

Ponieważ zawsze chciałem stworzyć model samolotu w komputerze. A gdy już to zrobiłem – stwierdziłem, że to 

dobra zabawa, i że warto tym doświadczeniem podzielić się z innymi. 

Dawno temu byłem zwykłym modelarzem i robiłem redukcyjne modele samolotów. To hobby dość specyficzne. 

Ślęczymy miesiącami nad naszym dziełem, starając się nanieść na kawałek materiału maleńkie nity, złącza 

blach, czy drobne detale tablic przyrządów. Sądzę, że w porównaniu z modelarzami, wędkarze mają mniej mę-

czące, choć podobnie monotonne hobby. W dodatku, zamiast tworzyć ładne, błyszczące miniaturki, nanosimy 

na ich powierzchnię zabrudzenia i przetarcia, aby wyglądały jak rzeczywiste, zużyte i gdzieniegdzie pordzewiałe 

maszyny. Nagrodą za ten wysiłek jest okazja do pokazania naszych dzieł komuś, kto potrafi docenić ich finezję. 

Mówiąc szczerze, dziwnym trafem są to zazwyczaj inni modelarze. A może tak naprawdę chodzi tu o możliwość 

nawiązania dyskusji na tak ezoteryczne tematy, jak wyższość Spitfire’a IX nad FW 190 A4? Albo paląca kwestia, 

jak był pomalowany P-40K, na którym Witold Urbanowicz latał nad Chinami w 1943r? 

Otóż chciałbym teraz zaoferować wszystkim modelarzom zupełnie nowy materiał i narzędzia. Zamiast własne-

go, czasami nieco pobrudzonego aerografem biurka – okno na inny świat, w głębi ekranu.  

Jest tu niezwykle plastyczny materiał, który można "wytłaczać" w dowolne powłoki, bez obawy, że go zabraknie. 

Są tu farby, dla których można dokładnie ustalić odcień i zasady nakładania. Można tu wreszcie odtworzyć gru-

bość blachy poszycia, jak w prawdziwym samolocie! Tu, gdy stwierdzisz, że okapotowanie silnika, który wyko-

nałeś rok temu, powinno mieć inny kształt, zawsze możesz ten błąd poprawić. I to nie raz! Tutaj nigdy Twój mo-

del nie obrośnie kurzem. Nie będziesz wysłuchiwał narzekań domowników na to, że nie ma już gdzie zmieścić 

Twojej kolekcji. Możesz kopiować i przesłać swój model innym hobbystom, takim jak Ty, bez obawy, że coś się z 

nim stanie podczas transportu. Z obiektów, które w ten sposób stworzysz, można szybko budować całe sceny 

(wirtualne dioramy).  

Jedyne, do czego trzeba się przyzwyczaić, to to, że niczego w tym świecie nie można dotknąć. Możesz tylko 

patrzeć i łapać wszystko myszką. Rozwój bardziej zaawansowanych urządzeń dotykowych od dziesięciu lat 

„drepcze w miejscu”. Za to niedrogie i odpowiednio dokładne drukarki 3D stają się już ogólnie dostępne. Obec-

nie, po kilku próbach, możesz zacząć „drukować” swoje własne zestawy do sklejania. 

Ten świat wirtualnego modelarstwa stał niepostrzeżenie dostępny. W istocie każdy komputer wyprodukowany 

obecnie to silna stacja graficzna, o której w latach 90-tych można było tylko pomarzyć. Co więcej – odpowiednie 

programy, które potrafią ten potencjał wykorzystać, stały się dostępne za darmo! Stworzyły je dziesiątki progra-

mistów Open Source. Ludzie ci pokazali, że stać ich co najmniej na to samo, co twórców najlepszych progra-

mów komercyjnych. I te aplikacje są coraz lepsze! Podczas pracy nad takim oprogramowaniem nie ma typowe-

go dla komercyjnych projektów pośpiechu, związanego z napiętymi terminami (a pośpiech rodzi błędy). W efek-

cie, dzięki pracy odpowiednio dużej grupy entuzjastów, powstaje dobry i stabilny program. 

Podsumowując – kupując parę lat temu komputer do gier, nabyłeś wszystko, co potrzeba do wejścia w świat 

wirtualnego modelarstwa. Oczywiście, budowa modeli komputerowych także wymaga nieodłącznych cech każ-

dego modelarza: precyzji i cierpliwości. Mam jednak nadzieję, że ta książka ułatwi Ci, drogi Czytelniku, jak naj-

szybsze osiągnięcie pożądanych rezultatów. Potem możesz pójść dalej i zrobić to samo jeszcze lepiej, niż tu 

proponuję. Przeczytanie dalszych stron oszczędzi Ci sporo czasu, a niekiedy – frustracji. Ta ostatnia bywa nie-

odłącznym składnikiem pracy z „tą głupią maszyną” – komputerem. Postaram się nie zanudzać i pokazywać 

dużo ilustracji, więc mam nadzieję, że "Wirtualne modelarstwo" Cię zainteresuje. 

Witold Jaworski 
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Co zawiera ta publikacja? 

„Wirtualne Modelarstwo” uczy „od zera”, jak tworzyć takie komputerowe modele samolotów1 i ich wizualizacje, 

takie jak pokazana na okładce książki. Aby szybciej udostępniać Czytelnikom uaktualnione fragmenty tego po-

radnika, zdecydowałem się stworzyć i opublikować wyciągi z jego tekstu, związane z określoną dziedziną. Są 

to: „Tom I: Przygotowania”, „Tom II: Modelowanie”, „Tom III: Materiały i tekstury”, oraz „Tom IV: Detale i rende-

rowanie”. Przebieg pracy prezentuję na przykładzie modelu myśliwca Curtiss P-40B. Ta maszyna zawiera kla-

syczne rozwiązania, stosowane w większości samolotów tego okresu. Z całym rozmysłem nie wybrałem Spitfi-

re, Mustanga, Thunerbolta, Focke-Wulfa czy Messerschmita. Nie chciałem zabierać Ci przyjemności samo-

dzielnego odwzorowania tych słynnych samolotów! 

 

Możesz tworzyć model każdego  myśliwca z okresu II wojny światowej, czytając jednocześnie kolejne 

rozdziały z tej książki. To wcale nie musi być P-40. Wszystkie te samoloty wykonuje się bardzo podob-

nie. W trakcie tej pracy na pewno zetkniesz się ze wszystkimi zagadnieniami, które są tu opisane. 

 
 Ta książka ma służyć zarówno tym, którzy dopiero zaczynają swoją przygodę „w 3D”, jak i tym, którzy mają już 

w tej dziedzinie pewne doświadczenie. W związku z tym, w części podstawowej opisuję co trzeba zrobić. 

Szczegółowe instrukcje, jak posłużyć się odpowiednim programem, umieściłem w częściach poświęconym de-

talom („Szczegóły obsługi programów rysunkowych”). Ich zawartość przypomina tekst systemów pomocy (Help) 

aplikacji. To krótkie sekcje, opisujące pojedyncze polecenia (zazwyczaj nie są dłuższe niż dwie-trzy strony, i 

zawieraj kilka ilustracji). 

Dzieląc materiał na część „podstawową” i „szczegółową”, starałem się uniknąć niepotrzebnych, wydłużających 

tekst wskazówek, w rodzaju "kliknij tu, a potem naciśnij tamto". Zamiast tego, w odpowiednich miejscach opisu 

umieściłem odsyłacze (wewnętrzne linki) do sekcji z detalami tych poleceń. Jeżeli nie znasz programu, o którym 

akurat piszę, korzystaj z tych odsyłaczy i czytaj umieszczone w nich informacje szczegółowe2. Przygotowałem 

je tak, abyś nauczył się posługiwać wszystkimi narzędziami "od zera", w trakcie czytania części podstawowej. 

Gdy już będziesz wiedział, jak zrobić to, co opisuję – po prostu przestaniesz do nich zaglądać. 

Książka zawiera jeszcze jedną część: "Dodatki". To materiały, które mogą być ciekawe dla co dociekliwszych 

Czytelników. Tematyka "Dodatków" przypomina trochę "groch z kapustą": od wybranych zagadnień optyki (de-

formacja obrazu na fotografii, refrakcja światła), do odwzorowania profili lotniczych. A oprócz tego: metody zaa-

wansowanej weryfikacji rysunków samolotu (na poziomie tworzenia planów modelarskich) oraz szczegółowy 

opis właściwości powierzchni podziałowych. Nie musisz do „Dodatków” zaglądać, choć sądzę, że niektórzy mo-

gą w tych materiałach znaleźć dla siebie coś interesującego. 

 
1 Nie omawiam tu przygotowania modeli do wydruku 3D, ani do gier/symulatorów lotu. Jeżeli chciałbyś „drukować” własne zestawy do 

sklejania, zapoznaj się z pierwszymi częściami tego poradnika, o rysunkach referencyjnych i modelowaniu i pomiń resztę, dotyczącą wizua-

lizacji: materiałów, tekstur, kompozycji. W przypadku modeli dla gier/symulatorów – ta książka będzie użyteczna, ale w swoim projekcie 

musisz jeszcze uwzględniać specyficzne wymogi docelowego „silnika gry” (ang. „game engine”).  

2 Zakładam, że korzystanie z części drugiej będzie zawsze wyrywkowe. Stąd większość z zagadnień, które tam się znajdują, jest omówiona 

bez dalszych odnośników. Takie podejście powoduje, że np. opis skalowania w edytorze siatki Blendera jest niemal dosłowną kopią opisu z 

edytora obiektów. Różnią się tylko ilustracjami i paroma zdaniami. Po prostu nie wiem, który z tych tematów otworzysz jako pierwszy, a w 

każdym chciałbym zapewnić pełną informację.  
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Konwencje zapisu 

Wskazówki dotyczące klawiatury i myszki oparłem na założeniu, że masz standardowe: 

• klawiaturę – w normalnym układzie amerykańskim, 102 klawisze (dodam także parę uwag o klawia-

turze notebooka, bo sam na takiej pracuję); 

• myszkę – wyposażoną w dwa przyciski i kółko przewijania (które daje się także naciskać: wtedy 

działa jak trzeci, środkowy przycisk). 

 

Wywołanie polecenia programu będę zaznaczał następująco: 

Menu→Polecenie - taki zapis oznacza wywołanie z menu „Menu” polecenia „Polecenie”. W przypadku 

bardziej zagnieżdżonych menu może wystąpić więcej strzałek! 

Panel:Przycisk - taki zapis oznacza naciśnięcie w oknie dialogowym lub panelu "Panel" przycisku 

„Przycisk”. Czasami mogę także w ten sposób napisać o przełączniku lub liście 

rozwijalnej. W podobny sposób będę także oznaczał inne hierarchiczne zależności 

np. warstw. Wtedy jednak będą występować w kolorze zielonym, a nie niebieskim.   

 

Naciśnięcie klawisza na klawiaturze: 

Alt - K  - myślnik pomiędzy znakami klawiszy oznacza jednoczesne naciśnięcie obydwu kla-

wiszy na klawiaturze. W tym przykładzie trzymając wciśnięty Alt , naciskasz K ; 

G , X  - przecinek pomiędzy znakami klawiszy oznacza, że je naciskasz (i zwalniasz!) po 

kolei. W tym przykładzie najpierw G , a potem X  (tak, jak gdybyś chciał napisać 

wyraz „gx”). 

 

Naciśnięcie klawisza myszki: 

 LPM   - lewy przycisk myszy; 

 PPM   - prawy przycisk myszy; 

 SPM    - środkowy przycisk myszy (naciśnięte kółko przewijania); 

 KM  - kółko przewijania (pełni tę rolę, gdy jest obracane). 

Na koniec – „w kwestii formalnej”: jak mam się do Ciebie zwracać? Zazwyczaj w poradnikach używa się formy 

bezosobowej („teraz należy zrobić”). To jednak, mówiąc szczerze, czyni czytany tekst mniej zrozumiałym. Aby ta 

książka była jak najbardziej czytelna, zwracam się do Czytelnika w krótkiej, drugiej osobie („teraz zrób”). Cza-

sami używam także osoby pierwszej („teraz zrobiłem”, „teraz zrobimy”). Tak jest mi łatwiej1.  

 

 
1 Podczas pracy nad modelem traktowałem nas – czyli Ciebie, drogi Czytelniku, i siebie, piszącego te słowa – jako jeden zespół. Może 

trochę wyimaginowany, ale w jakiś sposób prawdziwy. Przecież tworząc tę książkę ja także wiele się uczyłem, bo wiedziałem, że każde 

zagadnienie mam Ci porządnie przedstawić! 
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Jak czytać tę książkę? 

Ta książka jest publikacją elektroniczną, dostarczaną w formacie PDF. Poniżej pokazuję jej angielską wersję, 

otwartą w systemie Windows, w popularnej, bezpłatnej przeglądarce Adobe Acrobat Reader (Rysunek 1): 

 

 Rysunek 1 Czytanie książki w przeglądarce PDF (Adobe Reader) 

Aby ten poradnik był bardziej czytelny niż drukowane książki, przeniosłem większość szczegółowych opisów z 

głównego tekstu do podrozdziałów, pozostawiając w ich miejscu odsyłacze (wewnętrzne „linki”). Używaj ich, aby 

zapoznać się ze szczegółami, a potem wracaj do głównego tekstu. Aby nie „zaśmiecać” zawartości poradnika, 

nie wyróżniałem specjalnie tych skrótów kolorem lub podkreśleniem. Możesz je jednak rozpoznać na podstawie 

kontekstu („por. str. …”) a także po zmianie kształtu kursor myszki na „wskazującą dłoń” (tak jak to pokazuje 

Rysunek 1). Gdy klikniesz w taki skrót, przejdziesz na stronę, na którą odsyła Cię tekst. Aby powrócić w po-

przednie miejsce książki, wykorzystaj przycisk Wstecz umieszczony u góry ekranu (Rysunek 1). Działają tak 

samo, jak w przeglądarce internetowej. Jednak w domyślnej konfiguracji Adobe Reader przyciski Wstecz/Dalej 

nie są wyświetlane. Rysunek 2 pokazuje, jak je dodać do paska narzędzi: 

 

Rysunek 2 Dodawanie przycisków Wstecz/Dalej do paska narzędzi (Adobe Reader) 

Przyciski Wstecz/Dalej 
– jak w przeglądarce 

Oglądaj w trybie 
“ciągłym” 

Ważny element: wewnętrzne linki w 
tekście. Kursor myszki zmienia się 
ponad nimi we „wskazującą dłoń” 

 

Struktura książki: 
rozdziały, sekcje 

 

Używaj Wstecz aby 
wrócić z objaśnienia 

1. Kliknij PPM  na przyborniku 

by otworzyć to menu 

2. Wybierz stąd 
przycisk Next View  
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Aby dodać przyciski Wstecz/Dalej do przybornika1, kliknij LPM  na pasku narzędzi i z menu kontekstowego wy-

wołaj submenu Show Page Navigation Tools…. Wybierz z niego polecenia Previous View i Next View (por. 

Rysunek 2). Za każdym razem możesz wybrać tylko jedno z tych poleceń. 

Aby ten dokument PDF można było poprawnie odczytać na różnych urządzeniach, jest zapisany w standardzie 

PDF/A. Po otworzeniu pliku książki, Adobe Reader wyświetla o tym odpowiedni komunikat u góry ekranu 

(Rysunek 3): 

 

 

 

Rysunek 3 Zamykanie wiadomości o formacie PDF/A (Adobe Reader) 

Jeżeli chcesz zachować tę książkę w oryginalnej postaci, kliknij ikonę (i) z lewej strony (por. Rysunek 3). Jeżeli 

jednak chciałbyś na własne potrzeby zaznaczać jakieś fragmenty i/lub dodawać własne notatki – kliknij przycisk 

Enable Editing po prawej.  

* * * 

 

Możesz wydrukować egzemplarz „Wirtualnego modelarstwa” na użytek własny. Możesz go także nie 

drukować i czytać wprost z ekranu podczas pracy nad modelem. Oszczędzisz w tym przypadku trochę 

tonerów i papieru – zawsze to o skrawek lasu więcej. Co więcej, możesz wtedy korzystać z hipertek-

stowych odsyłaczy i widzieć ilustracje w pełnym kolorze. 

 
 Oczywiście, jeżeli wolisz częste kartkowanie prawdziwego papieru – drukuj całość2. Nawet jeżeli Twoja drukar-

ka obsługuje wydruk dwustronny, przygotuj dwie ryzy formatu A4 i nowy toner, aby wydrukować pełne wydanie 

(cztery tomy) tej książki! Zapewniam, że nie było to moim celem. 

* * * 

 

 

1 Zawsze można użyć skrótów klawiszowych (Wstecz: Alt  -  , Dalej: Alt  - → ) , ale jakoś raźniej jest mieć te przyciski „pod ręką”. 

2 Nie chciałem w tej elektronicznej książce rezygnować z kolorowych ilustracji. W związku z tym wiele z nich na wydruku wydaje się być 

mało kontrastowa. Aby temu w jakimś stopniu zaradzić, na niektórych ilustracjach zmieniałem kolory odnośników (na ciemniejsze lub ja-

śniejsze). Dzięki temu na wydruku są w miarę czytelne. 

Kliknij tu, by ukryć tę wiado-
mość i pozostawić książkę w 
trybie „tylko do odczytu” 

Kliknij tutaj, jeżeli chcesz 
dodawać swoje własne 
komentarze i zaznaczenia 
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 (CC) Witold Jaworski, 2009 – 2020. 

Oczywiście, możesz czytać tę książkę na tablecie, szczególnie jakimś większym. Dla urządzeń z systemem 

Android polecam także Adobe Reader (Rysunek 4): 

                   

Rysunek 4 Zawartość książki w systemie Android (Adobe Reader wersja mobilna) 

W stosunku do wersji z komputerów PC (pokazanej na poprzednich stronach), ten Adobe Reader ma uprosz-

czony interfejs użytkownika (Rysunek 5):  

 
 

 

Rysunek 5 Interfejs użytkownika programu Adobe Reader (Android) 

Na szczęście nadal można tu ustawić ciągłe wyświetlanie stron (opcja Continuous, por. Rysunek 5). To przyda-

je się szczególnie dla mniejszych ekranów! 

Naciskanie środka 
ekranu przełącza 
widoczność pa-
sków narzędzi 

Suwak stron 

Układ 

stron 

Struktura 
książki 
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W mobilnym wariancie Adobe Acrobat Reader także możesz korzystać z linków. Niestety, na ekranach doty-

kowych nie ma kursora, który by się zmieniał ponad takim odsyłaczem. Wystarczy jednak pamiętać, że każdy 

numer strony, ilustracji lub rozdziału zawiera odpowiedni link. Po prostu naciśnij odpowiedni tekst (Rysunek 6): 

 

 

 

Rysunek 6 Korzystanie z hipertekstowych odsyłaczy 

Aby powrócić z takiego „skoku” w poprzednie położenie w tekście książki, skorzystaj z przycisku „<”, który poja-

wi się z prawej (przy numerze strony – Rysunek 7): 

     

 

 

Rysunek 7 Powrót do poprzedniego miejsca (Android) 

Naciśnij na 

numer strony… 

… i to ją 
otworzy! 

… a znajdziesz się z powro-
tem na stronie, z której 
wywołałeś ten link, 

Naciśnij 
suwak… 

Page selection dialog: 

…potem naciśnij 
tę pozycję… 
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 (CC) Witold Jaworski, 2009 – 2020. 

Rysunek 7 pokazuje okno wyboru strony, otwierane po naciśnięciu suwaka. Naciśnij w nim pozycję Go to last 

viewed, a wrócisz do tekstu głównego. (Mówiąc szczerze, wersja Adobe Acrobat Reader dla systemu Android 

sprzed kilku lat była wygodniejsza: miała przycisk Wstecz obok numeru aktualnej strony). 

Adobe Acrobat Reader ma także swój wariant dla systemu iOS. Niestety, w jego oknie wyboru strony brakuje 

kluczowej pozycji „Go to last viewed” (Rysunek 8): 

 

Rysunek 8 Okno wyboru strony w Adobe Reader dla iOS 

Dlatego jestem zmuszony zarekomendować dla iOS inny program: GoodReader. Ta płatna aplikacja (aktualnie 

dostępna w AppStore za 27zł) to doskonałe narzędzie do czytania na IPadzie (Rysunek 9): 

    

Rysunek 9 GoodReader dla iOS 

Poza samym czytaniem, GoodReader jest wygodnym narzędziem do zarządzania plikami książek na tablecie i 

w chmurze. Zawiera nawet własną przeglądarkę do obsługi umieszczonych w tekście odsyłaczy do Internetu. 

Naciśnij suwak by otwo-
rzyć okno wyboru strony… 

… lecz nie ma w nim pozycji 
Go to last viewed, którą używa-
liśmy w systemie Android! 
 

Naciśnij, by przełączyć przyborniki 

Zarządzaj 
książkami 

Komentuj i zaznaczaj 
fragmenty tekstu 

Nawigacja po 
stronach i inne 
kontrolki 

https://www.goodreader.com/
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U dołu ekranu znajdziesz w nim w tak przydatny przycisk Wstecz, ale także wiele innych „gadżetów”, jak np. 

pasek wyboru stron (Rysunek 10): 

 

Rysunek 10 GoodReader dla iOS 

Oprócz przycisku Wstecz, który pozwala na powrót z połączonej strony, GoodReader potrafi także zaznaczyć w 

tekście wszystkie wewnętrzne odsyłacze. Wystarczy tylko włączyć w ustawieniach książki opcję Show link 

bounds (Rysunek 11): 

 

Rysunek 11 GoodReader: kilka przydatnych opcji w ustawieniach książki 

Osobiście jednak, tak jak napisałem na początku tej sekcji, wolę czytać tekst bez takich oznaczeń. 

 

Struktura 
książki 

Przycisk 
Wstecz 

Wyszuki-
wanie 

Ustawienia 
książki 

Pasek 
przewijania 

Ta opcja rysuje 
niebieskie ramki 

wokół odsyłaczy 

Tutaj można także wyłączyć własną 
przeglądarkę Internetu GoodReader 
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Przygotowanie „warsztatu pracy” dla tego projektu 

Po pierwsze, potrzebujesz komputer. Nie musi być to nowa maszyna, ale sugeruję nie używać sprzętu sprzed 

więcej niż siedmiu lat.  

Przypuszczam, że większość czytelników tej książki używa komputera z Windows. Podczas opisu instalacji 

koncentruję się wyłącznie na tym środowisku. Sam go używam na moich komputerach. Nie mam żadnych do-

świadczeń z Linuksem ani z Mac OS, więc nie będę pisał o instalacjach, których nie wykonałem. Jeżeli używasz 

systemów innych niż Windows – poszukaj wskazówek na temat ich instalacji na stronach poszczególnych pro-

gramów. (Adresy tych portali zawiera Rozdział 2. Znajdziesz je na początku każdej z jego sekcji). 
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Rozdział 1. Pobranie materiałów pomocniczych 

 

Pliki towarzyszące tej książce możesz pobrać ze strony: http://samoloty3d.pl/wm4_p.xml. Utrzymuję 

tam ich aktualne wersje1. Uaktualniam je co jakiś czas, aby odpowiadały aktualnej wersji Blendera. 

 
 Następujące pliki są ważną częścią tej książki: 

- source.zip:  zawiera skrypty Pythona, plany P-40B, udostępnione przez producenta fragmenty rysun-

ków technicznych (P-40E) i inne pomocnicze materiały; 

- optional.zip: dodatkowe (opcjonalne) materiały; 

Rozpakuj wszystkie pobrane pliki *.zip do tego samego folderu. Rysunek 1.1 pokazuje strukturę podkatalogów, 

jaka powstanie po ich rozpakowaniu (pliki nie wymienione powyżej należą do innych części tej publikacji): 

 

 

 

 

 

 

 

 

 

    

 

 

 

 

Rysunek 1.1 Strona, z której możesz pobrać pliki Blendera 

Oczywiście, nazwa mój_folder zależy od Ciebie. 

 

 
1 Na tej stronie znajdziesz także odpowiedzi na najczęstsze pytania zadawane przez Czytelników oraz informacje o zmianach w opisywa-

nym oprogramowaniu, jakie się pojawiły po publikacji tej książki. 

mój folder 

model 

la5 

p40 

history 

optional 

source 

textures 

background 

Zawartość pliku la5.zip 

Zawartość pliku source.zip 

Zawartość pliku optional.zip 

Zawartość pliku textures.zip 

Zawartość plików p40.zip  

Rozpakuj wszystkie pobrane 
pliki w tym folderze. Stworzy to 
odpowiednie podkatalogi: 

http://samoloty3d.pl/wm4_p.xml
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Rozdział 2. Instalacja oprogramowania 

W tym rozdziale omówimy pokrótce instalację oprogramowania, z którego będziemy korzystać. W tym tomie to: 

- GIMP: pomocniczy, do edycji obrazów rastrowych; 

- Inkscape: pomocniczy, do edycji obrazów wektorowych; 

 
To oprogramowanie jest udostępniane w zasadach licencji GPL. Oznacza to m.in., że nie można pobierać za 

nie żadnych opłat. (Oczywiście, jeżeli masz gest, a program Ci się bardzo spodoba, możesz wspomóc twórców 

dotacją – ale na zasadzie zupełnej dobrowolności. Szczegółowy opis, jak to zrobić, znajdziesz na stronie inter-

netowej każdego z tych projektów). 
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2.1 Instalacja GIMP 

W tej książce używam GIMP 2.10. Pobierz jego program instalacyjny ze http://www.gimp.org (Rysunek 2.1.1):  

 

Rysunek 2.1.1 Portal projektu GIMP 

Obecnie (w czasie, gdy piszę tę książkę), ta strona kieruje na http://www.gimp.org/downloads (Rysunek 2.1.2): 

 

Rysunek 2.1.2 Strona z programem instalacyjnym 

Udostępniony tam uniwersalny program instalacyjny zawiera obydwie wersje GIMPA: 32-bitową i 64-bitową. Po 

uruchomieniu rozpoznaje typ systemu operacyjnego, i, gdy jest to możliwe, instaluje wersję 64-bitową1. 

 

 
1 W 64-bitowych systemach Windows 7 i Windows 8 aplikacje 32-bitowe możesz poznać po tym, że ich pliki znajdują się w katalogu 

C:\Program Files (x86)\, podczas gdy pliki aplikacji 64-bitowych – w C:\Program Files\. 

Click here 

Pobierz ten program 
instalacyjny 

http://www.gimp.org/
http://www.gimp.org/downloads
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 (CC) Witold Jaworski, 2009 – 2020. 

 

Portal GIMP udostępnia także pliki instalacyjne poprzedniej wersji programu. (Znajdziesz je na tej sa-

mej stronie, poniżej wersji aktualnej). Obecnie jest to GIMP 2.8, lecz w przyszłości, gdy aktualną wersją 

będzie GIMP 3.0, znajdziesz w tym miejscu GIMP 2.10 (sądzę, że nie wcześniej niż w 2023r). 

 
 W procesie instalacji Gimpa nie ma żadnych "haczyków". Po prostu naciskaj przycisk Next. 

Podczas pierwszego uruchomienia GIMP rejestruje różne swoje komponenty, więc będzie wyświetlał swój ekran 

powitalny przez minutę lub dwie (Rysunek 2.1.3): 

 

Rysunek 2.1.3 Ekran powitalny GIMP 

(Normalnie będzie startował o wiele szybciej). Następnie GIMP otwiera główne okno programu (Rysunek 2.1.4): 

 

Rysunek 2.1.4 Główne okno GIMP w domyślnym, ciemnym motywie 

Osobiście nie przepadam za taką ciemną kolorystyką i monochromatycznymi ikonami. Co więcej – to jest no-

wość. GIMP 2.8 i wszystkie wersje poprzednie używały jaśniejszego motywu z większymi, kolorowymi ikonami. 

Pasek postępu 
rejestracji kompo-
nentów programu 

W tym przyborniku 
część poleceń jest 
ukryta (w grupach) 

Jednobarwne 
ikony 
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Większość poradników o GIMP wykorzystuje tę jaśniejszą kolorystykę. Dlatego sugeruję nadać oknom GIMP 

bardziej „klasyczny” wygląd (Rysunek 2.1.5): 

 

Rysunek 2.1.5 Główne okno GIMP w bardziej „klasycznych” barwach   

Aby go uzyskać, otwórz okno Edit→Preferences. Na liście Interface→Theme wybierz System, a na liście 

Interface→Icon theme wybierz Color. Dodatkowo sugeruję „rozwinąć" przybornik, tak, aby pokazywał wszyst-

kie polecenia. W tym celu wyłącz opcję Use tool groups z panelu Interface→Toolbox. (Szczegóły tej instalacji 

możesz znaleźć na str. 119). 

 

Jeżeli nigdy wcześniej nie używałeś GIMP – możesz zerknąć na krótkie wprowadzenie do tego programu, 

umieszczone na str. 123.   

 

 

 

 

Wszystkie 

polecenia 

Klasyczne, 
kolorowe 
ikony 
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2.2 Instalacja Inkscape 

W tej książce używam Inkscape 1.0. Jego instalator można pobrać z http://www.inkscape.org (Rysunek 2.2.1):   

 

Rysunek 2.2.1 Strona projektu Inkscape 

Kliknij w jeden ze wskazanych na ilustracji powyżej linków, aby przejść do strony pobrań (Rysunek 2.2.2): 

 

Rysunek 2.2.2 Strona z plikami instalacyjnymi Inkscape 

Kliknij tu (lub tu) aby przejść 
do pobierania programu 

Przypuszczam, że ta strona odczytuje z przeglądarki 
standardowe informacje o systemie użytkownika, aby 
zaproponować właściwą wersje pliku instalacyjnego 

Kliknij ten przycisk 
by pobrać program 
instalacyjny 

Jeżeli chcesz stworzyć “przenośną” 
instalację, możesz po prostu pobrać 
i rozpakować ten plik archiwum *.7z 

http://www.inkscape.org/


24 Przygotowanie „warsztatu pracy” dla tego projektu 

 

 

Wirtualne modelarstwo – Tom I: Przygotowania 

www.samoloty3d.pl 

Portal Inkscape wykorzystuje standardową informację o systemie operacyjnym, dostarczaną przez Twoja prze-

glądarkę, do wyboru prawidłowego pakietu instalacyjnego (to powinna być wersja 64-bitowa). 

 

Ważna informacja na temat aktualizacji Inkscape: zgodnie ze wskazówkami ze strony pobrań, przed 

instalacją nowej wersji należy usunąć (odinstalować) poprzednią. 

W takim przypadku możesz się zastanowić nad użyciem do aktualizacji tego programu wersji spakowanej w pliku 

*.7z (patrz str. 23, Rysunek 2.2.2). Wystarczy wówczas usunąć całą dotychczasową zawartość folderu Inkscape i 

rozpakować w to miejsce pliki z pobranego archiwum *.7z.  

 
 Klasyczny proces instalacji także jest prosty, wystarczy klikać po kolei w przyciski Next. Pamiętaj, aby zazna-

czyć wstawienie ikony Inkscape na pulpit, bo to akurat domyślnie jest wyłączone (Rysunek 2.2.3): 

 

Rysunek 2.2.3 Wybierz opcję Create Icon 

Przy pierwszym uruchomieniu Inkscape wygląda jak poniżej (Rysunek 2.2.4): 

 

Rysunek 2.2.4 Ekran Inkscape przy pierwszym uruchomieniu 

To tak zwany „szeroki” (Wide) układ ekranu. 

 

Wybierz tę opcję 
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Proponuję wprowadzić tu dwie drobne modyfikacje. Zmień najpierw poleceniem View→Default układ ekranu na 

taki, w którym pasek poleceń znajduje się u góry, a nie po prawej stronie. Następnie w oknie preferencji 

(Edit→Preferences), przejdź do panelu Interface→Theme, i przełącz ikony (lista icon theme) na hicolor. (Ten 

motyw zawiera klasyczne ikony dla odbić lustrzanych i ćwierćobrotów – por. Rysunek 2.2.5) 

 

Rysunek 2.2.5 Ten sam ekran, po modyfikacjach 

Szczegółowy opis instalacji Inkscape znajdziesz na str. 135. 

 

W układzie Default 
ten przybornik jest u 
góry ekranu Motyw hicolor zawiera 

klasyczne ikony odbić 
lustrzanych i ćwierćobrotów 
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Przygotowanie rysunków referencyjnych 

Model cyfrowy powstaje na podstawie dwuwymiarowych planów: rzutu z boku, góry, dołu, przodu, ewentualnie 

także z tyłu. Takie rysunki muszą być dokładne. Inaczej tylko utrudnią nam pracę1. 

Ta część książki przedstawia proces przygotowania tych kluczowych materiałów referencyjnych na przykładzie 

myśliwca Curtiss P-40B. Omówię tu kilka ogólnych metod, których możesz użyć do weryfikacji planów dowolne-

go samolotu. Informacje z tej części mogą być także przydatne do przygotowania klasycznych planów modelar-

skich. Przy okazji zapoznamy się tu z programem rysunkowym Inkscape (i podstawami GIMP). 

 

Jeżeli szukasz wyłącznie podstawowych instrukcji jak przygotować obrazy wzorcowe samolotu dla 

projektu w 3D, przeczytaj z tej części tylko Rozdział 3. Jeżeli zamierzasz wykonać model P-40 w Blen-

derze, przeczytaj także Rozdział 6. (Rozdział 4 i Rozdział 5 są przeznaczone dla tych, którzy chcą two-

rzyć dokładniejsze modele).   

 
  

 

 

 

 

 
1 Gdy płat na rysunku z góry wypada w innym miejscu kadłuba niż na rysunku z boku - zaczyna się problem. Podobnie, gdy na planach lewy 

ster wysokości ma nieco inny obrys niż prawy. I który jest poprawny? Takie błędy występują dość często, nawet na dobrych planach mode-

larskich. Mylić się jest rzeczą ludzką, a nie darmo stare powiedzeniem kreślarzy brzmi: "papier zniesie wszystko". 
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Rozdział 3. Adaptacja typowych planów modelarskich 

W tym rozdziale pokażę podstawowy proces przygotowania rysunków referencyjnych. Trzeba je wyprostować, 

sprawdzić poprawność proporcji i zapisać w plikach o ujednoliconych wymiarach. Po zapoznaniu się z umiesz-

czonymi tu sekcjami będziesz w stanie sam przygotować zestaw rysunków wzorcowych, których użyjesz w 

Blenderze. 

Jako przykłady typowych (całkiem dobrych) planów modelarskich wybrałem dwa zestawy rysunków P-40B, 

opracowane przez dwóch różnych autorów: 

• Jacka Jackiewicza – rysunki opublikowane w monografii "Curtiss P-40", wydanej w roku 2000 przez AJ 

Press, w ramach serii "Monografie lotnicze" (zeszyt nr 64); 

• Mariusza Łukasika – rysunki opublikowane w monografii "Curtiss P-40", wydanej w roku 2008 przez 

Kagero, w ramach serii "Monografie" (zeszyt nr 36). Obecne są dostępne w innym zeszycie, chociażby 

w sklepie Kagero.  

 

 

Monografia AJ Press dawno już została wyprzedana. Jeżeli chcesz używać dokładnie tych samych 

rysunków jak przedstawione w tym rozdziale, możesz stąd pobrać archiwum *.zip ze skanami zeszytu 

#64. (Podany link przekierowuje na serwer, na którym je znalazłem).  

 
 

 

Gdy rozpakujesz archiwum source.zip, które towarzyszy tej książce (por. str. 18), w folderze 

source\references\sample znajdziesz pliki Inkscape (*.svg) nazwane: drawings_(3.2).svg … 

drawings_(3.7).svg. Zawierają rezultaty poszczególnych sekcji (3.2 … 3.7) tego rozdziału. 

 
 

https://sklep.kagero.pl/curtiss-p-40-b-c-d-e.html
http://airplanes3d.net/downloads/wm4/blueprints/typical
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3.1 Skanowanie planów modelarskich 

W Internecie możesz znaleźć mnóstwo rysunków samolotów, lecz większość z nich jest marnej jakości. Kla-

syczne papierowe monografie są często jedynym źródłem bardziej szczegółowych planów1. W takim przypadku 

musisz zeskanować ich strony. Na szczęście to może być całkiem proste, jeżeli używasz spopularyzowanego 

kilka lat temu połączenia kopiarki, skanera i drukarki2. Upewnij się tylko, że Twój skaner jest podłączony do 

komputera i zasilania, przyłóż skanowaną stronę na jego pulpicie, i uruchom GIMP3.  

W GIMP wywołaj polecenie File→Create→Scanner/Camera by zeskanować aktualną stronę (szczegóły − por. 

str. 128). Choć na współczesnych skanerach możesz osiągnąć wysokie rozdzielczości (do 1200 dpi), użyj dla 

planów dużo mniejszych wartości (np. 300 dpi). Rysunek 3.1.1 przedstawia przykład uzyskanego obrazu: 

 

Rysunek 3.1.1 Zeskanowany rysunek 

Po zakończeniu skanowania przyjrzyj się uzyskanemu obrazowi, szukając ewentualnych deformacji spowodo-

wanych przez zagięcia papieru, lub innych wad. W przypadku, który pokazuje Rysunek 3.1.1, znalazłem trzy 

błędy. Pierwszy z nich: nieznaczny obrót strony – można łatwo skorygować. Rozmyta krawędź wzdłuż szwu 

także jest OK, dopóki nie zbliża się do żadnego fragmentu rysunku. Jednakże trzeci błąd zdyskwalifikował ten 

skan: rozmyty kontur statecznika, przy zewnętrznej krawędzi strony. (Najprawdopodobniej niechcący pofałdo-

wałem ten obszar podczas skanowania). Musiałem usunąć ten rezultat (poleceniem File→Close View, bez 

zapisywania) i powtórzyć całą operację. Gdy uzyskasz obraz wolny od wad, zapisz go jako plik *.jpg, używając 

polecenia File→Export (patrz str. 131). 

 
1 Od razu możesz odrzucić wszystkie rysunki bez linii nitów (oczywiście, w przypadku konstrukcji metalowych). Wyjątkiem od tej reguły są 

nowoczesne myśliwce, gdyż w ich stosunkowo grubym, wypolerowanym poszyciu, płaskie, wpuszczane nity są praktycznie niewidoczne. 

2 Na przykład: moja drukarka/skaner/kopiarka Brother DCP-125 kosztowała niewiele więcej niż jej komplet tonerów; 

3 Jeżeli używasz GIMP po raz pierwszy – zerknij na jego krótkie wprowadzenie na str. 123.  

Rozmyty 
kontur 
steru  

Niewielki obrót 
skanowanej strony  

Rozmyta krawędź 
wzdłuż szwu  
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3.2 Przygotowanie rzutu z lewej 

Rysunki po zeskanowaniu nie nadają się do natychmiastowego użycia. Zazwyczaj są mniej lub bardziej znie-

kształcone – na przykład osie samolotu nie są idealnie poziome lub pionowe. Mogą im się także przytrafić pro-

blemy z wzajemną prostopadłością. Takie rzeczy trzeba sprawdzić i skorygować. Stworzymy w ten sposób ich 

poprawione wersje: każdy rzut w oddzielnym pliku. Zrobię to w Inkscape. 

Wczytaj do Inkscape (File→Import, patrz str. 143) jeden z zeskanowanych arkuszy, zawierający rzut z boku. 

Zazwyczaj najlepiej jest użyć w tym celu jednego z głównych arkuszy planów. Raczej nie korzystaj z zestawie-

nia różnych wersji samolotu, ponieważ na rysunkach robionych metodą tradycyjną – w tuszu – zestawienie ko-

lejnych wersji jest zawsze narysowane mniej starannie. Jeżeli chcesz używać dokładnie tych samych skanów 

jak poniżej (z monografii AJ Press), pobierz z tego pliku archiwum obraz o nazwie 63.tif. Na początek, złap go 

myszką i przesuń1 na środek strony dokumentu Inkscape (Rysunek 3.2.1): 

 

Rysunek 3.2.1 Zeskanowana strona, włączona (link) do dokumentu Inkscape (Jacek Jackiewicz, AJ Press) 

Jak widać, poza widokiem z lewej ta strona zawiera także widok z góry, którego na razie nie potrzebujemy. Wy-

tnijmy go z tego obrazu. 

 

 
1 Jeżeli zupełnie nie znasz Inkscape – patrz wskazówki, jak przesunąć obiekt na str. 139. 

Teraz potrzebujemy 
tylko tego widoku 

http://airplanes3d.net/downloads/wm4/blueprints/typical
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Powiększ nieco aktualny rysunek (szczegóły – patrz str. 144) i obrysuj widok z boku konturem zamkniętym 

(szczegóły – patrz str. 147). Ten zgrubny obrys nie musi być dokładny (Rysunek 3.2.3a), więc rysuj go swobod-

nie, omijając inne elementy zeskanowanego obrazu. Gdy będzie gotowy, użyj go do obcięcia reszty skanu 

(Object→Clip→Set, patrz str. 148). Rysunek 3.2.3b) przedstawia rezultat tej operacji: 

 

 

Rysunek 3.2.2 Wycinanie rzutu z boku ze skanu strony 

Teraz sprawdzimy, czy rysunek nie jest obrócony ani przekoszony. Umieść linie pomocnicze (guides: szczegóły 

– patrz str. 149) na liniach konstrukcyjnych, które powinny być pionowe lub poziome (Rysunek 3.2.3): 

 

Rysunek 3.2.3 Przykładowe rozmieszczenie linii pomocniczych 

Zapewne zapytacie, skąd wiem, które łączenia blach na kadłubie P-40 były pionowe lub poziome. No cóż, nie 

ma na to precyzyjnej odpowiedzi. Zacznijmy od poziomych. Na każdym rysunku i wielu zdjęciach widać na ka-

Obrysuj rzut z 
boku konturem 
zamkniętym 

 

Clip 

Widok z boku, wycięty z 
zeskanowanego obrazu 

a) 

b) 

Główny szew 
kadłuba 

Linie po-
mocnicze Linie poziome i pionowe 

są odchylone w tą samą 
stronę  



Rozdział 3 Adaptacja typowych planów modelarskich 31 

 

 
 (CC) Witold Jaworski, 2009 – 2020. 

dłubie długi szew, ciągnący się od ogona do okapotowania silnika (por. Rysunek 3.2.3, szew biegnący od 

przedniej krawędzi steru do płaszczyzny przekroju „D”). Jego linia przebiega odrobinę poniżej osi śmigła. W 

opisie technicznym samolotu można wyczytać, że kadłub P-40 był składany z dwóch połówek: górnej i dolnej. 

Co więcej, na zachowanych zdjęciach z odbudowy pewnego nowozelandzkiego P-40N widać, że granica po-

działu biegnie właśnie wzdłuż tego szwu. Wydaje się to tym bardziej prawdopodobne, że blachy w P-40 były 

łączone "na zakładkę". Krawędź dolnej połówki kadłuba – ta niewidoczna, schowana "pod zakładką" – znajduje 

się jakieś 2 cm powyżej szwu. To prawdopodobnie ślad po oryginalnej osi samolotu, jaka występowała na jego 

rysunkach konstrukcyjnych. Linie pionowe, które sprawdzam, są to po prostu linie głównych wręg. Krawędź 

steru kierunku – zakładam, że jest prostopadła do osi kadłuba, bo na taką wygląda. (Technolodzy, gdy robią już 

coś ukośnego, to jest to zwykle pochylone o jakiś znaczący kąt, a nie o ułamek stopnia). 

Jak pokazuje to Rysunek 3.2.3, wszystkie linie obrazu: poziome i pionowe są odchylone o podobny kąt. Na tej 

podstawie oceniłem, że ten widok z lewej jest nieco obrócony, ale ta deformacja może być dodatkowo połączo-

na z niewielkim przekoszeniem. Zacznijmy od odwrócenia obrotu, a potem zobaczymy, co dalej. Umieść oś 

obrotu (por. str. 151) w punkcie przecięcia poziomej linii pomocniczej i głównego szwu kadłuba, a następnie 

obracaj (por. str. 154) widok z boku aż te dwie linie się dokładnie pokryją, jak to pokazuje Rysunek 3.2.4: 

 

Rysunek 3.2.4 Korygowanie obrotu obrazu  

Teraz szwy na rysunku przylegają do linii pomocni-

czych. Trzeba to jednak sprawdzić w zbliżeniu. Przej-

rzyj ten rzut z boku fragment po fragmencie. Zauważ, 

jak niedoskonałe są widziane w takim powiększeniu 

linie rysunku. Przyczyną jest czarno-biały (B/W) for-

mat zapisu tego obrazu. W jego strukturach danych 

każdy piksel jest reprezentowany przez pojedynczy 

bit. To najbardziej „spakowany” format zapisu: wyni-

kowy plik *.tif jest trzy razy mniejszy od tego samego 

obrazu zapisanego w formacie *.jpg. Niestety, w przy-

padku skanów tworzy nierówne, lekko poszarpane 

linie.  

Podczas tego przeglądu znalazłem niewielkie odchy-

lenie na okapotowaniu silnika (Rysunek 3.2.5). To 

może być efekt deformacji np. podczas skanowania. 

W takim przypadku wszystkie linie tego obszaru po-

winny mieć podobne odchylenia. Jednak dwie sąsied-

nie linie wydają się być zupełnie pionowe. 

 

Rysunek 3.2.5 Niewielkie odchylenia na osłonie silnika  

 

Umieść oś obrotu w punk-
cie przecięcia szwu kadłuba 
i poziomej linii pomocniczej 

Wyłącz 
przyciąganie 

Sąsiednie szwy 
są pionowe 

Niewielkie 
odchylenie 
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Znalazłem jeszcze inne odchylenie na ogonie (Rysunek 3.2.6). Linia głównego szwu, biegnąca poziomo przez 

cały kadłub, w tym obszarze wyraźnie jest zagięta w dół. Nie jest to duże odchylenie, ale wykracza poza tole-

rancję "jednego piksela", jaka może wystąpić w liniach skanowanych rysunków.  

  

Rysunek 3.2.6 Szczegółowe sprawdzanie równoległości linii rysunku - odchylenia na ogonie 

Tak jak w poprzednim przypadku, nie znalazłem podobnej deformacji wśród pozostałych linii kadłuba. W szcze-

gólności, zmierzyłem kąt zaklinowania statecznika poziomego. Zgodnie z opisem technicznym samolotu powi-

nien wynosić +2º – i tak jest! Więc co o tym sądzić?  

Przyjrzyjmy się dokładniej. Rysunek Jacka Jackiewicza, który tu analizujemy, wygląda na wykonywany metodą 

tradycyjną. (Kreślony najpierw ołówkiem, potem – poprzez kalkę – tuszem). Dla porównania, popatrz na widok z 

boku z rysunków Kagero. Opracowano je kilka lat później, w programie rysunkowym (Rysunek 3.2.7): 

 

 

 

 

 

Rysunek 3.2.7 Inny rysunek, wykonany  na komputerze (Mariusz Łukasik, Kagero) 

Zeskanowałem ten obraz w odcieniach szarości, ale wygląda lepiej nawet w B/W. Zauważ, że nie widać na nim 

odchyleń, które dostrzegłem na rysunku z AJ Press. Ostatecznie doszedłem do wniosku, że te drobne dewiacje 

na planach AJ Press to po prostu przypadkowe, ludzkie pomyłki. 

Ten szew jest tu 
zagięty do dołu 

Kąt zaklinowania statecznika: 
+ 2º - zgodny z opisem kon-
strukcji 

Bez odchyleń 
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Więcej niż połowa dostępnych obecnie planów samolotów powstała w zeszłym stuleciu. Większość z 

nich była kreślona ręcznie, więc możliwe, że napotkasz na nich błędy podobne do opisanych powyżej.   

 
 * * * 

W tej sekcji wycięliśmy z zeskanowanej strony rzut z boku i skorygowaliśmy jego geometrię. Teraz czas zapisać 

ten plik Inkscape (File→Save, por. str. 142). Nazwijmy go drawing.svg. W dalszych sekcjach tego rozdziału 

będziemy dodawać do tego dokumentu inne rzuty z zeskanowanych planów i organizować je za pomocą 

warstw. 

Podsumowanie 

• Zawsze zaczynaj pracę nad rysunkami od przygotowania widoku z lewej strony. W większości przypadków 

to najdokładniejszy1 z rzutów. Staraj się unikać wycinania tej sylwetki z mniej ważnych części planów, jak 

np. lista poszczególnych wersji samolotu. 

• W Inkscape możesz szybko wyciąć fragment obrazu (np. – rzut z boku z zeskanowanej strony). Kontur ta-

kiego fragmentu może być złożonym wielobokiem (str. 30). 

• Sprawdź, czy zeskanowany obraz nie jest zdeformowany (str. 30), i popraw typowe odchylenia, jak obrót 

skanowanej strony (str. 31). 

• Część z planów była kreślona ręcznie. W takich rysunkach możesz znaleźć wiele niewielkich niedoskona-

łości w kształcie samolotu czy w liniach szwów poszycia (str. 31, 32). 

 

 

W danych towarzyszących tej książce (por. str. 18) znajdziesz plik Inkscape opisany w tej sekcji: 

source\references\sample\drawings_(3.2).svg.   

 
  

 
1 Widoki z boku są zawsze najlepiej udokumentowane, gdyż najwięcej zdjęć samolotów to zdjęcia poziome - z boku lub z przodu. Wielu 

kreślarzy często zupełnie odruchowo zaczyna tworzenie planów właśnie od rzutu z lewej. Używają później tej sylwetki jako odniesienia przy 

rysowaniu pozostałych rzutów samolotu (w szczególności: z góry i z dołu). Widoki z tyłu i z przodu są najmniej dokładne, gdyż są zazwyczaj 

wyznaczane na sam koniec, ze złożenia rzutów z boku, góry i dołu. Przez to sumują się w nich wszystkie ewentualne błędy z innych rzutów!  
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3.3 Skalowanie rysunków 

Wszystkie rysunki, które włączasz do dokumentu Inkscape, powinny mieć identyczną skalę. Właściwy dobór jej 

podziałki pozwala na szybkie i proste sprawdzenie geometrii samolotu, co pokażę w dalszych sekcjach. W tej 

sekcji tylko zaczniemy ten proces: dobierzemy skalę dla tego P-40 i dopasujemy odpowiednio widok z boku. 

W pierwszej kolejności, musisz znać rozmiar oryginalnego obiektu. W przypadku rzutu z boku zazwyczaj bę-

dziesz mieć do dyspozycji tylko długość całkowitą. Najlepszym źródłem są tu rysunki poglądowe, publikowane 

przez producenta samolotu. Rysunek 3.3.1 pokazuje rzut z boku pochodzący z jednego z najwcześniejszych 

rysunków P-40, opublikowanych przez Curtiss w 19411:   

 

Rysunek 3.3.1 Rzut z boku P-40 z oryginalnego rysunku poglądowego Curtiss (opublikowany w 1941r.) 

Jak większość rysunków poglądowych, przedstawiono tu tylko ogólny układ samolotu. Celem było pokazanie, 

że jest to wolnonośny dolnopłat z silnikiem rzędowym, zamkniętą kabiną pilota i chowanym podwoziem. Jed-

nakże kilka podanych tu wymiarów dostarcza informacji „z pierwszej ręki”. Oczywiście, nie wszystkie są przy-

datne. Nigdy nie użyłem podanych tu wysokości czy kąta pochylenia samolotu na ziemi, gdyż zależą od ugięcia 

goleni podwozia2. Z tego rysunku można użyć tylko długość całkowitą. Curtiss podaje ten główny wymiar w 

stopach i calach, podczas gdy wszystkie pozostałe wymiary są tylko w calach. Stąd łatwiej będzie, gdy prze-

liczmy na cale także długość całkowitą: wynosi 380.56”. W oparciu o historię tej konstrukcji możemy śmiało 

założyć, że jest to długość pierwszych trzech wersji: P-40-cu, P-40B, i P-40C. 

 

Zawsze staraj się odczytywać wymiary samolotu z oryginalnych rysunków poglądowych. Monografie i 

inne wtórne źródła tylko ślepo kopiują takie informacje jedne od drugich, be jakiejkolwiek weryfikacji. 

Czasami prowadzi to do znacznych błędów3. 

 
 Zwróć także uwagę, że ten rysunek potwierdza niejawne założenie z poprzedniej sekcji: oś śmigła była położo-

na powyżej konstrukcyjnej linii kadłuba. To nie jest ewidentne na rysunku AJ Press, ale można to wyraźnie do-

strzec na rzucie z boku z planów Kagero (por. str. 32, Rysunek 3.2.7). 

 
1 Oczywiście, przedtem były tajne. USAAC zamówiło 524 P-40 w kwietniu 1939r., a pierwsze dostawy rozpoczęły się w marcu 1940r. 

2 Długość amortyzatorów goleni podwozia P-40 mogła się różnić o parę cali. Zależało to od aktualnej masy samolotu. Jest mało prawdopo-

dobne, że ich pozycja odpowiada idealnej neutralnej pozycji zwymiarowanej na tym rysunku. (Nawet nie wspominam ewentualnych błędów 

w pozycji podwozia, które także mogą się pojawić na analizowanych planach). 

3 Na przykład: w większości publikacji o „krótkonosych” P-40 (P-40D i E) możesz znaleźć że ich długość to 31’ 2” (374”). Jednak zgodnie z 

oryginalnymi rysunkami poglądowymi P-40E, wynosiła ona 31’ 8 23/32” (380.72”). (Osłona silnika była krótsza, ale kołpak śmigła był większy 

niż w P-40C.) Tak więc tzw. “krótkonose” P-40 były w istocie odrobinę dłuższe od wcześniejszych („długonosych”) wersji! 

380.56” 

Zauważ, że oś śmigła jest powyżej 
linii konstrukcyjnej kadłuba 
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 (CC) Witold Jaworski, 2009 – 2020. 

Rysunki Inkscape można dowolnie skalować: dotyczy to także dołączonych do nich obrazów rastrowych. Ozna-

cza to, że nie musisz się martwić o odpowiednią rozdzielczość finalnych rysunków referencyjnych: będziesz 

mógł ją precyzyjnie ustawić podczas eksportu do pliku rastrowego (por. str. 159). 

Dzięki temu, że nie zamierzam drukować tego dokumentu Inkscape, dobrym pomysłem jest użycie skali 1:1. W 

ten sposób będziesz widzieć wszystko w tych samych jednostkach jak podane w oryginalnych wymiarach. Stąd 

w oknie File→Document Properties proponuję przełączyć wyświetlane jednostki na cale (por. str. 152).  

 

Dla konstrukcji z USA, jak ten P-40, sugeruję na wyświetlane jednostki dokumentu Inkscape wybierać 

cale. Dla samolotów z Polski, Niemiec, Francji, czy ZSSR, używaj centymetrów. 

 
 W tym pliku Inkscape wyłączyłem także wyświetlanie ramki strony. (Będziemy eksportować wynikowe pliki refe-

rencyjne używając innych ustawień, a ta ramka tylko mogłaby się nakładać na jakieś szczegóły). 

Od tej chwili, wszystkie wartości w tym dokumencie (położenie i rozmiar obiektu, pozycja myszki, itd.) są wyra-

żone w calach. Usuń wszystkie użyte dotychczas linie pomocnicze (por. str. 149) i ustaw po jednej linii pionowej 

i poziomej, przecinających się w X=0, Y=0 (Rysunek 3.3.2): 

 

Rysunek 3.3.2 Pierwsze dwie linie pomocnicze i oś obrazu 

Przesuń obraz rzutu z lewej i wyrównaj go do nowej linii poziomej (X=0). Następnie umieść oś tego obrazu w 

punkcie (0, 0), jak pokazuję powyżej. 

Dodaj następną pionową linię tam, gdzie ma się kończyć kadłub P-40 (X=380.56 – ustaw tę wartość w oknie 

właściwości linii pomocniczej, por. str. 150). Rysunek 3.3.3 pokazuje, jak to powinno teraz wyglądać: 

 

Rysunek 3.3.3 Następna pionowa linia pomocnicza 

Rzut z boku wydaje się mały. To normalne, gdyż w tej chwili jego długość to tylko 8” (szerokość strony A4). 

Linia pionowa (X=0) 

Linia pozioma (Y=0) 

Oś obrazu 

Pionowa linia 
(X=380.56) 

To jest obraz 
rzutu z boku 
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Teraz proporcjonalnie powiększ rzut z lewej, wykorzystując oś obrazu jako środek transformacji. (Przeciągnij 

uchwyt ramki selekcji, trzymając wciśnięte klawisze Shift + Ctrl  – por. str. 155): 

 

Rysunek 3.3.4 Rzut z boku w skali 1:1 

 

Możesz zablokować te trzy linie pomocnicze (włączając opcję Locked w ich oknach właściwości – 

patrz str. 150), ponieważ będziemy ich jeszcze używać do skalowania kolejnych rzutów. 

 
 Podczas skalowania warto pamiętać o regule „zewnętrznej krawędzi obrysu”. Klasyczny rysunek w skali jest 

kreślony za pomocą linii o dwóch różnych grubościach: cieńszej dla szczegółów wewnętrznych (łączenia paneli, 

itp.), i grubszej, dla obrysu obiektu. Aby uniknąć niejednoznaczności, wszyscy autorzy planów zakładają, że 

prawdziwy kontur odwzorowanego obiektu leży na zewnętrznej krawędzi obrysu (Rysunek 3.3.5):  

   

 

Rysunek 3.3.5 Reguła „zewnętrznej krawędzi obrysu” w planach modelarskich 

W ten sposób na granicy koloru czarnego i białego uzyskuje się linię konturu o zerowej szerokości. Dlatego 

pamiętaj, że obrys sylwetki samolotu powinien tylko „dotykać” linii pomocniczych, tak jak na ilustracji powyżej.  

Powiększ obraz 
z wciśniętymi 

Shift + Ctrl  

380.56” 

Wyłącz 
przyciąganie 

Prawdziwy kontur leży 
na zewnętrznej krawędzi 
obrysu  

Kontur obiektu jest 
obrysowany grubszą 
linią niż szczegóły 
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 (CC) Witold Jaworski, 2009 – 2020. 

Inkscape importuje obrazy w ich oryginalnym rozmiarze. W przypadku skanów jest to rozmiar strony (zazwyczaj 

to format A4: 8”x10”). Stąd w dalszych sekcjach tego rozdziału będziesz musiał powiększyć w ten sam sposób 

każdy ze skanów. 

 

Do skali „1:1” można także podejść inaczej: zakładając, że podstawową jednostką jest 1px, któremu 

odpowiada (w zależności od jednostek miary samolotu) 0.1 cala lub 1mm. W ten sposób nadal bę-

dziesz w stanie używać w Inkscape narzędzia „miarka”, która podaje rezultat w pikselach, niezależnie 

od aktualnych ustawień dokumentu. (Przykład takiego skalowania znajdziesz na str. 192). 

 
 Podsumowanie 

• Zawsze staraj się korzystać z wymiarów pochodzących z pierwotnego źródła, na przykład oryginalnych ry-

sunków poglądowych samolotu (str. 34). Jeżeli w żaden sposób nie możesz nic takiego znaleźć – sprawdź 

długość i rozpiętość w jak największej liczbie publikacji (ponieważ niektóre z nich mogą podawać błędne 

dane). 

• W dokumencie Inkscape zawierającym rysunki referencyjne sugeruję użyć skali 1:1. Oznacza to użycie cali 

dla samolotów wymiarowanych w calach i centymetrów dla samolotów zwymiarowanych w jednostkach 

metrycznych (str. 35). 

• Aby szybko i dokładnie powiększać zeskanowane obrazy, przygotuj trzy linie pomocnicze: dwie z nich po-

winny się przecinać w punkcie (0,0), a trzecia, pionowa, w punkcie odpowiadającym całkowitej długości 

samolotu. W opisanym przypadku to X= 380.56 (str. 35). 

• Wpasuj sylwetkę kadłuba pomiędzy te linie pomocnicze (str. 36) – w widoku z boku i we wszystkich kolej-

nych obrazach, które będziemy importować w dalszych sekcjach tego rozdziału. 

 

 

W danych towarzyszących tej książce (por. str. 18) znajdziesz plik Inkscape opisany w tej sekcji: 

source\references\sample\drawings_(3.3).svg.   
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3.4 Porównanie rzutów z prawej i lewej 

Zacznijmy od przygotowania oddzielnej warstwy dla widoku z prawej. Aktualnie widok z lewej znajduje się na 

domyślnej warstwie o nazwie Layer 1. Otwórz panel Layer→Layers. Zmień nazwę Layer 1 na Left (por. str. 

161) i stwórz nową warstwę o nazwie Views (por. str. 164). Przenieś Left do Views (por. str. 162) a potem dodaj 

do Views kolejną podwarstwę przeznaczoną na widok z prawej, o nazwie Right (Rysunek 3.4.1): 

                            

Rysunek 3.4.1 Przygotowanie struktury warstw dla tego dokumentu 

Ukryj warstwę Left i podświetl Right. (W ten sposób staje się warstwą bieżącą). Następnie wstaw obraz zeska-

nowanej strony z widokiem z prawej (może to być 64.tif z tego archiwum), i powtórz wszystkie operacje opisane 

w dwóch poprzednich sekcjach. (Wytnij go ze strony, ustaw poziomo, powiększ proporcjonalnie do skali 1:1). 

Rysunek 3.4.2 przedstawia oryginalną zeskanowaną stronę i rezultat tych operacji:   

  

Rysunek 3.4.2 Przygotowanie widoku z prawej (warstwa Right) 

Zauważyłem, że w tym widoku oś śmigła jest położona o wiele wyżej ponad osią kadłuba (więcej niż 1”) niż w 

widoku z lewej. 

 

Widok z lewej znajduje 
się na tej (domyślnej) 
warstwie 

Ustaw Right jako 
warstwę bieżącą 

Ukryj warstwę z 
widokiem z lewej 

Była Layer 1  

W tym widoku oś 
śmigła jest ponad 1” 
powyżej osi kadłuba 

Uwaga: gdy rysujesz w skali 1:1, domyślna szerokość linii 
(0.01 cala) jest tak cienka, że kontur staje się niewidoczny w 
normalnym powiększeniu. Zwiększ ją do 0.5 cala w panelu 
Fill and Stroke (str. 170) 
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 (CC) Witold Jaworski, 2009 – 2020. 

Nie wiemy także, czy nie istnieją inne, mniej widoczne różnice. Aby je 

znaleźć, umieśćmy „lustrzane odbicie” widoku z lewej strony ponad 

widokiem z prawej i sprawdźmy, gdzie ich linie się różnią. (To wyma-

gający test dla kreślonych ręcznie rysunków. Człowiek nie jest w sta-

nie dokładnie odtworzyć dwóch tak złożonych kształtów).  

W tym momencie proponuję stworzyć dla różnych porównań i innych 

chwilowych potrzeb nową warstwę o nazwie Wrk. Umieść ją poniżej 

Views. Dodaj do Wrk podwarstwę Cmp. To jest tymczasowe miejsce 

na sylwetkę, z którą będziemy pracować  (Rysunek 3.4.3). 

Na razie przesuń obraz widoku z prawej do warstwy Cmp (Layer→Move Selection to Layer, por. str. 165)1. 

Następnie ukryj warstwę Right (aktualnie pustą) i przerzuć obraz umieszczony na warstwie Cmp (Object→Flip 

Horizontal, patrz str. 167). Rysunek 3.4.4 przedstawia rezultat: 

 

Rysunek 3.4.4 Lustrzane odbicie widoku z prawej (dla porównań) 

Sugeruję także użycie jednego z tzw. filtrów (efektów rastrowych) do zabarwienia linii tego obrazu. Użyłem tu 

filtra Filters→Color→Channel Painting do przypisania wszystkim czarnym liniom kontrastowego koloru nie-

bieskiego (por. str. 168). Rysunek 3.4.5 pokazuje, jak to teraz wygląda: 

 

Rysunek 3.4.5 Kontrastowa, odwrócona wersja widoku z prawej 

 
1 Dla różnych porównań w Inkscape zazwyczaj sugeruję użycie klonów źródłowego obiektu (por. str. 187), ponieważ klony automatycznie 

odwzorowują ewentualne modyfikacje wprowadzone do obiektu źródłowego. Jednak podłączone obrazy rastrowe to specjalny przypadek, 

ponieważ one już są referencjami do zewnętrznych plików. Dlatego łatwiej jest tymczasowo przerzucić widok z lewej niż obsługiwać jego 

klon. 

 

Rysunek 3.4.3 Dodatkowe warstwy „robocze” 

 

Umieść ten obraz 
na warstwie Cmp 

Ukryj warstwę 
Right 

Obraz przerzucony w poziomie z 
prawej na lewą (Flip Horizontal) 
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Na koniec włącz widoczność warstwy Left i zmniejsz jej nieprzejrzystość (Opacity) do 50% (Rysunek 3.4.6): 

 

Rysunek 3.4.6 Nałożone na siebie widoki z prawej i lewej 

W rezultacie widzimy obydwa widoki z boku, jeden na drugim. Ewentualne różnice występują w miejscach, 

gdzie szare linie (widoku z lewej) są odsunięte od niebieskich linii widoku z prawej. Oczywiście, pomiń takie 

asymetryczne detale jak rurka Pitota czy pokrywa luku bagażowego (obydwie są z lewej strony). 

Prześledź w powiększeniu odchylenia pomiędzy tymi obrazami. Zwracaj szczególną uwagę na kluczowe linie, 

takie jak główne łączenia paneli kadłuba czy krawędź steru. Pamiętaj, że małe różnice są nie do uniknięcia w 

ręcznie kreślonych planach, szczególnie w kształcie krzywych.  

Pierwsza, największa różnica jest widoczna w przedniej części kadłuba (Rysunek 3.4.7): 

 

Rysunek 3.4.7 Porównanie rzutów z prawej i lewej (przednia część kadłuba) 

W porównaniu z niebieską sylwetką, czarny kontur wygląda jak wygięty do dołu. Największe odchylenie wystę-

puje w okolicach czubka kołpaka śmigła. Który z tych dwóch obrazów jest poprawny?   

 

 

Włącz widoczność i 
zmniejsz nieprzejrzystość 
warstwy Left 

Porównanie widoku z lewej 
(szare linie) z widokiem z 
prawej (niebieskie linie) 

Pionowe różnice na 
kołpaku śmigła i 
okapotowaniu silnika 

Poziome różnice pomiędzy 
poszczególnymi wręgami 
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Dla odchylenia w pionie mamy przynajmniej jedną wskazówkę: zgodnie z rysunkiem poglądowym (por. str. 34, 

Rysunek 3.3.1) czubek kołpaka (oś śmigła) była położona nieco powyżej konstrukcyjnej osi kadłuba. Z tego 

powodu błękitny kontur jest bardziej prawdopodobny, ale z drugiej strony – nie znamy tego wymiaru. 

Przypadek różnicy w poziomie jest trudniejszy. Jeżeli pobrałeś skany planów z Internetu, masz do wyboru tylko 

dwie opcje: umieszczenie odpowiednich linii w środku odstępów pomiędzy konturami (aby zminimalizować błę-

dy, lub rzucić monetą i wybrać jeden z tych konturów1.  

Na szczęście wiele lat temu kupiłem egzemplarz tej monografii AJ Press, więc wykonałem nowe skany tych 

stron. Starałem się to zrobić tak dokładnie, jak to jest możliwe. Pojawił się jednak problem ze szwem tego ze-

szytu. Nie chciałem go zniszczyć2, więc skanowałem wygięte strony. Rysunek 3.4.8 pokazuje szczegóły: 

 

 

 

 

 

                      

Rysunek 3.4.8 Skany rzutów z lewej i z prawej, oraz położenie szwu książki 

W przypadku widoku z lewej (Rysunek 3.4.8a) zagiąłem skanowaną stronę. Spowodowało to wąski pas defor-

macji wzdłuż jej wewnętrznej krawędzi. Na nieszczęście, w moim egzemplarzu sklejony szew nakłada się na 

czubek kołpaka, który na skanie jest odcięty. Wydaje się, że skany udostępnione w Internecie pochodzą z lep-

szej kopii, ponieważ przynajmniej widać na nich czubek kołpaka (por. str. 29, Rysunek 3.2.1). Tym niemniej 

nadal jest nieco zdeformowany3. 

Widok z prawej umieszczono w monografii AJ Press na następnej stronie (Rysunek 3.4.8b). W efekcie, połowa 

jego kołpaka leży wewnątrz szerszego obszaru deformacji. Jest ona spowodowana wygięciem skanowanej 

strony w pobliżu szwu. W rezultacie, zeskanowany kontur kołpaka jest krótszy niż powinien być na idealnie pła-

skim papierze. Zwróć też uwagę, że oś śmigła jest lekko wygięta do góry.  

 
1 Oczywiście, zawsze jest jeszcze trzecia opcja: poszukać planów opracowanych przez innych autorów, i skompilować widok z boku używa-

jąc dwóch lub więcej różnych planów. 

2 Wygląda na to, że to internetowe źródło tych rysunków zrobiło tak samo. (Te strony także są wygięte, ale jest to mniej widoczne w czarno-

białym formacie B/W, użytym w tych skanach). 

3 Monografia P-40 AJ Press była opublikowana w 2000r. Sądzę, że ten konkretny skan był stworzony kilka lat później, a następnie szeroko 

wykorzystywany w różnych sylwetkach barwnych lub innych planach. Możesz je wszystkie rozpoznać po charakterystycznym „tępym” czub-

ku kołpaka. Gdy uświadomisz sobie, że wszystko to wzięło się z przypadkowo zagiętej strony, lepiej zrozumiesz, dlaczego sprawdzam 

dokładnie każdy kawałek planów samolotu. 

Obszar 
deformacji 

Obszar 
deformacji 

Strona 63 (zgięta) Strona 64 Szew książki 
(klejony) 

Pulpit skanera Pulpit skanera 

Obcięty 
czubek 
kołpaka 

Oś 
śmigła 

Wygięcie 
osi 

a) b) 
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Ponieważ w obydwu widokach, które do tej pory przygotowaliśmy, kołpaki są mniej lub bardziej zdeformowane, 

użyjmy widoku z lewej P-40B z 62 strony monografii AJ Press. Znajdziesz ją w pliku 62.tif z tego archiwum. Ta 

lista wczesnych wersji P-40 jest jedyną stroną, na której kołpaki śmigła widoków z lewej znajdują się przy kra-

wędzi zewnętrznej (tj. na obszarze bez deformacji). W poprzednich sekcjach ostrzegałem przed użyciem rysun-

ków z takich zestawień wersji, gdyż są zazwyczaj mniej dokładne. Jednak w tym przypadku wydają się być ide-

alnymi kopiami rzutu ze strony 63 zeszytu AJ Press. Mogły powstać jako jego kserokopie (popularna technika w 

latach 90-tych), do których następnie dorysowano niewielkie poprawki specyficzne dla poszczególnych wersji. 

Wytnij z tej strony sylwetkę P-40B (Rysunek 3.4.9): 

 

Rysunek 3.4.9 Wycinanie kolejnego widoku z lewej 

Obszar zniekształceń (taki jak pokazuje Rysunek 3.4.8b) występuje wzdłuż prawej krawędzi tej strony i obejmu-

je stery kierunku. Spróbujemy połączyć ten i poprzedni obraz (obydwa zdeformowane) w jeden, poprawny. 

Najpierw ukryj warstwę Cmp (użyjemy jej później). Poniżej widzisz wyciętą sylwetkę (Rysunek 3.4.10). Umieści-

łem ją na nowo utworzonej warstwie Tmp. Dla łatwiejszego rozróżnienia, użyłem filtru Channel Painting do 

zmiany koloru linii tego rysunku na czerwony: 

 

Rysunek 3.4.10 Kolejny widok z lewej 

Wytnij tę 
sylwetkę 

Wydaje się, że te cztery sylwetki 
P-40 są kserokopiami widoku z 
lewej (tego ze strony 63 mono-
grafii AJ Press), którym doryso-
wano odpowiednie szczegóły 

Obszar zniekształceń 
wzdłuż szwu książki 

Niezdeformowany obszar 
skanowanej strony  

Możesz rozpoznać ten obraz 
po czerwonych liniach 

Stworzyłem nową 
warstwę dla tego 

obrazu: Tmp 
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Zdecydowałem się dopasować te dwa widoki z lewej wzdłuż przedniej krawędzi steru kierunku, ponieważ na 

czerwonym rysunku jest to pierwsza pionowa linia z niezdeformowanego obszaru (Rysunek 3.4.11): 

 

Rysunek 3.4.11 Porównanie dwóch widoków z lewej (czarny – z warstwy Left, czerwony – z warstwy Tmp)  

Następnie wyskalowałem czerwoną sylwetkę tak, że czubek jej niezdeformowanego kołpaka dotyka lewej linii 

pomocniczej. Rezultat może przypominać dwukolorowe obrazki dla okularów 3D, bo wszystkie czarne linie są 

odsunięte od czerwonych odpowiedników. Zmierzyłem fizycznie (w monografii) długość obydwu sylwetek i odle-

głości pomiędzy kluczowymi wręgami. Wszystkie są identyczne. (Całkowita długość obydwu konturów wynosi 

199mm). Oznacza to, że czarny obraz jest w tej chwili zbyt duży. 

Naprawmy to: zablokuj warstwę Tmp i odblokuj warstwę Left. Zaznacz czarną wersję rzutu z lewej i przesuń jej 

oś (pivot point) na przednią krawędź steru kierunku (Rysunek 3.4.12). Następnie zmniejszaj proporcjonalnie 

ten obraz, aż jego czarne linie wręg pokryją się z czerwonymi: 

 

Rysunek 3.4.12 Przeskalowany czarny rzut z lewej 

Aby połączyć te dwa obrazy w jeden rzut z lewej o poprawnych proporcjach, wyłącz widoczność warstwy Left, i 

odetnij zdeformowany ster kierunku od czerwonej sylwetki (Rysunek 3.4.13): 

 

Rysunek 3.4.13 Odcinanie zdeformowanego steru kierunku 

 

W czerwonej sylwetce ster kierunku jest 
zdeformowany (przez szew książki) 

Dopasowałem czarny i czerwony 
rysunek wzdłuż krawędzi steru  

W czarnej sylwetce kołpak jest 
zdeformowany (przez szew) 

Różnica w kształcie 
kołpaka śmigła 

Umieść tu oś 
skalowania 

Zmniejsz czarną 
sylwetkę 

Różnica w konturach 
steru kierunku 

Obrysuj nowym konturem niezde-
formowaną część tej sylwetki   

Ster pozostaw 
na zewnątrz  
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Aby odtworzyć oryginalny, czarny kolor linii, usuń czerwony filtr (Filters→Remove Filters). Następnie przenieś 

ten obcięty obraz (Layer→Move Selection to Layer) z warstwy Tmp na warstwę Left (Rysunek 3.4.14): 

 

Rysunek 3.4.14 Obraz z odciętym sterem kierunku 

Gdy teraz włączysz z powrotem widoczność warstwy Left, ujrzysz poprawiony widok z boku (Rysunek 3.4.15): 

 

Rysunek 3.4.15 Poprawiony widok z lewej (warstwa Views:Left) 

„Odbarwiona” wersja czerwonego obrazu zasłania (por. str. 170) cały oryginalny widok z lewej, oprócz steru. 

 

Zawsze sprawdzaj skany planów, aby uniknąć takich deformacji, jaką przedstawia Rysunek 3.4.11. 

 
 Teraz przeskalujmy odwrócony rzut z prawej w ten sam sposób, jaki pokazuje Rysunek 3.4.12. Włącz widocz-

ność warstwy Cmp i zmniejsz proporcjonalnie skalę niebieskiego obrazu, dopasowując go do czarnych linii 

rzutu z lewej. Efekt przedstawia Rysunek 3.4.16:   

 

Rysunek 3.4.16 Dopasowany rzut z prawej (niebieskie linie)  

Usuń czerwony filtr  

Przenieś ten obraz 
z Tmp do Left  
 

Ten były czerwony, obcięty obraz, jest 
nałożony na oryginalny rzut z lewej 

Tu umieść oś 
transformacji 

Zmniejsz proporcjonalnie niebieski obraz, 
aby pasował do linii wręg czarnego obrazu 

Niezdeformowany kontur steru 
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Po tym dopasowaniu, porównajmy znowu rzuty z lewej i prawej. Jak widać poniżej, część różnic w okapotowa-

niu silnika wciąż jest widoczna. Jednak nie jestem pewien, czy jest to wynik pomyłki podczas kreślenia, czy ślad 

kolejnej deformacji (Rysunek 3.4.17):  

 

Rysunek 3.4.17 Różnice pomiędzy rzutem z lewej (czarny) i prawej (niebieski) – część przednia  

Pionowe różnice pozostały bez zmian (por. Rysunek 3.4.7). Kołpak śmigła, osłona silnika i krawędź natarcia 

skrzydła wydają się być lekko obrócone. Lecz który kontur – czarny czy niebieski – jest właściwym? Jednocze-

śnie kontury chwytu powietrza do silnika i osłon km są dobrze dopasowane. Podobną sprzeczność można do-

strzec pomiędzy obręczami celownika (rozsunięte) i konturem wiatrochronu kabiny pilota (zgodny).  

Dostrzegłem także inne różnice na ogonie samolotu (Rysunek 3.4.18): 

 

Rysunek 3.4.18 Różnice pomiędzy rzutem z lewej (czarny) i prawej (niebieski) – część tylna 

 

Niebieski kołpak jest nieco wyżej, ale 
osłony chwytów powietrza się pokrywają 

Różnica w 
krawędziach 
natarcia 
skrzydeł 

Tylne część skrzydeł i środek 
kadłuba są dopasowane  

Pochylone 
wręgi? 

Różne 
krawędzie 
steru 

Statecznik 
poziomy jest 
dopasowany 

Różne kontury 
usterzenia  

Wszystkie wręgi wydają 
się być pochylone o 0.9° 

Linia 
pionowa 
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Rysunek 3.4.18 wykazuje różnice w kształcie usterzenia pionowego, podczas gdy usterzenie poziome i ze-

wnętrzny kontur kadłuba są do siebie dopasowane. Wszystkie niebieskie wręgi są pochylone – tak, jakby cały 

ogon w niebieskim obrazie był przekoszony o 0.9°. (To może wyjaśniać także różnice w konturach usterzenia). 

Podczas gdy różnice w przedniej części kadłuba mogą być rezultatem błędu kreślarza, deformacja widoczna w 

tylnej części rzutu z prawej wydaje się być efektem przekoszenia obrazu o 0.9°. W takim przypadku przypusz-

czam, że to niebieski obraz (widok z prawej) jest zdeformowany. (Ponieważ wszystkie niebieskie linie wręg są 

pochylone o ten sam kąt, podczas gdy czarne linie są pionowe). Spróbujmy odwrócić tę transformację (szcze-

góły przekoszenia – por. str. 157), i zobaczymy, czy to pomogło (Rysunek 3.4.19): 

 

Rysunek 3.4.19 Odwracanie przekoszenia niebieskiego obrazu 

Wygląda na to, że to był dobry ruch: teraz lewy (czarny) i prawy (niebieski) obraz ogona stały się dopasowane. 

Rysunek 3.4.20 pokazuje szczegóły tylnej części kadłuba: 

 

Rysunek 3.4.20 Dopasowanie szczegółów ogona 

Po tej transformacji wszystkie różnice w tym obszarze znikły jak za dotknięciem czarodziejskiej różdżki. (Po-

równaj Rysunek 3.4.20 i Rysunek 3.4.18). Mówiąc szczerze, nie spodziewałem się tak udanej korekty. 

Oś transformacji umieściłem w punkcie, w 
którym czarny i niebieski kontur się pokrywa 

Przekoszenie o 0.9° 

Wszystkie wręgi 
są pionowe  

Dopasowane 
krawędzie steru 

Dopasowane 
kontury 
usterzenia 
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Teraz obejrzyjmy przednią część kadłuba (Rysunek 3.4.21): 

 

Rysunek 3.4.21 Różnice w przedniej części kadłuba 

Porównując ilustrację powyżej i Rysunek 3.4.17, można stwierdzić, że pionowe różnice są bez zmian. Obecne 

przekoszenie spowodowało dodatkową deformację obrazu: dolna łopata śmigła jest wygięta. Zauważ jednak, że 

ta część leży w obszarze deformacji skanowanej strony (jak pokazuje Rysunek 3.4.8b). W istocie, byłem wcze-

śniej zaskoczony, że ta łopata nie jest wykrzywiona! Widocznie w tym miejscu kompensowały się dwie różne 

deformacje. Gdy odwróciliśmy jedną z nich, drugie zniekształcenie wróciło do swojego normalnego stanu. Na 

szczęście jest też postęp: znikły wszystkie inne różnice! Teraz niebieskie obręcze celownika, krawędzie natarcia 

skrzydeł oraz wręgi kadłuba pasują do swoich czarnych odpowiedników (z widoku z lewej). 

Załóżmy roboczo, że lewy kontur (czarny obraz) jest poprawny, i dopasujmy do niego kontur prawy. Zacznij od 

skopiowania niebieskiego obrazu na warstwę Tmp i wycięcia obszaru wokół osłony silnika (Rysunek 3.4.22): 

 

Rysunek 3.4.22 Wycinanie przedniej, zdeformowanej części niebieskiego obrazu 

Krzywa 
łopata 
śmigła 

Obręcze celownika 
pasują do siebie 

Dopasowane krawędzie 
natarcia skrzydeł  

Dopasowane 
wręgi  

Pionowe różnice 
pozostały 

Zdeformowany obszar 
niebieskiego obrazu 

Skopiuj niebieski obraz 
na warstwę Tmp 

Wytnij z tej kopii 
osłonę silnika  

Zablokuj na chwilę 
warstwę Cmp (zawiera 
oryginalną kopię niebie-
skiego obrazu) 
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Przenieś oś transformacji z ogona (por. Rysunek 3.4.19) na prawą krawędź wyciętego fragmentu (jak pokazuje 

to Rysunek 3.4.23, a przekoś w dół o 0.5º. (Dla odróżnienia, modyfikowany obszar jest w kolorze czerwonym): 

 

Rysunek 3.4.23 Poprawianie konturu przedniej części kadłuba (do rzutu z lewej)  

 

Dlaczego użyłem przekoszenia, a nie obrotu? Ponieważ wszystkie pionowe linie w tym obrazie zostały 

już skorygowane w rezultacie poprzedniej transformacji (por. Rysunek 3.4.19). 

 
 Ostatecznie, jedyne różnice pomiędzy rzutem z lewej i z prawej pozostają w zniekształconym pasie przecho-

dzącym przez czubek kołpaka i dolną łopatę śmigła (por. Rysunek 3.4.21). Teraz przenieś te dwie części widoku 

z prawej z warstw Cmp i Tmp do warstwy Views:Right1 (Rysunek 3.4.24): 

 

Rysunek 3.4.24 Ostatnie poprawki w pliku Inkscape  

Jak widzisz, pozostają tam w „roboczym” kolorze niebieskim i nadal w stanie odwróconym. To dlatego, że ciągle 

mogą być modyfikowane, jeżeli tylko napotkam jakąś nową wskazówkę dotyczącą osłony silnika (zdjęcie, lub 

nowe plany). Możliwe jest także, że obydwa: prawy i lewy widok z tej monografii AJ Press są nieprawidłowe. W 

dalszych rozdziałach pokażę, gdzie szukać dodatkowych informacji i jak ich używać. 

 
1 Oryginalny obraz rzutu z prawej przeniosłem na warstwę Cmp, gdyż początkowo chciałem go użyć w nieco inny sposób. Równie dobrze 

mógł pozostać na warstwie Right. Na pewno jednak warto mieć dodatkowe warstwy robocze na „wycinanie” fragmentów do poprawy. 

Oś transformacji  

Modyfikowana 
część (czerwona)  

Końcówka kołpaka i 
łopata śmigła pozostają 

zdeformowane 

Przekoś 
obraz o 
0.5° 
 

Przenieś obrazy z 
warstw Cmp i 
Tmp do Right  
 

Zmieniłem barwę poprawionego 
fragmentu na niebieską  
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Z drugiej strony, w tym projekcie nie potrzebujemy idealnego widoku z prawej. Ostatecznym celem tego rozdzia-

łu nie jest stworzenie lepszych planów modelarskich. Mamy tylko zaadaptować te rysunki dla stworzenia do-

kładnego modelu 3D samolotu. W praktyce będziemy używać głównie rzutu z lewej, przełączając się na rzut z 

prawej tylko w celu odtworzenia asymetrycznych szczegółów kadłuba1.  

  

Podsumowanie 

• Następnym krokiem w weryfikacji planów modelarskich jest porównanie dwóch odpowiadających sobie rzu-

tów (w tym przypadku były to widok z lewej i z prawej – str. 40). 

• Przy porównywaniu różnych obrazów/rysunków w Inkscape używaj warstw (str. 38). 

• Gdy znajdziesz różnice pomiędzy porównywanymi obrazami – musisz określić, który z nich jest zniekształ-

cony. W przypadku pokazanym w tej sekcji, obydwie sylwetki samolotów są zdeformowane. Było to spo-

wodowane zniekształceniem skanowanych stron wzdłuż szwu książki (str. 41). 

• Czasami można odtworzyć poprawny obraz z dwóch zniekształconych wersji. (O ile każda z nich jest zde-

formowana w inny sposób). W tej sekcji odtworzyłem oryginalny rzut z lewej z dwóch różnych sylwetek (str. 

42 - 44). 

• W Inkscape podstawową metodą poprawiania obrazu rastrowego (jak skany planów) jest „nakładanie ła-

tek”. Polega to na skopiowaniu obrazu, wycięciu z tej kopii fragmentu do poprawy, poddaniu ewentualnej 

transformacji i umieszczeniu rezultatu ponad oryginalnym obrazem (str. 44, 47, 48). 

• Nałożone na obrazy „łatki” są łatwe do usunięcia – w ten sposób możesz w razie potrzeby szybko odtwo-

rzyć oryginalny obraz. 

• W tej sekcji skorygowałem widok z prawej (str. 46 - 48) zakładając (roboczo) że widok z lewej jest popraw-

ny. (Wcześniej w tej sekcji złożyłem widok z lewej z dwóch różnych obrazów. W ten sposób stał się bardziej 

„potwierdzony” od pojedynczego obrazu z rzutem z prawej). Oczywiście, to założenie może się ostatecznie 

okazać fałszywe. Pokażę to w dalszych rozdziałach.  

 

 

W danych towarzyszących tej książce (por. str. 18) znajdziesz plik Inkscape opisany w tej sekcji: 

source\references\sample\drawings (3.4).svg.   

 
  

 
1 Na przykład: kołpak śmigła stworzymy używając konturu z widoku z lewej. Zdeformowana dolna łopata śmigła z widoku z prawej nie jest 

specjalną przeszkodą: nie można ufać konturowi tej części z rzutu z boku, nawet gdy nie jest zniekształcony. (Zazwyczaj te łopaty są ryso-

wane „na oko”). Dla modelu 3D tej łopaty potrzebujemy z tego rysunku tylko informacji o położeniu płaszczyzny śmigła. Zapewnia ją niezde-

formowany kontur górnej łopaty. 

 

Zniekształcenia pokazane na str. 45 i poprawione na dalszych stronach mogły powstać podczas skła-

du do druku. (To kolejny rodzaj deformacji planów modelarskich). 
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3.5 Przygotowanie rzutów z góry i z dołu 

Gdy rzuty z boku są już zweryfikowane, przygotujmy obydwa rzuty pionowe. W warstwie Views stwórz ich pod-

warstwy, o nazwach Top i Bottom. Umieść na nich obrazy wycięte z odpowiednich skanów (Rysunek 3.5.1) : 

     

Rysunek 3.5.1 Nowe warstwy na widoki z góry i z dołu  

Możesz wyciąć rzut z dołu, którego tu używam, z pliku 64.tif, a widok z góry – z pliku 63.tif. (Obydwa te pliki już 

używałeś do wycięcia widoków z boku – por. str. 30 i 38). Na szczęście, tym razem wycinane fragmenty nie 

nakładają się na zdeformowane obszary tych zeskanowanych stron. 

W rysunkach kreślonych ręcznie, takich jak ten, obydwa widoki pionowe powstawały z tego samego wzorcowe-

go obrysu. Dlatego najpierw porównamy te dwa obrazy, nawet jeżeli jeszcze nie są odpowiednio „wyrównane” w 

poziomie i pionie. W ten sposób chcę znaleźć ewentualne deformacje. Obróciłem widok z dołu i zabarwiłem na 

niebiesko, ustawiłem przejrzystość warstwy Top na 50%, i wyrównałem obydwa widoki (Rysunek 3.5.2a):  

                 

Rysunek 3.5.2 Pierwsze dopasowanie rzutów z góry i z dołu  

Następnie proporcjonalnie zmniejszyłem widok z dołu, dopasowując obydwa skrzydła (Rysunek 3.5.2b). 

W tym przypadku 
oba obrazy są poza 
zdeformowanymi 
obszarami skanów  

a) b) 

Oś transformacji Dopasowane 
rozpiętości 
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 (CC) Witold Jaworski, 2009 – 2020. 

Większa część tych dwóch obrazów pasuje do siebie: różnią się tylko ich ogony (Rysunek 3.5.3): 

 

Rysunek 3.5.3 Różnice na obszarze ogona samolotu 

Zgodnie z opisem technicznym, usterzenie pionowe P-40 było nachylone do płaszczyzny symetrii samolotu pod 

kątem 1.5º. Nie wykonałem lustrzanego odbicia widoku z dołu, więc niebieski i czarny kontur powinny się tu 

różnić o kąt 2x1.5º = 3º. Nic z tych rzeczy! Jak możesz dostrzec na ilustracji powyżej, czarne i niebieskie kontu-

ry steru kierunku pasują do siebie. Myślę, że autor planów zapomniał o tym efekcie kopiując rzut z góry. Jednak 

na ilustracji powyżej widać inne odchylenia pomiędzy czarnymi i niebieskimi konturami. Największe przemiesz-

czenie czarnych linii występuje na prawym stateczniku pozio-

mym. Rysunek 3.5.3 wskazuje na znaczną deformację widoku 

z góry: na niebieskim obrazie przednia krawędź steru wysoko-

ści i wszystkie inne linie pionowe są równoległe do rozpiętości 

skrzydeł, podczas gdy na czarnym – nie. Dlatego zdecydowa-

łem się używać widoku z dołu jako wzorcowego, i potem dopa-

sować do niego linie widoku z góry.  

Aby uprościć dalsze precyzyjne skalowanie i dopasowywanie 

do widoku z boku, zdecydowałem się chwilowo połączyć te 

dwa obrazy w grupę (Object→Group – szczegóły por. str. 

171). W tej grupie zmniejszyłem nieprzejrzystość widoku z 

góry do 20%. W ten sposób można go nadal zaznaczać, ale 

prawie nie jest widoczny – jak to pokazuje Rysunek 3.5.4. W 

przeciwnym razie jego czarne linie mogłyby być nieco mylące. 

Widok z góry jest w tej grupie „ładunkiem”, podlegającym takim 

samym transformacjom jak widok z dołu. W tym momencie 

grupa znajduje się na warstwie Top. 

 

Rysunek 3.5.4 Grupa obrazów widoków z góry i dołu 

 

Niewielka deformacja 
końcówki statecznika 

Ogólne przesunięcie 
czarnych linii 

Różne 
szerokości 
kadłuba 

Linie wręg pasują 
do siebie 

Dopasowane 
stateczniki 

Statecznik pionowy P-40 
był asymetryczny (kąt 
odchylenia: 1.5º) 

Czarne linie są 
przekoszone do tyłu 

Czarny obraz 
jest w 20% 
nieprzejrzysty 
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Teraz ustaw tę grupę równolegle do poziomej linii pomocniczej, następnie powiększ ją tak, by pasowała do linii 

pionowych (długości kadłuba). Na koniec dodaj kolejne linie i sprawdź prostopadłość skrzydeł (Rysunek 3.5.5): 

  

Rysunek 3.5.5 Sprawdzanie prostopadłości skrzydeł 

Jak widzisz, te skrzydła nie są idealnie prostopadłe. (To normalne w ręcznie kreślonych planach). Oczywiście, 

wykonałem ten sam test dla usterzenia poziomego (Rysunek 3.5.6): 

  

Rysunek 3.5.6 Sprawdzanie prostopadłości usterzenia poziomego 

Odchylenia od pionu są tu nieznaczne (Rysunek 3.5.6a) ponieważ to usterzenie jest trzy razy mniejsze od 

skrzydeł. Jednak Rysunek 3.5.6b pokazuje, że wszystkie poziome linie są tu przekoszone! 

Dwie nowe linie 
pomocnicze 

Ustaw linie przy 
krawędzi natarcia i 
szwie na końcu 
lewego skrzydła…   

…i sprawdź, czy 
przechodzą przez 
te same miejsca na 
prawym skrzydle 

Odchylenia 

Kadłub  jest 
ustawiony 
wzdłuż linii 
poziomej 

Podobne 
odchylenia 

w poziomie 

Znaczne 
odchylenie 
w pionie 

a) b) 

Długość samolotu 
dopasowałem do 
tych dwóch linii 
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Jak zinterpretować te odchylenia? Jak je skorygować? Sądzę, że deformacja tego usterzenia może być rezulta-

tem dwóch, lub więcej różnych odchyleń. Co więcej – te odchylenia wydają się różnić pomiędzy widokiem z 

góry i z dołu (por. Rysunek 3.5.3). Dlatego zdecydowałem się najpierw skorygować odchylenie skrzydeł. Na-

stępnie rozdzielę tę grupę i przygotuję oddzielne „łatki” na każdy ze zdeformowanych stateczników. 

Aby ustawić skrzydła prostopadle do kadłuba, przekosiłem tę grupę o 0.2º (Rysunek 3.5.7): 

                 

Rysunek 3.5.7 Korygowanie poziomego odchylenia skrzydła 

Zwróć uwagę, że asymetryczne położenie osi tej transformacji (por. Rysunek 3.5.7) pozwala się skupić wyłącz-

nie na poprawie odchylenia prawej końcówki skrzydła. Jednak ma to także efekt uboczny: niewielkie przesunię-

cie kadłuba w kierunku poziomym. Przed rozdzieleniem tych dwóch obrazów skorygowałem to przesuwając je 

pomiędzy linie wyznaczające długość samolotu. Potem zdecydowałem się wykonać jeszcze jeden test: czy 

kadłub z rzutu z dołu pasuje do rzutu z lewej (Rysunek 3.5.8):  

 

 

Rysunek 3.5.8 Porównywanie pozycji wręg w widokach z dołu i z boku 

Włącz widoczność warstwy Views:Left. Jak widać w ilustracji powyżej, różnice w położeniu wręg narastają od 

osłony silnika do ogona. Największa występuje przy przedniej krawędzi steru kierunku. 

Oś obrotu 

Zwiększaj przeko-
szenie, dopóki 
krawędź natarcia 

nie dotknie tej linii 

Kadłub jest minimalnie 
przesunięty wzdłuż osi 

poziomej 

Różnice narastają 

w kierunku ogona  

Wręgi osłon silnika 
pasują do siebie 
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To wskazówka, że powinniśmy proporcjonalnie zmniejszyć skalę tej grupy obrazów, tak by niebieskie wręgi po-

kryły się ze swoimi odpowiednikami z rzutu z lewej (Rysunek 3.5.9): 

 

Rysunek 3.5.9 Dostosowanie skali rzutów pionowych do widoku z lewej  

 
Teraz rozdziel tymczasową grupę (Object→Ungroup) stworzoną na stronie 51, pozostawiając widok z góry na 

warstwie Views:Top, i przenosząc widok z boku do warstwy Wrk:Cmp. Jeżeli potem widok z góry zasłania 

widok z dołu, możesz zmienić ich kolejność poleceniem Object→Lower to Bottom (szczegóły – patrz str. 170). 

Aby przygotować „łatkę” na widok z dołu: zablokuj i ukryj warstwę Views:Top, usuń niebieski filtr z widoku z 

dołu, i skopiuj go na warstwę Wrk:Tmp. Następnie zablokuj warstwę Wrk:Cmp i wytnij usterzenie poziome z 

kopii umieszczonej na Wrk:Tmp (Rysunek 3.5.10a): 

                

Rysunek 3.5.10 Korygowanie deformacji usterzenia w widoku z dołu     

Dla odróżnienia zmieniłem kolor tej „łatki” na niebieski. Umieść oś obrotu jak pokazuje Rysunek 3.5.10b) i prze-

koś ten niebieski obraz w pionie, aż środkowa szczelina w osłonie kółka ogonowego stanie się pozioma. 

 

Ster kierunku w rzucie z góry lub z dołu wygląda jak niepozorny trójkąt. Często jest zbyt długi lub zbyt 

krótki, szczególnie na ręcznie kreślonych rysunkach. Taka różnica może zepsuć skalę całego rysunku, 

gdy po prostu dopasujesz jego obraz do deklarowanej całkowitej długości samolotu. 

Oś transformacji 

Zmniejszaj proporcjonalnie 
rozmiar tej grupy (niebieski 
obraz) aż dopasujesz jej 
wręgi do rzutu z lewej 

a) b) 

Oś obrotu  

Wyprostuj 
tę linię  

Pozioma 
krawędź 
panelu 
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 (CC) Witold Jaworski, 2009 – 2020. 

To jedyna indywidualna poprawka, którą potrzebowaliśmy wprowadzić w widoku z dołu. Teraz usuń niebieski 

filtr, połącz oryginalny obraz i jego „łatkę” w jedną grupę (Object→Group) i przenieś na warstwę 

Views:Bottom. Następnie zablokuj tę warstwę. 

Przeanalizujmy teraz widok z góry, więc ukryj Views:Bottom i odkryj warstwę Views:Top. (Pokolorowałem linie 

tego obraz na czerwono). Jak widzisz, kadłub i usterzenie w tym rzucie są pełne asymetrii (Rysunek 3.5.11):  

 

Rysunek 3.5.11 Asymetrie w widoku z góry     

Już wcześniej zauważyliśmy różnice w kontrach usterzenia pomiędzy widokiem z góry i z dołu (por. Rysunek 

3.5.3). Teraz odkryłem, że kontur kadłuba także jest asymetryczny (Rysunek 3.5.11)! Widać tu także inne „ręcz-

ne” błędy, jak dwie ukośne wręgi pomiędzy silnikiem a kabiną pilota. 

Zdecydowałem się skorygować tę asymetrię kadłuba i usterzenia poprzez niewielki obrót wokół osi umieszczo-

nej na pierwszej wrędze (przegrodzie silnika).  Rysunek 3.5.12a) pokazuje, jak to wygląda (czerwone linie – rzut 

z góry, czarne linie – rzut z dołu) :  

     

Rysunek 3.5.12 Korygowanie asymetrii kadłuba i usterzenia (widok z góry) 

Po tym obrocie wykonałem jeszcze niewielkie przekoszenie tego fragmentu obrazu (Rysunek 3.5.12b). Skory-

gowałem w ten sposób usterzenie, w którym pomimo obrotu pozostała niewielka deformacja. 

Pierwsza i druga 
wręga są prze-
koszone o 1º 

Asymetryczne 
usterzenie  

Asymetryczny 
kontur kadłuba 

Oś obrotu: na 
przegrodzie 
silnika 

Skoryguj tę różnicę 
przekoszeniem 

Obróć obraz 

o 0.2º 

Oś przekoszenia 

Czerwone linie: wycięty 
kadłub (od przegrody silnika) 
i usterzenie poziome 

a) b) 

Niebieski kontur to 
odbicie lewej strony 
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Jednak porównanie widoków z góry i z lewej ujawniło inne różnice (Rysunek 3.5.13): 

 

Rysunek 3.5.13 Różnice w położeniu szczegółów kadłuba pomiędzy widokiem z góry i z lewej 

Wygląda na to, że wszystkie szczegóły kadłuba od bazy kołpaka do luku bagażowego są przesunięte o stały 

dystans ok. 1 cala. Jedynym wyjątkiem od tej reguły są dwie skośne wręgi w środku kadłuba. Jedynym możli-

wym wyjaśnieniem tak dziwnych odchyleń jest zwykła ludzka pomyłka. To błąd kreślarski, popełniony przez 

autora tych planów modelarskich. Biorąc pod uwagę inne deformacje opisane na poprzedniej stronie zakładam, 

że ten widok z góry jest nieprawidłowy i że położenie tych detali jest poprawne na widoku z lewej. 

Kontur dla tej „łatki” narysowałem precyzyjnie wzdłuż zewnętrznego konturu kadłuba (Rysunek 3.5.14): 

 

Rysunek 3.5.14 Wycinanie wewnętrznych szczegółów kadłuba 

Te dwa segmenty modyfikowałem w trybie Edit path (szczegóły – patrz str. 177 i 178). Następnie wyciąłem i 

przesunąłem ten fragment obrazu do przodu, dopasowując jego szczegóły do widoku z lewej (Rysunek 3.5.15): 

 

Rysunek 3.5.15 Dopasowanie do widoku z lewej 

 

Te wszystkie detale 
są przesunięte! 

Wręgi kołpaka 
pasują do siebie 

Wręgi ogona 
pasują do siebie 

Dolne punkty tych dwóch 
skośnych wręg pasują do ich 
odpowiedników z rzutu z lewej 

Poprowadź te kontury po wewnętrznej 
stronie krawędzi kadłuba 

Przesuń ten obraz do przodu, 
dopasowując do widoku z lewej 
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 (CC) Witold Jaworski, 2009 – 2020. 

 
W widoku z góry pojawiło się teraz kilka nieciągłych linii pomiędzy najnowszą i poprzednią „łatką” (za kabiną). 

Aby to skorygować, obróciłem czerwony fragment obrazu o ułamek stopnia (Rysunek 3.5.16): 

 

Rysunek 3.5.16 Dopasowanie ostatnio poprawionego fragmentu do poprzedniej „łatki” 

To koniec poprawek w tej sekcji. Usuń czerwony filtr z ostatniej „łatki” i połącz wszystkie obraz z warstwy 

Views:Top w jedną grupę. Poniżej demonstruję rezultat: dopasowane widoki z góry i z dołu, wyrównane do 

pionowych i poziomych linii pomocniczych (Rysunek 3.5.17): 

 

Rysunek 3.5.17 Widoki z góry i z dołu po korektach 

Jak widzisz, te rzuty wciąż jeszcze zawierają kilka drobnych deformacji i różnic. 

 

Nie porównuję kształtu skrzydeł w widokach z lewej i z dołu/góry. Przyczyna jest prosta: kontur skrzy-

dła w widoku z boku jest zawsze nieprawidłowy. Jest zazwyczaj rysowany na widokach z lewej i prawej 

jako znacznik, który sygnalizuje „tu jest skrzydło”. 

Oś obrotu Aby dopasować te linie, obróć 
czerwony obraz o 0.09º 

Skrzydła są dopasowane i 
prostopadłe do osi kadłuba 

Usterzenia poziome 
są dopasowane i 
prostopadłe do osi 
kadłuba 

Drobne różnice 
konturu kadłuba 
pomiędzy widokiem 
z góry i z dołu 

W widoku z dołu rury 
wydechowe są prze-
sunięte do tyłu 

Przegroda silnika i następna 
wręga są nadal pochylone 1º 

widok z góry – czarne linie 
widok z dołu – niebieskie linie a) 

b) 

c) 
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W szczególności, rury wydechowe w widoku z dołu są przesunięte do tyłu (Rysunek 3.5.17a). Znajdują się na 

nim w złym miejscu, tak jak w oryginalnym rzucie z góry. Pozostawiłem je tam, ponieważ dwie sąsiednie wręgi 

pasują do widoku z lewej. (Za dużo kłopotów dla tak małej „łatki”). Z podobnej przyczyny pozostawiłem dwie 

ukośne wręgi w widoku z góry (Rysunek 3.5.17b). Zauważ też, że pomiędzy widokiem z góry i z dołu nadal ist-

nieje niewielka różnica w szerokościach kadłuba (obydwa są nieco asymetryczne). Widać ją najlepiej przed 

statecznikiem poziomym (Rysunek 3.5.17c). Równie dobrze może się jednak okazać, że żaden z tych obrysów 

nie odpowiada prawdziwemu kształtowi kadłuba1.  

W tych planach z monografii AJ Press rzut z góry jest mniej pewnym źródłem od rzutu z dołu. (Zazwyczaj bywa 

odwrotnie). Dlatego, tak długo jak będzie to możliwe, będę używać widoku z dołu jako podstawowego rzutu w 

kierunku pionowym, na przykład formując skrzydła lub usterzenie poziome. Z widoku z góry będę potrzebował 

tylko informacji o szerokości różnych szczegółów w środku kadłuba. 

Wciąż jeszcze nie skończyliśmy analizy tych rzutów pionowych. W następnej sekcji sprawdzimy ich proporcje 

(rozpiętość i kilka innych wymiarów). 

 

Podsumowanie 

• W przypadku rzutów z góry i z dołu, wykonaj wstępne porównanie ich „surowych” wersji (tzn. wyciętych ze 

skanu strony – str. 50)2; Pozwoli to na pierwsze oszacowanie ewentualnych zniekształceń tych rysunków 

(str. 51). 

• Gdy obydwa widoki są (mniej więcej) dopasowane, możesz połączyć je w tymczasową grupę, aby nie po-

wtarzać wyrównywania i skalowania (51). 

• Sprawdź, czy skrzydła i usterzenie poziome są prostopadłe do osi kadłuba (str. 52). Jeżeli nie – skoryguj to 

przez odpowiednią transformację (zazwyczaj – przekoszenie: por. str. 53). 

• Na początku wyskaluj te obrazy, dopasowując je do całkowitej długości samolotu. Następnie porównaj je z 

rzutem z lewej. W szczególności – sprawdź, czy pasują do siebie odpowiednie wręgi kadłuba (str. 53). 

• Zawsze dopasuj skalę widoków pionowych tak, by ich wręgi pasowały do widoku z lewej. Jest to ważniej-

sze od dokładnego dopasowania do ogólnej długości samolotu (str. 54). 

• Po wykonaniu testów i ewentualnych poprawek wyliczonych powyżej, rozdziel tymczasową grupę. Następ-

nie napraw zidentyfikowane różnice pomiędzy wszystkimi trzema widokami (z góry, z dołu i z lewej: str. 54-

57). 

• Jeżeli znajdziesz jakąś różnicę – zawsze zakładaj, że poprawna wersja jest na rzucie z lewej. (Poza kontu-

rem skrzydła: ten na rzutach z boku jest zawsze niepoprawny). 

• Możesz pozostawić jakieś niewielkie błędy bez poprawek – tak długo, jak jesteś w stanie je ignorować, 

używając w zamian innych rysunków (str. 57). 

 

 

W danych towarzyszących tej książce (por. str. 18) znajdziesz plik Inkscape opisany w tej sekcji: 

source\references\sample\drawings (3.5).svg.   

 
1 Na zdjęciach bardzo trudno jest weryfikować szerokość kadłuba. Co więcej, tylko nieliczne z nich pokazują kadłub P-40 widziany z góry, 

gdyż większość zdjęć samolotów jest robiona z boku. Kontury kadłuba w rzutach z góry i z dołu, które możesz znaleźć w większości planów 

modelarskich, są oparte na niewielu pewnych informacjach i dużej liczbie różnych przypuszczeń. 

2 Jeżeli na Twoim planie te dwa widoki są narysowane jako dwie połówki (to popularna konwencja) – odwróć jedną z nich i dopasuj do 

drugiej. 
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 (CC) Witold Jaworski, 2009 – 2020. 

3.6 Weryfikacja proporcji rzutów pionowych 

W poprzedniej sekcji użyliśmy już długości P-40B do skalowania rzutów z góry i z dołu (por. str. 52, Rysunek 

3.5.5). W tej sekcji porównany te obrazy z innymi wymiarami naniesionymi przez Curtiss w rysunku poglądo-

wym z 1941r. (Rysunek 3.6.1):  

 

Rysunek 3.6.1 Wymiary P-40(cu) – w stopach i calach (Curtiss, 1941r.) 

To jest kolejny rzut z rysunku, którego użyliśmy już w sekcji 3.3. W tym przypadku wszystkie wymiary, które 

widać powyżej, są użyteczne. Jest tu podana nie tylko rozpiętość skrzydeł, ale także rozpiętość usterzenia po-

ziomego, oraz zwymiarowany bazowy „trapez” skrzydła. Przenieśmy teraz te dane do naszego rysunku w Inks-

cape (Rysunek 3.6.2): 

 

Rysunek 3.6.2 Te same informacje, naniesione na rysunek w Inkscape 
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447.5” 
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Cięciwa podstawy płata 
pasuje do trapezu 
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Drobna 
różnica 

Czerwony trapez 
jest narysowany 
na dodatkowej 
warstwie Aux 

Czerwony kontur trapezu 
umieściłem na krawędzi 
podstawy skrzydła  

Bazowy 
„trapez” 
skrzydła  
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Rysunek 3.6.2 pokazuje dwie nowe linie pomocnicze wyznaczające rozpiętości skrzydła i usterzenia, oraz ba-

zowy trapez płata, narysowany za pomocą czerwonej linii kreskowanej. Umieściłem go na warstwie Aux – stwo-

rzonej z myślą o podobnych pomocniczych rysunkach. Na rysunku poglądowym brakuje informacji o położeniu 

skrzydła względem osi kadłuba, więc umieściłem ten trapez na krawędzi natarcia centralnej wręgi skrzydła. 

Znalazłem ten punkt ekstrapolując krawędź natarcia skrzydła narysowaną na rzucie z góry AJ Press. 

Dobra wiadomość jest taka, że długość cięciwy podstawy płata pasuje do wymiarów (108”)1. Jednak końcówka 

skrzydła jest nieco za wąska. Połowa rozpiętości na tych planach to 225.60”, zamiast 223.75” (=447.5”/2), które 

można odczytać z rysunku poglądowego. (To oznacza różnicę o 1.85” po każdej stronie samolotu). 

Co ciekawe, rozpiętość skrzydeł z tych planów AJ Press jest zbliżona do długości skrzydła P-40 bez wzniosu 

(6º): 225” (Rysunek 3.6.3): 

 

Rysunek 3.6.3 Widok z przodu z rysunku poglądowego Curtiss 

Z drugiej strony, rozpiętość usterzenia poziomego także jest zbyt duża (por. Rysunek 3.6.2) i to w podobnej 

proporcji jak skrzydło (77.45” wobec 76.375”). To oznacza, że możemy łatwo poprawić obydwie różnice rozpię-

tości poprzez zmianę skali obrazów wzdłuż osi Y (Rysunek 3.6.4):   

 

Rysunek 3.6.4 Korygowanie różnic w rozpiętości 

 
1 To oznacza, że miałem rację dopasowując wręgi kadłuba z widoków z góry i dołu do ich odpowiedników z rzutu z lewej (por. str. 53). 

Widok z lewej jest zazwyczaj najbardziej precyzyjną częścią planów, o ile nie został zdeformowany podczas druku lub skanowania. 

225” 

Oś transformacji 

Zmniejsz rozmiar obrazów 
wzdłuż osi Y, korygując 
różnice w rozpiętości 
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 (CC) Witold Jaworski, 2009 – 2020. 

Oczywiście, pozostał problem ze zbyt wąską końcówką skrzydła (Rysunek 3.6.5a):  

                                

Rysunek 3.6.5 Problem z cięciwą końcówki skrzydła (plany AJ Press) 

Co ciekawe, lewe skrzydło z „surowego”, zeskanowanego widoku z dołu pasuje lepiej do tego konturu (Rysunek 

3.6.5b). Jednak drugie skrzydło z tego samego obrazu nie pasuje do niego wcale. Jak może pamiętasz, w sekcji 

3.5 poprawialiśmy tę deformację przekoszeniem skrzydeł (por. str. 53). Teraz zacząłem się zastanawiać czy 

przypadkiem tylko prawa strona tego rysunku była zdeformowana… No cóż, z drugiej strony krawędź spływu w 

obydwu przypadkach nie pasuje do trapezu skrzydła. A gdy zmniejszysz rozpiętość w tym „surowym” obrazie, 

zwiększy się pokazywany przez Rysunek 3.6.5b) odstęp pomiędzy czerwoną i czarną krawędzią spływu. 

Sprawdziłem to na planach z monografii Kagero. Te wykonane na komputerze rysunki wyglądają na bardziej 

precyzyjne. Dziwnym trafem ich skrzydła są identyczne z moimi „wyrównanymi” skrzydłami (Rysunek 3.6.6):  

 

 Rysunek 3.6.6 Podobny problem na planach Kagero 

Na rysunku Kagero znalazłem jeszcze inny błąd: za mały statecznik poziomy. W następnym rozdziale napiszę 

więcej o różnicach i podobieństwach pomiędzy tymi dwoma planami. Tutaj mogę tylko stwierdzić, że monografia 

Kagero nie pomogła mi znaleźć prawdziwego konturu skrzydła. 

Nieprawidłowa 

krawędź natarcia 
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krawędź spływu 
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skrzydła (widok z dołu) Aktualny (wyrównany) rysunek 

Nieprawidłowa 
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jest za małe 
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Podsumowanie 

• Do sprawdzenia proporcji widoków z góry i z dołu potrzebujesz przynajmniej rozpiętości skrzydeł (zakłada-

jąc, że już sprawdziłeś całkowitą długość tego samolotu). Wszystkie inne wymiary, które możesz znaleźć 

na jego rysunkach poglądowych, także się przydadzą (str. 59). 

• Nanieś na swój rysunek wszystkie wymiary, które znajdziesz – jako linie pomocnicze (rozpiętości skrzydeł i 

usterzenia) lub jako dodatkowe szkice (np. trapez skrzydła). Dobrym pomysłem jest umieszczenie takich 

szkiców na odrębnej warstwie (str. 59). 

• Gdy Twój rysunek w Inkscape jest w skali 1:1 (por. str. 36), możesz uniknąć jakichkolwiek przeliczeń jedno-

stek podczas nanoszenia linii pomocniczych lub rysowania kontur skrzydła. (Takie przeliczenia są kolejnym 

źródłem potencjalnych błędów). 

• Naprawienie ewentualnej różnicy w rozpiętościach skrzydeł jest łatwe – wystarczy przeskalować rysunek w 

kierunku prostopadłym do osi kadłuba (str. 60). Jednak, gdy znajdziesz dostatecznie dużo danych by zwy-

miarować podstawowy trapez skrzydła – możesz odkryć, że ich kształt na analizowanych planach jest nie-

prawidłowy (str. 61). W takim przypadku lepiej poszukaj lepszych rysunków lub innych danych, na przykład 

skanów oryginalnej dokumentacji skrzydeł.  

 

 

W danych towarzyszących tej książce (por. str. 18) znajdziesz plik Inkscape opisany w tej sekcji: 

source\references\sample\drawings (3.6).svg.   

 

 

     

 

Gdybym na podstawie dodatkowych wymiarów z rysunku poglądowego nie narysował trapezu skrzy-

dła, nie odkryłbym, że jego kształt na analizowanych planach jest błędny. (Tak mogłoby się zdarzyć, 

gdybym użył tylko całkowitej długości i rozpiętości, publikowanych w monografiach P-40).  
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3.7 Złożenie rysunków  

Przygotowałem także rzuty z przodu i z tyłu. Wyciąłem je z dwóch kopii tej samej zeskanowanej strony (pliku o 

nazwie 65.tif z tego archiwum), umieszczając każdy obraz na jednej z dwóch nowych warstw: Views:Front i 

Views:Rear (Rysunek 3.7.1):  

 

Rysunek 3.7.1 Wycięcie rzutów z przodu i z tyłu z zeskanowanej strony monografii AJ Press 

Jak widzisz, wycięte obszary leżą poza polem deformacji, ciągnącym się wzdłuż lewej krawędzi tej strony. 

Najpierw dopasowałem do siebie te dwa wycięte obrazy w ich „surowej” postaci, tak jak to zrobiłem z rzutami z 

góry i z dołu (por. str. 50). Dla wygody pokolorowałem linie widoku z przodu na niebiesko (Rysunek 3.7.2): 

 

Rysunek 3.7.2 Porównanie obydwu obrazów w ich „surowej” (zeskanowanej) postaci 

Zdeformowany obszar 
zeskanowanej strony 

Wyciąłem ten fragment z obrazu strony 
i umieściłem na warstwie Rear  
 

Ten rysunek wygląda jak jeden obraz, ale 
składa się z dwóch kopii skanu tej samej 
strony. Górna kopia jest umieszczona na 
półprzeźroczystej warstwie Front 

Wyciąłem ten fragment z obrazu strony 
i umieściłem na warstwie Front  

Lewe skrzydło widoku z 
przodu jest zdeformowane 

Prawe skrzydło 
widoku z przodu 
jest za grube 

http://airplanes3d.net/downloads/wm4/blueprints/typical
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Na obydwu obrazach dopasowałem do siebie kontur kadłuba Jednak w rzucie z przodu (Rysunek 3.7.2) niebie-

ska końcówka lewego skrzydła nie pasuje do końcówki czarnego rzutu z tyłu, a prawe skrzydło jest zbyt grube.  

Następnie proporcjonalnie powiększyłem i wyrównałem obydwa rzuty do osi poziomej i pionowej. Ponieważ na 

tylnym widoku widać główny szew kadłuba, użyłem go do wyrównania obydwu rzutów (Rysunek 3.7.3a): 

                          

Rysunek 3.7.3 Wyrównane i powiększone rzuty z tyłu i przodu 

Rysunek 3.7.3b) pokazuje, że pomimo pionowej orientacji osi kół podwozia i usterzenia poziomego, końcówka 

lewego skrzydła w widoku z przodu (niebieski) jest poniżej jego końcówki skrzydła prawego. 

Szczegóły kadłuba w widoku z przodu także nie pasują do widoku z tyłu. Jak pokazywałem wcześniej (str. 32, 

34), oś śmigła P-40 znajdowała się powyżej osi konstrukcyjnej, wzdłuż której biegnie główny szew kadłuba. 

Zwróć uwagę, że na widoku z przodu (niebieskie linie) oś śmigła znajduje się poniżej tej linii (Rysunek 3.7.4): 

 
 

Rysunek 3.7.4 Inne odchylenia w widoku z przodu (niebieskie linie) 
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Oś kadłuba 

Koniec lewego 
płata jest poniżej 

końca prawego  

a) b) 

Koła są usta-
wione pionowo 

Główny szew 
kadłuba 

Konstrukcyjna płaszczyzna 
kadłuba (główny szew, 
widoczny w widoku z tyłu) 

Ten kołpak śmigła wydaje się być 
po złej stronie konstrukcyjnej 

płaszczyzny kadłuba 

Zewnętrzne kontury kadłuba widoków 

z przodu i z tyłu pasują do siebie  
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Na szczęście te dwa widoki są najmniej ważne: większość informacji dostarczają rzuty z boku, góry i dołu. W 

mojej pracy widok z przodu (i ewentualnie – z tyłu) jest potrzebny tylko do paru szczegółów, jak kształt łopaty 

śmigła czy grubość usterzenia poziomego. Dlatego nie będę dopasowywał tych rzutów do pozostałych rysun-

ków. Pominę także przekroje kadłuba (por. Rysunek 3.7.1): traktuję je jako „rysunki poglądowe”, a nie dokładne 

materiały referencyjne. Przyczynę wyjaśnię w następnym rozdziale. 

Ostatecznym rezultatem naszej pracy nad tym rysunkiem w Inkscape są rastrowe obrazy rzutów samolotu. 

Wczytamy je potem do Blendera jako rysunki wzorcowe. Stwórzmy więc pierwszy z nich: rzut z lewej.  

Nasz Inkscape używa białego tła, więc możesz sobie nie zdawać sprawy jak wiele obszarów wokół sylwetki 

samolotu jest przeźroczystych (Rysunek 3.7.5): 

 

Rysunek 3.7.5 Przeźroczyste obszary wokół widoku z lewej 

W Blenderze te nieregularne, przejrzyste obszary na rysunkach referencyjnych wyglądałyby nieco dziwnie, dla-

tego proponuję umieścić za tymi sylwetkami białe prostokąty. Stworzyłem tu jeden z nich (por. str. 181) na od-

dzielnej warstwie, którą nazwałem Frames (Rysunek 3.7.6): 

 

Rysunek 3.7.6 Prostokątne tło za sylwetką samolotu 

Taka „ramka” ma także drugą rolę: określa obszar wynikowego obrazu rastrowego (Rysunek 3.7.7): 

 

Rysunek 3.7.7 Ustawienia eksportu do pliku rastrowego 

Przejrzysty 
obszar 

Biały prostokąt z czerwoną ramką – 
umieszczony na warstwie Frames 

File→Export PNG Image 

Ustaw Export area 
na Selection 

Dopasuj rozmiar obrazu 

Zaznacz ten 
prostokąt 
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Otwórz panel ustawień eksportu (File→Export PNG Image, por. str. 159) i wybierz z sekcji Export area opcję 

Selection. Następnie zaznacz prostokąt ramki, aby Inkscape przyjął jego obszar jako obszar eksportowanego 

obrazu. W sekcji Image size ustaw odpowiednią liczbę „pikseli na cal”. (Ja wybrałem tu 7 dpi: jak możesz zau-

ważyć w polach po lewej, oznacza to obraz rastrowy o wymiarach 2800x1120px). Ustaw jakąś opisową nazwę 

dla wynikowego pliku (używając przycisku Export As) i następnie kliknij przycisk Export. Rysunek 3.7.8 poka-

zuje te końcowe ustawienia i uzyskany plik: 

         

Rysunek 3.7.8 Eksportowanie widoku z lewej do pliku rastrowego 

W ten sposób uzyskaliśmy pierwszy rysunek (obraz) wzorcowy dla naszego modelu 3D. Jak pokazuje to Rysu-

nek 3.7.9, potrzebujemy sześciu takich obrazów:  

 

 

Rysunek 3.7.9 Unifikacja rozmiarów i położenia sylwetek rysunków wzorcowych dla Blendera 

Zwróć uwagę, że ujednoliciłem odpowiednie wysokości i szerokości (wymiary A, B i C) poszczególnych rysun-

ków (Rysunek 3.7.9), podobnie jak położenie sylwetki wewnątrz obrazu (wymiary f, g, h). Rysunek 3.7.9 poka-

zuje rzut z dołu (4) obrócony o 90º w lewo. Ustawiłem go w ten sposób wyłącznie na tej ilustracji. Chciałem w 

ten sposób pokazać, że długość boku A i odstęp f są takie same, jak na rzucie z boku. 

Kliknij ten przycisk by 
utworzyć obraz rastrowy 

B 

A 

f 

f 

f 

h 
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g 

g 

A B 
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Sugeruję komponowanie nazw obrazów referencyjnych z następujących elementów: 

• symbol typu samolotu (w tym przypadku – „P-40B”); 

• id monografii (gdy używasz dwóch różnych planów, na przykład – „AJPress” lub ‘Kagero”); 

• nazwa rzutu (ja używam nazw angielskich: “Left”, “Top”, “Bottom”, “Right”, “Front”, “Rear”). 

Używając tych reguł, zapisałem widok z lewej do pliku o nazwie P40B-AJPress-Left.png. 

Dla sześciu obrazów, które pokazuje Rysunek 3.7.9, stwórz trzy ramki: dla widoków z boku, widoków piono-

wych, oraz z widoków przodu i z tyłu. Umieść każdą z tych ramek na oddzielnej warstwie (Rysunek 3.7.10): 

 

Rysunek 3.7.10 Ustawienia warstw do generowania kolejnych rysunków wzorcowych 

Następnie wyeksportuj kolejne obraz przełączając widoczności odpowiednich podwarstw Views i Forms. Na 

przykład, w ilustracji powyżej włączyłem warstwy Views:Top i Frames:Vertical. Gdy wyeksportuję zawartość tej 

ramki do obrazu (P-40B-AJPress-Top.png), ukryję Views:Top i odsłonię Views:Bottom, a następnie zapiszę 

wynikowy obraz pod kolejną nazwą (P-40B-AJPress-Bottom.png). I tak dalej. 

 

Obrót wynikowych obrazów o 90º nie ma znaczenia, ponieważ można je łatwo obrócić z powrotem w 

Blenderze. Na przykład – możesz wyeksportować obrazy rastrowe z pionowo ustawionymi widokami z 

przodu i z tyłu (jak pokazuje je Rysunek 3.7.3), a potem wczytać je do Blendera i ustawić poziomo. 

 

Unifikacja rozmiarów obrazów nie jest konieczna. Jednak, gdy użyjesz takich samych odległości A, B, 

C, f, g, h w swoich rysunkach wzorcowych (jak pokazuje to Rysunek 3.7.9), będzie o wiele łatwiej 

ustawić je w Blenderze. Pamiętaj też, aby używać tej samej wartości dpi (w tym przypadku – 7).  

Umieść odpowiednią 
ramkę na każdej z 

tych warstw 

Złożenie widoku z góry 
(Top) i ramki z warstwy 
Vertical tworzy wynikowy 
obraz referencyjny 
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P-40 miał znaczny wznios skrzydeł (6º - por. Rysunek 3.7.3 lub Rysunek 3.6.3), więc sugeruję przygotować 

oddzielny rysunek referencyjny „spłaszczonego” skrzydła (tzn. bez wzniosu). Pomoże to w budowie modelu. 

Aby to zrobić, skopiuj widok z dołu (grupę z warstwy Views:Bottom) do nowej warstwy o nazwie Views:Wing i 

wytnij z tego obrazu obszar skrzydeł (Rysunek 3.7.11): 

 

Rysunek 3.7.11 Wycinanie obrazu skrzydeł 

Następnie przeskaluj to skrzydło wzdłuż osi Y, wydłużając je do 223.75” /cos(6º) = 225” (Rysunek 3.7.12): 

      

Rysunek 3.7.12 „Spłaszczanie” rysunku skrzydła 

Podczas eksportu do obrazu rastrowego, wyświetl tę warstwę Views:Wing z warstwą Frames:Vertical.  

Wytnij obraz 
skrzydeł 

Kopia warstwy Bottom, 
umieszczona na nowej 
warstwie o nazwie Wing  

Oś transformacji 

Skaluj 
wzdłuż 
osi Y 

223.75” 225” 
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Podsumowanie 

• Przygotuj widok z przodu (i – jeżeli jest na Twoich planach – widok z tyłu) w podobny sposób jak zrobiliśmy 

to dla widoków z boku i z góry/dołu (str. 63 - 64). 

• Wyeksportuj każdy z pięciu (lub sześciu) rzutów samolotu do oddzielnego pliku rastrowego (*.png). Przed 

eksportem umieść za każdym z rysunków w charakterze tła biały prostokąt. Rozmiar tego prostokąta okre-

śla eksportowany obszar rysunku (str. 65 - 66). 

• Sugeruję ujednolicić rozmiary (wysokość i szerokość) każdego z eksportowanych obrazów, a także poło-

żenie (osie) zawartych w nich sylwetek samolotu (str. 66). (Dzięki temu będzie je łatwiej ustawić w prze-

strzeni 3D). 

• Jeżeli samolot, który odtwarzasz, ma znaczny wznios skrzydeł, możesz także dodatkowo przygotować 

jeszcze jeden rysunek wzorcowy skrzydła bez wzniosu (str. 68). 

 

 

W danych towarzyszących tej książce (por. str. 18) znajdziesz plik Inkscape opisany w tej sekcji: 

source\references\sample\drawings (3.7).svg. Zwróć uwagę, że rzut z prawej jest wciąż przestawiony: 

wolę go pozostawić w tym stanie, gotowy do ewentualnych przyszłych porównań z widokiem z lewej.  

W folderze source\references\sample\result możesz przejrzeć rysunki wzorcowe wyeksportowane z 

tego pliku (rzut z prawej przerzuciłem na drugą stronę w GIMP). 
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Rozdział 4. Najczęstsze błędy w planach samolotów 

W poprzednim rozdziale omówiliśmy już dwa typowe problemy, które można napotkać w wielu planach mode-

larskich: 

• różnice pomiędzy poszczególnymi rzutami tego samego samolotu (typowe dla rysunków sporządzo-

nych ręcznie, omówione w sekcjach 3.4 i 3.5); 

• nieprawidłowe proporcje (rozpiętość/długość) rzutów z góry i z dołu (omówione w sekcji 3.6). 

W tym rozdziale opiszę dwie dalsze klasy błędów, które możesz napotkać w planach Twojego samolotu. Są to: 

• niepoprawny widok z przodu (i – jeżeli występuje – z tyłu); 

• powtarzanie tych samych błędów w różnych planach, opracowanych przez różnych autorów (tak, że 

możesz je uznać za „potwierdzone” detale i kształty). 
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4.1 Zgodność z widokiem z przodu i przekrojami 

W poprzednim rozdziale zrezygnowałem z porównywania widoków z przodu i z tyłu z pozostałymi rysunkami 

(por. str.  65). Zrobiłem to, ponieważ większość autorów kreśli swoje plany w następującej kolejności: 

1. Rzut z boku (zazwyczaj lewego) to najbardziej wiarygodna część planów. Jest używany przez ich auto-

rów m.in. jako wzorzec dla kolejnych rzutów, m.in. ewentualnego rzutu z prawej. 

2. Rzut z góry (i z dołu): są mniej wiarygodne, gdyż pionowe zdjęcia samolotu są rzadziej spotykane. 

3. Rzut z przodu (i z tyłu): są najmniej wiarygodne, ponieważ kumulują się w nich błędy rzutów z boku i z 

góry. 

4. Przekroje (kadłuba, skrzydła): w dużej mierze są oparte na widoku z przodu, więc ich jakość jest tak ni-

ska, że zdecydowanie sugeruję używać ich wyłącznie jako „rysunków poglądowych”1. 

Ponieważ w sekcji 3.7 znalazłem już różnice pomiędzy rzutem z przodu i z tył, byłem zupełnie pewien, że po-

równanie ich z innymi rzutami ujawniłoby więcej błędów. Nie chciałem się o nich rozpisywać w poprzednim roz-

dziale, lecz tutaj umieszczam zestawienie widoku z tyłu (niebieski) i z lewej (czarny) z rysunków AJ Press 

(Rysunek 4.1.1): 

 

 

 

 

Rysunek 4.1.1 Różnice pomiędzy rzutem z lewej i z tyłu 

Na ilustracji powyżej zaznaczyłem za pomocą czerwonych linii wszystkie znalezione różnice. Linie te łączą od-

powiednie punkty widoku z boku i z tyłu. Zgodne elementy nie są połączone liniami. Szczerze mówiąc, spo-

dziewałem się większej liczby błędów. Najpierw zauważyłem, że płaszczyzna symetrii kadłuba (1) jest w widoku 

z tyłu przechylona w lewo, podczas gdy końcówki skrzydeł i ster głębokości są poziome. To chyba błąd kreśla-

rza. Kolejnym, większym błędem w tym rysunku jest wylot umieszczony za skrzydłami, pod kadłubem (2): w 

widoku z tyłu jest narysowany zdecydowanie za nisko. Następnym błędem jest zbyt niska pozycja narożnika 

oprofilowania skrzydła w widoku z boku (3). W tym przypadku powinien być wyżej, na takim poziomie ja w wido-

ku z tyłu. Jak wspomniałem w poprzednim rozdziale, kontur skrzydła w widoku z boku jest zazwyczaj błędny. 

Dlatego w przypadku (4): różnicy w położeniu końcówek płata, zupełnie nie wiem, która jest poprawna2. Wresz-

cie osłona kabiny (5) i końcówka usterzenia (6) są w widoku z tyłu umieszczone zbyt nisko. 

 
1 W przypadku wręg kadłuba lepszym pomysłem jest odtworzenie ich kształtów używając punktów przecięcia płaszczyzny wręgi z kolejnymi 

liniami podłużnic, poprowadzonymi zgodnie z widokiem z boku i z góry. W przypadku żeber skrzydła: jeżeli znasz nazwę zastosowanego 

profilu (np. „NACA 2215”), możesz użyć dokładnych współrzędnych z danych o tym kształcie (por. str. 255). 

2 W każdym razie, w moim modelu 3D po prostu podniosę płaszczyznę skrzydła o 6º (por. 60, Rysunek 3.6.3), i to powinno określić praw-

dziwe położenie tych końcówek. (Zakładam, że płaszczyzna konstrukcyjna skrzydła P-40 łączyła krawędź natarcia i krawędź spływu). 

5. Zbyt niska 
osłona kabiny  

6. Za niskie 
usterzenie 

3. Typowy błędny narożnik oprofilowania 
skrzydła (powinien być wyżej) 

1. Odchylenie kadłuba i statecznika 
pionowego w rzucie z tyłu   

4. Różnice w wzniosie 
skrzydła (która z tych 
wersji jest prawdziwa?) 

2. Ten wylot 
był wyżej 
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Jednak w przypadku widoku z przodu, ¾ kadłuba jest zupełnie nieprawidłowe (Rysunek 4.1.2): 

 

Rysunek 4.1.2 Różnice pomiędzy rzutem z lewej i z przodu 

Różowy obszar, który pokazuje Rysunek 4.1.2, obejmuje część widoku z przodu która, w porównaniu z rzutem z 

boku, została przesunięta w dół. Te różnice zmieniają się wzdłuż osi pionowej. Największe występują dla śmi-

gła: jego oś znajduje się jakieś 3” poniżej osi z rzutu z boku. Nie wymienię tu już dalszych błędów, jak nieprawi-

dłowy kształt oprofilowania skrzydeł1, lub czy pozycja usterzenia poziomego. 

Sprawdziłem także w tym widoku z przodu dwa wymiary podane w rysunku poglądowym (Rysunek 4.1.3 poka-

zuje ten widok w kolorze czarnym) :  

 

 

Rysunek 4.1.3 Porównanie rzutu z przodu z rysunkiem poglądowym 

Jak widać, rozstaw kół na rysunku AJ Press jest zbyt wąski. Dziwnym trafem, poprawny kąt wzniosu (6º) wystę-

puje tylko na lewym skrzydle, które traktowałem jako „zdeformowane” (por. str. 63, Rysunek 3.7.2). Czy to 

oznacza, że pozostałe skrzydła, na obydwu rysunkach, są błędne? No cóż, to jest możliwe. 

 
1 Wydaje mi się, że autor rysunków AJ Press błędnie założył tu stałą szerokość kadłuba – od przegrody silnika do kabiny pilota.  

Wewnątrz tego różowego obszaru 
wszystko jest przesunięte do dołu  

Różnica w położeniu 
końcówek skrzydła 

Największy błąd to 
pozycja osi śmigła 

Nie porównuję pozycji kół 
podwozia: mogą być 
różne dla różnych ugięć 
amortyzatorów   

Błędny 
kształt  

Błędne 
położenie  

97.875”  

97.875” 

Zbyt wąski 
rozstaw kół  

To skrzydło jest zbyt 
grube – więc nie ufam 
także temu statecznikowi. 

6º 

Dziwnym trafem, to “zdefor-
mowane” skrzydło ma po-
prawny wznios 6º (we wszyst-
kie pozostałych to 7.5º) 

Rysunek poglądowy 
(Curtiss, 1941) 
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 (CC) Witold Jaworski, 2009 – 2020. 

Na szczęście, do formowania modelu skrzydła nie potrzebujemy ani widoku z przodu, ani jego przekrojów z 

planów. Zazwyczaj możesz zidentyfikować początkowy (i ewentualnie – końcowy) profil płata, a także kąty za-

klinowania1 i wzniosu z opisu konstrukcji samolotu.  W przypadku P-40 są to: NACA 2215 w płaszczyźnie syme-

trii kadłuba, NACA 2209 na końcu płata, kąt zaklinowania = 1º. Kąt wzniosu: 6º już znamy z rysunku poglądo-

wego. Wykorzystując te symbole profili i wymiary cięciw możesz precyzyjnie odtworzyć współrzędne początko-

wego i końcowego przekroju poprzecznego skrzydła z odpowiednich tabeli NACA (por. str. 257). Są tu jednak 

dwie niewiadome: lokalizacja profilu końcowego (NACA 2209) i ewentualne zwichrzenie płata2. Dla pierwszej 

generacji wolnonośnych jednopłatów (takich, których pierwszy prototyp zbudowano przed 1937), można bez-

piecznie założyć brak zwichrzenia, jeżeli takiej informacji nie umieszczono w opisie technicznym. Profil końcowy 

jest zazwyczaj podawany dla podstawy eliptycznej końcówki skrzydła. Rysunek 4.1.4 przedstawia dane geome-

tryczne skrzydła P-40, odtworzone na podstawie opisu technicznego (bez kątów: zaklinowania i wzniosu):    

 

Rysunek 4.1.4 Profile skrzydła P-40 (wg opisu technicznego, bez kąta zaklinowania) 

Korzystając z tych dwóch profili można łatwo odtworzyć prawdziwą grubość skrzydła. Oczywiście, nie znamy 

szczegółów kształtu jego eliptycznej końcówki, lecz jej kontur odczytany z planów także może być błędny3. 

 

Opis techniczny samolotu jest wiarygodniejszym źródłem niż rzut z przodu z jego planów. (Z takiego 

opisu można odczytać profile skrzydła i ewentualne kąty zaklinowania oraz wzniosu). 

 
 Najtrudniejszym przypadkiem jest usterzenie samolotu. Nie ufam grubościom stateczników: ani tych narysowa-

nych w widokach z przodu, ani tych z tyłu. (To moja reguła: w większości planów są to stosunkowo małe ele-

menty, w których łatwo popełnić błąd). Pomyłka w kreśleniu „o połowę szerokości linii”, zaniedbywalna w innych 

przypadkach, może być znacząca w szacowaniu grubości statecznika. Co więcej, nawet gdyby te rysunki były 

perfekcyjne, niezerowe kąty zaklinowania usterzenia i tak zepsułyby taki pomiar. Na nieszczęście, w opisie 

technicznym nie można znaleźć żadnej informacji o profilach zastosowanych w usterzeniu samolotu. W więk-

 
1 Jest to kąt natarcia skrzydła dla kadłuba ustawionego poziomo.  

2 Różnica w kątach zaklinowania profili u podstawy i na końcu płata (tzn. skręcenie płata o niewielki kąt, zazwyczaj 2-3º). Skrzydła Super-

marine Spitfire były jednym z pierwszych przypadków takiego rozwiązania. (Umożliwiało uniknięcie niespodziewanego przeciągnięcia). 

3 Zaobserwowałem, że w jednym z popularnych planów Bf 109 autor niestarannie nakreślił w widoku z przodu zbyt grube końcówki skrzydeł.  

Od tego czasu widziałem wiele modeli Messerschmitta ze zbyt grubymi skrzydłami. Wydaje się, że modelarze ślepo wierzą swoim rysun-

kom wzorcowym, nie uświadamiając sobie, że te kreski także kreślił człowiek. A człowiek myli się zazwyczaj w 2-3% swojej pracy! 

NACA 2215 
(15%)  

NACA 2209 
(9%)  

Zazwyczaj profil końcowy jest 
podawany dla końca prostego 
odcinka krawędzi spływu/natarcia 
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szości widoków z boku, które widziałem (a także widoków z góry), profil podstawy usterzenia pozostawiał wiele 

do życzenia. Wystarczy je porównać ze zdjęciami (Rysunek 4.1.5): 

               

Rysunek 4.1.5 Porównanie profilu prawdziwego usterzenia z jego rysunkiem z planów modelarskich 

Jak widać na ilustracji powyżej, krawędź natarcia prawdziwego statecznika poziomego jest dużo cieńsza niż na 

rysunku z planów. (To jest typowy błąd, który zaobserwowałem na wielu planach różnych samolotów). Takim 

rysunkom nie można ufać: stabilizator pionowy w widoku z góry także może być zbyt szeroki. 

 

Niestety, nie jestem w stanie odtworzyć grubości elementów usterzenia z takich zdjęć. W najgorszym 

przypadku trzeba zrobić pierwszą wersję modelu 3D, a potem dostosować kształt usterzenia poprzez 

porównanie tego modelu z dostępnymi zdjęciami. 

 
 Tym niemniej, wciąż możesz próbować znaleźć informację o tym usterzeniu w innych źródłach. (Pokażę to w 

następnym rozdziale, na przykładzie oryginalnego rysunku złożeniowego steru wysokości).  

To wszystko, co mogę powiedzieć o typowych błędach rzutu z przodu. Teraz sprawdźmy przekroje kadłuba. 

Skopiowałem je ze skanu tej samej strony, z której pochodzą rzuty z przodu i z tyłu (por. str. 63, Rysunek 3.7.1). 

Aby łatwiej rozstawiać te przekroje w oznaczonych miejscach na widoku z lewej, każdy z nich jest wycięty od-

dzielnie. Jednocześnie połączyłem je w jedną grupę, aby utrzymać ich rozmiary w tej samej skali, a ich osie 

wyrównać wzdłuż jednej linii. Rysunek 4.1.6 pokazuje tę grupę wyskalowaną i wyrównaną do rzutu z przodu: 

 

Rysunek 4.1.6 Przekroje kadłuba: wyskalowane i dopasowane do widoku z przodu 

Zwróć uwagę na drugą poziomą oś w przekrojach G, H, J i K. Wygląda na konstrukcyjną oś kadłuba. 

 

Zdjęcie: David Spurgeon-Jackson 

Ta krawędź natarcia 
jest dużo cieńsza niż 
na tym rysunku 

To jest oś 
śmigła 

To jest konstrukcyjna 
oś kadłuba 



Rozdział 4 Najczęstsze błędy w planach samolotów 75 

 

 
 (CC) Witold Jaworski, 2009 – 2020. 

Ponieważ te przekroje są wyrównane do nieprawidłowej osi śmigła z rzutu z przodu, nie ma się co dziwić, że nie 

pasują do widoku z lewej (Rysunek 4.1.7): 

 

 

 

Rysunek 4.1.7 Przekroje kadłuba: wyskalowane i dopasowane do widoku z przodu 

Jak widać, różnice są na tyle znaczące, że nie ma już sensu porównywać ich z widokiem z góry. Ewidentnie 

przekrój B zawiera jakieś dodatkowe błędy, ponieważ nie pasuje nawet do rzutu z przodu1.  

 

W większości planów modelarskich przekroje kadłuba nie pasują do widoków z przodu i góry. Ponieważ 

każdy z nich trzeba byłoby przygotować jako oddzielny obraz, nie są warte tego wysiłku. 

 
 W praktyce, wykorzystuję linie podłużnic z widoków z boku i z góry (poprowadzone wzdłuż szwów paneli i linii 

nitów) do określenia kluczowych punktów dla przekrojów kadłuba. Pokażę to w następnej części tej książki. 

Podsumowanie 

• W większości przypadków, rzut z lewej jest najdokładniejszym rysunkiem w planach modelarskich. Rzuty z 

góry i z dołu są mniej wiarygodne. 

• Rzuty z przodu i z tyłu są najmniej wiarygodnymi rysunkami (str. 71, 72). 

• Zazwyczaj możesz odtworzyć podstawowy kształt skrzydeł używając informacji z rzutów z góry i z dołu 

oraz z opisów technicznych (str. 73). Rzuty z przodu, z boku, oraz przekroje skrzydeł mogą w tym przypad-

ku wprowadzić w błąd. 

• Nie ufaj rysunkom usterzenia w rzutach z przodu i z tyłu (str. 72), oraz profilom usterzenia poziome-

go/pionowego w rzutach z boku i z góry (str. 74). 

• Przekroje kadłuba zazwyczaj zupełnie nie pasują do rzutów z lewej i z góry (str. 75). 

  

 

 
1 Jak widać na widoku z lewej, przekrój B odpowiada przedniemu „obramowaniu” wlotu powietrza do chłodnicy. To same „obramowanie” 

jest narysowane w widoku z przodu (por. Rysunek 4.1.6). Porównując te dwa kontury zauważysz, że przekrój B jest zbyt niski (głęboki). 

Te przekroje są zbyt niskie 
Przekrój B 
nie pasuje 
do niczego 

Przekroje J i K 
pasują do kadłuba 

Nieprawidłowe położenie osi śmigła 
w przekrojach osłony silnika  
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4.2 Kopiowanie błędów innych autorów 

Przed erą komputeryzacji, gdy wszystkie plany modelarskie kreśliło się w tuszu, trzeba było przyjąć za podsta-

wę jakiś wybrany, starszy rysunek. Nawet dostęp do oryginalnej dokumentacji wymagałby szukania kluczowych 

wymiarów, rozproszonych wśród setek rysunków złożeniowych. Nie wspomnę już o czasie, jakiego wymagałyby 

takie poszukiwania! Dlatego nowy szkic powstawał w oparciu o jakiś wcześniejszy plan, opracowany przez in-

nego autora, który wydawał się najlepszy. Oczywiście, w tej nowej wersji poprawiało się wszystkie zidentyfiko-

wane błędy. Zazwyczaj jednak były to detale: inne położenie stopnia w kadłubie, różnice w ramkach osłony ka-

biny, itp. Nawet dziś wielu autorów tworzy rysunki w podobny sposób, poprawiając znalezione błędy, czasami 

nieświadomie tworząc nowe, lecz w zasadzie – powtarzając pomyłki swoich poprzedników. W tej sekcji poznasz 

historię rysunków P-40, które analizował Rozdział 3. Opiszę tu możliwe przyczyny wielu błędów, które zidentyfi-

kowałem podczas porównywania poszczególnych rzutów z tych planów.  

Pewnego razu, przeglądając Internet w poszukiwaniu informacji o P-40, natknąłem się na stare plany Curtiss P-

36. Autorem tych rysunków z 1969r. jest Paul R. Matt (Rysunek 4.2.1): 

 

Rysunek 4.2.1 Rysunki P-36 z 1969r, opracowane przez Paula Matta 

W tym czasie spędziłem już nad planami AJ Press tyle godzin, że kontur tego rzutu z góry wydał mi się dziwnie 

znajomy. W istocie, różnice w obszarze za przegrodą silnika pomiędzy P-36 i wczesnymi P-40 były niewielkie, 

podstawowa geometria skrzydła, usterzenia, środka kadłuba i ogona były takie same w obydwu konstrukcjach. 

Dlatego pomyslałem, że te rysunki P-36 mogą być przydatne. Na szczęście, udało mi się znaleźć drugi arkusz 

tych planów, zawierający rzut z boku i z przodu (por. Rysunek 4.2.2). Widać, że te rysunki pełne są wymiarów. 

Oceniłem, że te informacje bardzo się przydadzą w naszym projekcie. Dlatego, pomimo widocznych deformacji 

tych skanów, zdecydowałem się porównać je z rysunkami wzorcowymi, które przygotowaliśmy w poprzednim 

rozdziale. 

Deformacje 

skanowania 
To arkusz 1 (z 2) 
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Poniżej widać rzut z boku P-36 z drugiego arkusza Paula Matta (Rysunek 4.2.2). Dla porównania z innymi ry-

sunkami pokolorowałem ten obraz na niebiesko:    

 

Rysunek 4.2.2 Rzut z boku z rysunków Paula Matta (część arkusza 2/2) 

Jak widać powyżej, ten arkusz także zawiera wiele wymiarów1. Myślę, że jedynym możliwym źródłem tak do-

kładnych, liczbowych wartości przedstawionych na tych planach jest oryginalna dokumentacja producenta2. 

Oczywiście, można na nich także znaleźć pewne błędy, jak np. brakujące strzałki na środkowej linii ogólnych 

wymiarów kadłuba (por. Rysunek 4.2.2). 

Nałóżmy na ten obraz sylwetkę z planów AJ Press (autor: Jacek Jackiewicz, 1999). Linie rysunku AJ Press są 

czarne, a Paula Matta – niebieskie (Rysunek 4.2.3):   

 

 

 

Rysunek 4.2.3 Porównanie rysunków Paula Matta i Jacka Jackiewicza (rzuty z boku) 

Wygląda na to, że za przegrodą silnika obydwa rysunki idealnie do siebie pasują! Oczywiście, widać tu kilka 

różnic, związanych ze zmianami wprowadzonymi we wczesnych P-40. Zauważmy, że obydwa plany były kre-

ślone ręcznie. Praktycznie nie ma szans, aby mogły do siebie tak dobrze pasować w wyniku przypadku. Ozna-

cza to, że Jacek Jackiewicz użył tych planów P-36 jako podstawy do opracowania sylwetki P-40. 

 
1 To przykład „dobrej starej szkoły” planów modelarskich. Szkoda, że zostały zastąpione przez sylwetki bez żadnych wymiarów.  

2 Popatrz na przykład na ogólne długości kadłuba, mierzone od krawędzi natarcia podstawy skrzydła. Z tą linią odniesienia spotkasz się 

powtórnie w następnym rozdziale, na bardziej szczegółowych rysunkach poglądowych P-40. Także pomysł na wymiarowanie położenia osi 

sterów może być oczywisty na rysunku złożeniowym prawdziwego samolotu, gdyż są głównymi linie odniesienia na rysunkach złożeniowych 

sterów wysokości i kierunku. Jednak dla modelarza, który nie widzi tych linii „na samolocie”, jest to co najmniej dziwne. 

Oś śmigła była 1.75” 
poniżej osi kadłuba 

Brakujące strzałki 
i linia odniesienia Wymiary ogólne 

Położenie wręg kadłuba 

Te sylwetki idealnie 
do siebie pasują 

W P-36 ten “kil” pod 
kadłubem był krótszy 

W P-40 usunięto 

tę wypukłość 

Przegroda 
silnika 
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Ponieważ skany obydwu rzutów z góry: Paula Matta i z monografii AJ Press są zdeformowane (por. str. 51, 55, i 

76), ich złożenie nie jest już tak dokładnie dopasowane. Poniżej użyłem tu „surowego” skanu widoku z dołu z 

rysunków Jacka Jackiewicza, jako mniej zniekształconego (Rysunek 4.2.4): 

 

Rysunek 4.2.4 Porównanie rzutów z góry z rysunków Paula Matta i monografii AJ Press 

Jak widać na ilustracji powyżej, kontury tych skrzydeł pasują do siebie, z wyjątkiem niewielkiego odchylenia 

wzdłuż krawędzi natarcia. Czy pamiętasz, jak w sekcji 3.6 (str. 59) zastanawiałem się, dlaczego rozpiętość 

skrzydeł na planach AJ Press jest zbliżona do ich długości (tzn. skrzydła bez wzniosu)? Popatrz na uwagę, któ-

rą zaznaczyłem na rysunku Paula Matta: te skrzydła są  narysowane bez wzniosu! Dlatego położenie końcówki 

płata jest na nich podane jako 225” (por. str. 60 i 68). Jacek Jackiewicz nie podał tej istotnej informacji!  

Paul Matt nakreślił zbyt wąską końcówkę skrzydła – choć podaje jej poprawny wymiar (Rysunek 4.2.5): 

 

Rysunek 4.2.5 Błąd w nakreślonym kształcie końcówki płata 

To dlatego to skrzydło nie pasuje do bazowego „trapezu” płata z rysunku poglądowego (por. str. 59)! Jacek Jac-

kiewicz skopiował ten błąd. 

Te skrzydła są 
narysowane 
bez wzniosu! 

Tutaj jest prawdziwe 
225” 

223.75” 

Różnica pomiędzy 
krawędziami natarcia  

Ogon na czarnym 
rysunku jest skrzywiony  

Obecnie: 
226.11” 

Dysproporcje skrzydła 
Paula Matta w skali 1:1  

Tu jest 
prawdziwe 

4’-6” 
 

Poprawny kąt nachylenia 
krawędzi natarcia 
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Kontur płata P-36 Paula Matta zawiera jeszcze jeden błąd: po proporcjonalnym przeskalowaniu rysunku do 1:1, 

końcówka skrzydła oznaczona jako „225” jest w 226.11” (por. Rysunek 4.2.4). Nawet jeżeli Jacek Jackiewicz 

zdecydował się uwzględnić wznios skrzydeł i skrócić je wzdłuż osi Y o 223.75/225 = 0.9944, to otrzymałby płat 

o rozpiętości 226.11”*0.9944 = niemal 225”1! 

Aby porównać ogon i usterzenie, musiałem obrócić rysunek AJ Press o 0.38º (Rysunek 4.2.6): 

 

Rysunek 4.2.6 Porównanie konturów ogona (czarne linie – rysunek AJ Press) 

Po tej poprawce kontur kadłuba i prawego usterzenia z rysunku Jacka Jackiewicza (czarne linie) pasuje do ry-

sunku Paula Matta (niebieskie linie). Zwróć uwagę, że na podanym wymiarze rozpiętość usterzenia jest po-

prawna, ale rysunek znów jest zbyt szeroki2. (Na ilustracji powyżej widać nadal dwie linie o rozstawie 153.375”, 

które ustawiliśmy w sekcji 3.6). Wygląda na to, że lewe usterzenie jest zniekształcone na obydwu porównywa-

nych rysunkach, więc nie mogę ich tu porównać. (Rysunek 4.2.6 pokazuje ten obszar na różowo). 

Porównując opisy techniczne i zdjęcia P-36 i P-40, możesz znaleźć informację o różnicy w konstrukcji sterów 

wysokości. Cięciwa tego steru w P-36 była nieco dłuższa, w związku z kompensacją aerodynamiczną wzdłuż 

całej osi obrotu (por. Rysunek 4.2.6). W P-40 zrezygnowano z tej kompensacji, pozostawiając położenie osi 

steru i kontur zewnętrzny usterzenia bez zmian. W rezultacie cięciwa steru głębokości w P-40 była nieco krót-

sza. Jak widać powyżej, Jacek Jackiewicz skopiował ten ster do swojego rysunku bez tych zmian. 

 
1 Wydaje się jednak, że ten niuans jest zbliżony do ogólnej tolerancji planów AJ Press. Zmierzyłem fizyczną rozpiętość widoków z góry i z 

dołu z tej monografii. W zadeklarowanej skali 1:48, dla skrzydeł bez wzniosu powinna wynosić 225*25.4mm/48 = 238.1mm. Dla skrzydeł ze 

wzniosem, w tej samej skali, to: 223.75*25.4mm/48 = 236.8mm. Co stwierdziłem? Zmierzona rozpiętość widoku z dołu to 238mm (czyli 

zbliżona do rozpiętości skrzydeł bez wzniosu), podczas gdy ta sama rozpiętość w widoku z góry to nieco poniżej 237mm (czyli niemal do-

kładnie odpowiadająca skrzydłom ze wzniosem). 

2 Starałem się to poprawić poprzez przeskalowanie całego rysunku P. Matta wzdłuż osi Y (tak, jak to zrobiliśmy z planami AJ Press na str. 

60). Na nieszczęście, te różnice rozpiętości skrzydeł i usterzenia nie są proporcjonalne! 

Obydwa rysunki są w tym 
obszarze zdeformowane 

Tu jest praw-
dziwe 153.375” 

Ta kompensacja aerodynamiczna 
została usunięta w P-40 

Oś obrotu steru 
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Na koniec, nie jestem pewien czy Jacek Jackiewicz skopiował także rzut z przodu z rysunku Paula Matta. Ich 

obrazy nie pasują do siebie (a przynajmniej – górne części, jak pokazuje to Rysunek 4.2.7a): 

 

 Rysunek 4.2.7 Porównanie dolnych części widoków z przodu (czarne linie – rysunek AJ Press) 

Patrząc na porównanie powyżej, wydaje się, że lewe skrzydło z widoku z przodu AJ Press jest najmniej zdefor-

mowane: prawe skrzydło z tego widoku i obydwa kontury skrzydeł z widoku z tyłu są nieprawidłowe (por. str.  

63). Rysunek 4.2.7b) i c) pokazują coś, czego szczególnie nie lubię: regres. Kontur końcówki skrzydła na arku-

szu Paula Matta (Rysunek 4.2.7c) ukazuje charakterystyczny kształt widoczny na zdjęciach: górna krawędź 

prosta, dolna wypukła. (To skrzydło było na końcach „zawinięte do góry”). Jacek Jackiewicz „poprawił” tę koń-

cówkę – skrzydło stało się proste, a kontur jego końcówek – symetryczny. Rezultat, choć niewątpliwie wygląda 

„ładniej”, zupełnie mija się z prawdą! 

Górne części tych rzutów z przodu nie pasują do siebie z powodu różnic w położeni skrzydeł. Jednak można je 

przecież porównać oddzielnie (Rysunek 4.2.8): 

 

Rysunek 4.2.8 Porównanie górnych części widoków z przodu 

Płaszczyzny usterzenia poziomego i szczyt osłon kabiny teraz do siebie pasują. Jednak podstawa owiewki ka-

biny jest szersza na rysunku J. Jackiewicza (jak gdyby założył, że ten kadłub się nie zawężał). Grubość sta-

tecznika poziomego jest różna na każdym z tych planów. Jak wspomniałem wcześniej, w tym momencie trudno 

powiedzieć, która jest poprawna. Zauważ interesujący szczegół: środek kołpaka śmigła na rysunku AJ Press 

jest w tym samym miejscu, co śmigło w P-36: to wygląda na oczywisty błąd kopiowania! 

P-40 miał większe koła, I dlatego ich 
rozstaw był nieco szerszy niż w P-36 

Górna krawędź była prosta 

Dolna krawędź była wypukła 

Ten kontur lewego 
płata jest najbliższy 
prawdziwego kształtu  

a) b) 

c) 

W tym obszarze 
kontury nie pasują 

do siebie 

Regres: 

Statecznik poziomy u Matta jest 
grubszy niż u Jackiewicza  

W tym obszarze 
kontury nie pasują 

do siebie 

Podstawa osłony kabiny na czarnym 
obrazie jest szersza niż na niebieskim 

Środek tego kołpaka śmigła P-40 
leży tam, gdzie oś śmigła w P-36! 
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Większość błędów Paula Matta wydaje się brać z pomyłek przy przeliczaniu oryginalnych wymiarów 

samolotu na skalę 1:241. Dlatego o wiele łatwiej jest weryfikować rysunki referencyjne w skali 1:1, jak 

to robimy w Inkscape. W tym przypadku nie potrzeba takich przeliczeń. 

 

 

Wydaje się, że Jacek Jackiewicz skopiował do swoich rysunków wszystkie błędy popełnione przez 

Paula Matta, i dodał kilka nowych. To typowa sytuacja w planach kreślonych ręcznie. 

 
 Dodatkowe błędy w rysunkach AJ Press to: 

• widok z góry: przesunięcie szczegółów kadłuba (por. str. 56), pokrywy km w skrzydłach (por. str. 82); 

• widok z przodu: nieprawidłowa końcówka skrzydła, nieprawidłowe położenie osi śmigła (a w efekcie – wi-

dok z przodu kadłuba, który zupełnie nie pasuje do widoku z lewej: por. str. 64 i 72). 

Zwróć uwagę, że żaden z nich nie pojawił się w widoku z boku, który został skopiowany bez błędów. To kolejne 

potwierdzenie mojej tezy, że rysunki z boku (w szczególności – z lewej) są najbardziej wiarygodne2. 

Dziś w Internecie masz natychmiastowy dostęp do dziesiątek szczegółowych zdjęć Twojego samolotu, oraz 

programy graficzne w których można łatwo porównywać jego różne plany. W świecie pełnym takich fantastycz-

nych narzędzi niełatwo sobie wyobrazić, jak trudne było kreślenie planów w „erze analogowej”. Nie obwiniaj 

ówczesnych autorów za kopiowanie cudzych błędów: kreśląc w tuszu moje rysunki, robiłem to samo. 

Osiem lat później, w 2007r, inny wydawca (Kagero) zamówił plany P-40 od innego autora: Mariusza Łukasika. 

W tej dekadzie wiele zdjęć historycznych samolotów było już dostępnych w Internecie. M. Łukasik przygotował 

swoje plany w programie graficznym. Przypuszczam, że nie miał dostępu do żadnych rysunków producenta, ani 

nie znał prac Paula Matta, więc zdecydował się wykorzystać w swoich planach rysunki J. Jackiewicza. Wydaje 

się, że na początku zweryfikował je w podobny sposób, jaki pokazuje Rozdział 3. Zapewne także natknął się 

także na nieprawidłowe proporcje rzutów z góry i z dołu (por. str. 59). Jednak przypuszczam, że używał do tych 

porównań tylko ogólnej długości i rozpiętości, podanych w publikacji AJ Press. Dlatego podczas gdy ja skory-

gowałem te proporcje zmniejszając rozpiętość (por.  str. 60), on zdecydował się skompensować je wydłużeniem 

kadłuba. Moja decyzja nie miała wpływu na rzut z boku, podczas gdy jego korekta minimalnie zmieniła jego 

proporcje wzdłuż osi X (o około 1%). Na nieszczęście, nawet tak mała różnica jest widoczna, i pozmieniała po-

prawne proporcje pochodzące z oryginalnego rysunku Paula Matta (Rysunek 4.2.9):  

 

 

Rysunek 4.2.9 Porównanie rzutów z boku (czerwone linie – rysunek M. Łukasika) 

 
1 Skala 1: 24 jest podana w tabelce z opisem arkuszy Paula Matta jako skala oryginalnego rysunku (por. Rysunek 4.2.1). Przypuszczam, że 

te plany były zmniejszane do końcowej skali 1:48 w procesie druku. (W latach 80-tych i 90-tych używaliśmy do tego kserokopiarek). 

2 Por. „ranking wiarygodności” poszczególnych rzutów planów modelarskich w pierwszych akapitach sekcji 4.1. 

Różnice pomiędzy tymi dwoma rysunkami 
są największe na osłonie silnika i usterzeniu  
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Poniżej widzisz tę samą sylwetkę, zmniejszoną wzdłuż osi X o około 1%1, tak że linie odpowiednich wręg ka-

dłuba zostały do siebie dopasowane (Rysunek 4.2.10): 

 

Rysunek 4.2.10 Porównanie rzutów z boku (czerwone linie – rysunek M. Łukasika) 

Większość linii tego rysunku jest brązowa, co oznacza, że po poprawce te dwie sylwetki pasują do siebie. Jest 

tylko kilka różnic. Wygląda na to, że Mariusz Łukasik nieznacznie zmniejszył długość kołpaka śmigła oraz sze-

rokość steru kierunku. Poprawił także oczywisty błąd w kształcie szwu oprofilowania skrzydła, który pojawił się 

jeszcze na rysunkach Paula Matta, i stamtąd został skopiowany na plany Jacka Jackiewicza. 

Poniżej możesz zobaczyć porównanie rzutów z góry z Kagero i AJ Press (Rysunek 4.2.11). Linie rysunku Jacka 

Jackiewicza są na czarno. Porównuję tu skorygowaną wersję jego rzutu, tzn. rezultat poprzedniego rozdziału: 

 

Rysunek 4.2.11 Porównanie rzutów z góry (czerwone linie – rysunek Kagero) 

 
1 Obydwie oryginalne sylwetki (AJ Press i Kagero) były w skali 1:48. Długość kadłuba P-40B/C w tej skali to 201.5mm. Zmierzona fizycznie 

długość rzutu z lewej J. Jackiewicza to 199.5mm, podczas gdy na rysunku M. Łukasika to 201.5mm (+/- 0.3mm). Sylwetki, które pokazuje 

Rysunek 4.2.9 zostały proporcjonalnie dopasowane do prawdziwej długości kadłuba, i dlatego czerwone kontury rysunku Kagero wydają się 

być mniejsze i przesunięte na zewnątrz niż czarne linie z planów AJ Press. 

Różnice w długościach 
kołpaka   

Różnice w szerokości 
steru kierunku   

Tutaj M. Łukasik poprawił 
oczywisty błąd rysownika  

Większość linii 
pasuje do siebie    

Mniejszy 
statecznik 
poziomy  

Oś steru 
wysokości  

Różne 
kontury  

Inny układ 
żeber lotki 

Błędny szczegół, 
skopiowany z 
rysunku AJ Press 

Szczegóły kadłuba 
za kokpitem są 
przesunięte do tyłu 
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 (CC) Witold Jaworski, 2009 – 2020. 

Ogólnie, Mariusz Łukasik poprawił wiele błędów planów Jacka Jackiewicza: kontury jego skrzydeł i usterzenia 

są symetryczne, szczegóły osłony silnika i centralnych sekcji kadłuba pasują do widoku z lewej. Wydaje mi się, 

że próbował także używać zdjęć do poprawy innych szczegółów. Być może stąd wziął się na rysunku Kagero 

inny układ żeber lotki (por. Rysunek 4.2.11 – linie czerwone). Jednak w tym przypadku się pomylił (to żebra z 

rysunku Matta/Jackiewicza pasują do zdjęć). Na nieszczęście, M. Łukasik nie poprawił innej pomyłki z planów 

AJ Press: dziwnej osłony skrzydłowych km (por. Rysunek 4.2.11). W rysunkach Kagero zwraca uwagę znaczna 

zmiana w usterzeniu poziomym. Jest ono mniejsze niż na planach Matta/Jackiewicza, a kontur krawędz i spływu 

steru wysokości ma inny kształt. Oś tego steru (choć nie jest bezpośrednio oznaczona na planach) wydaje się 

być w tym samym miejscu co na rysunkach AJ Press (por. Rysunek 4.2.11). Być może M. Łukasik zorientował 

się na podstawie zdjęć, że ten kontur na rysunkach Matta/Jackiewicza jest nieprawidłowy, i starał się to popra-

wić. Czy z tego samego powodu skrócił cięciwy statecznika poziomego? Doprawdy, nie wiem.  

Nie będę się tu rozpisywać nad widokiem z przodu, tylko krótko wspomnę, że na planach M. Łukasika jest prak-

tycznie narysowany od nowa. Poprawiono w nim położenie śmigła, kąt wzniosu skrzydeł, i wiele innych błędów. 

(W programie 2D jest o wiele łatwiej synchronizować ze sobą poszczególne rzuty, podczas gdy na planach kre-

ślonych ręcznie było to niezwykle trudne). 

Dlatego byłem naprawdę zaskoczony, gdy wykonałem najbardziej oczywisty test: proste porównanie rzutów z 

góry i z dołu z rysunków M. Łukasika. Rysunek 4.2.12 pokazuje rezultat: 

 

Rysunek 4.2.12 Porównanie rzutów z góry (czerwony) i z dołu (niebieski) z planów Kagero 

Jak widzisz, w widoku z dołu niebieski kontur skrzydła i podziały paneli są rozstawione szerzej niż w widoku z 

góry. To ewidentna pomyłka: nawet najlepszy program nie pomoże, gdy nie sprawdzasz wyników swojej pracy. 

 

Znając prawdziwą długość cięciwy w najszerszym miejscu płata z oryginalnych rysunków poglądowych 

(por. str. 59) możemy łatwo stwierdzić, że błękitny kontur jest nieprawidłowy. Jednak jeżeli miałbyś do 

dyspozycji tylko te plany Kagero, nie mógłbyś jednoznacznie określić, który płat jest poprawny! 

 

Przesunięte linie 
podziału paneli! 

Przesunięta 
krawędź spływu!  
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Jeżeli wyobrażałeś sobie, że plany modelarskie to dokładny i bezbłędny „wyciąg z oryginalnej dokumentacji” 

samolotu1, to mam nadzieję, że ten i poprzedni rozdział wyjaśniły to nieporozumienie. W pewien sposób praca 

nad takimi rysunkami przypomina pracę średniowiecznych skrybów2: dawno temu ktoś miał dostęp do oryginal-

nej dokumentacji (w tym przypadku był to Paul Matt). Potem ktoś inny zaadaptował te plany, wprowadzając przy 

okazji kilka dodatkowych błędów (to był Jacek Jackiewicz). Potem kolejny autor użył tej kopii, poprawił zauwa-

żone nieprawidłowości, ale także stworzył kilka nowych (to był Mariusz Łukasik). W efekcie, gdybyś nie znał ich 

historii, mógłbyś potraktować te trzy rysunki jako trzy niezależne źródła!   

W następnym rozdziale zaproponuję kilka metod poprawiania rysunków wzorcowych, których przygotowanie 

opisywał Rozdział 3. 

Podsumowanie 

• Nowe plany modelarskie zazwyczaj są oparte na starszych planach. W rezultacie, ewentualne błędy są ko-

piowane pomiędzy rysunkami różnych autorów. Na przykład – błędny kształt skrzydła z arkusza Paula Mat-

ta z 1969r (str. 78) został powtórzony w 1999 na rysunku Jacka Jackiewicza, i (pośrednio) w 2007r na pla-

nach Mariusza Łukasika. 

• Współcześni autorzy starają się poprawić niedokładności znalezione we wcześniejszych rysunkach (str. 

82). Jednak każda nowa wersja planów zazwyczaj wprowadza także nowe błędy (str. 80, 82, 83). 

• Programy rysunkowe (jak Inkscape) są wspaniałymi narzędziami do porównywania różnych planów. Wyko-

rzystuj je do identyfikacji ewentualnych zależności pomiędzy znalezionymi rysunkami (jak robię to w tej 

sekcji). W szczególności, zawsze sprawdzaj, czy podstawowe kontury sylwetek samolotu z tych obrazów 

pasują do siebie. Możesz także próbować je dopasować po niewielkim przeskalowaniu wzdłuż osi X lub Y 

(str. 81, 82). 

 

 

 
1 Na różnych forach modelarzy 3D widziałem wiele wątków “prac w trakcie” (WIP), których autorzy wydają się myśleć właśnie w ten sposób. 

Podobnie, w wątkach modelarzy „plastikowych” można czasami zobaczyć zdjęcie skrzydeł modelu położonych na odpowiedniej sylwetce z 

planów. Autor takiego zdjęcia uważa, że model jest „błędny”, jeżeli nie pasuje do tego rysunku. Nigdy nie przyjdzie mu do głowy, że praw-

dziwa może być sytuacja odwrotna! (Niektóre zestawy do sklejania są dokładniejsze od wielu planów). 

2 W „erze przed-komputerowej” ta analogia była nawet celniejsza: autorzy planów także kreślili swoje rysunki w tuszu! Mały, ostry skalpel do 

usuwania plamek i nadlewek linii był naszym najlepszym przyjacielem…   
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 (CC) Witold Jaworski, 2009 – 2020. 

Rozdział 5. Korygowanie rysunków samolotu 

Jak miałeś się okazję przekonać w poprzednich dwóch rozdziałach, plany modelarskie zazwyczaj zawierają 

błędy. W tym rozdziale omówimy metody, które poprawią dokładność tych rysunków. W pierwszej sekcji za-

czniemy od najbardziej oczywistego źródła: zdjęć. W kolejnych sekcjach tego rozdziału przejrzymy bardziej 

unikalne zasoby, jak szczegółowe rysunki poglądowe, diagramy rozkładu wręg (ang. stations diagram), czy 

fragmenty oryginalnej dokumentacji samolotu.  
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5.1 Zdjęcia 

Rysunki, które przygotowaliśmy w poprzednich sekcjach mówią tylko połowę prawdy od odwzorowywanym sa-

molocie. Aby znaleźć tę drugą połowę, zgromadź jak najwięcej jego szczegółowych zdjęć. Są niezbędne do 

dalszej pracy. Na przykład – nigdy nie podejmę się odtworzenia szczegółów podwozia bez kilkudziesięciu takich 

fotografii. Możesz je znaleźć w Internecie: wyszukaj frazy „<twój samolot> walkaround” (np. dla tego P-40 użyj 

„P-40 walkaround”). Pamiętaj, że bardziej szczegółowy model wymaga większej liczby zdjęć. Zbieraj wszystko 

co znajdziesz, bo nigdy nie wiesz, która z tych fotografii okaże się najbardziej użyteczna! 

 

Zazwyczaj samolot, który budujesz, miał kilka różnych wersji. W przypadku P-40 było ich co najmniej 

dziesięć. Zanim zaczniesz analizować zdjęcia, zapamiętaj podobieństwa i różnice pomiędzy tymi wa-

riantami. Na przykład – wiedziałem, że jedyną różnicą w usterzeniach P-40 były inne popychacze try-

merów, zmodyfikowane w P-40D. Stąd w moim P-4B mogłem użyć szczegółów sterów wysokości i 

kierunku przedstawionych na zdjęciach P-40E, pomijając tylko te dwa detale.  

 
Najprostszym wykorzystaniem zdjęć jest porównywanie ich z odpowiednim fragmentem rysunku samolotu. Dla 

przykładu, przyjrzyjmy się osłonom karabinów pomiędzy przegrodą silnika a kabiną pilota (Rysunek 5.1.1): 

 

 

 

    

Rysunek 5.1.1 Porównanie rysunków samolotu ze zdjęciami 

Rysunek 5.1.1a) i b) pokazuje dwa fragmenty zdjęć odrestaurowanego P-40B z Duxford (Wlk. Brytania). Osłona 

karabinów jest tu zdjęta, i widać dokładnie kształty dwóch kolejnych wręg kadłuba, oznaczonych na planach 

literami D i E. Zwróć uwagę, że ich kształt odpowiada „pudełkowatemu” kształtowi zamków zamontowanych tu 

Browningów M2 (w szczególności – ich górnym, zewnętrznym krawędziom). Wygląda na to, że kontury tych 

dwóch wręg tworzą w tym obszarze prosty segment, potem wyraźnie zaznaczone zaokrąglenie przy narożni-

kach zamków karabinów, i wreszcie zamknięcie z góry łagodną krzywą. Nic takiego nie widać na planach AJ 

Press i Kagero (Rysunek 5.1.1c). Ich przekroje tego obszaru są nieprawidłowe. Możemy tylko spekulować, dla-

czego pierwszy z autorów nie zauważył tego niuansu. Może zasugerował się kształtem przegrody silnika w 

późniejszych wersjach P-40? W P-40D kompletnie przebudowano tę część kadłuba, usuwając karabiny i obni-

żając osłonę kabiny pilota. Od tego wariantu, przekroje w tym obszarze były zbliżone do eliptycznych. 

D 
E 

D E 

Prosta krawędź 
konturu wręgi   

E 

D 

Poprawione 
kontury 
przekrojów   

Wygląda na to, że Jacek Jackiewicz nie 
zauważył ostrzejszej krawędzi kadłuba, bie-
gnącej wzdłuż zamków karabinów maszyno-
wych. (Nie pasowałyby do jego przekroju E) 

Zamek 
karabinu 

Zamek karabinu   

a) 

b) 

c) 
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 (CC) Witold Jaworski, 2009 – 2020. 

Mariusz Łukasik (Kagero) także nie dostrzegł tego błędu, choć jestem pewien, że miał do dyspozycji więcej 

zdjęć niż Jacek Jackiewicz (AJ Press). 

 

Nie używaj tych dwóch przekrojów kadłuba z rysunków AJ Press/Kagero nawet jako „sugestii” jego 

kształtu, ponieważ są po prostu błędne. 

 
W istocie, w tych wczesnych wersjach P-40 (do P-40C włącznie) cały kadłub za przegrodą silnika był „odziedzi-

czony” po ich poprzedniku: P-36/H.75 (Rysunek 5.1.2): 

 

Rysunek 5.1.2 Ten sam fragment kadłuba w Hawk 75 (wariant eksportowy P-36) 

Co interesujące, na rysunkach Paula Matta przekroje kadłuba lepiej pasują do tych zdjęć, choć ich kształt wyda-

je się nadal być zbyt „zaokrąglony” (Rysunek 5.1.3): 

 

  

Rysunek 5.1.3 Przekroje kadłuba P-36 na rysunku Paula Matta 

 

Zdjęcie: Mark Mills 

Ten Hawk 75 był wyposażony w dwa mniej-
sze karabiny kalibru 7.5mm. Każdy z nich 
mógł być zastąpiony większym M2 
(12.7mm), takim samym jak te w P-40 

1 3 

1 3 

Ten promień 
był mniejszy 

Zaokrąglona krawędź, biegnąca 
wzdłuż zamków karabinów 

Ten kontur 
przypomina 
zdjęcia 

Od przegrody silnika 
do końca ogona, P-36 
i wczesne P-40 miały 
identyczną geometrię 
kadłuba  
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Zdjęcia „z obchodu” pokazują odrestaurowane samoloty. Niektóre z ich części nie są oryginalne, i ich kształty 

mogą się nieznacznie odbiegać od prawdziwych konturów. Na przykład, popatrz na kołpak śmigła P-40B z Na-

tional Museum of Naval Aviation w Pensacola (Rysunek 5.1.4a): 

            

Rysunek 5.1.4 Odrestaurowany i oryginalny kołpak śmigła 

Rysunek 5.1.4b) ukazuje kołpak oryginalnego samolotu z 1940r. Wydaje mi się, że w odrestaurowanym egzem-

plarzu kołpak jest za duży: jego krawędź podstawy nie pasuje do osłony silnika, i pomiędzy nimi widać większą 

szczelinę (Rysunek 5.1.4a) niż pokazywana przez Rysunek 5.1.4b). Na zdjęciu z 1940r widać, że kołpak był 

nieco mniejszy. Porównując ich czubki, zauważyłem także niewielką różnicę w kształcie z boku. Przypuszczam, 

że kołpak w tym odrestaurowanym samolocie był odtworzony później, może w muzealnym warsztacie. Trudno 

jest uzyskać poprawny kształt tej części, szczególnie gdy brak jest oryginalnej dokumentacji technicznej1.  

W tym samym egzemplarzu z Pensacola brakuje wręgi podtrzymującej chłodnice cieczy (Rysunek 5.1.5): 

    

Rysunek 5.1.5 Brakujące elementy w muzealnym egzemplarzu P-40B 

 
1 Nie zachowała się żadna oryginalna dokumentacja wczesnych wersji P-40. Na zachowanych mikrofilmach Curtiss można znaleźć rysunki 

P-36, H.75, a potem – od razu P-40D i późniejszych (por. str. 219).  

Oryginalny samolot (1940) Egzemplarz odrestaurowany 

Krawędź tego kołpaka nie jest 
dopasowana do kadłuba tak, 
jak w oryginalnym samolocie 

Drobne różnice w 
konturze w widoku 
z boku  

a) b) 

Zdjęcie: NASM Zdjęcie: largescalemodeller.com 

Zdjęcie: largescalemodeller.com Zdjęcie: NASM 

Wręga, która podtrzymywała 
chłodnice, jest tu nieobecna   

Tej osłony wylotu 
powietrza także 
tu nie ma 

Brak popy-
chaczy klap 

Brak trójkątnych 
uszczelnień pomiędzy 
środkowymi klapami 
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(Przypuszczam, że zostały zamocowane w jakiś prowizoryczny sposób – może są zawieszone na korpusie 

silnika?) W tym egzemplarzu występują także braki w wyposażeniu kabiny. 

Oczywiście, w tym przypadku najlepsze są historyczne zdjęcia oryginalnych samolotów. 

Egzemplarze latające są zazwyczaj w lepszym stanie, choć drobne szczegóły w dawniej odrestaurowanych 

samolotach mogą się różnić od oryginałów. (Zazwyczaj można znaleźć takie „przeróbki” wśród paneli poszycia 

o bardzo złożonym kształcie). Jednakże w tych przypadkach powinieneś być wyczulony na obecność nowocze-

snego wyposażenia nawigacyjnego i innych drobnych modyfikacji (Rysunek 5.1.6): 

      

 Rysunek 5.1.6 Przykłady modyfikacji wprowadzonych do obecnie latających egzemplarzach historycznych samolotów 

Aby szybciej i efektywniej przeglądać i po-

równywać zebrane zdjęcia, pogrupowałem 

je na dysku w foldery „tematyczne”. Ich 

nazwy pochodzą od odpowiednich części 

samolotu (Rysunek 5.1.7): 

Zauważ, że dla „długonosych” P-40 (B” i 

„C”) utworzyłem katalog o nazwie H81, a 

dla „krótkonosych” (wariant „D” i dalsze) – 

katalog o nazwie H87. („H81” i ‘H87” są 

oznaczeniami typu samolotu stosowanymi 

wewnętrznie w Curtiss. P-36 w tej nomen-

klaturze to „H75”. Wydaje się, że różnica 

pomiędzy tymi wczesnymi i późniejszymi 

wersjami P-40 była na tyle duża, że otrzy-

mały różne oznaczenia typu. Oficjalny 

symbol „P-40” zachowano tylko z przyczyn 

formalnych).  

 

W „statycznych” egzemplarzach z muzeum może brakować niektórych z mniej widocznych części. 

Mogą w nich także występować części odtworzone, które są tylko (lepszym lub gorszym) przybliżeniem 

oryginałów. Jedyną metodą ich identyfikacji jest porównanie ze zdjęciami innego egzemplarza. 

 

Rysunek 5.1.7 Moje foldery ze zdjęciami P-40 

 

Zmieniona 
rurka wylotowa 

Współczesne 
anteny 

Współczesne instrumenty, ukryte 
w atrapach zamków km. 

Brak projektora 
celownika P-36C P-40E 

Zakończenie “kila” 
pod kadłubem P-40 

Pogrupowałem 
zdjęcia P-40 w 
takie foldery: 
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Teoretycznie, konur samolotu na idealnym zdjęciu z boku powinien odpowiadać konturowi na ortogonalnym 

rzucie z boku. To jedna z własności „czystej” projekcji perspektywicznej (por. str. 248). Jednak nie żyjemy w 

idealnym świecie, i fotografie samolotu wykonane dokładnie w poziomie, idealnie prostopadle do płaszczyzny 

symetrii maszyny, zazwyczaj nie istnieją. Zresztą, nawet gdyby były idealnie prostopadłe, to nie będą wypozio-

mowane: większość samolotów z II WŚ miała kółka ogonowe. Co więcej, istnieje jeszcze jeden problem optycz-

ny: tak zwane „zniekształcenie beczkowate” (por. str. 249). Z tego powodu przedstawione poniżej, dobrze znane 

zdjęcie Tomahawka IA z 1940r, nie może być użyte jako obraz referencyjny (Rysunek 5.1.8): 

 

Rysunek 5.1.8 Zdjęcie z boku Curtiss H81 A2, znanego także jako Tomahawk IA 

Lewa goleń podwozia kompletnie zasłaniająca na nim prawą może być myląca: w istocie, jest to efekt uboczny 

silnego zniekształcenie tej fotografii (Rysunek 5.1.9): 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Rysunek 5.1.9 Możliwe położenie kamery i samolotu na zdjęciu powyżej 

Podobne zniekształcenie występuje na tym zdjęciu wzdłuż osi pionowej. 

Źródło: NSAM (via flicker.com) 

 

Ten lewy goleń podwozia za-
słania prawy, Czy to znaczy, że 
to zdjęcie wykonano dokładnie 

pod katem 90º? 

Przypuszczalna deformacja płaszczyzny symetrii 
samolotu na tym zdjęciu (por. Rysunek 5.1.9)  

1 2 3 

Linia horyzontu jest ponad połową 
wysokości zdjęcia. To oznacza, 
że kamera jest skierowana w dół 

Kamera 

Ten samolot jest ustawiony 
ukośnie do kamery  

Duże zniekształcenie beczkowate 
na tym zdjęciu: zwróć uwagę na 
różnicę kątów pomiędzy promie-
niami 1 i 3 

2 3 

1 3 

Promień 1: kontur pod-
stawy kołpaka śmigła 
jest wygięty w lewo 
 

Promień 3: obraz statecznika 
poziomego jest wygięty w 
prawo 

Promień 2: Prostopadły 
do osi samolotu 

1 
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W rezultacie, jedynym stosunkowo niezdeformowanym obszarem na zdjęciu, które pokazuje Rysunek 5.1.8, jest 

dolna część osłony silnika. Choć nawet w tym przypadku zakres ewentualnego błędu jest nadal szeroki. 

Współczesne zdjęcia samolotów w locie są dużo lepszym materiałem do ewentualnych porównań, gdyż są wy-

konane z użyciem teleobiektywu. W takiej projekcji zniekształcenie beczkowate jest minimalne: 

 

Rysunek 5.1.10 Współczesne zdjęcie odrestaurowanego P-40C z Duxford, wykonane teleobiektywem 

Uważaj na ustawienie powierzchni sterowych, takich jak ster kierunku. W lecącym P-40 jest on zazwyczaj od-

chylony w prawo, aby kontrować efekt strumienia zaśmigłowego. Stąd kontur tego steru na tym zdjęciu może 

się nieco różnić od reszty sylwetki samolotu. 

Takie zdjęcie wykonane kamerą o bardzo długiej ogniskowej można porównać z rysunkami (Rysunek 5.1.11): 

 

Rysunek 5.1.11 Porównywanie sylwetki samolotu ze współczesnego zdjęcia z rysunkiem referencyjnym 

Na ilustracji powyżej kierunek kamery nie jest idealnie prostopadły do płaszczyzny symetrii samolotu, więc mo-

żemy porównywać tylko kontur kadłuba. Wszystkie inne szczegóły, jak wręgi, skrzydło, usterzenie poziome, są 

przesunięte przez to odchylenie. (Nawet zewnętrzny celownik i jego muszka tu nie pomogą, ponieważ na P-40 

były montowane po prawej stronie wiatrochronu). Na razie możemy tylko orzec, że osłona chłodnicy na rysunku 

jest większa niż na zdjęciu, a „kil” pod skrzydłem – zbyt krótki. Także średnica podstawy kołpaka śmigła z ry-

sunku wydaje się być nieco mniejsza od tej ze fotografii. 

 
1 Jednak to konkretne zdjęcie jest jednym z trudniejszych przypadków. Czasami przypuszczam, że Curtiss używał do takich „oficjalnych” 

fotografii jakiejś starej, szerokokątnej kamery na trójnogu, jakie były produkowane na początku XXw. 

 

Zniekształcenie beczkowate występuje na większości historycznych zdjęć1. W rezultacie, tylko ich 

fragment mogą być porównywane z rysunkami samolotu 

  

Źródło: wikimedia.org 

W lecącym P-40 ster kierunku jest 
zazwyczaj odchylony w prawo 

Kamera nie była 
idealnie pozioma  

Odchylenie 
linii wręg 
kadłuba 

Największe różnice widać wokół 
chłodnicy i końcówki „kila” kadłuba 

Odwróciłem to zdjęcie 
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Kiedy zbudujesz pierwszą wersję swojego modelu w 3D, możesz ją ponownie porównać z tymi zdjęciami. W 

takim przypadku możesz spróbować dokładniejszej metody. Używa się w niej zdjęć o wysokiej rozdzielczości 

jako dokładnych obrazów referencyjnych, tak samo, jak używasz skanów planów modelarskich (por. str. 251). 

Więcej na ten temat znajdziesz w załączniku do tomu II. 

Podsumowanie 

• Zdjęcia szczegółów samolotu możesz znaleźć w Internecie, szukając frazy „<typ samolotu> walkaround”. 

Fotografie z takich „obchodów” są często publikowane na różnych portalach modelarskich (str. 86). 

• Wiele błędów rysunków referencyjnych można zidentyfikować poprzez prostą konfrontację ze zdjęciami, na 

przykład – nieprawidłowe kontury przekrojów kadłuba (str. 86, 87). 

• Uważaj na „dosztukowane” części w odrestaurowanych samolotach. Szczególnie w przypadku statycznych 

ekspozycji w muzeach, niektóre elementy mogą być nieprawidłowe, a innych może brakować. Najlepszą 

metodą identyfikacji takich różnic jest porównanie ze historycznymi zdjęciami oryginalnych samolotów (str. 

88). 

• W odrestaurowanych, latających samolotach możesz napotkać pewne współczesne elementy, takie jak 

dodatkowe anteny. Także te detale możesz zidentyfikować poprzez porównanie z historycznymi zdjęciami 

(str. 89).    

• Aby łatwo odnaleźć potrzebne zdjęcie, zorganizuj je na swoim dysku w foldery odpowiadające poszczegól-

nym głównym zespołom samolotu (str. 89). 

• Fotografia wykonana prostopadle do płaszczyzny symetrii samolotu powinna zawierać dokładny kontur ka-

dłuba i usterzenia pionowego. Oczywiście, w praktyce taki ideał nie jest możliwy, nie tylko z powodu ewen-

tualnych odchyleń kamery, ale także z powodu występującego w obiektywie tzw. „zniekształcenia beczko-

watego” (str. 90). Jednak możesz traktować współczesne zdjęcia wykonane teleobiektywem jako pewne 

przybliżenie takiej projekcji (str. 91).  

 

  

 

 

 

 

Oczywiście, zanim zmodyfikujesz rysunek, powinieneś zweryfikować te spostrzeżenia na kilku innych 

zdjęciach. W ten sposób możesz zmniejszyć ewentualne błędy tych porównań. 
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5.2 Szczegółowe rysunki poglądowe 

W poprzednich sekcjach używaliśmy już rysunku poglądowego wczesnego P-40 (por. str. 34, 59, 60). Czasami 

w instrukcjach obsługi samolotu można znaleźć bardziej szczegółową wersję takiego diagramu, z większą licz-

bą wymiarów. Niestety, w przypadku P-40 to rysunki późniejszych wersji: P-40E i następnych (Rysunek 5.2.1): 

 

 

Rysunek 5.2.1 Widok z boku P-40E1 (rysunek poglądowy) 

W porównaniu z P-40B/C, większa część kadłuba P-40E została zmieniona. Na ilustracji powyżej zaznaczyłem 

ten obszar na różowo. Ta wersja używała innego reduktora śmigła niż w P-40B/C, przez co osłona silnika jest 

krótsza, oś śmigła – wyżej, a jego kołpak jest większy niż we wczesnych P-40. W rezultacie, ten wariant jest 

minimalnie dłuższy (31’ 8 23/32”) niż P-40B/C (31’ 8 18/32”). Jednak dolna część kadłuba za przegrodą silnika po-

została bez zmian, podobnie jak położenie żeber kadłuba. Dlatego możemy użyć tego diagramu P-40E do okre-

ślenia położenia kluczowych zespołów, na przykład – usterzenia. Zwróć także uwagę, że wymiary położenia osi 

steru kierunku (20’ 1 1/2”) i steru wysokości (19’ 11 7/8”) są zgodne z rysunkiem Paula Matta (por. str. 77) . Użył w 

nim tej samej linii odniesienia, umieszczonej na 

krawędzi natarcia podstawy skrzydła. To dlatego 

przypuszczam, że korzystał z oryginalnych ry-

sunków Curtiss1. 

Wymiary z tego diagramu pozwalają nam okre-

ślić położenie skrzydła względem przegrody 

silnika (na str. 60 nie znaliśmy tej wartości). 

Rysunek 5.2.2 pokazuje wymiary X i Y noska 

podstawy skrzydła: w poziomie od przegrody 

silnika (9”) i pionowo od osi kadłuba (21 ½”). 

Podaje także położenie w pionie krawędzi spły-

wu tej sekcji skrzydła (23.39”). Długość cięciwy 

w tym miejscu można odczytać z widoku z góry 

(to 9’, czyli 108”).     

 
1 Jednak istnieją także rozbieżności pomiędzy wymiarami z rysunków Matta i tym diagramem: 1. Cięciwa jego steru kierunku jest 29 7/8”, 

podczas gdy było to 29 27/32” (
1/32 – to może być błąd zaokrągleń). 2: Odległość od końcówki steru kierunku do osi kadłuba (68 1/2" wobec 68 

1/8") – to może być spowodowane błędem odczytu mianownika tego ułamka („2” zamiast „8”). 

 

Rysunek 5.2.2 Określanie dokładnego położenia skrzydła 

 

31’ 8 23/32” 

 

Położenie 
przegrody 
silnika 

 

Zmodyfikowana 
część kadłuba  

20’ 1 1/2” 

 

19’ 11 7/8” 

 

9” 

 

Oś śmigła jest 3.078” 
powyżej konstrukcyjnej 
linii kadłuba 

 

Źródło: aircorpslibrary.com 

Przegroda 
silnika 

Profil podstawy 
skrzydła 

9’ 
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Oczywiście, niezwłocznie naniosłem te informacje na rysunku wzorcowy. Zrobiłem to na widoku z „odciętym” 

skrzydłem (Rysunek 5.2.3), ponieważ w takim wariancie jest bardziej użyteczny przy budowie modelu: 

 

Rysunek 5.2.3 Uaktualniony rysunek wzorcowy (to rzut z prawej z publikacji Kagero) 

Dla łatwiejszego dopasowania tych wymiarów, przesunąłem sylwetkę samolotu w Inkscape tak, że teraz pasuje 

do pionowej linii odniesienia przy krawędzi natarcia skrzydła. Użyłem tu profilu NACA 2215 (por. str. 257). Różni 

się on od oryginalnego konturu narysowanego w widoku z boku. W zasadzie osie usterzenia dobrze pasują do 

tego rysunku Kagero. Znalazłem też jedną różnicę - w krawędzi natarcia statecznika (Rysunek 5.2.3).  

Widok z góry tego rysunku poglądowego także dostarcza wielu szczegółowych wymiarów (Rysunek 5.2.4): 

 

Rysunek 5.2.4 Widok z góry P-40E1 (rysunek poglądowy) 

W praktyce wszystkie te wymiary dotyczą także P-40B/C, gdyż opisują one szczegóły usterzenia i skrzydła. Dla 

przykładu – mogę użyć wymiarów usterzenia z tej ilustracji do sprawdzenia położenia i rozmiaru usterzenia 

poziomego. Jak może pamiętasz, pomiędzy planami Kagero i AJ-Press była tu różnica (por. str. 82). 

Przesunąłem ten rysunek, aby 
pasował do pionowej linii ref. Oś steru 

kierunku  

Oś steru 
wysokości  

Dokładny kształt podstawy 
skrzydła (NACA 2215)  

Prawdziwa krawędź 
natarcia statecznika?  

Oś steru wysokości 
jest zwymiarowana 
w rzucie z boku 

20 9/32” 

42 3/4” 

Zwróć uwagę, że odchylony o 1.5º 
jest ten statecznik, ale nie ster! 

Szczegóły lotek I klap 

Źródło: aircorpslibrary.com 
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W końcu mogłem także „zakotwiczyć” krawędź natarcia podstawowego trapezu skrzydła w udokumentowanym 

punkcie: (0,0). Rysunek 5.2.5 przedstawia ten trapez w kolorze czerwonym, rysunek poglądowy jest na nim 

czarny, pomocnicze linie Inkscape są niebieskie, a porównywany rzut z góry Kagero jest zielony: 

 

Rysunek 5.2.5 Porównanie skrzydeł i usterzenia poziomego 

Jak widać powyżej, kontury skrzydeł i usterzenia z rysunku poglądowego dobrze pasują do zadeklarowanych 

wymiarów (niebieskie linie pomocnicze). Skrzydło nawet pasuje do podstawowego trapezu, który tu umieściłem. 

To samo dotyczy usterzenia. Na rysunku Kagero (zielone linie) ster wysokości pasuje do wymiarów, ale statecz-

nik poziomy z planów Kagero jest zbyt mały. Dodatkowo, skrzydło na tych planach jest przesunięte do przodu. 

Widok z przodu na rysunku poglądowym tylko potwierdza wymiary, które omawia Rozdział 3 (Rysunek 5.2.6): 

 

Rysunek 5.2.6 Widok z przodu P-40E1 (rysunek poglądowy) 

Skrzydła z rysunku 
poglądowego pasują do 
podstawowego trapezu 
skrzydła (czerwony) 

Kontur zielonego steru 
kierunku pasuje do 
podanego wymiaru 
cięciwy – i do rysunku 
poglądowego   

Cięciwa zielonego 
statecznika jest 
zbyt krótka (~ 2”) 
 

Zielone skrzydło 
jest przesunięte 
(o około 1”) 

Źródło: aircorpslibrary.com 

225” 

Ten rozstaw kół (8’ 2 1/8”) jest 
minimalnie szerszy niż na rysunku 
P-40-cu (8’ 1 7/8” – por. str. 60) 
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Zwróć uwagę na nieznaczną różnicę w rozstawie kół (2/8”), pomiędzy rysunkiem poglądowym P-40-cu (str. 60) a 

wymiarem pokazywanym przez Rysunek 5.2.6. Może w P-40E zastosowano szersze opony? Co ciekawe, ten 

wymiar w podobnym rysunku poglądowym P-40N-1 jest jeszcze szerszy: 8’ 2.5” (różnica: 6/8”), choć w tym wa-

riancie użyto mniejszych kół, o średnicy 27” (wobec 30” z wcześniejszych wersji P-40) . 

Jako dodatek do rysunku poglądowego, niektórzy producenci dostarczali także tzw. diagram pozycji (wręg) 

(ang. stations diagram). Niestety, Curtiss nie należy do tej grupy, dlatego na ilustracji poniżej użyłem rysunku 

Douglasa z „Erection And Maintenance Manual” bombowca nurkującego SBD Dauntless (Rysunek 5.2.7): 

  

Rysunek 5.2.7 Przykład diagramu pozycji (wręg) bombowca SBD Dauntless 

Każda z tych pozycji to pojedyncza wręga kadłuba lub żebro skrzydła/usterzenia. Ich symbole odpowiadają 

odległościom od płaszczyzny odniesienia. W przypadku skrzydeł i usterzenia poziomego to płaszczyzna syme-

trii samolotu, w przypadku kadłuba – przegroda silnika. W przypadku skrzydła te odległości są mierzone wzdłuż 

płaszczyzny odniesienia, która może być łamana. Na przykład: w tym SBD centropłat był bez wzniosu, podczas 

gdy wznios zewnętrznych części skrzydeł wynosił około 7.5º. Stąd pozycje żeber na przedstawionym powyżej 

diagramie są mierzone wzdłuż linii łamanej, biegnącej poprzez centropłat i końcówkę skrzydła (Rysunek 5.2.7). 

Bazą dla wymiarów 
pozycji wręg jest 
przegroda silnika 

Wręgi kadłuba są zazwyczaj 
identyfikowane po numerze 
(frame numer) 

Bazą dla pozycji żeber 
skrzydła jest płaszczyzna 
symetrii samolotu 

Pozycje żeber steru 
kierunku są mierzone 
od osi kadłuba 

Podział tego 
skrzydła na 
żebrze 66 

Pozycje żeber 
skrzydła są 
mierzone wzdłuż 
linii łamanej  

Pozycje żeber usterzenia są 
mierzone od płaszczyzny 
symetrii samolotu 
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Na zakończenie tej sekcji o rysunkach poglądowych chciałbym podkreślić, że należy polegać tylko na wymia-

rach z oryginalnych rysunków producenta. W sekcji 4.2 analizowaliśmy plany P-36 opracowane przez Paula 

Matta (str. 76, 77, 80). Jak przypuszczalnie zauważyłeś, jest tam mnóstwo wymiarów. Większość z nich jest 

dokładna, ale są też różnice (por. stopka na str. 93). Jako inny przypadek, chciałbym krótko omówić rysunki P-

40D nakreślone w 1943r. przez słynnego autora planów: Williama Wylama. Tak jak praca Paula Matta, składają 

się z dwóch arkuszy. Na pierwszym możesz znaleźć klasyczne trzy rzuty tego samolotu. Na drugim autor umie-

ścił szczegóły kształtu P-40D, wypełnione mnóstwem wymiarów (Rysunek 5.2.8):  

  

Rysunek 5.2.8 Rysunek P-40D autorstwa Williama Wylama (1943)  

Na pierwszy rzut oka wygląda to na „marzenie modelarza”: wszystkie dokładne wymiary na jednej stronie! 

 

Wykorzystuj diagramy pozycji do weryfikacji położenia każdego połączenia paneli i linii nitów związa-

nych z wręgą kadłuba lub żebrem skrzydła i usterzenia. To także duża pomoc w określaniu dokładnego 

położenia kabiny pilota i innych elementów Twojego samolotu. 

  

https://www.modelaircraft.org/sites/default/files/files/WylamWilliamBillAustin.pdf
http://airplanes3d.net/downloads/wm4/blueprints/Wylam-P40D-1.jpg
http://airplanes3d.net/downloads/wm4/blueprints/Wylam-P40D-2.jpg
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Jednak porównajmy rzuty z boku z arkusza W. Wylama z rysunkiem poglądowym P-40E Curtissa. Powinny być 

identyczne1. Rezultat pokazuje Rysunek 5.2.9: 

 

 

Rysunek 5.2.9 Błędy w rzucie z boku W. Wylama  

Suma wszystkich cząstkowych odległości, podanych na rysunku Wylama (w ciągu wymiarowym od nosa do 

ogona, powyżej kadłuba), to ogólna długość 31’ 7” – podczas gdy powinno to być to 31’ 8 23/32”. Innym poważ-

nym błędem w pracy W. Wylama jest położenie osi śmigła na osi kadłuba, podczas gdy powinna się znaleźć 

3.078” powyżej. Szczerze mówiąc, to złe położenie osi dyskwalifikuje wszystkie pozostałe wymiary z tego rzutu: 

nie mogą być poprawne, skoro bazują na błędnych liniach odniesienia. Rozmiary usterzenia na rysunku Wyla-

ma także nie zgadzają się z wymiarami z rysunku Curtissa (różnice wahają się od 1” do 2”). 

Jednak pierwszą niezgodnością, którą zauważyłem w rysunku Wylama, były dziwne, „spłaszczone” spody prze-

krojów kadłuba (Rysunek 5.2.10a). Nie pasowały do eliptycznych kształtów ze zdjęć (Rysunek 5.2.10b): 

         

Rysunek 5.2.10 Błędne przekroje kadłuba na rysunku Wylama  

 
1 Pomiędzy P-40D i P-40E nie było specjalnych różnic zewnętrznych, oprócz dwóch dodatkowych km w skrzydłach P-40E (razem sześć, 

zamiast czterech z P-40D). Dziwnym trafem, na tym diagramie P-40E1 widać tylko po dwa km w każdym skrzydle (por. Rysunek 5.2.6). 

31’ 8 23/32” 

31’ 7” 

Oś śmigła znajdowała się 
powyżej osi kadłuba 

Spłaszczone dolne części  a) J-J K-K 

Eliptyczne 
kontury 
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Wniosek: nie można polegać na tym rysunku P-40D autorstwa W. Wylama. Pomimo deklaracji (por. Rysunek 

5.2.8) zawiera zbyt wiele błędów. Podobne odchylenia mogą wystąpić w planach innych autorów1.  

Podsumowanie 

• Szczegółowe rysunki poglądowe można znaleźć w oryginalnych instrukcjach technicznych samolotu, na 

przykład „Erection And Maintenance Instructions”. 

• Wymiary z takich diagramów pozwalają na określenie dokładnej pozycji skrzydła względem kadłuba (str. 

93, 94), a także innych szczegółów, jak osie sterów (str. 93). 

• Rysunek poglądowy P-40, analizowany w tej sekcji, zawiera także kilka wymiarów usterzenia, na przykład 

– długości cięciw. Wykorzystałem je do weryfikacji kształtu usterzenia poziomego z rysunków Kagero (str. 

95). 

• Czasami możesz napotkać różnice pomiędzy dwoma oryginalnymi rysunkami poglądowymi. (Na przykład – 

kwestia rozstawu kół podwozia, opisana na str. 95). 

• Jeżeli znajdziesz diagram pozycji wręg swojego samolotu, użyj go do sprawdzenia położenia wręg kadłuba 

i żeber skrzydła oraz usterzenia (str. 96). 

• Nie ufaj wymiarom samolotu podanym w źródłach wtórnych, na przykład – ze starych planów modelar-

skich. Niektóre z nich mogą być błędne (str. 98).  

 

 
1 W tamtych czasach użycie oryginalnej dokumentacji samolotu było dość trudne. Rozdział 9 pokazuje, jak wyglądały oryginalne rysunki 

Curtiss. Pracując z takimi arkuszami, liczne wymiary szczegółowe trzeba sprawdzać wielokrotnie. Być może w 1969r. Paul Matt miał taką 

możliwość, korzystając z dokumentacji utrwalonej na mikrofilmie. Przypuszczam, że w 1943r. William Wylam uzyskał jednorazowy dostęp 

do oryginalnych arkuszy, które przejrzał i wykorzystał do wykonania szkiców i notatek. Dlatego jego rysunki P-40D zawierają więcej błędów 

niż plany P-36 wykonane przez Paula Matta.    



100 Przygotowanie rysunków referencyjnych 

 

 

Wirtualne modelarstwo – Tom I: Przygotowania 

www.samoloty3d.pl 

5.3 Oryginalne rysunki złożeniowe 

Czasami można znaleźć w Internecie pojedyncze arkusze z oryginalnej dokumentacji samolotu. Zazwyczaj są 

to różne rysunki złożeniowe, zeskanowane z dość niską rozdzielczością. W przypadku P-40 takie materiały 

możesz znaleźć na portalu p40warhawk.com1. Tak jak w większość rysunków poglądowych, ta dokumentacja 

dotyczy późniejszych (tak zwanych „krótkonosych”) wersji tego myśliwca. Rysunek 5.3.1 pokazuje przykład 

takiego rysunku (to struktura skrzydła P-40F): 

 

Rysunek 5.3.1 Oryginalny rysunek Curtiss struktury skrzydła P-40F 

Jednak ogólna geometria skrzydła pozostała niezmienna we wszystkich wersjach P-40.Na ilustracji powyżej 

zaznaczyłem na różowo modyfikacje wprowadzone w P-40D (były związane z nowymi karabinami). Co ważne, 

szczegółowe wymiary na tym skanie są nadal czytelne! Używając ich, można odtworzyć dokładny kształt koń-

cówki skrzydła w widoku z góry. Ten rysunek ujawnia, że było to złożenie trzech łuków. Rzut z przodu pokazuje 

także, że płaszczyzna referencyjna skrzydła to płaszczyzna cięciw kolejnych żeber (Rysunek 5.3.2): 

 

Rysunek 5.3.2 Szczegóły skrzydła (widok z przodu) 

 
1 Domyślne warianty obrazów, podstawione na tym portalu pod nazwy części, są plikami *.gif o niskiej rozdzielczości. Aby uzyskać bardziej 

szczegółową wersję, użyj linków „TIFF”, umieszczonych z prawej strony każdej z tych pozycji. 

Zmiany w strukturze, 
wprowadzone w P-40D 

Te wymiary można 
odczytać! 

Kształt tej końcówki 
jest złożeniem 
trzech łuków 

Położenia 
żeber Kształt końcówki 

(por. str. 80) 

Linia referencyjna (płaszczyzna 
cięciw profili żeber skrzydła) 

Osadzenie goleni 
podwozia (pochylone 
pod kątem wzniosu)   

http://www.p40warhawk.com/Models/Technical/Technical.htm
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Sądzę, że mogę użyć ten skan jako rysunek wzorcowy skrzyła, zamiast obrazu przygotowanego na str. 68. Jak 

pokazuje to Rysunek 5.3.3, ten obrys pasuje do podstawowego trapezu z rysunku poglądowego: 

 

Rysunek 5.3.3 Widok w płaszczyźnie skrzydła (czarne linie) ponad widokiem z góry AJ Press (niebieskie linie) 

Pamiętaj, że kształt nakreślony na oryginalnych rysunkach jest tylko ilustracją dla ich wymiarów. Na przykład, 

Rysunek 5.3.4 pokazuje końcówkę skrzydła odtworzoną z trzech zwymiarowanych łuków2: 

 

Rysunek 5.3.4 Szczegóły końcówki skrzydła 

Promień zielonego łuku (AB) jest 415/32”, brązowego łuku (BC) jest 12”, a fioletowego (CD) – 26 ½”. Jak widać, 

kontur końcówki nakreślony na tym rysunku różni się nieco od kształtu narysowanego zgodnie z podanymi wy-

miarami. To samo dotyczy położenia linii odniesienia i środków łuków, widocznych na arkuszu Curtiss. Jednak w 

 
1 Na przykład – zobacz ten oraz ten post z mojego bloga. Opisują pomyłki w modelu SBD spowodowane błędnymi liniami odniesienia. 

2 Szczegóły dotyczące rysowania łuków w Inkscape znajdziesz na str. 185. 

 

Poprawna identyfikacja linii i płaszczyzn referencyjnych pomaga w odtworzeniu geometrii samolotu. 

Gdy założysz ich położenia w złych miejscach, nawet z dobrymi wymiarami uzyskasz błędny kształt1.    

  

Niebieski: 
rysunek 
AJ Press 

Płaszczyzna zapory 
silnika jest w skrzydle 
P-40 linią referencyjną 

Oryginalny rysunek pasuje do 
trapezu skrzydła (dopasowa-
nego do płaszczyzny cięciw) 

225” 

1
0

8

”
 

Wyrównałem ten rysunek do osi samolotu, 
a następnie rozciągnąłem go, dopasowu-
jąc do rozpiętości i cięciwy u podstawy. 

B 

C 

D 

AB 

CD 

BC 

Niewielkie odchylenie od konturu 

10 ½” 

Różnice w położeniu 

środków łuków 

Cięciwa w punkcie 
zamocowania  

54” 

Zamocowanie (podczas montażu): 
197” od podstawy skrzydła 

A 

https://airplanes3d.wordpress.com/2020/05/16/original-sbd-dauntless-blueprints-wing-geometry/
https://airplanes3d.wordpress.com/2020/06/02/comparing-my-sbd-model-with-original-blueprints/
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przypadku łuku CD wątpię, czy jego środek został w ogóle zaznaczony. Na końcu jego wymiaru promienia nie 

mogę dostrzec żadnego małego krzyżyka. Przypuszczam, że jest to zamierzone: dla podanego promienia mo-

żesz znaleźć ten środek dopasowując łuk CD pomiędzy łuk BC i krawędź natarcia skrzydła w punkcie D (por. 

Rysunek 5.3.4). Na rysunkach technicznych zawsze unika się przewymiarowania! 

Oczywiście, na rysunkach złożeniowych znajdziesz mnóstwo niezwymiarowanych kształtów. (Głównym celem 

takich arkuszy jest pokazanie, jak należy połączyć ze sobą poszczególne elementy. Dlatego dla warsztatu naj-

ważniejszą informacją na tych rysunkach są odsyłacze do numerów części). Przyjrzyjmy się dokładniej jednemu 

z takich arkuszy. Będzie to rysunek złożeniowy steru wysokości, pobrany z p40warhawk.com. 

Najpierw trzeba dopasować taki skan do rysunku wzorcowego. Oznacza to, że musisz określić jego dokładne 

położenie i skalę. W przypadku rysunku skrzydła pominąłem ten temat, ale ten ster jest dobrą okazją do wyja-

śnienia, jak znajduję te wartości (Rysunek 5.3.5): 

 

Rysunek 5.3.5 Dopasowanie obrazu steru wysokości do naszego rysunku wzorcowego (widoku z góry) 

Kluczowymi liniami odniesienia na tym rysunku są: oś steru i oś kadłuba. (Na ilustracji powyżej zaznaczyłem je 

na czerwono). Środek tego rysunku umieściłem w na przecięciu tych dwóch linii. 

Na początek wyrównałem ten obraz do tych dwóch osi (był odrobinę obrócony). Dzięki szczegółowemu rysun-

kowi poglądowemu (por. str. 93), mogłem precyzyjnie umieścić oś steru w odległości 230.875” od przegrody 

silnika. Ta informacja pozwoliła mi ustalić dokładne położenie tego obrazu na ogólnym rzucie z góry. 

Aby dobrać właściwą skalę, użyłem najdłuższych poziomych i pionowych wymiarów jakie znalazłem na tym 

arkuszu. Rysunek 5.3.5 pokazuje je jako czerwone, półprzejrzyste strzałki. Najpierw umieściłem linie pomocni-

cze (oznaczone na ilustracji powyżej kolorem niebieskim) w odpowiednie położeniach. Następnie proporcjonal-

nie powiększyłem ten obraz, dopasowując płaszczyzny zawiasów (oznaczone na tym skanie przez dwie linie 

odniesienia ich poziomych wymiarów) do odpowiednich linii pomocniczych. W ostatnim kroku sprawdziłem linie 

odniesienia trzech wybranych wymiarów pionowych. Okazało się, że ten skan był lekko zdeformowany, gdyż 

wystąpiły niewielkie różnice pomiędzy liniami pomocniczymi i odpowiadającymi im liniami odniesienia tych wy-

miarów. Skorygowałem to rozciągając nieco obraz steru wysokości wzdłuż osi pionowej. 

 

Wymiary są najważniejszym elementem dokumentacji technicznej. Kopiuj kształty narysowane na ta-

kich arkuszach tylko wtedy, gdy nie są zwymiarowane. Z powodu różnych zniekształceń ich obrys mo-

że się różnić od prawdziwych konturów, szczególnie w przypadku skanów mikrofilmów.     

  

Oś kadłuba  

Oś steru 
wysokości  

641/8” 341/4” 

Powiększyłem ten obraz, dopa-
sowując go do tych zwymiaro-
wanych płaszczyzn zawiasów 

Musiałem trochę “naciągnąć” obraz w 
pionie, by dopasować do tych wymiarów 

230 7/8” od 
przegrody 
silnika 

Środek (wszystkich 
transformacji) 

http://www.p40warhawk.com/Models/Technical/Technical.htm
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Po tym skalowaniu porównałem uzyskaną cięciwę steru z wymiarem z rysunku poglądowego (20 9/32” – por. str. 

94). Jak pokazuje to Rysunek 5.3.6, doskonale do siebie pasują: 

 

 

 

Rysunek 5.3.6 Kształt usterzenia poziomego (niebieski rysunek pod spodem: plany AJ Press) 

Na ilustracji powyżej zaznaczyłem niezwymiarowany segment konturu czerwoną, przerywaną linią. W tym przy-

padku musimy polegać na narysowanym kształcie. Nawet jeżeli zawiera błędy, będą one mniejsze od dużych 

różnic, które można dostrzec pomiędzy tym konturem steru kierunku a umieszczonym poniżej fragmentem pla-

nów Matta/Jackiewicza (z AJ Press, zaznaczone na niebiesko). Na szczęście, ten arkusz dokumentacji zawiera 

dwa wymiary, które pozwoliły mi z większą precyzją określić kształt usterzenia poziomego. Są to: promień (18 

½”) i środek (4 29/64” od osi steru) łuku końcówki (Rysunek 5.3.6). Zakładając, że końcówka statecznika jest 

kontynuacją kształtu steru (tak to wygląda na zdjęciach), i wykorzystując długość cięciwy podstawy z rysunku 

poglądowego (42 ¾”), narysowałem przypuszczalny kontur usterzenia poziomego (linie fioletowe). Jak widać, 

jego krawędź natarcia dobrze pasuje do rysunku Matta/Jackiewicza. Jednak kształt końcówki i krawędzi spływu 

są na tych planach z AJ Press dalekie od prawdziwego konturu. Równie duże różnice (choć w innych miej-

scach) w kształcie usterzenia poziomego możesz znaleźć pomiędzy tym oryginalnym rysunkiem a planami M. 

Łukasika (Kagero). Żadna z tych dwóch publikacji nie pokazuje poprawnie tej części. 

 

Jeżeli to możliwe, używaj do dopasowania takiego obrazu dwóch-trzech wymiarów w każdym z kierun-

ków. W przypadku steru wysokości użyłem dwóch wymiarów poziomych i trzech pionowych. Takie 

nadmiarowe dane pozwalają zminimalizować ewentualne błędy kreślarzy. 
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Rysunek steru kierunku zawiera jeszcze jedną ukrytą wskazówkę: informację o grubości usterzenia poziomego. 

Jak wspomniałem na str. 73-74, plany P-40 nie dostarczają wiarygodnej informacji o grubości stabilizatorów. 

Jednak wykorzystując dwa rysunki z p40warhawk.com można przynajmniej określić przybliżoną grubość uste-

rzenia poziomego. Użyłem kształt jego podstawy, widoczny na obrazie oprofilowania usterzenia (por. str. 258), 

aby oszacować grubość steru kierunku i statecznika poziomego przy kadłubie. Porównanie tych wartości z wi-

dokiem z góry steru kierunku prowadzi do wniosku, że krawędź natarcia tego elementu miała okrągły przekrój 

(Rysunek 5.3.7):   

 

Rysunek 5.3.7 Odtwarzanie przybliżonego widoku z przodu steru wysokości (na podstawie widoku z góry) 

Skoro tak, to krawędź natarcia steru wysokości jest stożkiem ściętym (Rysunek 5.3.7). W takim przypadku mo-

żesz odtworzyć jej widok z przodu z dwóch kopii obrysu z góry, jak zrobiłem to na ilustracji powyżej. Użyję tego 

konturu podczas modelowania steru, a także (po przeskalowaniu wzdłuż osi pionowej) statecznika poziomego. 

Oczywiście, to nadal tylko przybliżenie, oparte na kilku założeniach i niezwymiarowanym kształcie z rysunku 

złożeniowego. Jednak oceniam je jako lepsze od niepewnych konturów z planów. 

Na p40warhawk.com można także znaleźć rysunki złożeniowe usterzenia pionowego. Dopasowałem je do 

wzorcowego rzutu z boku używając tej samej metody jak dla steru wysokości (por. Rysunek 5.3.5). W tym przy-

padku także przydało się położenie osi steru z rysunku poglądowego (Rysunek 5.3.8 oznacza je na czerwono): 

                

Rysunek 5.3.8 Dopasowanie steru kierunku i statecznika pionowego do rysunku wzorcowego 

Kontury oprofilowania usterzenia i 
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Dopasowałem 
ten statecznik 
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Najpierw dopasowałem skan steru kierunku (Rysunek 5.3.8a). Był nieco zdeformowany i wymagał drobnego 

obrotu i przekoszenia. Dla tego elementu rysunek poglądowy podaje dokładną „ramkę”, utworzoną przez poło-

żenie osi (232 ½”), długość cięciwy (29 27/32”), i wysokość (60 1/8” od osi kadłuba do czubka steru kierunku – por. 

Rysunek 5.2.1 ze str. 93). Po dopasowaniu steru do tych linii, wykorzystałem zwymiarowane na nim położenie 

zawiasów do umieszczenia dwóch linii pomocniczych. Rysunek 5.3.8 oznacza je na niebiesko. Następnie 

sprawdziłem, czy pasują do linii zawiasów z tego rysunku: pasowały. 

Następnie załadowałem skan statecznika pionowego. Na nieszczęście, większość jego wymiarów jest nieczy-

telna. Jednak widać na nim osie zawiasów steru i cięciwę statecznika poziomego. W rezultacie poprzedniego 

kroku, linie pomocnicze odpowiadające osiom zawiasów były na swoich miejscach. Z rysunku złożeniowego 

odczytałem położenie w pionie osi steru wysokości (18 1/8”), i poprowadziłem linię pomocniczą odpowiadającą 

cięciwie statecznika poziomego (Rysunek 5.3.8b). Potem dopasowałem statecznik pionowy do tych linii. 

Gdy ten statecznik był już na miejscu, mogłem wykorzystać jego kształt i linię cięciwy statecznika poziomego do 

dopasowania do rysunku wzorcowego rzut z boku oprofilowania usterzenia. To oprofilowanie wyciąłem z arku-

sza pokazanego na str. 258. Jego wymiary są nieczytelne, więc takie dopasowanie było jedyną możliwą metodą 

użycia. Rysunek 5.3.9 porównuje uzyskany obraz z rzutem z boku AJ Press (linie niebieskie): 

 

Rysunek 5.3.9 Porównanie oryginalnych rysunków usterzenia pionowego z rzutem z boku AJ Press (linie niebieskie) 

W ilustracji powyżej możesz dostrzec wiele różnic pomiędzy czarnymi liniami oryginalnych rysunków i niebie-

skimi konturami z planów AJ Press. Największa z nich występuje na krawędzi natarcia statecznika. Mniejsze 

różnice mogły być spowodowane błędem kreślarza1. Jednak to złożenie nie jest specjalne czytelne z powodu 

nakładających się detali z oryginalnych arkuszy. Skutecznie zasłaniają wiele niebieskich linii z planów.  

 
1 Tutaj porównujemy kształty, a nie jawne wymiary. Rysunek 5.3.4 pokazuje możliwe odchylenia konturów na oryginalnych arkuszach. 
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Z tego powodu zdecydowałem się przerysować kluczowe szczegóły z tych rysunków. Naniosłem je w na od-

dzielną warstwę Inkscape. O wiele łatwiej było pracować po kolei z pojedynczymi arkuszami: zacząłem od opro-

filowania usterzenia, potem odrysowałem zewnętrzne szczegóły statecznika (Rysunek 5.3.10): 

 

       

Rysunek 5.3.10 Przerysowanie konturów statecznika 

Szczegóły rysowania krzywych w Inkscape wyjaśniam na str. 180. Przerysowuję te szczegóły tylko aby porów-

nać kluczowe kontury i linie podziału paneli. Dlatego pominąłem tu szeregi nitów biegnące wzdłuż ich krawędzi. 

Zaznaczyłem sobie tylko te, które znajdują się w środku paneli poszycia – por. Rysunek 5.3.10a). Oczywiście, 

wykorzystałem tu wszystkie wymiary które mogłem odczytać z tego czarno-białego skanu. W ten sposób ziden-

tyfikowałem promień i środek łuku końcówki statecznika (Rysunek 5.3.10b). Kolejnym wymiar pozwolił mi do-

kładnie wyznaczyć jego tylną krawędź (na oryginalnym rysunku jest odrobinę bliżej osi steru niż 9 ¼” podane na 

wymiarze). Po przerysowaniu statecznika przełączyłem się na ster kierunku. Nie znalazłem wymiarów jego kra-

wędzi spływu, więc musiałem skopiowałem jej kształt z rysunku.  

Rysunek 5.3.11 pokazuje bardziej czytelne porównanie prawdziwego kształtu usterzenia (linie czerwone) i ry-

sunku AJ Press (linie niebieskie): 

 

 Rysunek 5.3.11 Porównanie konturów z oryginalnej dokumentacji (czerwone) i planów AJ Press (niebieskie) 
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Jak wyjaśniałem wcześniej (por. str. 77), niebieski kontur pochodzi z rysunku P-36, nakreślonego przez Paula 

Matta w 1969r, który został później użyty przez Jacka Jackiewicza (AJ Press) i (pośrednio) przez Mariusza Łu-

kasika (Kagero). W zasadzie, różnice które pokazuje Rysunek 5.3.11 są niewielkie. Największa z nich – w poło-

żeniu krawędzi natarcia statecznika – nie przekracza 2”. Oznacza to, że w docelowej skali tych planów (1:48) te 

odchylenia były mniejsze od 1mm. Taka tolerancja może być zadowalająca dla plastikowych zestawów do skle-

jania. Jednak model komputerowy pozwala na o wiele większą dokładność, dlatego muszę poprawiać te rysunki 

wzorcowe. 

Rysunek 5.3.11 pokazuje także moją próbę określenia położenia tylnej krawędzi kadłuba na podstawie zakoń-

czenia oprofilowania usterzenia. W porównaniu z rysunkami AJ Press jest ona przesunięta o około 1” do przo-

du. Niestety, na p40warhawk.com nie można znaleźć żadnego oryginalnego rysunku kadłuba, więc nie mogę 

potwierdzić tej hipotezy żadnym jawnym wymiarem. 

W tej sekcji wykorzystaliśmy tylko kilka arkuszy. Oryginalna dokumentacja jednosilnikowego samolotu z okresu 

II Wojny Światowej składa się zazwyczaj z kilku tysięcy rysunków. Co prawda, większość z nich nie jest przy-

datna do naszych celów, bo zawiera różne trywialne detale jak śruby, nakrętki i różne kątowniki. Obecnie można 

kupić dostęp do skanów mikrofilmów dokumentacji kilkunastu popularnych samolotów z tych czasów. Więk-

szość z nich to myśliwce produkcji USA. Efektywne korzystanie z tak wielkiego zbioru rysunków wymaga orga-

nizacji plików podobnej do tej, jaką używam w przypadku fotografii. Więcej na ten temat możesz przeczytać na 

str. 199. 

Podsumowanie 

• Każdy oryginalny rysunek samolotu, który znajdziesz w Internecie, może być ważnym źródłem informacji. 

Gdy znasz na pamięć różnice pomiędzy poszczególnymi wersjami modelowanej konstrukcji, możesz łatwo 

określić, czy znaleziony arkusz jest użyteczny. Dzięki tej wiedzy byłem w stanie użyć w moim P-40B rysu-

nek skrzydła P-40F (str. 100). 

• Skany oryginalnej dokumentacji wymagają podobnej weryfikacji i poprawek jak plany modelarskie, które 

omawia Rozdział 3. Wyprostowanie i dopasowanie do znanej rozpiętości i cięciwy rysunku skrzydła ze str. 

101 wymagało niewielkiego obrotu i przekoszenia. Zawsze używaj najdłuższych wymiarów poziomych i 

pionowych, jakie znajdziesz na oryginalnym rysunku, do określenia jego dokładnego położenia i skali, a 

także skorygowania ewentualnych deformacji (str. 102, 104). 

• Narysowane na rysunku technicznym kształty obiektów są tylko w charakterze ilustracji. Dla warsztatu naj-

ważniejszymi informacjami są wymiary i numery części. Dlatego kontury samolotu z rysunków złożenio-

wych mogą odbiegać od prawdziwego kształtu. Jeżeli to możliwe, sprawdzaj te linie używając wszelkich 

wymiarów, jakie możesz tylko znaleźć (str. 101, 103). 

• Czasami niektóre brakujące szczegóły konstrukcji można wydedukować na podstawie dwóch (lub więcej) 

rysunków. Rób tak, gdy nie posiadasz jakiegokolwiek bezpośredniego źródła tych informacji (por. rzuty z 

boku i z przodu na str. 104, wyprowadzone z rzutu z góry i z profilu usterzenia). 

• Liczne szczegóły, które występują w oryginalnych rysunkach złożeniowych, mogą utrudnić korzystanie z 

rysunku wzorcowego (str. 105). W takim przypadku, odrysuj ich kluczowe linie na dodatkowej warstwie In-

kscape (str. 106). 

   

 

http://www.p40warhawk.com/Models/Technical/Technical.htm
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Rozdział 6. Sugestie końcowe 

Tym rozdziałem kończymy pierwszą część tego przewodnika, poświęconą rysunkom referencyjnym. Rozdział 3 

pokazał, jak przygotować takie obrazy z planów modelarskich. Mogłeś także poznać typowe błędy, które wystę-

pują w takich rysunkach. Rozwinięcie tych zagadnień zawiera Rozdział 4. Rozdział 5 wyliczył ewentualne meto-

dy radzenia sobie z takimi problemami, zaczynając od najbardziej popularnego źródła (zdjęć), a kończąc na 

najrzadszych (oryginalnych rysunkach samolotu). W tym krótkim rozdziale wskażę najlepsze plany P-36/P-40 i 

podam kilka końcowych sugestii, dotyczących dalszej pracy nad naszym cyfrowym modelem tego samolotu.   
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6.1 Najlepsze rysunki Curtiss P-40 

Ostatecznie, na rysunki referencyjne P-40 rekomenduję plany, które opublikował Jumpei Temma na swoim por-

talu. Rysunek 6.1.1 przedstawia jeden z tych obrazów (dokładniej: rzut z boku, w wersji 2.6): 

 

Rysunek 6.1.1 Rzut z boku P-40B z portalu Jumpei Temma 

Autor wykreślił te rysunki na podstawie oryginalnej dokumentacji Curtiss, opublikowanej przez AirCorps Libra-

ry1. Ten portal udostępnia rysunki P-36 i późniejszych wersji P-40 (P-40D i następne). Niestety, nie znalazł tam 

niemal żadnych materiałów związanych z osłoną silnika wczesnych wersji P-40 (P-40-cu/B/C). Dlatego ta część 

planów Jumpei Temmy jest oparta na analizie zdjęć. Wydaje się, że Autor porównywał swoje rysunki ze współ-

czesnymi zdjęciami odrestaurowanych maszyn tak, jak to opisałem to w sekcji 5.1, na str. 91.  

Wykorzystaj te plany do stworzenia zestawu rysunków referencyjnych, których potem użyjemy do budowy na-

szego modelu. Wytnij widok z boku i powiększ go do skali 1:1, tak jak to opisuje Rozdział 3. Powiększ propor-

cjonalnie ten obraz, wykorzystując podane na nim: położenie przegrody silnika (X=0) i oś steru (X=232.5”). W 

moim rysunku Inkscape umieściłem w tych miejscach dwie linie pomocnicze, do których potem dopasowałem 

osie zaznaczone na tej sylwetce (Rysunek 6.1.2):   

 

Rysunek 6.1.2 Powiększanie rzutu z lewej do skali 1:1 

 
1 Więcej informacji na ten temat dostarcza Rozdział 9 (str. 213)  
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Wyraźnie 
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Proporcjonalnie powiększaj ten rysunek, aż 
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Linia pomocnicza 
wzdłuż osi steru 

Linia pomocnicza 
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transformacji  232 1/2” 

0 

http://soyuyo.main.jp/p40b/p40be-1.html
http://soyuyo.main.jp/p40b/p40be-1.html
https://aircorpslibrary.com/
https://aircorpslibrary.com/
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Czemu nie dopasowałem tego rysunku do linii wyznaczających całkowitą długość samolotu? Ponieważ jego 

kołpak śmigła jest zbyt długi! Podczas gdy wszystkie inne sekcje kadłuba pasują dokładnie do oryginalnych 

wymiarów, czubek kołpaka przekracza długość P-40B (380.56”) o około 1”  (Rysunek 6.1.3): 

 

 

 

Rysunek 6.1.3 Sprawdzanie kluczowych wymiarów kadłuba na rzucie z boku Jumpei Temmy (wersji 2.7)  

Na ilustracji powyżej są trzy nowe linie pomocnicze: 1 na czubku kołpaka (118 7/32” od przegrody silnika), 2, u 

podstawy kołpaka (92 5/16” od przegrody) oraz 3, na krawędzi spływu steru kierunku (262 11/32” od przegrody). 

Wymiary 1 i 3 pochodzą z rysunków poglądowych, a wymiar 2 pochodzi z rysunku szczegółów kołpaka o nume-

rze 75-42-808. Jak widać, wpasowanie tej sylwetki pomiędzy linie 1 i 3 zepsułoby wszystkie pozostałe wymiary. 

Rysunek 6.1.4 przedstawia rzut z góry wycięty z tych samych planów, po obrocie i dostosowaniu do skali 1:1. 

Jak widać, kontury i położenie skrzydła oraz usterzenia doskonale pasują do danych źródłowych, które wyko-

rzystywałem do sprawdzania rysunków innych autorów:  

 

Rysunek 6.1.4 Sprawdzanie rzutu z góry P-40B Jumpei Temmy (dotyczy rysunków z wersji: 2.5) 
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Jak to pokazuje Rysunek 6.1.4, poza kołpakiem śmigła cała sylwetka doskonale pasuje do wymiarów ogólnych i 

oryginalnych rysunków. Przypuszczam, że Autor skopiował ten kołpak ze zdjęć odrestaurowanych P-40 (z 

Duxford?). Jak wspomniałem wcześniej (por. str. 88), detale w takich samolotach mogą się różnić od orygina-

łów. To w szczególności dotyczy tych „długonosych” P-40, gdyż ich dokumentacja zaginęła (por. str. 219). Z 

przyczyn technologicznych, kołpak w odrestaurowanym samolocie mógł być nieco dłuższy. Szacuję także, że 

minimalna tolerancja prostego porównywania rysunku ze zdjęciem to więcej niż 1% odwzorowywanych wymia-

rów. Przeszkodą są tu różne drobne zniekształcenia, występujące na fotografiach.     

Różnica w długości kołpaka jest tylko jednym z wielu drobnych odchyleń występujących, w związku z brakiem 

dokumentacji, w odwzorowaniu kształtu okapotowania silnika w odrestaurowanych P-40B/C. W 2019 natknąłem 

się w zasobach AirCorps Library na obiecujący rysunek (L-10202), który przypominał tę osłonę. Po szczegóło-

wej analizie (por. sekcja 9.6) zdecydowałem, że przedstawia on ostatni wariant XP-40, który był niemal iden-

tyczny z seryjnymi P-40-cu/B/C. Połączyłem ten skan ze skanami rysunków kadłuba P-36, i użyłem archiwal-

nych zdjęć i innych szkiców Curtiss do złożenia najbardziej prawdopodobnej sylwetki tych P-40 (Rysunek 6.1.5): 

 

Rysunek 6.1.5 Widok z boku P-40, złożony z oryginalnej dokumentacji samolotu 

Ten rysunek znajdziesz w materiałach ze str. 18: source/reference/drawings/P-40B_side.png. Obrysowałem na 

nim mniej widoczne kontury. Robiąc to, użyłem linii czerwonych dla kształtów potwierdzonych przez dokładne 

wymiary, a linii niebieskich dla kształtów odtworzonych na podstawie zdjęć. Odcieniem pośrednim (fioletowym) 

oznaczyłem elementy narysowane w oparciu o wnioski wyciągnięte z dostępnych wymiarów i zdjęcia. 

Możesz używać tego złożenia jako alternatywnego rzutu z boku. Poniżej przedstawiam jego porównanie z syl-

wetką nakreśloną przez Jumpei Temmę (rysunek Temmy jest tu w kolorze zielonym) :  

 

Rysunek 6.1.6 Porównanie rzutu z boku wg rysunków Curtiss i planów Jumpei Temmy (linie zielone) 

 

W poprzednich rozdziałach nie użyłem rysunków Jumpei Temmy, ponieważ są „zbyt dobre”. Nie ma na 

nich deformacji ze skanowania, i niemal wszystkie linie pasują do swoich odpowiedników w innych 

rzutach. Pasują także – poza kilkoma wyjątkami, opisanymi w tej sekcji – do wymiarów z dokumentacji 

samolotu. Używając przykładu tak wysokiej jakości nie mógłbym opisać wszystkich typowych błędów, 

które możesz napotkać w popularnych planach modelarskich!  

  

Czerwone linie są narysowane 
wg jawnych wymiarów 

 

Niebieskie linie 
pochodzą ze zdjęć 

Niewielkie różnice w 
tych dwóch obszarach 
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W zasadzie, sylwetki pokazywane przez Rysunek 6.1.6 pasują do siebie. Można jedynie dostrzec drobne różni-

ce w szczegółach osłony silnika, ramek kabiny pilota i linii podłużnic za tą kabiną. Rysunek 6.1.6 zaznacza te 

obszary kolorem różowym. Poniżej omówię krótko te odchylenia. 

Rysunek 6.1.7 przedstawia różnice w przedniej części kadłuba. Tak jak na poprzedniej ilustracji, tu także linie 

rysunku Jumpei Temmy są zabarwione na zielono:  

 

Rysunek 6.1.7 Różnice w szczegółach osłony silnika (zielone linie to rysunek Jumpei Temmy) 

Na rysunku Temmy wszystkie poziome podziały paneli są odrobinę niżej niż moje (6). Narysowałem te fioletowe 

linie pochodzą z rysunku L-10202 (por. str. 241). Różnica w położeniu płaszczyzny śmigła (2) może wynikać z 

różnicy w długości jego kołpaka (1). To się może zdarzyć, gdy określa się położenie łopat śmigła w stosunku do 

ogólnej długości kołpaka. Naniosłem także dodatkowy podział paneli (3), widoczny na archiwalnych zdjęciach. 

Położenie i średnica chwytu powietrza do silnika (4) z mojej sylwetki pochodzą z odnalezionego szkicu SK-

2603. Podobnie czerwone kontury osłon luf karabinów (5) są oparte o szkic SK-2605 (por. str. 239). Zwróć także 

uwagę na kształt osłony (7). Po porównaniu archiwalnych zdjęć doszedłem do wniosku, że ten ukryty detal jest 

nieprawidłowo odtworzony we wszystkich latających obecnie P-40B/C, na których wzorował się Jumpei Temma. 

Przypuszczam, że kolejne ekipy kopiowały go z pierwszego odbudowanego samolotu.  

Zanim omówię ramki kabiny pilota, chciałbym wyjaśnić to, co widać w tym obszarze na moim rysunku:   

 

Rysunek 6.1.8 Wyjaśnienie szczegółów osłony kabiny na moim rysunku  

Jest to osłona kabiny z P-36. Na rysunku struktury kadłuba (czarne linie na ilustracji powyżej) kształt ramki za 

kabiną jest nieprawidłowy. Poprawny kształt tych ramek (wg rys. 75-21-078) naniosłem w kolorze czerwonym. 
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Choć ramki osłon kabiny w P-36 i P-40-cu/B/C różnią się w wieloma szczegółami, założyłem, że geometria 

oszklenia pozostała bez zmian. Przedstawione poniżej porównanie jest oparte na tym założeniu: 

 

Rysunek 6.1.9 Różnice wokół kabiny pilota (rysunek Jumpei Temmy jest w kolorze zielonym)    

Rysunek 6.1.9 pokazuje, że podstawa owiewki kabiny z rzutu boku Temmy (zielone linie) jest przesunięta do 

tyłu o około 1” (1), podczas gdy poziome krawędzie tylnej ramki i linie podziału paneli są przesunięte w dół o 

około 0.5” (2). To samo dotyczy owiewki kabiny (3). Przypuszczam, że jest to rezultat nieuniknionych błędów w 

kompensacji różnic pomiędzy prostopadłym rzutem i porównywanymi zdjęciami. W praktyce żadna fotografia 

samolotu nie jest wykonana w kierunku idealnie prostopadłym do jego płaszczyzny symetrii. 

Osłona kabiny P-40 przesuwała się wzdłuż szyny o przekroju teownika, podczas gdy w P-36 był zastosowany 

ceownik. Na podstawie zdjęć można wnioskować, że w P-40 ta szyna była przynitowana do podłużnicy biegną-

cej w tym miejscu pod poszyciem kadłuba. Stąd sądzę, że powinna być nieco wyżej niż u Jumpei Temmy.   

Na rysunek referencyjny z moim rzutem z boku naniosłem skorygowane szczegóły osłony kabiny P-40 

(Rysunek 6.1.10). Jest to tylko przypuszczalny kształt, częściowo oparty o archiwalne zdjęcia (niebieskie linie), 

a częściowo bazujący na rysunkach osłony kabiny P-36 (czerwone linie):  

 

Rysunek 6.1.10 Skorygowany kształt osłony kabiny we wczesnych P-40   

Gdy zbuduję pierwszą wersję naszego komputerowego modelu, sprawdzę kształt tych niebieskich elementów 

za pomocą dokładniejszego, przestrzennego porównania ze zdjęciami (por. str. 116). 

 

Zwróć uwagę, że niebieskie linie na moim rysunku reprezentują tylko alternatywną hipotezę. W sek-

cjach 9.6 (str. 232) i 9.7 (str. 238) szczegółowo wyjaśniam tok rozumowania, który za nimi stoi. Możesz 

je traktować jako równie prawdopodobne, jak odpowiednie szczegóły z rysunków Jumpei Temmy (któ-

ry na swojej stronie także pozostawił nieco wskazówek dotyczących ich kształtów). Gdybyś miał wąt-

pliwości, przeanalizuj obydwa opisy i zdecyduj, który wariant wybierasz.     
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http://soyuyo.main.jp/p40b/p40be-1.html
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Zakładam również, że szerokość osłony silnika w ostatnim wariancie XP-40 i w pierwszych seryjnych P-40 była 

taka sama. Dlatego, przygotowując te rysunki referencyjne, użyłem współrzędnych z L-10202 (por. str. 220, 

221) do dokładniejszego określenia szerokości przodu kadłuba. Uzyskany kontur nałożyłem na widok z góry 

Jumpei Temmy. Widać pomiędzy nimi drobne różnice (Rysunek 6.1.11):  

 

Rysunek 6.1.11 Korygowanie szerokości konturu osłony silnika na rzucie z góry Jumpei Temmy (w wersji 2.5)   

Jako dodatkowy sprawdzian, naniosłem także kontur kadłuba za przegrodą silnika. Wykorzystałem do tego celu 

wymiary z rysunku P-36 nr 75-21-140 (por. str. 225)1. Zauważyłem niewielkie różnice (Rysunek 6.1.12):  

 

 

 

Rysunek 6.1.12 Dokładna szerokość kadłuba P-40 za przegrodą silnika (zielone linie: rysunek Jumpei Temmy) 

Widoczne w powiększeniu nieznaczne odchylenia w szerokości i symetrii mogą być rezultatem skopiowania linii 

z oryginalnego rysunku Curtiss, bez sprawdzania dostępnych wymiarów. Jak o tym wspomniałem w sekcji 5.3, 

kontury obiektu na rysunkach fabrycznych mogą się nieco różnić od prawdziwego kształtu (por. str. 101). 

 
1 Sądzę, że możemy spokojnie założyć zgodność geometrii tego odcinka kadłuba P-36 i wczesnych P-40. Przypuszczam też, że szerokości 

jego wręg zostały nawet zachowane w późniejszych wariantach z „długim ogonem” (por. ten post z mojego bloga). 

 

Kreśląc kontury samolotu na rysunkach, stosowałem konwencję planów modelarskich: prawdziwy 

kontur odwzorowanego obiektu leży na zewnętrznej krawędzi linii obrysu.  
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Czerwony kontur: szerokość 
osłony silnika wg L-10202  

Kadłub Temmy jest 
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asymetryczny 

Czerwona linia: kontur 

kadłuba wg 75-21-140 

https://airplanes3d.wordpress.com/2019/12/19/a-new-finding-about-the-long-tail-p-40s/
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Wśród materiałów towarzyszących tej książce (por. str. 18) znajdziesz gotowe do użycia obrazy referencyjne, 

wycięte z planów Jumpei Temmy. Umieściłem je w katalogu source/reference/drawings/temma/ 1. 

Podsumowanie 

• Rysunki Jumpei Temmy są obecnie najdokładniejszymi planami P-40 (str. 109, 110), a także P-36. Wyko-

rzystaj je jako źródło do przygotowania standardowego zestawu 6 rysunków referencyjnych samolotu (tak, 

jak opisuje to Rozdział 3). Będziemy ich używać w dalszych częściach tej książki. 

• Do skalowania rzutu z boku P-40B autorstwa Jumpei Temmy użyj umieszczonych na tym rysunku jawnych 

wymiarów: płaszczyzny przegrody silnika i osi steru kierunku (str. 109). Wygląda na to, że kołpak śmigła na 

tych planach jest odrobinę za długi (o około 1”), i nie pasuje do całkowitej długości samolotu podanej na ry-

sunkach poglądowych (str. 110). 

• Jako dodatek do rysunków Temmy możesz użyć alternatywny rzut z boku, który złożyłem z oryginalnych 

rysunków Curtiss (str. 111). Jest oparty na dokumentacji kadłuba P-36 (od przegrody silnika do końca steru 

kierunku) i unikalnych szkicach osłony silnika XP-40, które znalazłem wśród „nieskategoryzowanych” ska-

nów mikrofilmów. Sądzę, że opisana na nich geometria dotyczy także wczesnych P-40 (za wyjątkiem dol-

nej części osłony chłodnicy cieczy).  

• W związku z brakiem oryginalnej dokumentacji, przednia część P-40B Jumpei Temmy (od kołpaka śmigła 

do przegrody silnika) jest oparta na zdjęciach, zazwyczaj odrestaurowanych samolotów. Oznacza to, że ten 

obszar jest mniej „potwierdzonym” niż pozostałe części jego planów. Porównując rzut z boku Temmy z ory-

ginalnymi rysunkami Curtiss, znalazłem wiele drobnych różnic w kształcie osłony silnika i szczegółach wo-

kół kabiny pilota (str. 111 - 114). 

• Aby nie zwodzić Czytelnika, zaznaczałem moje poprawki rysunków Jumpei Temmy dwoma kolorami: czer-

wone linie to kontury potwierdzone przez oryginalną dokumentację (zazwyczaj – przez jawne wymiary). 

Niebieskie linie są oparte wyłącznie na analizie zdjęć, co oznacza, że są równie prawdopodobne jak ich 

odpowiedniki z rysunku Temmy. W tych „niebieskich” przypadkach możesz przejrzeć historyczne zdjęcia i 

sam zdecydować, który wariant jest bliższy prawdy. 

• W materiałach towarzyszących tej książce umieściłem gotowe do użycia rysunki referencyjne P-40B oparte 

o plany omawiane w niniejszej sekcji. Znajdziesz je w folderze source/reference/drawings/temma/.       

 

 

 
1 Rzuty z boku pochodzą z wersji 2.7 tych rysunków, a rzuty z góry i z dołu – z wersji 2.5. 
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6.2 Nie spoczywaj na laurach! 

Przygotowanie rysunków wzorcowych to tylko pierwszy krok w procesie tworzenia dokładnego, cyfrowego mo-

delu samolotu. Możesz nieświadomie popełnić dalsze błędy podczas formowania jego kształtu w Blenderze. 

Remedium jest proste: sprawdzaj swój model na każdym etapie projektu. Na przykład, możesz przygotować w 

przestrzeni 3D pomocnicze szablony, do szybkiego sprawdzania kilku kluczowych wymiarów (jak całkowita dłu-

gość czy kształt podstawowego „trapezu” skrzydła). 

Co więcej, gdy główne podzespoły Twojego modelu 3D będą gotowe, możesz go ustawić w takiej samej projek-

cji perspektywicznej jak na zdjęciu o wysokiej rozdzielczości, ustawionym jako tło kamery (Rysunek 6.2.1): 

 

Rysunek 6.2.1 Projekcja modelu 3D na zdjęcie wstawione jako tło kamery 

Gdy raz dopasujesz taką projekcję do modelu, możesz używać tych zdjęć jak precyzyjnych rysunków wzorco-

wych, podobnych do planów! Ta metoda jest szczególnie użyteczna, gdy nie zachował się żaden oryginalny 

rysunek samolotu. Jej maksymalny błąd dla jednosilnikowego samolotu nie powinien przekroczyć 1” dla ogólnej 

rozpiętości czy długości. Jednak dopasowanie projekcji do takiego tła może być czasami trudne, szczególnie w 

przypadku starszych zdjęć, wykonanych obiektywem o nieznanej ogniskowej. Detale tej metody opisuje Tom II. 

Projekcja z kamery 
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Rozdział 6 Sugestie końcowe 117 

 

 
 (CC) Witold Jaworski, 2009 – 2020. 

Szczegóły obsługi programów rysunkowych 

Zawartość tej części bardzo przypomina zawartość plików podpowiedzi do programów używanych w tej książce. 

Są tu zestawione opisy tych poleceń, które zostały wykorzystane w jej poprzednich częściach. Z założenia bę-

dziesz z nich korzystał wyrywkowo (por. „Jak czytać tę książkę?”, str. 11). Nie doszukuj się więc w kolejności 

dalszych rozdziałów i sekcji jakiejś przemyślanej metody wprowadzania w obsługę programu. Ta istnieje w po-

przednich częściach tej książki. To tam specjalnie dobrałem kolejność prezentowanego materiału w ten sposób, 

byś mógł stopniowo poznawać wszystkie potrzebne zagadnienia. 

 

Gdy zdecydujesz się wydrukować tę książkę dla własnych potrzeb, proponuję pozostawić tą część w postaci 

elektronicznej. W przeglądarce PDF szybciej znajdziesz podany na takim wydruku numer strony, niż kartkując 

gruby plik kartek. (No i zużyjesz mniej drzew z lasów...). 
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Rozdział 7. GIMP – szczegóły obsługi 

Nazwa GIMP pochodzi, jak sądzę, od pierwszych liter angielskiego Graphic Image Processor. Jest to jeden z 

pierwszych, dużych i ukończonych projektów Open Source. 
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7.1 Instalacja 

Pobierz ze strony http://www.gimp.org/downloads/ plik instalacyjny (patrz str. 20) i uruchom go (do przeprowa-

dzenia tej operacji musisz mieć uprawnienia Administratora). Program instalacyjny wyświetla najpierw okno 

dialogowe pozwalające ustalić język w jakim będą wyświetlane poszczególne ekrany (Rysunek 7.1.1a), a na-

stępnie ekran startowy (Rysunek 7.1.1b): 

 

Rysunek 7.1.1 Instalacja GIMP – pierwsze dwa ekrany 

Jeżeli chcesz np. zmienić folder programu – przejdź do Customize. Na jednym z ekranów, które się wówczas 

pojawią, możesz na przykład zmienić folder, w którym zostaną umieszczone pliki programu. Potem wrócisz na 

ekran startowy.  

Ja jednak proponuję zainstalować GIMP bez jakiejkolwiek zmiany domyślnych parametrów: naciśnij od razu 

przycisk Install. Spowoduje to rozpoczęcie całej operacji (Rysunek 7.1.2a): 

 

                

Rysunek 7.1.2 Dalsze ekrany programu instalacyjnego 

Po zakończeniu kopiowania plików i rejestracji komponentów program instalacyjny wyświetli ekran końcowy 

(Rysunek 7.1.2b). 
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http://www.gimp.org/downloads/
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Potem możesz uruchomić GIMP. Na początku pojawi się okno startowe (Rysunek 7.1.3): 

 

Rysunek 7.1.3 GIMP – okno startowe 

Po chwili okno startowe znika i otworzy się główne okno programu (Rysunek 7.1.4): 

 

Rysunek 7.1.4 Domyślny wygląd okna GIMP (ciemny motyw kolorystyczny) 

Jak widać powyżej, ten interfejs użytkownika jest utrzymany w bardzo ciemnej tonacji. Mam wrażenie, że w 

ciągu ostatnich lat ten styl stał się bardzo „modny” wśród programów graficznych. Jednak w GIMP jest to no-

wość. GIMP 2.8 i wszystkie poprzednie wersje używały jaśniejszego motywu i większych, wielobarwny ikon. 

Większość poradników GIMP pokazuje właśnie ten poprzedni wariant barw. Dlatego na następnej stronie suge-

ruję przełączyć GIMP do takiej jaśniejszej, bardziej klasycznej postaci. 
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Obszar obrazu 

Przyborniki 

Menu rozwijalne 
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Wywołaj polecenie Edit→Preferences aby otworzyć okno konfiguracji GIMP. Następnie przejdź do listy 

Interface→Icon Theme i zaznacz motyw Color (Rysunek 7.1.5): 

             

Rysunek 7.1.5 Wybór motywu Color dla ikon 

Zauważ, że GIMP natychmiast zmienia wygląd okien zgodnie z tym, co ustawiasz. Teraz przełącz się do listy 

Theme, i zaznacz w niej motyw System (Rysunek 7.1.6): 

              

Rysunek 7.1.6 Wybór motywu System dla okien 

Chciałbym także zaproponować jeszcze jedną zmianę w ustawieniach GIMP. Domyślnie ikony poleceń w przy-

borniku są pogrupowane w „stosy”. Możesz tylko widzieć polecenie ze szczytu tego stosu, i musisz „przewijać” 

jego elementu za pomocą kółka myszki (Rysunek 7.1.7): 

 

Rysunek 7.1.7 Grupowanie poleceń w przyborniku 

To nowość, wprowadzona w GIMP 2.10. Mówiąc szczerze, nie podoba mi się ten pomysł: nie widzisz wszyst-

kich dostępnych poleceń, podczas gdy na ekranie nadal jest wiele wolnej przestrzeni na ich ikony. 

Idź do Icon 
Theme  Wybierz 

Color 

Idź do 
Theme  

Wybierz 
System 

Grupa poleceń ma zawsze 
czarny prawy dolny narożnik. 

Możesz zmienić widoczne 
polecenie w grupie obra-

cając KM  

Możesz także wywołać te polecenia 
za pomocą skrótów klawiatury 

Przesuń myszkę nad grupę, 
by zobaczyć jej stos poleceń 
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Na szczęście możesz wyłączyć to grupowanie poleceń i ujrzeć przybornik ze wszystkimi ikonami. Aby to zrobić, 

w oknie konfiguracji (Preferences) przejdź do panelu Interface→Toolbox i wyłącz opcję Use tool groups 

(Rysunek 7.1.8): 

  

Rysunek 7.1.8 Wyłączenie grupowania poleceń 

Zwróć uwagę, że w tym samym panelu, w liście Tool Configuration możesz ukryć nieużywane polecenia. Jed-

nak na początek sugeruję pozostawić je wszystkie w przyborniku, ponieważ jeszcze musisz się przekonać, któ-

re z nich będą przydatne, a które nie. 

 

Aby potwierdzić te wszystkie zmiany w konfiguracji GIMP, u dołu okna Preferences kliknij przycisk OK. 

 

 

 

 

Otwórz 
Toolbox 

Wyłącz tę 
opcję 

Kliknij OK, by 
zapisać te zmiany 

Tutaj możesz ukryć 
polecenia, których 
nie potrzebujesz 

Mały, “pogrupowany” 

przybornik 

Duży, “płaski” 

przybornik 
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7.2 Wprowadzenie 

Podczas uruchamiania, ładowanie wszystkich komponentów zajmuje w Gimp parę chwil. W tym czasie pokazy-

wane jest "okno startowe" (Rysunek 7.2.1): 

 

Rysunek 7.2.1 Okno startowe GIMP 

Po zakończeniu ładowania, ujrzysz główne okno programu (Rysunek 7.2.2):  

 

Rysunek 7.2.2 Domyślny ekran GIMP (2.10) 

Obszar pośrodku okna to miejsce na obrazy. Po jego obu stronach są umieszczone panele dialogowe z przybo-

rami rysunkowymi lub innymi pomocami. Paneli dialogowych jest w programie dużo, w dodatku mogą być łą-

czone w zakładki (jak te z prawej strony przykładowego okna). 

 

Możesz zmieniać szerokość bocznych obszarów za pomocą myszki (patrz str. 125). 

 
  

 

Obszar obrazu 

Kolejny zestaw 
paneli  

Pasek stanu 

Menu rozwijalne 

Przybornik  

Kolejny zestaw 

paneli 

Zestaw 
kilku paneli 
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Rysunek 7.2.3a) przedstawia ważniejsze elementy okna przybornika (Toolbox) i panelu z opcjami narzędzi: 

 

                                                                

Rysunek 7.2.3 Przybornik i panel dialogowa 

Przyjrzyj się nagłówkowi obszaru zakładek w oknie Toolbox. Jest tam, po prawej stronie, taki niepozorny przy-

cisk „strzałki”. Gdy w niego klikniesz – otworzysz menu rozwijalne sterowania panelami (Rysunek 7.2.3b). 

Pierwszą jego pozycją jest submenu, odpowiadające aktywnej zakładce tego zestawu. Na tej ilustracji zestaw 

zawiera pozycję o nazwie Tool Options.  

 

Jeżeli w obszarze masz więcej niż jedną panel, możesz każdą z nich „wyciągnąć” w oddzielne okno 

„pływające” ponad ekranem. Służy do tego polecenie Detach Tab z menu panelu 

 
 Polecenie Close Tab zamyka aktualną zakładkę (jeżeli była to ostatnia zakładka – zniknie cały obszar).  

Zajmijmy się jednak innym poleceniem z tego menu: Add Tab. Jest to zagnieżdżone menu, prezentujące do 

wyboru wszystkie dostępne zakładki (Rysunek 7.2.4a). Gdy wybierzesz z tego menu jedną z zakładek, GIMP 

doda ją do przybornika (Rysunek 7.2.4b): 

                                                  

Rysunek 7.2.4 Dodawanie do przybornika dodatkowej zakładki 

 

Narzędzia do 
edycji obrazu 

a) 

Z menu Add Tab 
możesz wybrać nowy 
panel, którego po-
trzebujesz do pracy 

Panel Layers wyświetla listę 
warstw rysunku. Gdy żaden 
rysunek nie jest jeszcze 
otwarty, ta lista jest pusta 

a) b) 

Zamknięcie 
aktualnej 
paneli 

Aktualna barwa 
i barwa tła 

Ten mały przycisk 
otwiera menu ste-
rowania panelami 

b) 

Wydzielenie aktual-
nej paneli w okno. 
(aktywne dla dwóch 
i więcej paneli) 

Podświetlone 
aktualne 
narzędzie i 
panel z jego 
ustawieniami 

a) 
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Na ekranie możesz mieć otwartych kilka obszarów z panelami. Panele można przenosić pomiędzy obszarami 

metodą „przeciągnij i upuść”, „łapiąc” myszką (LPM) za zakładkę (Rysunek 7.2.5):  

 

Rysunek 7.2.5 Przenoszenie pojedynczego panelu pomiędzy obszarami dialogowymi  

 

Jeżeli nie chcesz przez nieuwagę przeciągnąć myszką jakiegoś panelu – możesz wyłączyć możliwość 

takiego przeciągania, włączając w jego menu (por. Rysunek 7.2.3b) opcję Lock Tab to Dock. 

 
 Posługując się tymi poleceniami możesz skompletować zakładki, które są Ci potrzebne do pracy. Wydaje mi się, 

że do naszych celów na razie wystarczą trzy: Tool Options, Brushes i Layers (por. Rysunek 7.2.6): 

  

Rysunek 7.2.6 Sugerowany układ ekranu 

“Złap” (LPM ) tą zakładkę, 

przeciągnij ją, i upuść w 
innym obszarze 

Aby zmienić szerokość tych 
obszarów, “złap” je myszką 

(LPM ) i przesuń w prawo 

lub w lewo. 
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Jeżeli brakuje Ci miejsca na ekranie, można przenieść wszystkie potrzebne panele na jedną stronę 

ekranu, a potem szerokość przeciwległego obszaru zmniejszyć do zera. 

 
 W centrum okna programu wyświetlany jest edytowany obraz. Rysunek 7.2.7 przedstawia kilka istotnych ele-

mentów tego obszaru, które pojawiają się gdy wczytałeś istniejący plik lub stworzyłeś nowy: 

 

Rysunek 7.2.7 Elementy obszaru obrazu 

W GIMP możesz naraz otworzyć wiele obrazów. Każdy z nich zostanie umieszczony w odrębnej zakładce 

(Rysunek 7.2.8). Można także ten sam obraz otworzyć w kilku zakładkach (View→New View).  

 

 

Rysunek 7.2.8 Praca z wieloma obrazami naraz 

Aktualne powiększenie 
obrazu (%). Można je 
wybrać z listy lub wpisać 
z klawiatury. 

Linijki: pozioma 
i pionowa 

Współrzędne 
kursora myszki 

Alternatywne 
narzędzie do 
przewijania 

Jednostka linijek 
i współrzędnych 

Włącz, by ekran wyświetlał 
w każdym powiększeniu ten 
sam fragment rysunku 

Przycisk zamykający okno 
Miniatura 
obrazu 
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Jeżeli chcesz widzieć różne obrazy lub fragmenty obrazu w oknach ustawionych obok siebie – wyłącz 

opcję Windows→Single-Window Mode. 

 
 Jednym z typowych elementów interfejsu użytkownika są kontrolki, umożliwiające określenie jakiejś ograniczo-

nej wartości (np. intensywność jakiegoś efektu). Podstawowym problemem w przypadku takich elementów jest 

pogodzenie możliwości szybkiej i łatwej zmiany za pomocą myszki, z możliwością wpisania dokładnej wartości. 

We wcześniejszych wersjach programu starano się to umożliwić za pomocą zespołu dwóch kontrolek: suwaka i 

pola tekstowego (Rysunek 7.2.9a). W wersji 2.8 GIMPa połączono te dwa elementy w całość (Rysunek 7.2.9b): 

 

                                  

Rysunek 7.2.9 Nowy rodzaj kontrolki – połączenie suwaka i pola tekstowego  

W taką kontrolkę można wpisać za pomocą klawiatury dokładną wartość – podczas pisania zachowuje się tak, 

jak klasyczne pole liczbowe (Rysunek 7.2.10a). Alternatywnie możesz także przesunąć pasek wartości klikając 

myszką w górną krawędź kontrolki (Rysunek 7.2.10b). Przeciągnięcie granicy paska wzdłuż dolnej krawędzi 

pozwala uzyskać drobniejsze zmiany (Rysunek 7.2.10c): 

 
 

 

 

 

 

 

 

Rysunek 7.2.10 Szczegóły obsługi nowej kontrolki zakresu  

 
W GIMP polecenia z palety narzędzi (przybornika) są 

dostępne także poprzez menu Tools (Rysunek 7.2.11). 

Twórcy programu pogrupowali je tam w kilka submenu: 

Selection Tools, Paint Tools, Transform Tools. W 

tekście książki łatwiej i bardziej jednoznacznie jest mi 

podawać polecenia z menu, niż umieszczać obrazki 

ikon do naciśnięcia. Będę więc powoływał się na nazwy 

poleceń. Jeżeli wolisz korzystać z przybornika – otwórz 

tylko raz podane przez mnie menu, aby upewnić się o 

którą ikonę chodzi (są zawsze widoczne obok napi-

sów). Gdy już rozpoznasz ten symbol – używaj przy-

bornika. 

 

 

 

 

 

Rysunek 7.2.11 Menu Tools (okno obrazu) 

Te ikony znaj-
dziesz także w 
przyborniku,  

GIMP 2.6 GIMP 2.8 i dalsze 

a) b) 

a) 

b) 

c) 

Możesz tu wpisać dokładną wartość (ciemniejszy pasek z 
lewej dopasuje się do niej, gdy klikniesz w inną kontrolkę) 

Możesz także zmieniać wartość 
co 1, klikając w te strzałki 

Gdy klikniesz w górną krawędź, granica 
paska (wartość) przesunie się w to miejsce 

Przeciągnij krawędź paska wzdłuż dolnej 
krawędzi, aby dokonać jakichś drobniej-
szych, bardziej precyzyjnych poprawek  

Do określania % przejrzystości 
służył zespół suwaka i pola 
tekstowego 

Kontrolka łącząca funkcje 
suwaka i pola tekstowego 
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7.3 Skanowanie strony 

Włącz skaner i upewnij się, że jest przyłączony do komputera. Umieść stronę, którą chcesz zeskanować, na 

pulpicie skanera. Następnie wywołaj w GIMP polecenie File→Create→Scanner/Cammera (Rysunek 7.3.1):  

 

Rysunek 7.3.1 Wybór skanera  

Spowoduje to otwarcie okna Select Source. Wybierz z niego jeden z dostępnych interfejsów skanera. W przy-

kładzie powyżej mój DCP-J125 oferuje dwa interfejsy: TW(AIN) i WIA. Wybrałem WIA, ale w zasadzie obydwa 

obsługuje się podobnie i obydwa pozwalają uzyskać podobne rezultaty.  

Gdy w oknie Select Source klikniesz przycisk Select, GIMP otworzy okno ustawień skanowania (Rysunek 

7.3.2): 

 

Rysunek 7.3.2 Okno ustawień skanowania  

Kliknij w tym oknie przycisk Preview, aby wykonać szybki podgląd skanowanej strony. Pozwoli to określić, czy 

jej pozycja na pulpicie skanera jest prawidłowa. Dodatkowo, możesz także „złapać” myszką ( LPM) i przeciągnąć 

uchwyty obszaru skanowania, aby go lepiej dopasować do rysunku. 

Wywołaj polecenie 
Scanner/Camera … 

… i wybierz jeden z 
interfejsów skanera 

Kliknij tu, aby uzyskać 
szybki skan (do oceny 
orientacji strony i obszaru 
skanowania) 

Tu możesz zmienić liczbę 
barw i rozdzielczość   

Przeciągnij te uchwyty by 
zmienić obszar skanowania   
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Po prawej stronie okna ustawień znajduje się lista (przycisków wyboru) gotowych zestawów parametrów. W 

zasadzie pozwala na zmianę liczby i typu barw skanowanego obrazu (może być w kolorze, odcieniach szarości, 

lub czarno-biały). Aby określić dokładnie te i inne ustawienia, kliknij link Adjust the quality of the scanned 

image. Spowoduje to otwarcie okna Advanced Properties (Rysunek 7.3.3): 

                                                                                       

Rysunek 7.3.3 Zmiana rozdzielczości skanowania 

Możesz tutaj zmienić rozdzielczość skanowania. Dla planów sugeruję nie więcej niż 300 dpi, i ustawienie z listy 

Picture type: Grayscale picture. Możesz także poeksperymentować z kontrastem (Contrast) i jasnością 

(Brightness), jeżeli coś z nimi jest nie tak na podglądzie. Wszystkie ustawienia, jakie zaakceptujesz w oknie 

Advanced Properties są zapisywane w ostatniej pozycji listy wyboru (Custom Settings). Dzięki temu, przy ska-

nowaniu kolejnej strony możesz wybrać tę pozycję, zamiast ustawiać wszystko na nowo. 

Gdy ustawienia wydają się być poprawne, kliknij przycisk Scan (por. Rysunek 7.3.2). Po chwili GIMP otworzy 

nową zakładkę i wyświetli w niej rezultat operacji (Rysunek 7.3.4): 

 

Rysunek 7.3.4 Zeskanowany obraz 

Te ustawienia są 
zapamiętane tutaj   

Tu moższesz 
je zmienić   

Typowe ustawienia 

Zeskanowany 
obraz  
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7.4 Otwieranie pliku (obrazu) 

Aby otworzyć obraz, wybierz z menu polecenie File→Open 

(Rysunek 7.4.1): 

 

 

 

 

Spowoduje to pojawienie się okna dialogowego wyboru pliku 

(Rysunek 7.4.2). Okno to nie przypomina standardowego 

okna Windows. Dzieje się tak dlatego, że GIMP używa do 

obsługi okienek zestawu komponentów o nazwie GTK+1. Tak 

właśnie wygląda w GTK+ komponent do wyboru plików: 

 

 

Rysunek 7.4.2 GIMP – okno wyboru plików 

GIMP rozpoznaje wiele różnych formatów zapisu obrazu. Po naciśnięciu Open załaduje wskazany w oknie dia-

logowym plik. 

 

Istnieje także prostsza metoda na załadowanie obrazu. Możesz „przeciągnąć” myszką plik *.jpg, *.png, 

*.tif czy *.svg do pustego okna GIMP, i tam go „upuścić”. 

 
  

 

Pliki *.tif, *.jpg lub *.png nie przechowują informacji o warstwach. Dlatego gdy GIMP importuje ich za-

wartość, tworzy pojedynczą warstwę nazwaną tak samo jak importowany plik. 

 

 
1 GTK+ jest biblioteką procedur Open Source pozwalającą na pisanie programów, które będą działały w wielu różnych systemach operacyj-

nych, m. in. Linux, Windows, Mac OS. Wydaje mi się, że wykorzystuje ją popularna odmiana Linux-a: Ubuntu. Dlatego to okno będzie wy-

glądać znajomo dla użytkowników tego systemu. 

 

Rysunek 7.4.1 Otwarcie istniejącego obrazu 

Aktualna ścieżka. Kliknij w 
jeden z tych przycisków by 
zmienić folder 

Tu możesz 
wpisać na-
zwę pliku 

Lista 
typowych 
skrótów 

Pliki w aktualnym 
folderze 

Podgląd 
wybranego 
pliku 
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7.5 Zapisanie pliku (obrazu) 

W obecnej wersji GIMP polecenie File→Save As pozwala zapisać obraz tylko we własnym formacie programu 

(*.xcf). Używaj go wtedy, gdy chcesz zapisać obraz w tej postaci, i/albo jako plik o zmienionej nazwie. Jeżeli 

chcesz zachować obraz w innym formacie (np. *.jpg, *.png, *.tif,…) należy użyć poleceń File→Export lub 

File→Export As  (Rysunek 7.5.1): 

                             

Rysunek 7.5.1 Różne metody zapisywania pliku 

Taki dziwny podział został wprowadzony w GIMP 2.8. Potem, w odpowiedzi na krytykę, dodano polecenie 

Overwrite <nazwa pliku>, do szybkiego zapisu typowych obrazów. Każde z tych poleceń otwiera okno (Rysunek 

7.5.2) podobne do tego, w którym wybieraliśmy plik do załadowania (por. Rysunek 7.4.2, str. 130): 

  

Rysunek 7.5.2 Okno zapisywania do pliku 

W oknie Export Image (Rysunek 7.5.2) wybieramy folder, do którego zapiszemy rysunek. Wpisujemy także na-

zwę pliku. Bardzo ważne jest także wpisanie właściwego rozszerzenia pliku – np. .png, .tif, albo .jpg. (GIMP 

określa sposób zapisu obrazu na podstawie rozszerzenia pliku, które podasz). Na koniec naciśnij na w oknie 

Export Image przycisk Export. 

Polecenia Save w GIMP zapisują 
obraz wyłącznie w natywnym for-
macie programu (*.xcf). 

Użyj poleceń Export do zapisu 
obrazu w jednym z popularnych 
formatów: PNG, JPEG, TIFF, …  

 

Gdy otworzysz obraz w innym formacie niż *.xcf, 
zobaczysz tu polecenie Overwrite…. Używaj go 
jako odpowiednika klasycznego Save  

 

Wpisz tutaj nazwę dla pliku obrazu. GIMP rozpo-
znaje format zapisu po wpisanym rozszerzeniu! 

Użyj tych kontrolek do wyboru 
folderu, w którym zapiszesz plik  
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W zależności od formatu zapisu, który wybrałeś, GIMP może 

jeszcze pokazać pomocnicze okno, z dodatkowymi opcjami. 

Rysunek 7.5.3 pokazuje takie okno dla formatu TIFF. Można tu 

ustalić sposób kompresji obrazu. Wybieraj zawsze opcję LZW. 

(Nie sprawdzałem innych, ale LZW jest bardzo popularną me-

todą i poprawnie wczytuje się do Blendera). 

Po naciśnięciu kolejnego przycisku Export, nasz rysunek zo-

stanie ostatecznie zapisany na dysku.  

 

Gdyby GIMP wyświetlił komunikat o braku moż-

liwości zapisania informacji o przejrzystości w 

pliku TIFF, wywołaj polecenie Image→Flatten 

Image i spróbuj jeszcze raz. 

 
  

 

 

 

 

 

Format JPEG pozwala uzyskać pliki o najmniejszym rozmia-

rze, ale za pewną cenę: pogorszenia jakości obrazu. Nie obsługuje też przejrzystości. Dla plików *.jpg GIMP 

wyświetla inne okno dialogowe (Rysunek 7.5.4): 

   

Rysunek 7.5.4 Okno zapisywania do pliku 

Kontrolki w oknie Export Image as JPEG pomagają dobrać kompromis pomiędzy jakością obrazu i rozmiarem 

wynikowego pliku. Zawsze włączaj opcję Show preview in image window,  a potem spróbuj zmniejszyć war-

tość Quality poniżej 90%. Obserwuj, jak zmniejsza to rozmiar pliku, a w oknie głównym GIMP – jaki ma to 

wpływ na obraz. W ten sposób szybko dobierzesz znajdziesz optymalne ustawienie. 

 

Rysunek 7.5.3 Okno dodatkowe – zapis w formacie TIFF 

Wybierz tę opcję 
kompresji obrazu 

Włącz podgląd obrazu i obserwuj jego rozmiar, 
by znaleźć optymalną wartość Quality  

Nigdy nie używałem Advanced Options, 
lecz możesz z nimi poeksperymentować: 
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Dla "biało-czarnych" obrazów (np. plany, zeskanowane w odcieniach szarości) możesz ustawić całkiem 

niską wartość parametru Quality (około 70%) bez specjalnej utraty jakości. W ten sposób uzyskasz o 

wiele mniejsze pliki niż dla kolorowych obrazów o tych samych rozmiarach.   

 
  

PNG jest tzw. „formatem bezstratnym” (podobnie jak 

TIFF): przechowuje oryginalne wartości każdego piksela 

obrazu. Zachowuje także informację o przejrzystości. W 

przypadku zapisu do pliku PNG (Rysunek 7.5.5) pozosta-

wiaj poziom Compression level na najwyższej wartości 

(9). W tym formacie najwyższy poziom kompresji nie 

wpływa na jakość, a pozwala uzyskać najmniejsze pliki. 

Są one jednak dużo większe od identycznych obrazów 

zapisanych w formacie JPEG. 

 

 

W przypadku formatów PNG i JPEG możesz 

użyć przycisku Save Defaults by zapamiętać 

typowe parametry zapisywania, jakie stosujesz 

(Znajdziesz je w dolnej części ich okien – por. 

Rysunek 7.5.4 i Rysunek 7.5.5). Od tej pory 

GIMP będzie je proponował od razu. 

 
  

 

 

 

 

Rysunek 7.5.5 Okno dodatkowe – zapis w formacie PNG 

Ustaw najwyższy 
poziom kompresji 
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Rozdział 8. Inkscape – szczegóły obsługi 

Na Inkscape natknąłem się przypadkiem. GIMP ma dość ograniczone możliwości rysowania linii wektorowych. 

A ja szukałem więc czegoś, w czym można by było wygodnie rysować (i poprawiać) linie nitów i łączenia blach 

dla tekstur poszycia samolotu. Gdy wertowałem jego plik podpowiedzi, szukając szczegółów dostępnych funkcji, 

natknąłem się na zdanie: „Rysowanie linii w GIMP nie jest tak wygodne, jak w wyspecjalizowanych programach, 

np. Inkscape”.  

 

Co to jest to „Inkscape”? Wystarczyło wpisać to hasło w Google, by znaleźć stronę tego projektu. Jest to naj-

młodszy z programów, używanych w tej książce. Opisana tutaj wersja 1.0 została udostępniona w 2020r1.  

 

 
1 Inkscape jest tworzony od 2003r i jest „gałęzią” jeszcze wcześniejszego projektu o nazwie Sodipodi. Pierwsza opublikowana wersja miała 

numer 0.35. Takie niekomercyjne projekty mogą być bardziej „szczere” w numeracji wersji: przypuszczam, że oryginalne cele związane z 

funkcjonalnością osiągnięto dopiero w wersji 1.0.  
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8.1 Instalacja 

Pobierz z portalu http://inkscape.org (por. str. 23) i uruchom program instalacyjny (wymaga uprawnień Admini-

stratora). Na początku pojawia się ekran "powitalny", a następnie ekran z umową licencyjną (Rysunek 8.1.1): 

                   

Rysunek 8.1.1 Instalacja GIMP – pierwsze dwa ekrany 

Po naciśnięciu przycisku I Agree na ekranie License Agreement, przejdziemy do następnego okna (Rysunek 

8.1.2): 

                   

Rysunek 8.1.2 Wybór opcji instalacji (1) 

W oknie Install Options wybierz opcję Create Inkscape Desktop Icon. W oknie Choose Install Location mo-

żesz zmienić domyślny folder programu. 

Następne dwa okna zaakceptowałem be żadnych zmian (Rysunek 8.1.3): 

                   

Rysunek 8.1.3 Wybór opcji instalacji (2) 

(Oczywiście, jeżeli na Twoim dysku brakuje miejsca, możesz zmienić typ instalacji w oknie Choose Compo-

nents). Po naciśnięciu przycisku Install rozpocznie się instalacja. 

Wybierz tę opcję 

http://inkscape.org/
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Inkscape wyświetla postęp instalacji na typowym pasku, a potem otwiera okno końcowe (Rysunek 8.1.4): 

                   

Rysunek 8.1.4 Instalacja Inkscape - ekrany: postępu i finalny 

Gdy uruchomisz Inkscape po raz pierwszy, wyświetli okno jak poniżej (Rysunek 8.1.5): 

 

 

Rysunek 8.1.5 Okno Inkscape (układ jak przy pierwszym uruchomieniu) 

Nie wiem czemu, ale zawsze po instalacji Inkscape jego układ ekran jest ustawiony w tak zwanym trybie „sze-

rokim” (Wide). W tym trybie przybornik z poleceniami systemowymi jest umieszczony po prawej (tak, jak to po-

kazuje Rysunek 8.1.5). 

Kliknij tutaj 

Myślę, że ten pasek z poleceniami 
New, Open, Save, Print, itp. powinien 
się znaleźć u góry okna 
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Osobiście wolę widzieć polecenia New, Save, Print, u góry okna, poniżej menu. W tym programie nie można 

jednak po prostu przesunąć myszką paska z poleceniami (przynajmniej jeszcze w tej wersji). Aby zmienić ten 

układ ekranu, wybierz opcję View→Default z menu (Rysunek 8.1.6): 

  

Rysunek 8.1.6 Wybór alternatywnego układu ekranu 

Na koniec jeszcze jedna poprawka: po kilku dniach używania tej wersji Inkscape doszedłem do wniosku, że 

domyślne cztery ikony odbić lustrzanych i ćwierćobrotów (Rysunek 8.1.7) są mylące. (Przypuszczam, że przy-

czyną jest zbytnia generalizacja symboli tych strzałek. Patrząc na nie, trudno powiedzieć, czy reprezentują obrót 

czy polecenie Undo). Na szczęście znalazłem alternatywę: otwórz okno Edit→Preferences, i przejdź do panelu 

Interface→Theme. Wybierz inny zestaw ikon, zawierający bardziej konwencjonalne symbole, z listy Change 

icon theme: 

 

 

 

 

 

 

 

 

Rysunek 8.1.7 Zmiana aktywnego zestawu ikon 

Przełącz układ ekranu na 
Default, w którym pasek 
poleceń jest u góry okna 

The cztery ikony z domyślnego motywu (“system 

icons”) są zbyt ogólne, a przez to - mylące! 

Więc otworzyłem okno 
Edit→Preferences…  

… wybrałem tam motyw hicolor (ikony w 

tym zestawie są bardziej konwencjonalne) 

W zestawie hicolor te ikony są mniej 
kolorowe, lecz nadal czytelne 

Tutaj możesz także zmienić 
kolory okien Inkscape … przeszedłem 

do Interface→ 
Theme … 
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Przy okazji: gdy zmieniasz zestaw ikon, zwróć uwagę na ustawienia ich rozmiarów! Niektóre z nich wymagają 

restartu programu, i wtedy możesz być zaskoczony jak bardzo duży jest rozmiar Large, czy nawet Small! Dla 

wybranego zestawu hicolor sugeruję następujące ustawienia rozmiarów ikon (Rysunek 8.1.8): 

 

Rysunek 8.1.8 Ustalenie rozmiaru ikon dla motywu hicolor 

Oczywiście, jeżeli jesteś fanem ciemnych, jednobarwnych motywów okien, możesz coś takiego ustawić także w 

Inkscape. Wystarczy włączyć opcję Use dark theme (Rysunek 8.1.9): 

 

Rysunek 8.1.9 Ustawienie ciemnego motywu okien Inkscape 

W tym motywie dobrym pomysłem jest włączyć opcję Use symbolic icons i dobrać ich barwę w polu Icon 

color (aby nie była zbyt jasna) – tak, jak na ilustracji powyżej.   

 

W przypadku pewnych rysunków (np. planów, schematów), warto jest wyłączyć ze skalowania grubość 

linii obrysu. Można to zrobić w oknie Preferences, panel Behavior→Transforms→Scale stroke width. 

(To ustawienie można później zmieniać w trakcie rysowania – por. str. 156).  

 
  

Sugerowane rozmiary ikon 
dla motywu hicolor  

Włącz tę opcję 

Dopasuj 

barwę ikon 
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8.2 Wprowadzenie 

Inkscape tworzy tak zwaną „grafikę wektorową”. Oznacza to, że jego rysunki są zapisywane jako zbiór precy-

zyjnych poleceń rysunkowych. Zasadniczo są to wierzchołki, połączone odcinkami prostych lub krzywych, jak w 

systemach CAD. Można je dowolnie modyfikować, a także powiększać bez pogorszenia jakości obrazu1. 

Układ okna Inkscape przypomina inne programy rysunkowe. Rysunek 8.2.1 przedstawia je jak po instalacji: 

 

Rysunek 8.2.1 Okno Inkscape 

W menu rozwijalnym u góry okna znajdziesz wszystkie polecenia programu. Na przybornikach rozłożonych 

wzdłuż jego krawędzi umieszczono skróty do najczęściej używanych poleceń i najpotrzebniejsze kontrolki. 

Główne narzędzia (tryby pracy) znajdują się w pionowym przyborniku po lewej. Poniżej menu rozwijalnego są 

umieszczone dwa paski: górny zawiera skróty do poleceń ogólnych (Uno/Redo, Copy/Cut/Paste, Open/Save). 

Niższy pasek wyświetla kontrolki zależne od aktualnego trybu (polecenia). Np. w trybie wyboru (Select) wyświe-

tla położenie i rozmiar wybranego obiektu, oraz kilka często używanych poleceń, jak np. Mirror. 

U dołu okna znajdziesz kilka dodatkowych kontrolek, związanych z barwą i przejrzystością wybranego obiektu, 

wyborem warstwy, informacją o położeniu kursora i aktualnym powiększeniu. W Inkscape 1.0 dodano tam także 

obrót całego rysunku (dokumentu). Jak dotąd nie miałem nigdy okazji używać tej funkcji. 

 
1 Dla przykładu, GIMP tworzy „grafikę rastrową”: jego obrazy są złożone z milionów pikseli (barwnych punktów), jak zdjęcia które robisz 

swoim smartfonem. Dlatego po powiększeniu 2-3 razy lub więcej obraz GIMP (lub każdy inny obraz rastrowy) staje się niewyraźny. 

Przybornik 

Wybrany obiekt 
(część rysunku) 

Położenie 
wybranego 
obiektu 

Rozmiar 
wybranych 
obiektów 

Undo/ 
Redo 

Copy/Cut/
Paste 

Menu rozwijalne 

Open/ 
Save 

Tryby przy-
ciągania 

Aktualna barwa 
i przejrzystość  Wybór 

warstw 

Aktualna 
pozycja 
kursora 

Aktualne 
powiększenie 

Obrót 

rysunku 
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Rysunki Inkscape są złożone z różnych otwartych lub zamkniętych konturów (obiektów). Ich kluczowe właści-

wości opisują ich obrys i wypełnienie. Możesz je zmieniać w panelu Fill and Stroke (Rysunek 8.2.2): 

 

Rysunek 8.2.2 Inkscape – panel Fill and Stroke 

W pasku poleceń znajduje się sekcja z pięcioma najczęściej używanymi panelami. Gdy klikniesz w jeden z jej 

przycisków, otworzy odpowiedni panel z prawej strony okna Inkscape. Możesz zmieniać szerokość tego obsza-

ru „ciągnąc” jego ramkę za pomocą myszki ( LPM). Jednak wydaje się, że każdy z tych paneli ma swoją mini-

malną szerokość, a Fill and Stroke jest najszerszym z nich (Rysunek 8.2.2 pokazuje jego minimalny rozmiar). 

Gdy klikniesz przycisk innego panelu (np. – Layers), ujrzysz go poniżej wcześniej otwartych (Rysunek 8.2.3): 

 

Rysunek 8.2.3 Okno Inkscape z dwoma panelami 

Kliknij, by otworzyć Fill and Stroke 

Można poszerzać ten obszar 
„ciągnąc” (LPM ) go myszką 

Zamyka 
ten panel 

Zmniejsza 
ten panel 

Kolor barwy 
zaznaczonego 
obiektu 

Te pięć przycisków otwierają odpowiednie panele 

Ten panel zawiera oddzielne za-
kładki z parametrami wypełnienia, 
barwy konturu, i pozostałymi usta-

wieniami konturu 

Tu możesz 
zmieniać 
przejrzystość 

Panel Fill and Stroke  

Panel Layers  

Granice paneli 
można przeciągać 
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Możesz także „złapać” myszką nagłówek panelu i „upuścić” na inny panel. To je ustawi w „stos”, który u dołu 

otrzyma pasek zakładek (Rysunek 8.2.4): 

        

Rysunek 8.2.4 Ułożenie paneli Inkscape „w stos” 

Możesz także użyć tej metody „przeciągnij i upuść” aby zmienić kolejność paneli1, lub ustawić je obok siebie (o 

ile masz odpowiednio szeroki ekran).   

 

Jeżeli “przeciągniesz i upuścisz” panel poza obszarem “dokowania”, Inkscape otworzy dla niej oddziel-

ne, „pływające” okno. 

 
  

 

 
1 Pamiętaj jednak, aby zawsze ustawić panel Layers poniżej Fill and Stroke. W tej wersji Inkscape jest mały błąd: nie można wydłużyć 

paneli poprzez przeciągnięcie jej ramki w dół, jeżeli poniżej znajduje się Fill and Stroke. Wygląda to tak, jak gdyby panele Inkscape miały 

także ustalony pewną minimalną wysokość. 

„Złap” (LPM ) 

nagłówek panelu 

Przeciągnij ją 
ponad inny panel 
i tam „upuść” 

Teraz jedna panel zasłania 
drugą. Możesz się pomiędzy 
nimi przełączać za pomocą 
tych zakładek 
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8.3 Otwieranie i zapisywanie do pliku 

Po wywołaniu polecenia File→Open Inkscape otwiera typowe okno wyboru plików systemu. W Windows 10 

wygląda ono tak, jak pokazuje Rysunek 8.3.1: 

 

Rysunek 8.3.1 Inkscape – okno wyboru pliku 

W tym oknie umieszczono także podgląd zawartości pliku podświetlonego na liście. Po naciśnięciu przycisku 

Open, wskazany obraz pojawi się w Inkscape. 

Podobnie w przypadku zapisu pliku (polecenie File→Save As) ujrzysz standardowe okno systemu (Rysunek 

8.3.2): 

  

Rysunek 8.3.2 Inkscape – okno zapisu pliku 

Jak możesz się przekonać przeglądając listę Save as type, Inkscape potrafi zapisywać obraz w wielu formatach 

wektorowych, m.in. w popularnym formacie PDF. 

Podgląd 

Obrazy Inkscape możesz zapi-
sać w wielu popularnych forma-
tach, np. Enhanced Windows 
Metafile (*.eps) lub PDF. 
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8.4 Wstawienie obrazu rastrowego 

Wywołaj polecenie File→Import. W oknie dialogowym wyboru plików, które się pojawi, wskaż jakiś plik rastrowy 

(Rysunek 8.4.1a): 

 

 

 

 

 

 

Rysunek 8.4.1 Wybór pliku rastrowego 

Gdy naciśniesz przycisk Open, Inkscape wyświetli dodatkowe okno dialogowe (Rysunek 8.4.1b). Wybierz na 

nim opcję Link. Wówczas wybrany obraz zostanie wstawiony do aktualnego rysunku (Rysunek 8.4.2): 

 

Rysunek 8.4.2 Obraz rastrowy, dołączony do dokumentu Inkscape 

Możesz przesuwać, obracać, 
skalować ten obraz tak, jak 
każdy inny element rysunku 

b) 

a) 

Wybierz 
obraz 
rastrowy 

W tej książce zawsze wybieram opcję 
Link. Uzyskuję w ten sposób mały 
rozmiar pliku SVG i automatyczną 
aktualizację importowanego obrazu  

Panel podglądu 



144 Szczegóły obsługi programów rysunkowych 

 

 

Wirtualne modelarstwo – Tom I: Przygotowania 

www.samoloty3d.pl 

8.5 Widok: powiększanie, przesuwanie 

Obsługa zmiany powiększenia (zoom)  i przesuwania obrazu (pan) jest w Inkscape taka sama jak w większości 

programów rysunkowych.  

Możesz na dwa sposoby powiększać/zmniejszać obraz na ekranie:  

• szybko i mniej dokładnie: trzymając wciśnięty Ctrl  i obracając kółkiem myszki (KM); 

• dokładnie, lecz wolniej: wpisując % powiększenia w pole u dołu okna (Rysunek 8.5.1); 

 
 

 

 

 

 

Rysunek 8.5.1 Widok: dwie metody zmiany powiększenia (Zoom) 

Przesunięcie widoku to ruch myszki z wciśniętym SPM . Możesz także użyć w tym celu pasków przewijania 

(scrollbars), umieszczonych po prawej i u dołu obszaru obrazu.  

 
Dodatkowo, zgodnie ze standardem Windows, obrót KM  powoduje przewijanie obrazu w górę i w dół. Już poza 

tym standardem, kombinacja Shift  - KM  przesuwa widok w poziomie. 

Dokładnie: wpisz tutaj 
powiększenie (w %) 

Bezpośrednio: 

Ctrl  - KM  
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8.6 Zaznaczanie obiektów (selekcja) 

Wybór (selekcja) obiektów odbywa się w Inkscape w sposób typowy dla aplikacji Windows. Zaznaczony 

obiekt/obiekty są obramowane prostokątną ramką z uchwytami (Rysunek 8.6.1).  

 

Naciśnięcie klawisz Esc  powoduje rezygnację z wykonanego wyboru (w menu rozwijalnym jest to polecenie 

Edit→Deselect) . 

 

Wybór pojedynczego obiektu to kliknięcie w jego obszar LPM . Powoduje jednocześnie wyłączenie z selekcji 

ewentualnych obiektów wybranych wcześniej (Rysunek 8.6.1):  

 

Rysunek 8.6.1 Zaznaczony, pojedynczy obiekt 

 

Gdy chcesz zaznaczyć obiekt, który nie ma wypełnienia, musisz kliknąć LPM  dokładnie w jedną z jego 

linii. Jeżeli np. wybierasz kwadrat, który nie ma wypełnionego środka, kliknięcie w jego wnętrze wcale 

go nie zaznaczy! 

 
 Aby wybrać wiele obiektów, jeden po drugim: trzymaj wciśnięty Shift  i klikaj w nie po kolei LPM  (Rysunek 

8.6.2): 

 

Rysunek 8.6.2 Zaznaczanie wielu obiektów – metoda bezpośrednia 

Jeżeli powtórnie klikniesz Shift  - LPM  w zaznaczony obiekt – zostanie wykluczony z selekcji. 

Kliknij LPM , aby 

zaznaczyć obiekt 

Ramka wokół 
zaznaczenia 

.. i tu też kliknij 

Trzymając wciśnięty 

Shift , kliknij tu LPM ... 



146 Szczegóły obsługi programów rysunkowych 

 

 

Wirtualne modelarstwo – Tom I: Przygotowania 

www.samoloty3d.pl 

 

Aby wybrać wiele obiektów za pomocą prostokątnego obszaru: wciśnij LPM  w miejscu, gdzie nie ma żadnego 

obiektu. To wyznacza jeden z narożników prostokąta; Następnie, trzymając wciśnięty LPM , przesuwaj kursor. 

Będziesz "ciągnął" w ten sposób przeciwległy narożnik obszaru selekcji. Miejsce, w którym zwolnisz LPM , wy-

znaczy rozmiar prostokąta. Wybrane zostaną wyłącznie obiekty, które mieszczą się w nim w całości (Rysunek 

8.6.3): 

 

 

Rysunek 8.6.3 Zaznaczanie obiektów obszarem prostokątnym 

1. Tu wciśnij LPM , by 

wskazać początek 
prostokąta 

3. Tu zwolnij LPM  – 

by zaznaczyć krańce 
wybranego obszaru 

2. Trzymając wciśnięty 

LPM , przesuwaj myszkę 
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8.7 Rysowanie linii  

Rysowanie linii zaczynamy od przełączenia się w odpowiedni tryb pracy – rysowania linii (Rysunek 8.7.1): 

 

Rysunek 8.7.1 Rysowanie linii w Inkscape 

Linię zaczynasz od kliknięcia LPM  w punkt, który będzie początkiem pierwszego odcinka. Od tej chwili za kurso-

rem myszki zaczyna się "ciągnąć" czerwona kreska (mimo, że nie naciskasz żadnego klawisza). Gdy po raz 

drugi klikniesz LPM  – wskażesz koniec odcinka. Linia może się składać z jednego lub więcej takich segmentów. 

Zwróć uwagę, że po wskazaniu drugiego punktu Inkscape "z własnej inicjatywy" rozpoczął "ciągnąć" kolejny 

odcinek linii.  

 

Aby usunąć ostatnio narysowany odcinek linii – naciśnij Backspace . 

 
  

 

Jeżeli rysowany odcinek ma być poziomy lub pionowy – podczas rysowania trzymaj wciśnięty Ctrl . 

 
Gdy rysujesz kontur otwarty, na koniec naciśnij Enter , by zakończyć rysowanie. 

Gdy rysujesz kontur zamknięty: podczas rysowania linii zbliż 

koniec ostatniego odcinka do początku pierwszego – tak, aby 

punkt początkowy został podświetlony (Rysunek 8.7.2). Gdy 

umieścisz w nim punkt końcowy odcinka, który rysujesz (kliknięcie 

LPM) – linia stanie się zamknięta. 

 

 

 

Rysunek 8.7.2 "Zamykanie" obrysu 

Po zbliżeniu kursora 
punkt początkowy 
staje się czerwony 

Ostatni 
segment linii 

Po narysowaniu ostatniego odcinka 

konturu otwartego, naciśnij Enter  

by zakończyć rysowanie linii 

1. Kliknij tutaj, 
by włączyć 
tryb rysowania 

2. Kliknij tutaj (LMB ) 

by rozpocząć nową 
linię. 

3. Klinij tutaj (LMB ) by zakończyć 

pierwszy odcinek... 
 

4. Kontnuuj 
następny 
odcinek 
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8.8 Wycinanie kształtów 

W Inkscape możesz „obciąć” dowolny obiekt wzdłuż zadanego konturu. Pokażę to na przykładzie obrazu. 

Wybierz obiekt(y) do obcięcia, oraz kontur tnący. Ten kontur powinien być jakimś obiektem o obrysie zamknię-

tym, położonym ponad pozostałymi wskazanymi obiektami. Rysunek 8.8.1 pokazuje przebieg operacji: 

                 

Rysunek 8.8.1 Wycinanie kontury z obrazu (rastrowego) 

Gdy obiekty są zaznaczone, wywołaj polecenie Object→Clip→Set. Spowoduje to odcięcie wszystkiego na 

zewnątrz konturu tnącego. Prostokątna ramka selekcji widoczna na ilustracji powyżej jest nieco myląca: kształt 

wyciętego fragmentu obrazu odpowiada dokładnie wskazanemu konturowi (Rysunek 8.8.2): 

 

Rysunek 8.8.2 Kształt wyciętego fragmentu obrazu 

 

Object→Clip→Release odtworzy stan początkowy, tzn. oryginalny obraz i kontur tnący. 

1. Wskaż obiekt 
do obcięcia 

2. Wskaż 
kontur tnący 

3. Wywołaj 
Object→Clip→Set 

Wycięty 
fragment   

Kształt uzyskanego fragment obrazu 
odpowiada dokładnie konturowi tnącemu 
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8.9 Linie pomocnicze (guides) 

W Inkscape możesz użyć linii pomocniczych (guides). Służą do zaznaczania jakiegoś istotnego miejsca, a także 

porównań. Tworzy się je poprzez "wyciągnięcie" z „linijek” umieszczonych po lewej lub u góry obszaru obrazu 

(Rysunek 8.9.1):  

 

 

Rysunek 8.9.1 "Pobranie" linii pomocniczej 

Linia pomocnicza nie jest częścią obrazu – nie jest drukowana ani nie pojawia się w obrazach wyeksportowa-

nych do pliku rastrowego. 

Istniejące linie pomocnicze można przesuwać. Gdy zbliżasz do nich wskaźnik myszki, linie zmieniają kolor na 

czerwony, a kursor myszki staje się „wskazującą dłonią” (Rysunek 8.9.2). W ten sposób Inkscape sygnalizuje, 

że wciśnięcie w tym obszarze LPM  i przesunięcie myszki przeniesie linię pomocniczą w nowe miejsce. Zostanie 

umieszczona tam, gdzie zwolnisz LPM . 

Aby usunąć linię pomocniczą – trzymając wciśnięty Ctrl , kliknij w nią LPM . 

Linie pomocnicze można także obracać. Środek ewentualnego obrotu jest zaznaczony za pomocą małego 

czerwonego okręgu. Rysunek 8.9.2 pokazuje, jak to zrobić:  

 

 

Rysunek 8.9.2 Obrót linii pomocniczej 

Tu wciśnij LPM  ... 

... i trzymając wciśnięty LPM  

przesuwaj myszkę w prawo 

Nowo utworzona 
linia pomocnicza 

Środek (możesz go 
przeciągnąć wzdłuż 

linii myszką z Ctrl ) 

Środek 
2. Przeciągnij tę linię (LPM ) z 

wciśniętym klawiszem Shift   

1. Zbliż kursor myszki do linii, 
aż stanie się czerwona 
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Kiedy klikniesz dwukrotnie (LPM) w linię pomocniczą (gdy jest czerwona), otworzy się okno jej właściwości 

(Rysunek 8.9.3): 

 

Rysunek 8.9.3 Zmiana właściwości linii pomocniczej 

Możesz tu zmienić kolor linii, ustalić jej dokładne położenie (współrzędne środka) i kąt obrotu. Co więcej, linie 

pomocnicze w Inkscape mogą mieć nadane etykiety i można je blokować. 

 

Gdy przyciąganie jest włączone, punkty charakterystyczne nowo utworzonych lub edytowanych obiek-

tów są przyciągane do linii pomocniczych. Czasami może to przeszkadzać. Przyciąganie możesz szyb-

ko przełączać naciskając % 1 na klawiaturze lub klikając najwyższy przycisk na pasku z trybami przy-

ciągania. 

 
  

 

1 Na klawiaturze nie ma klawisza % . Na typowej “polskiej klawiaturze programisty” trzeba nacisnąć kombinację Shift  – 5  (mam na myśli 

klawisz 5  umieszczony powyżej pierwszego rzędu liter – QWERTY). 

Linia może 
mieć etykietę 

Położenie 
środka 

Obrót 

Blokada 
przesuwania 
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8.10 Ramka selekcji 

W Inkscape, wokół każdego zaznaczonego obiektu rysowana jest ramka. Nazwijmy ją ramką selekcji.  

Początkowo ramka selekcji pojawia się zawsze w trybie "zmiany rozmiaru" (Rysunek 8.10.1). Jeżeli jednak 

jeszcze raz klikniesz w zaznaczony obiekt LPM , przełączysz się w tryb "obrotu/przekoszenia" (Rysunek 8.10.2): 

 

 

Rysunek 8.10.1 Ramka zmiany rozmiaru 

 

Rysunek 8.10.2 Ramka obrotu/przekoszenia 

Ramka obrotu zawiera bardzo ważny punkt – oś transformacji (Pivot). Jest oznaczona niewielkim krzyżykiem 

(Rysunek 8.10.2). Gdy nie możesz jej od razu dostrzec, zmniejsz aktualne powiększenie – wtedy łatwiej ją zna-

leźć.  

Oś można "złapać" (LPM) i przesunąć w inne miejsce 

(Rysunek 8.10.3).  

Oś jest wykorzystywana przez Inkscape podczas obrotu i 

przekoszenia, oraz – gdy trzymasz wciśnięty klawisz Shift  – 

podczas zmiany skali. 

 

 

 

 

Rysunek 8.10.3 Przesuwanie środka obiektu 

Złap (LPM ) i 

przesuń oś 

Uchwyty, pozwa-
lające zmienić 
rozmiar obiektu 

Oś trans-
formacji 

Uchwyty 
obrotu 

Uchwyty 
przekoszenia 
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8.11 Zmiana ustawień dokumentu 

Wywołaj polecenie File→Document Properties, aby otworzyć okno Document Properties (Rysunek 8.11.1): 

  

Rysunek 8.11.1 Właściwości dokumentu Inkscape 

Przełącz Display units na takie jednostki, w jakich jest zwymiarowany Twój samolot. Na przykład: w przypadku 

konstrukcji z USA wybierz cale, a w przypadku samolotów niemieckich – centymetry. 

Choć nie jest to niezbędne, to możesz także zmienić obszar strony, wpisując jej nowe wymiary w pola Width, 

Height sekcji Custom size. W takim przypadku dobrym pomysłem jest zmienić ich jednostki (Units) na takie 

same jak Display units. 

Czasami przydaje się zaznaczyć na rysunku obszary przejrzyste za pomocą jakiegoś kontrastowego wzoru. W 

takim przypadku włącz opcję Chceckerboard background. 

 

Okno Document Properties nie ma przycisku "OK." – zmiany zostają wprowadzone, gdy tylko zmienisz 

którykolwiek z jego parametrów. 

 
 Co więcej – to okno nie blokuje dostępu do podstawowego ekranu Inkscape. Oznacza to, że możesz mieć je 

otwarte przez cały czas pracy nad rysunkiem. 

Jeżeli Twój samolot jest zwymiarowany 
w calach, wybierz tu cale. 

Możesz także zmienić rozmiar 
strony (w takim przypadku zmień 
także te jednostki na in) 

Włącz tę opcję by 
zaznaczyć na rysunku 
przejrzyste obszary 

Kliknij tutaj, by ukryć 
ramkę strony 
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8.12 Przesunięcie 

"Złap" LPM  obiekt (tylko nie ramkę zaznaczenia!) i przesuwaj. Punkt, gdzie zwolnisz LPM , określi nowe położe-

nie obiektu. Na przykład, złap LPM  za obraz rastrowy i przesuń go do lewej krawędzi strony rysunku (Rysunek 

8.12.1). 

  

Rysunek 8.12.1 Przesunięcie obiektu 

Aby dobrze dopasować do siebie obydwa obrazy, często warto użyć linii pomocniczych (Rysunek 8.12.2): 

  

Rysunek 8.12.2 Zastosowanie linii pomocniczych do wyrównania dwóch obiektów 

Zamiast przesuwać obiekt myszką, można także wpisać dokładne współrzędne jego nowego położenia. Możesz 

to zrobić w polach X, Y, w przyborniku ponad obszarem rysunku (Rysunek 8.12.1). 

Tu możesz wpisać 
dokładne położenie 
obiektu 

Tryb Select  

Przeciągnij (LPM ) ten 

obiekt i ustaw go przy 
lewej krawędzi strony 
 

Przesuwane obiekty są 
“przyciągane” do najbliższej 
linii pomocniczej 



154 Szczegóły obsługi programów rysunkowych 

 

 

Wirtualne modelarstwo – Tom I: Przygotowania 

www.samoloty3d.pl 

8.13 Obrót 

Zaznacz obiekt, który ma być obrócony. Kliknij w niego jeszcze raz, aby przełączyć ramkę selekcji w tryb obrotu 

(szczegóły - str. 151).  

 

Przed obrotem możesz ustalić położenie osi obrotu. W ramce selekcji dla obrotu/przekoszenia ten 

punkt jest oznaczony małym krzyżykiem (Rysunek 8.13.1). Możesz go “złapać i przeciągnąć” myszką 

(szczegóły – patrz str. 151, Rysunek 8.10.3).  

 
 Złap (LPM) za jeden z narożników ramki i zacznij przesuwać. Obrót obiektu będzie zatwierdzony dla miejsca, w 

którym zwolnisz LPM  (Rysunek 8.13.1): 

 

                 

Rysunek 8.13.1 Obrót obiektu 

Aby obrót następował co 15º – podczas przesuwania myszki dodatkowo trzymaj wciśnięty klawisz Ctrl . 

 

Gdy wykonujesz precyzyjny obrót w dużym powiększeniu, często trudno jest utrzymać w tym samym 

oknie śledzony fragment obiektu i uchwyty ramki. W takim przypadku użyj dwóch okien. Wystarczy 

wywołać polecenie View→Duplicate Window. Wyświetli ono aktualny rysunek w nowym oknie Inksca-

pe. Każde z tych okien może pokazywać inny fragment rysunku, w innym powiększeniu. Przeciągaj 

uchwyt w jednym z nich, jednocześnie obserwując rezultaty w drugim. Ta metoda jest szczególnie 

przydatna na komputerach podłączonych do dwóch ekranów. 

 
 Jeżeli chcesz dokonać obrotu o dokładnie ustaloną wartość 

– otwórz panel Transform za pomocą polecenia 

Object→Transform ( Shift - Ctrl - M ). Wybierz w niej za-

kładkę Rotate (Rysunek 8.13.2). W polu Angle możesz 

wpisać dokładną wartość kąta obrotu.  

 

Rysunek 8.13.2 Panel transformacji – zakładka obrotu 

2. Złap LPM  za 

ten uchwyt... 

... i przesuń w 
nowe miejsce! 

Oś 
obrotu 

1. Kliknij w wybrany obiekt drugi 
raz, aby wyświetlić uchwyty obrotu 
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8.14 Skalowanie 

Zaznacz obiekt, który ma być zmieniony.  Następnie złap LPM  za uchwyt ramki selekcji i przeciągnij. Nowe roz-

miary obiektu będą ustalone dla miejsca, w którym zwolniłeś LPM  (Rysunek 8.14.1): 

 

 

              

Rysunek 8.14.1 Zmiana rozmiaru (skali) obiektu 

Domyślnym środkiem skalowania jest przeciwległy narożnik ramki. W trakcie przeciągania Inkscape oznacza 

aktualny środek transformacji niewielkim krzyżykiem, który znika, gdy zwolnisz klawisz myszki.  

Aby zmieniać skalę względem osi obiektu (patrz str. 151) – podczas przesuwania myszki dodatkowo trzymaj 

wciśnięty klawisz Shift . 

Aby skalować równomiernie we wszystkich kierunkach – podczas przesuwania myszki dodatkowo trzymaj 

wciśnięty klawisz Ctrl . 

 

Gdy wykonujesz precyzyjną zmianę skali w dużym powiększeniu, często trudno jest utrzymać w tym 

samym oknie śledzony fragment obiektu i uchwyty ramki. W takim przypadku użyj dwóch okien. Wy-

starczy wywołać polecenie View→Duplicate Window. Wyświetli ono aktualny rysunek w nowym oknie 

Inkscape. Każde z tych okien może pokazywać inny fragment rysunku, w innym powiększeniu. Prze-

ciągaj uchwyt w jednym z nich, jednocześnie obserwując rezultaty w drugim. Ta metoda jest szczegól-

nie przydatna na komputerach podłączonych do dwóch ekranów. 

 
 Jeżeli chcesz dokonać zmiany skali o dokładnie ustalo-

ną wartość – otwórz panel Transform za pomocą pole-

cenia Object→Transform ( Shift - Ctrl - M ). Wybierz w 

niej zakładkę Scale (Rysunek 8.14.2). W pola Width, 

Height możesz wpisać dokładne wartości nowej skali. 

  

 

Rysunki techniczne, takie jak plany modelarskie, są 

rysowane liniami o ściśle określonej grubości. Aby ją 

zachować podczas skalowania takich elementów jak 

kontury na rysunku samolotu, wyłącz przycisk umiesz-

czony po prawej stronie paska narzędzi (Rysunek 

 

Rysunek 8.14.2 Panel transformacji – zakładka skalowania 

Złap LPM  za 

ten uchwyt... 

... i przesuń w 
nowe miejsce! 

Domyślny środek 
transformacji leży na 
przeciwnym narożniku 
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8.14.3): 

 

Rysunek 8.14.3 Skalowanie fragmentu planów z zachowaniem oryginalnej szerokości linii 

Oczywiście, czasami zależy nam na tym, aby szerokość linii zmieniała się proporcjonalnie do skali obiektu. Do-

brym przykładem może być tu wzorcowy rysunek śruby i jego klony (Rysunek 8.14.4): 

 

Rysunek 8.14.4 Skalowanie szerokości linii wraz z konturem   

Aby uzyskać taki efekt, włącz przycisk pokazany na ilustracji powyżej. 

  

 

Wyłącz tę opcję, by zacho-
wać oryginalną szerokość 
linii w skalowanym fragmen-
cie rysunku 

Włącz tę opcję, aby 
proporcjonalnie zmniej-
szyć szerokość linii w 
kopiach śruby 

Wzorzec śruby 
i jego klony 
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8.15 Przekoszenie (Skew) 

Zaznacz obiekt, który ma być przekoszony. Kliknij w niego jeszcze raz, aby przełączyć ramkę selekcji w tryb 

przekoszenia (szczegóły - str. 151).  

 

Przed przekoszeniem możesz ustalić położenie osi obrotu. W ramce selekcji dla obrotu/przekoszenia 

ten punkt jest oznaczony małym krzyżykiem (Rysunek 8.15.1). Możesz go “złapać i przeciągnąć” mysz-

ką (szczegóły – patrz str. 151, Rysunek 8.10.3).  

 
 Następnie złap LPM  za jeden z uchwytów na boku ramki i przesuń. Przekoszenie obiektu będzie ustalone dla 

miejsca, w którym zwolnisz LPM  (Rysunek 8.15.1): 

 

 

                

Rysunek 8.15.1 Przekoszenie obiektu 

Aby zwiększać przekoszenie o 15º – podczas przesuwania myszki dodatkowo trzymaj wciśnięty klawisz Ctrl . 

 

Gdy wykonujesz precyzyjne przekoszenie w dużym powiększeniu, często trudno jest utrzymać w tym 

samym oknie śledzony fragment obiektu i uchwyty ramki. W takim przypadku użyj dwóch okien. Wy-

starczy wywołać polecenie View→Duplicate Window. Wyświetli ono aktualny rysunek w nowym oknie 

Inkscape. Każde z tych okien może pokazywać inny fragment rysunku, w innym powiększeniu. Prze-

ciągaj uchwyt w jednym z nich, jednocześnie obserwując rezultaty w drugim. Ta metoda jest szczegól-

nie przydatna na komputerach podłączonych do dwóch ekranów. 

 
 Jeżeli chcesz dokonać przekoszenia o dokładnie ustaloną 

wartość – otwórz panel Transform za pomocą polecenia 

Object→Transform ( Shift - Ctrl - M ). Wybierz w niej za-

kładkę Skew (Rysunek 8.15.2). W pola Horizontal, 

Vertical możesz wpisać dokładne wartości przekoszenia.  

 

 

 

 

 

 

 

Rysunek 8.15.2 Transformacja –przekoszenie 

2. Złap LPM  za 

ten uchwyt... 
... i przesuń w 
nowe miejsce! 

Oś obrotu 

1. Kliknij w wybrany obiekt drugi raz, 
aby wyświetlić uchwyty przekoszenia 
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8.16 Dokładnie określanie pozycji obiektu 

Przesunięcie za pomocą myszki zawsze jest obarczone jakimś błędem. Inkscape umożliwia – jako alternatywę 

– wpisanie dokładnych wartości numerycznych dla położenia i rozmiaru obiektu. Można to zrobić w trybie wybo-

ru obiektów. Służą do tego pola X, Y, W, H, umieszczone w przyborniku ponad rysunkiem (Rysunek 8.16.1): 

 

Rysunek 8.16.1 Obraz: ustalenie dokładnego położenia 

Najczęstsze zastosowanie tej funkcji, to dokładne pozycjonowanie obrazów na rysunku. Aby ustalić ostateczną 

pozycję, wpisz w pola X i Y współrzędne lewego górnego narożnika obrazu (Rysunek 8.16.1). Możesz także 

zmienić skalę obiektu, nadając mu nową szerokość (pole W) lub wysokość (pole H). 

 

Inkscape dolicza do rozmiaru obiektu także grubość jego obrysu (jeżeli kształt obiektu jest obrysowany 

– tzn. ma włączoną opcję Stroke – por. str. 175).  

 
Na przykład: kwadrat o rozmiarach 100x100 pikseli (px), obrysowany linią o szerokości 1px, ma rozmiary (W x 

H) 101 x 101 px. (Połowa szerokości linii obrysu nakłada się na wnętrze kwadratu). Ta sama zasada dotyczy 

współrzędnych X, Y. Aby dokładnie umieścić lewy górny narożnik kwadratu obrysowanego konturem o grubości 

1px w środku układu współrzędnych (0,0), musisz ustawić lewy górny narożnik jego ramki w X = -0.5px i Y = -

0.5px. 

 

Do uzyskania niewielkich, precyzyjnych przesunięć w poziomie lub pionie używaj umieszczonych przy 

polach X, Y, przycisków +/-.   

 

Współrzędne lewego górne-
go narożnika ramki obiektu  

Włącz tryb 
Select  

Szerokość i wysokość 
zaznaczonego obiektu 
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8.17 Eksport do obrazu rastrowego 

W Inkscape możesz wyeksportować wybrany obszar rysunku jako obszar rastrowy (odrębny plik). Obecnie ob-

sługiwany jest jeden format (*.PNG). Jednak, jeżeli potrzebujesz tego obrazu w innym formacie (np. *.jpg) mo-

żesz łatwo przekształcić taki plik używając GIMP (por. str. 131). 

Aby wyeksportować rysunek do obrazu rastrowego, wywołaj File→Export PNG Image. Inkscape otworzy wów-

czas panel Export PNG Image (Rysunek 8.17.1): 

 

 

Rysunek 8.17.1 Szczegóły eksportu do bitmapy (obrazu rastrowego)  

Sekcja Export area określa prostokątny obszar rysunku Inkscape, który ma być wyeksportowany. Możesz klik-

nąć jeden z przycisków opcji u góry paneli, które udostępniają gotowe ustawienia. Na przykład, gdy wybierzesz 

przycisk (przełącznik) Page, Inkscape umieści w polach poniżej zadeklarowany w ustawieniach dokumentu 

(por. str. 152) obszar rysunku.  

 

Do określenia Export area często wykorzystuję opcję Selection, wskazując przygotowany wcześniej 

prostokąt „ramki” (por. Rysunek 8.17.1). Taki pomocniczy prostokąt, umieszczony pod eksportowanym 

rysunkiem, pozwala mi na szybkie „wizualne” określenie eksportowanego obszaru.  

 

W sekcji Image size ustal rozmiary wynikowego obrazu rastrowego. Zrób to wpisując rozdzielczość (dpi) lub 

jeden z jego wymiarów (Width lub Height). Gdy zmieniasz jedno z tych trzech pól tej sekcji, Inkscape automa-

tycznie uaktualnia pozostałe dwa pola. 

 

Jeżeli eksportujesz wiele różnych obrazów z pojedynczego rysunku Inkscape (na przykład – wycięte z 

planów rysunki referencyjne), używaj takiej samej wartości dpi w każdej z operacji eksportu. W ten 

sposób zachowujesz jednolitą „skalę pikselową” tych obrazów. 

 

W polu Filename wpisz ścieżkę do docelowego pliku obrazu. 

 

Niech Cię nie zmyli przycisk Export As! Wykorzystuje on systemowe okno Zapisz jako do szybkiego 

wskazania ścieżki pliku, ale jego przycisk Save zapisuje tylko tę ścieżkę w polu Filename! 

Nazwa pliku obrazu 

Możesz wybrać jeden z predefiniowanych ob-
szarów, lub po prostu wpisać tutaj współrzędne 
narożników eksportowanego fragmentu rysunku 

Tu ustal rozmiar wynikowego 
pliku rastrowego (w pikselach) 

Kliknij ten przycisk by 
stworzyć wynikowy plik 
z obrazem (*.png) 

Do szybkiego określenia zapisywanego obszaru 
używam prostokąta umieszczonego pod ekspor-
towanym rysunkiem. (Wystarczy go zaznaczyć i 
kliknąć przycisk Export area:Selection). 
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Aby utworzyć plik obrazu zgodnie z aktualnymi ustawieniami widocznymi w Export PNG Image, kliknij przycisk 

Export u dołu panelu. 

 

Do wynikowego pliku *.png zapisywana jest tylko zawartość tych warstw Inkscape, które były widoczne 

w chwili kliknięcia przycisku Export. 

 
 W sekcji Advanced znajduje się pewna opcja, która może być użyteczna w przypadku eksportowania tekstur 

tak zwanych „map nierówności”. To obrazy paneli i nitów poszycia (ang. „bump maps”). Nakładające się panele 

poszycia samolotu będziemy odtwarzać w Inkscape za pomocą wielu obszarów wypełnionych gradientami. Aby 

poprawić jakość map nierówności w Blenderze, możesz przełączyć ich Bit depth z domyślnej RGBA_8 na 

Gray_16 (Rysunek 8.17.2): 

    

Rysunek 8.17.2 Zaawansowane opcje exportu tekstur „map nierówności”  

Oczywiście, dla wszystkich tekstur barwy używaj RGBA_8. Nie zapomnij sprawdzić tych ustawień, jeżeli po-

przednio wyeksportowałeś teksturę nierówności z opcją Gray_16! 

 

 

Jeżeli eksportowany plik ma być użyty jako tekstura, postaraj się, by miał taką samą wysokość i szero-

kość. Jeszcze lepiej, gdy rozmiar obrazu w pikselach jest jakąś potęgą liczby 2. Zazwyczaj stosuje się 

rozmiary 512, 1024, 2048, lub 4096 pikseli. 

 

 

 

 

 

Ustaw Bit depth 
wynikowego obrazu 
na Gray_16 

Kliknij tutaj by rozwinąć 
sekcję Advanced  
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8.18 Warstwy – zarządzanie 

Tak jak w większości programów rysunkowych, w Inkscape można grupować zawartość rysunku w warstwy. 

Idea jest prosta: obiekty zgrupowane w warstwie powyżej zasłaniają obiekty z warstwy poniżej. Aby przekonać 

się, jak to działa, porównaj obiekty i warstwy dokumentu Inkscape przedstawionego przez Rysunek 8.18.1: 

 

Rysunek 8.18.1 Panel zarządzania warstwami 

Panel zarządzania warstwami można otworzyć wywołując polecenie Layer→Layers ( Shift - Ctrl - L ), lub kliknię-

ciem w odpowiednią ikonę przybornika. Panel zapewnia pełną kontrolę ich stanu. Możesz ją (i wszystkie inne 

panele) "schować" lub przywołać z powrotem naciskając F12  (View→Show/Hide Dialogs). 

Większość z poleceń, które pokazuje Rysunek 8.18.1 jest także dostępna w menu rozwijalnym Layer. Jednak 

część z nich możesz wykonać poprzez bezpośrednią manipulację elementami stosu (listy) warstw. Na przykład, 

na ilustracji powyżej widać, jak można zmienić nazwę warstwy1. 

Poniżej pokazuję, jak przesunąć warstwę wzdłuż stosu: wystarczy „złapać” ją myszką ( LPM), przesunąć i „upu-

ścić” w miejscu docelowym (Rysunek 8.18.2): 

             

Rysunek 8.18.2 Zmiana kolejności warstw 

Zwróć uwagę na zieloną linię, która podczas przesuwania warstwy zaznacza aktualną pozycję na stosie. 

 
1 Istnieje także alternatywne polecenie: Layer→Rename Layer. Otwiera ono małe okno dialogowe, w którym możesz wpisać nową nazwę. 

Przełączanie 
widoczności  

Blokada 
zawartości 

Kliknij w nazwę, 
by ją zmienić 

Dodanie 
nowej 
warstwy 

Przesuwanie 
aktualnej warstwy 
po liście (stosie) 

Usunięcie 
aktualnej 
warstwy 

Podświetlona 
(aktualna) 
warstwa 

„Złap” tę 
warstwę 

(LPM )…  

… przeciągnij w 
nowe miejsce… 

…i tam ją 
„upuść” 
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W podobny sposób możesz przekształcić prosty stos (listę) warstw w bardziej złożoną hierarchię. Wystarczy 

wstawić jedną warstwę do wnętrza drugiej (Rysunek 8.18.3): 

              

Rysunek 8.18.3 Tworzenie hierarchicznej struktury warstw 

Poniżej listy warstw znajdują się trzy duże kontrolki. Zwróć szczególną uwagę na suwak Opacity. Steruje przej-

rzystością wybranej (aktywnej) warstwy. Będziesz go często używać (Rysunek 8.18.4): 

 

Rysunek 8.18.4 Zmiana przejrzystości warstwy 

Zwróć także uwagę na interesujący efekt rozmycia (Blur - Rysunek 8.18.5): 

 

Rysunek 8.18.5 Rozmycie zawartości wybranej warstwy 

Przeciągaj tę warstwę, aż Inkscape wy-
świetli ramkę wokół warstwy docelowej 

Ten trójkąt i odstęp sygnalizują, 
że Text jest podwarstwą Layer 2 

 

Teraz możesz widzieć zawartość 
warstw umieszczonych poniżej 

Zmniejsz nieprzejrzystość 
tej warstwy 

Zwiększ Blur tej 
warstwy do 25% 

To “rozmywa” jej zawartość 

Upuść ją tutaj 
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W Inkscape możesz sterować sposobem łączenia (Blend mode) pikseli z aktywnej warstwy. Jest to lista opera-

cji na barwach (por. str. 260), które Inkscape wykonuje na pikselach obecnej warstwy i obrazie zsumowanym z 

wszystkich warstw poniżej. Przy porównywaniu różnych planów może się tu przydać tryb Multiply. Pozwala 

„patrzeć poprzez” czarno-biały obraz zachowując nieprzejrzystość jego linii (Rysunek 8.18.6): 

 

Rysunek 8.18.6 Rezultat łączenia warstwy w trybie Multiply 

Oprócz paneli zarządzania, Inkscape ma dodatkową kontrolkę u dołu ekranu (Rysunek 8.18.7). Za pomocą tej 

listy rozwijalnej i dwóch przełączników można: 

• zmienić aktualną warstwę; 

• włączyć lub wyłączyć widoczność warstwy; 

• włączyć lub wyłączyć blokadę zmian dla obiektów umieszczonych na warstwie. 

 

Rysunek 8.18.7 Elementy szybkiego zarządzania warstwami 

Z kontrolki umieszczonej u dołu ekranu korzysta się najczęściej, gdyż nie zajmuje tyle cennej przestrzeni ekra-

nu, co panel Layers. Zwróć uwagę na pewne konwencję prezentowania nazwy warstw na liście rozwijalnej: 

• nazwa zablokowanej warstwy jest ujęta w nawiasy kwadratowe;  

• nazwa warstwy ukrytej jest szare, a nie czarna.  

 

W ten sposób, zaraz po rozwinięciu listy, możesz się szybko zorientować co do stanu każdej z warstw. 

Ustaw Blend mode tej 
warstwy na Multiply 

 

Wszystkie białe obszary Layer 2 
stały się zupełnie przejrzyste, 
podczas kiedy czarne linie są 
nadal w 80% nieprzejrzyste 

 

Przełączanie 
widoczności i 

blokady 

Wybór aktualnej warstwy 

Niewidoczna 
warstwa 

Zablokowana 
warstwa 
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8.19 Warstwy – dodanie nowej 

Otwórz panel Layers (Layer→Layers). Na panelu naciśnij przycisk . Możesz także (alternatywnie) użyć po-

lecenia z menu: Layer→Add Layer.... Pojawi się okno dialogowe nowej warstwy (Rysunek 8.19.1): 

 

Rysunek 8.19.1 Dodawanie nowej warstwy 

W oknie Add Layer wpisz w pole Layer name nazwę nowej warstwy. W polu Position możesz ustalić, w którym 

miejscu na liście ma być umieszczona (względem warstwy aktualnej). Następnie kliknij przycisk Add. Rysunek 

8.19.2 pokazuje rezultat: 

 

Rysunek 8.19.2 Nowa warstwa 

Możesz także stworzyć hierarchiczne „drzewo”  warstw: wystarczy wybrać w oknie Add Layer opcję A sublayer 

of current (Rysunek 8.19.3): 

                          

Rysunek 8.19.3 Wstawienie podwarstwy 

2. Wpisz tu 
nazwę nowej 
warstwy 

1. Kliknij w 
ten przycisk 

3. Ustal położenie nowej 
warstwy względem pod-
świetlonej (bieżącej) 

Nowo dodana warstwa 

Za pomocą tych klawiszy 
możesz zmienić kolejność 
warstw 

Stworzona niechcący? 
Tu możesz ją usunąć 

Wybierz tę 
opcję 

Podwarstwa 
Layer 2 
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8.20 Przeniesienie obiektu na inną warstwę 

Zaznacz obiekty, które chcesz przenieść na inną warstwę, i wywołaj polecenie Layer→Move Selection to 

Layer. Otworzy to okno dialogowe z listą warstw (Rysunek 8.20.1): 

                            

Rysunek 8.20.1 Okno wyboru warstwy docelowej 

Podświetl na liście warstwę docelową i kliknij w przycisk Move. 

 

W oknie Move to Layer podwarstwy są zawsze „zwinięte” – kliknij w warstwę główną, aby je rozwinąć.  

 
 Kiedy docelowa warstwa jest zupełnie nieprzejrzysta i bez rozmycia, jedynym widocznym wynikiem tej operacji 

jest zmiana w nazwie bieżącej warstwy wyświetlanej w pasku stanu. Inkscape wyświetla tam warstwę ostatnie-

go zaznaczonego obiektu. Rysunek 8.20.2 przedstawia, jak to wygląda przy przesunięciu obiektu pokazanym 

przez Rysunek 8.20.1 (powyżej): 

                     

Rysunek 8.20.2 Efekt zmiany warstwy, widoczny na pasku stanu 

 

Gdy warstwa źródłowa jest częściowo nieprzejrzysta (powiedzmy, w 70%), Inkscape przypisuje tę wła-

ściwość do obiektu, który opuszcza tę warstwę. W efekcie, gdy docelowa warstwa jest w 50% nieprzej-

rzysta, efektywna nieprzejrzystość przeniesionego obiektu zmniejsza się do 35% (70%*50%). Możesz 

ten efekt skorygować poprzez zwiększenie indywidualnej nieprzejrzystości obiektu do 100%.  

 
 Niestety, polecenie Move Selction to Layer nie ma żadnego skrótu klawiatury.  

Istnieją także dwa inne polecenia, które „sekwencyjnie” zmieniają warstwę obiektu: 

• przeniesienie na wyższą warstwę ( Shift - PgUp , albo Layer→Move Selection to Layer Above); 

• przeniesienie na niższą warstwę ( Shift - PgDn , albo Layer→Move Selection to Layer Below). 

 

Kliknij tutaj, aby 
rozwinąć podwarstwy  

Move Selection 
to Layer 

Początkowa 
warstwa: 
Layer 1  

Docelowa warstwa: 
Less important layer  
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8.21 Warstwy – usuwanie 

Otwórz panel Layers (Layer→Layers). Na panelu podświetl warstwę do usunięcia i naciśnij przycisk  

(Rysunek 8.21.1): (): 

 

                               

Rysunek 8.21.1 Usunięcie warstwy 

Możesz także – alternatywnie – użyć polecenia z menu: Layer→Delete Current Layer. 

2. Kliknij ten 
przycisk  

Layer  3 

usunięta  

1. Podświetl usuwaną 

warstwę  
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8.22 „Lustrzane odbicie” obiektu 

Zaznacz obiekt i wywołaj polecenie Object→Flip Horizontal (lub naciśnij H ). Możesz także kliknąć odpowied-

nią ikonę z paska przybornika (Rysunek 8.22.1): 

 

 

 

 

Rysunek 8.22.1 Przykład lustrzanego odbicia obrazu 

Sekcja „prostych transformacji” z paska narzędzi zawiera cztery polecenia (Rysunek 8.22.2): 

 

 

 

Rysunek 8.22.2 Ikony transformacji obiektu udostępnione w pasku przybornika 

 

Domyślny motyw okna Inkscape używa dla tych czterech poleceń innych ikon (por. str. 137).  

  
 

 

 

W odróżnieniu od poleceń Flip*, polecenia Rotate 90° * obracają obiekt wokół jego osi (pivot point). 

  

Kliknij ten przycisk 

Inkscape “odbija” obiekty względem ich 
geometrycznego środka, więc poziome 
położenie tej sylwetki wymaga poprawki 

Flip Vertical ( V ) 

Flip Horizontal ( H ) Rotate 90° CW ( Ctrl - ] ) 

Rotate 90° CCW ( Ctrl - [ ) 
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8.23 Zabarwianie czarno-białego obrazu 

Gdy porównujesz ze sobą złożone schematy (jak dokładne plany samolotu), czasami warto zmienić barwę ich 

czarnych (lub szarych) linii na inną, kontrastową. W tym celu możesz użyć tzw. „filtrów”. 

Wybierz obraz, który chcesz zabarwić, i wywołaj Filters→Color→Channel Painting (Rysunek 8.23.1): 

 

Rysunek 8.23.1 Wywołanie filtra Channel Painting 

W odpowiedzi, Inkscape otwiera okno dialogowe filtra (Rysunek 8.23.2): 

 

Rysunek 8.23.2 Zmiana opcji filtra 

Okno Channel Painting zawiera dwie zakładki: Options i Color. Najpierw przestaw pola Options do następują-

cych wartości: Red = - 3.50, Green = 5.00, Blue = 5.00, Alpha = - 5.00, następnie włącz Live preview. Zoba-

czysz wówczas efekt filtra na zaznaczonym obrazie. 

Jak widać, ten filtr zmienił barwę wszystkich czarnych linii tego obrazu rastrowego: w tym przypadku na błękit-

ne, lecz na Twoim komputerze może to być inny kolor. 

2. Otwórz ten filtr 

1. Wybierz obraz 

Ustaw parametry 
tak, jak tutaj 

Włącz tę opcję 
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Teraz przełącz się do zakładki Color i przypisz tym liniom taki kolor, jaki chcesz (Rysunek 8.23.3): 

 

Rysunek 8.23.3 Zmiana barwy filtra 

Gdy dobrałeś właściwą barwę – kliknij przycisk Apply, a potem Close. 

 

Kiedy klikniesz przycisk Apply, Inkscape wyłączy Live preview. Mimo to obraz będzie wyglądał jak 

przedtem, tzn. jego linie będą zabarwione na wybraną przez Ciebie barwę. Nie klikaj drugi raz w Apply, 

bo to tylko „zdubluje” efekt filtra. 

 
 Jeżeli chcesz zrezygnować z tej operacji – kliknij tylko przycisk Close (tzn. nie klikaj w Apply). 

 

Aby usunąć przypisany do obiektu filtr, użyj polecenia Filters→Remove Filters.  

 
  

Wybierz 
barwę linii 

Kliknij ten przycisk by 
zatwierdzić zmianę 
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8.24 Zmiana kolejności obiektów 

W Inkscape każdy obiekt jest umieszczony "ponad" albo "poniżej" innych. Przyjrzyjmy kwadratowi i elipsie, 

umieszczonym na tej samej warstwie (Rysunek 8.24.1). Elipsa zasłania kwadrat – jest obiektem pierwszopla-

nowym: 

 

  

Rysunek 8.24.1 Oryginalna kolejność obrazów 

Zaznacz elipsę. Następnie wywołaj polecenie Object→Lower to Bottom. Sytuacja ulegnie zmianie (Rysunek 

8.24.2): 

 

  

Rysunek 8.24.2 Kolejność obrazów po przesunięciu pierwszoplanowego "na dno". 

Spośród czterech poleceń, za pomocą których można w Inkscape zmieniać kolejność obiektów, w praktyce 

używałem tylko dwóch: 

• Object→Lower to Bottom (skrót klawiatury: End , ikona: ): umieszcza zaznaczony obiekt poniżej 

wszystkich innych; 

• Object→Raise to Top (skrót klawiatury: Home , ikona: ): umieszcza zaznaczony obiekt powyżej 

wszystkich dotychczas narysowanych. 

 

Omawiane powyżej polecenia zmieniają kolejność obiektów tylko w obrębie pojedynczej warstwy. (Aby 

przenieść obiekt do innej warstwy – patrz str. 165).  

 

 

Każdy nowy obiekt, który tworzysz, jest umieszczany ponad wszystkimi narysowanymi do tej pory.  

 

 

Obiekt pierwszoplanowy 
(tzn. "na wierzchu") 

...a elipsa znalazła się 
na samym spodzie  

Teraz kwadrat stał się 
pierwszoplanowy... 

Obiekt pod 
spodem  

Lower to Bootom – 

przemieść "na spód"  
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8.25 Łączenie obiektów w grupę 

Zaznacz elementy, z których chcesz stworzyć grupę, i wywołaj Object→Group ( Ctrl - G ) (Rysunek 8.25.1): 

 

Rysunek 8.25.1 Grupowanie obiektów 

Inkscape traktuje grupę obiektów jak pojedynczy element, który można skalować, obracać, itp. 

 

Gdy grupowane obiekty znajdują się na różnych warstwach, ta informacja jest utracona. Inkscape 

umieszcza nowo utworzoną grupę na warstwie, na której znajduje się ostatni zaznaczony obiekt.  

 
 Jeżeli grupowane obiekty są na różnych warstwach, i jedna z tych warstw jest częściowo przejrzysta, natych-

miast zauważysz różnicę. Po wywołaniu polecenia Group wyższy element może zasłonić niższy, bo teraz zna-

lazły się na tej samej warstwie (Rysunek 8.25.2): 

                

Rysunek 8.25.2 Przykład utraty przejrzystości w wyniku grupowania  

1.  Zaznacz 
obiekty. 

2. Wywołaj polecenie Group 
 

Niebieski obraz jest 
na niższej warstwie 

Czarny obraz jest 
na wyższej war-
stwie (częściowo 
przejrzystej) 

Group 

Czarny obraz 
zupełnie zasłonił 

niebieski 
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Na szczęście, napraw tego efektu jest prosta: możesz zmienić indywidualną przejrzystość (por. str. 176) górne-

go obrazu. W Inkscape można edytować zawartość grupy. Wystarczy kliknąć w nią podwójnie (LPM ), aby 

„wejść” do jej wnętrza (Rysunek 8.25.3): 

     

Rysunek 8.25.3 Przejście do wnętrza grupy  

Zauważ, że gdy wejdziesz do wnętrza grupy, Inkscape wyświetla jej nazwę w pasku stanu (np. #g1504), jako 

nazwę aktualnej warstwy (Rysunek 8.25.3). Na tej „warstwie” możesz robić wszystko to, co robisz z obiektami 

ze „zwykłej” warstwy. W szczególności możesz zmienić przejrzystość jednego z obrazów (Rysunek 8.25.4): 

    

Rysunek 8.25.4 Zmiana właściwości wybranego elementu grupy  

Kliknij dwukrotnie 
(LPM ) w grupę… 

.. i jesteś w jej 
wnętrzu! 

Ta grupa jest na 
warstwie Top 

Zmniejsz nieprzejrzystość czarnego obra-
zu ze 100% do 50%, by zobaczyć niebieski 
obraz umieszczony pod spodem 
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Aby wyjść z wnętrza grupy, można z menu kontekstowego (PPM) wywołać polecenie Goto parent, lub wybrać z 

listy umieszczonej na pasku stanu inną warstwę (Rysunek 8.25.5): 

 

Rysunek 8.25.5 Wyjście z wnętrza grupy  

 

Warstwy Inkscape są specjalnym rodzajem grup. (Ponieważ nie można ich zaznaczać jak obiektów).  

  
 

 

Operacją odwrotną do grupowania jest Object→Ungroup Shift - Ctrl - D . „Rozkłada” grupę na elemen-

ty, z których powstała. Transformacje (obrót, przesunięcie, skala), jakim została poddana grupa, zosta-

ją zachowane.  

  
Możesz użyć grup i klonowania w odtwarzaniu szczegółów poszycia samolotu, np. – śrub (Rysunek 8.25.6): 

 

Rysunek 8.25.6 Przykład użycia grupy obiektów i jej klonów  

Najpierw stworzyłem grupę śruby. Następnie ją sklonowałem (Edit→Clone→Create clone), zmniejszyłem tę 

kopię (zmniejszając jej skalę) i umieściłem na rysunku paneli jako pierwszą ze śrub. Wszystkie pozostałe śruby 

są kopiami (Edit→Duplicate, lub Ctrl - D ) tego pierwszego klona. Zwróć uwagę, że mogłem każdą z nich obró-

cić, tworząc bardziej naturalne wrażenie. 

Takie rozwiązanie pozwala mi zachować kontrolę nad zawartością tych wszystkich klonów. Na przykład, jeżeli 

zdecyduję się zmienić barwę wypełnienia tych wszystkich śrub, muszę tylko zmienić ustawienia wypełnienia w 

obiekcie „wzorcowym” (tj. w grupie). Inkscape natychmiast je powieli na wszystkie klony (Rysunek 8.25.7): 

 

Rysunek 8.25.7 Zmiana zawartości grupy zmienia jej wszystkie klony  

Wybierz inną warstwę 

Te śruby są klonami tej grupy 

To grupa trzech obiektów 
(“wzorzec” śruby) 

Zmieniłem kolor wypełnienia tego okręgu na szary, 
i to natychmiast zmieniło wszystkie klony tej grupy 
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Dobrą praktyką w przypadku takich „wzorców” jest zmiana ich nadawanych automatycznie nazw na bardziej 

zrozumiałe. Aby to zrobić, zaznacz grupę i wywołaj polecenie Object→Object Properties. Spowoduj to otwar-

cie panelu Object Properties (Rysunek 8.25.8): 

 

Rysunek 8.25.8 Zmiana nazwy grupy  

W tym panelu możesz wpisać nowy identyfikator (ID) i nazwę (Label) obiektu, w szczególności – grupy. (Zale-

cam wpisywanie jako nazwy identyfikatora, ale poprzedzonego znakiem „#”). Pamiętaj o kliknięciu na koniec 

przycisku Set, bo w przeciwnym razie nic nie zostanie zapisane! 

 

 

Identyfikator obiektu musi być unikalny w obrębie pliku Inkscape, tzn. każdy z Twoich wzorców musi 

mieć inny ID.   

  
 

Zaznacz grupę i otwórz 

panel z jej właściwościami 

Zmień ID i Label, a następ-
nie kliknij przycisk Set. 
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8.26 Właściwości kształtu 

Każdy obiekt w dokumencie Inkscape – poza obrazem rastrowym – jest figurą geometryczną, złożoną z dwóch 

elementów: 

• linii konturu (stroke);  

• wypełnienia (fill).  

 
Do zmiany wypełnienia i linii konturu obiektu(ów) służy panel Fill and Stroke (Rysunek 8.26.1): 

  

Rysunek 8.26.1 Okno właściwości kształtu (Fill and Stroke) 

W zakładce Stroke style ustalasz grubość i deseń linii obrysu. W zakładce Stroke paint ustalasz barwę (lub 

gradient) linii (Rysunek 8.26.2): 

  

Rysunek 8.26.2 Zmiana barwy linii – zakładka Stroke paint 

Kliknij tę ikonę by otworzyć 
panel Fill and Stroke  

Typ linii obrysu  

Szerokość obrysu  

Wypełnienie 
Kontur 
(obrys) 

Tutaj można zmienić 
przejrzystość i rozmycie 
pojedynczego obiektu 

Aktualna barwa obrysu: Flat (jednolity) color 

Jeszcze inna 
opcja: wzór 

Inna opcja barwy: gradient 
(liniowy lub eliptyczny) 

Wybór jednolitego koloru: 
(A oznacza Alpha, czyli 
nieprzejrzystość) 
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Zakładka sterująca wypełnieniem obiektu to Fill. Zawiera 

identyczne kontrolki jak Stroke paint.  

 

Spośród możliwych trybów wypełnienia wyróżnia się pierw-

sza opcja od lewej –  (Rysunek 8.26.3). Gdy ją wybie-

rzesz w zakładce Fill, obiekt w ogóle nie będzie miał wy-

pełnienia. (Analogicznie, wybór tej opcji w Stroke paint 

spowoduje, że obiekt w ogóle nie będzie miał obrysu). 

 

 

Inkscape pozwala sterować nieprzejrzystością pojedynczego obiektu dokładnie tak samo, jak steruje się nie-

przejrzystością całych warstw. Możesz ją zmieniać w panelu Fill and Stroke (Rysunek 8.26.1). Możesz także 

zrobić to samo za pomocą niewielkiej kontrolki O(pacity) umieszczonej w pasku stanu (Rysunek 8.26.4): 

            

Rysunek 8.26.4 Zmiana nieprzejrzystości obiektu (Opacity) 

 

Wybór w obydwu zakładkach: Fill i Stroke paint opcji no paint tworzy niewidzialny obiekt. Jeżeli popeł-

nisz taki błąd, nie będziesz go mógł wybrać kliknięciem. Zamiast tego użyj zaznaczenia za pomocą 

ramki. 

 
  

 

Jeśli wybierzesz wiele obiektów, ustawienia z panelu Fill and Stroke będą zapisane do wszystkich. To 

prosta metoda do wprowadzania do rysunku masowych zmian. 

 
  

 

Parametr O(pacity) to ogólna nieprzejrzystość całego obiektu. Aby uzyskać półprzejrzysty obrys z nie-

przejrzystym wypełnieniem, lub półprzejrzyste wypełnienie z nieprzejrzystym obrysem, użyj składnika 

A(lpha) w ustawieniach jednolitego koloru wypełnienia/obrysu. 

 
  

 

 

 

Rysunek 8.26.3 Wyłączenie wypełnienia wnętrza obiektu 

Wyłączone (w ogóle 
nie jest rysowane) 

Opacity = 100%: kształt 
jest nieprzejrzysty 

Opacity = 85%:  zasłonięta 
część kwadratu staje się 
widoczna 
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8.27 Edycja linii 

Linie (a właściwie – "ścieżki", bo Inkscape określa je jako paths), które narysowałeś, możesz później modyfiko-

wać. Służy do tego oddzielny tryb – edycji węzłów (Rysunek 8.27.1). (Węzłem linii jest każdy z jej wierzchoł-

ków): 

 

Rysunek 8.27.1 Edycja wierzchołków wybranej linii 

W tym trybie każdy punkt linii (węzeł) jest oznaczony małym rombem. Możesz za nie „łapać” (LPM) i przesuwać 

w nowe miejsca. Obowiązują tu dokładnie te same reguły, co przy edycji całych obiektów. Pojedyncze kliknięcie 

w węzeł oznacza go jako wybrany (węzeł wybrany zmienia swój kolor na niebieski). Jeżeli podczas wskazywa-

nia węzłów będziesz trzymać wciśnięty klawisz Shift  - możesz zaznaczyć wiele punktów naraz. Możesz je także 

zaznaczać obszarem prostokątnym. 

 

Aby dodać do linii nowy wierzchołek – kliknij dwukrotnie LPM  w segment, w miejscu, w którym Inkscape 

ma wstawić nowy węzeł. 

 
  

 

Aby usunąć wybrany węzeł/węzły – naciśnij klawisz Del . To zazwyczaj powoduje zmianę kształtu linii. 

  

Zaznacz węzły ścieżki 

Możesz “złapać” (LPM ) i 

przesunąć te punkty 

Współrzędne zaznaczonego 
wierzchołka (węzła) 

Włącz tryb Edit 

nodes ( N ) 
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8.28 Linie krzywe 

Aby stworzyć linię krzywą, wystarczy w trakcie rysowania kolejnego segmentu (por. str. 147) trzymać przez cały 

czas wciśnięty LPM . Muszę jednak przyznać, że dla dokładnego odwzorowania kształtu ta metoda jest trochę 

nieodpowiednia. W każdym razie "na co dzień" robię to w dwóch krokach: 

1. tworzę przybliżony obrys rysując zwykłą linię łamaną (patrz str. 147, 177); 

2. przekształcam kolejne segmenty łamanej w odcinki krzywej. 

 
Aby zmienić kształt linii łamanej w krzywą, musisz się przełączyć w tryb edycji (Edit nodes). Potem wystarczy 

"złapać" za segment linii (LPM ) i wygiąć w odpowiedni kształt (Rysunek 8.28.1): 

        

Rysunek 8.28.1 Linia krzywa uzyskana poprzez "wyciągnięcie"  

Alternatywną metodą jest zamiana poszczególnych węzłów (wierzchołków) z "ostrych" na "gładkie", poprzez 

naciśnięcie ikony . Rysunek 8.28.2 przedstawia, na czym to polega: 

        

Rysunek 8.28.2 Linia krzywa uzyskana poprzez zmianę typu węzła na "gładki, symetryczny" 

W węźle pojawiły się dwie styczne do krzywej. Możesz sterować kształtem linii zmieniając ich pochylenie i dłu-

gość. Przedstawiony na rysunku węzeł jest "symetryczny", co oznacza, że zmiana jednej stycznej powoduje 

identyczną zmianę drugiej. Dzięki temu wygięcie 

będzie bardziej "płynne", gdyż krzywe z obydwu 

stron węzła mają w tym miejscu taki sam promień 

krzywizny.  

Jeżeli nie zależy Ci na aż tak "dokładnych" zaokrą-

gleniach – możesz węzeł przełączyć w tryb  

(Rysunek 8.28.3). Wtedy styczne z każdej strony 

węzła będą utrzymywały współliniowość. Mogą się 

jednak różnić długością. 

 

Rysunek 8.28.3 Węzeł gładki, niesymetryczny  

 

Styczne mogą 
mieć nierówną 
długość 

…i przeciągnij! ...złap (LPM ) środek 

segmentu... 
 

Włącz tryb 
Edit nodes... 
 

1. Zaznacz 
ten węzeł  

2. Kliknij w 
tę ikonę 

Węzeł “gładki” 

Przesuń tę końcówkę by 
zmienić kształt krzywej  



Rozdział 8 Inkscape – szczegóły obsługi 179 

 

 
 (CC) Witold Jaworski, 2009 – 2020. 

 

Krzywe, uzyskane w ten sposób, "na oko" wyglądają na gładkie. Gdy jednak styczne w węźle różnią się 

długością, występuje w nich skokowa zmiana promienia krzywizny. 

 
 

Gdy chcesz uzyskać w węźle „narożnik” – przełącz się w tryb . Wtedy możesz manipulować każdą ze stycz-

nych oddzielnie  (Rysunek 8.28.4): 

 

 

Rysunek 8.28.4 Węzeł ostry  

Ostateczny kształt krzywej uzyskujesz, przekształcając kolejne węzły na "gładkie" i – zazwyczaj – symetryczne 

(Rysunek 8.28.5). Zaczynasz ten proces od jednego krańca linii łamanej. Sukcesywnie przekształcasz w krzywą 

i nadajesz właściwy kształt kolejnym segmentom, dopóki nie dotrzesz do końca linii. 

 

Rysunek 8.28.5 Krzywa z wieloma wierzchołkami 

Podobnie jak podczas edycji linii łamanych:  

• aby dodać nowy wierzchołek, kliknij dwukrotnie LPM  w miejscu, gdzie ma powstać. 

• aby wierzchołek usunąć – zaznacz go i naciśnij Delete .  

Ten wierzchołek 
wygładziliśmy jako 
pierwszy 

Ten wierzchołek 
był drugi 

Styczną na krańcu linii 
można "wyciągnąć" z 

węzła: Shift -LPM  

Styczne są 
niezależne 
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8.29 Odwzorowanie krzywizny 

W tej sekcji pokażę, jak za pomocą krzywych odwzorować kontur steru kierunku (odwzorowanie innego typo-

wego przypadku: łuku – jest opisane na str. 185). Jeżeli do tej pory w Inkscape rysowałeś tylko linie łamane – 

zerknij na str. 178. Znajdziesz tam wprowadzenie do tworzenia linii krzywych w Inkscape. 

Najpierw obrysuj kontur linią łamaną (Rysunek 8.29.1a). Wierzchołki linii wstawiaj w takich miejscach, by naj-

większe wybrzuszenie krzywej leżało w równej odległości od początku i końca odcinka (Rysunek 8.29.1b).  

              

Rysunek 8.29.1 Wstępny obrys steru kierunku – odcinkami prostych 

 

Po narysowaniu linii, włącz tryb edycji wę-

złów (Edit nodes). Zamień łamaną na 

krzywą, wygładzając kolejne wierzchołki (p. 

str. 179). Dla kolejnych węzłów (poza krań-

cowymi): 

• zaznacz węzeł jako "symetrycznie 

gładki" (Rysunek 8.29.2); 

• dostosuj krzywiznę za pomocą 

stycznych. Czasami trzeba także 

przesunąć węzeł. 

Podczas wygładzania może się także zda-

rzyć, że zdecydujesz się jakiś węzeł dodać 

(podwójne kliknięcie LPM) lub usunąć (za-

znaczenie węzła i naciśnięcie klawisza 

Delete ). 

 

Rysunek 8.29.2 Wygładzanie linii łamanej 

a) b) 

Maksymalne 
wybrzuszenie 
– w środku 
segmentu 

1 2 

3 

Obrysuj kontur 
linią łamaną 

Przełączenie węzła na 
"symetrycznie gładki". 
(Obydwie styczne mają ten 
sam kierunek i długość) 
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8.30 Rysowanie prostokąta 

Przełącz się w tryb rysowania prostokątów (Rysunek 8.30.1): 

 

Rysunek 8.30.1 Rysowanie kwadratu 

Wciśnij LPM  w miejscu, gdzie ma się znajdować jeden z narożników prostokąta. Następnie, trzymając wciśnięty 

LPM , przesuwaj kursor. Będziesz "ciągnął" w ten sposób przeciwległy narożnik prostokąta. Aby uzyskać kształt 

kwadratu, trzymaj jednocześnie wciśnięty Ctrl . Miejsce, w którym zwolnisz LPM , wyznaczy przeciwległy naroż-

nik obiektu. 

 

 

1. Włącz tryb 
rysowania pro-
stokątów 

2. Naciśnij LPM : tutaj będzie 

pierwszy narożnik... 

3. Gdy przeciągasz myszkę, 

możesz także wcisnąć Ctrl , aby 

zachować kształt kwadratu (do-
kładniej: boki o proporcji 1:1)... 

4. Zwolnij LPM : tutaj 

będzie przeciwległy 
narożnik. 
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8.31 Rysowanie elipsy 

W Inkscape okręgi rysuje się tak samo jak kwadraty (por. str. 181). Wybierasz tylko inny tryb rysowania: okrę-

gów (oznaczony ikoną: ). Następnie naciskasz LPM  w miejscu, gdzie mają sięgać lewe, górne granice elipsy. 

Przeciągasz kursor z wciśniętym LPM , i zwalniasz ten przycisk w miejscu, do którego mają sięgać prawe, dolne 

granice elipsy (Rysunek 8.31.1): 

 

Rysunek 8.31.1 Rysowanie okręgu 

Podobnie jak w przypadku kwadratów, ważne jest wciśnięcie klawisza Ctrl  podczas "przeciągania" drugiego 

punktu, bo inaczej narysujesz elipsę. 

 

Aby wyznaczyć nowy okrąg poprzez wskazanie środka i promienia – podczas przeciągania myszki 

trzymaj wciśnięty klawisz Shift . To zmusza Inkscape do przyjęcia początkowej pozycji myszki jako 

punktu środkowego.  

 
 

1. Kliknij tu, by włączyć 
rysowanie elips/okręgów 

2. Wciśnij LPM : tu jest 

pierwszy narożnik ramki... 

3. Podczas tego ruchu trzymaj 

wciśnięty Ctrl , aby uzyskać 

proporcję boków 1:1... 

4. ...zwolnij LPM : tu jest 

drugi narożnik ramki koła. 
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8.32 Edycja elipsy 

Gdy zaznaczysz okrąg lub elipsę pojedynczym kliknięciem (LPM), Inkscape obrysuje ją ramką selekcji. Możesz 

zmienić rozmiar tego obiektu przeciągając myszką uchwyty tej ramki, lub wpisując dokładne wartości położenia i 

rozmiaru w pola X, Y, W i H (Rysunek 8.32.1):  

 

Rysunek 8.32.1 Edycja elipsy za pomocą ramki selekcji 

Gdy klikniesz podwójnie (LPM) w elipsę lub w łuk, Inkscape przełącza się w tryb okręgu (Rysunek 8.32.2): 

  

Rysunek 8.32.2 Tryb edycji elipsy 

W tym trybie możesz zmienić główne promienie elipsy przeciągając (LPM) kwadratowe uchwyty umieszczone 

po lewej i u góry elipsy/okręgu, lub wpisując ich dokładne wartości w pola Rx, Ry. 

 

 

W trybie selekcji szerokość i wysokość podane w polach W i H uwzględniają szerokość ewentualnego 

konturu obiektu.  

 
 

Ramka selekcji: możesz 
zmienić rozmiar obiektu 
przeciągając te uchwyty 

Tryb 
selekcji 

Położenie tego narożnika 

X, Y 

W 

H 

Szerokość I wysokość 
obiektu (uwzględnia 
szerokość konturu) 

Tu możesz zmieniać 
promienie elipsy 

Tryb 
okręgu 

Ry 

Rx 

Możesz także zmieniać te 
promienie bezpośrednio, prze-
ciągając jeden z tych dwóch 
kwadratowych uchwytów 

UWAGA: Rx i Ry opisują 
kontur leżący pośrodku 
ewentualnego obrysu 

Aby przesunąć 
okrąg – przeciągnij 
jego środek (LPM ) 
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(Dla przykładu, porównaj wartość W pokazywaną przez Rysunek 8.32.1 i wartość Rx pokazywaną przez Rysu-

nek 8.32.2. Szerokość obrysu okręgu z tych ilustracji = 1). 

Aby przekształcić elipsę w łuk, w trybie edycji użyj okrągłych uchwytów (Rysunek 8.32.3): 

 

Rysunek 8.32.3 Redukcja elipsy do łuku 

Możesz wpisać dokładne wartości kątów łuku w umieszczonych w pasku narzędzi polach Start i End (Rysunek 

8.32.3). Użyj ikony  z tego paska, aby z powrotem przekształcić łuk w pełen okrąg (z powrotem do 360º). 

Aby ukryć linie wzdłuż promieni łuku, wybierz inny z trzech trybów jego rysowania (Rysunek 8.32.4): 

                 

Rysunek 8.32.4 Alternatywne tryby rysowania łuku 

 

 

Pola W i H w trybie selekcji mogą być większe o szerokość ewentualnej linii obrysu od wartości 2xRx i 

2xRy, które możesz odczytać w trybie okręgu.  

 
 

Użyj tych uchwytów 
do stworzenia łuku 

Tutaj możesz 
wpisać dokładne 
wartości kątów: 
początkowego i 
końcowego 

Kliknij tutaj, aby z 
powrotem zamknąć 
łuk w elipsę 
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8.33 Odwzorowanie obrysu zawierającego łuk 

W tej sekcji zademonstruję praktyczny przykład mapowania segmentu łuku w Inkscape. Do odtworzenia do-

kładnego kształtu łuku końcówki krawędzi spływu steru wysokości, użyję jego rysunku złożeniowego (Rysunek 

8.33.1): 

 

 

Rysunek 8.33.1 Wymiary kontury steru wysokości 

Kontur tej końcówki jest łukiem, określonym na tym rysunku przez dwa wymiary: promień (18 ½”) i odległość 

środka od osi steru (4 29
/64” ≈ 4.453”). Na ilustracji powyżej zaznaczyłem je na czerwono. Z rysunku poglądowe-

go odczytałem dokładne położenie osi steru (230.875” od przegrody silnika), więc umieściłem na tym rysunku 

niebieską linię pomocniczą, która przechodzi 

przez środek tego łuku (X = 230.875” – 4.453” 

= 226.422”). Zauważ, że na oryginalnym rysun-

ku ten punkt jest odrobinę odsunięty od linii 

pomocniczej (zapewne to błąd kreślarza). W 

tym momencie nie wyznaczam dokładnej 

współrzędnej Y tego środka (Rysunek 8.33.1): 

później po prostu dopasuję łuk o podanym 

promieniu do linii, którą zaznaczyłem rozpiętość 

usterzenia. 

W pierwszym kroku włączyłem tryb rysowania 

okręgu i umieściłem kursor myszki na linii jego 

środka. Następnie narysowałem pełen okrąg, 

trzymając wciśnięte klawisze Shift  i Ctrl  (por. 

str. 182). Pokazuje to Rysunek 8.33.2: 

 
 

Rysunek 8.33.2 Rysowanie początkowego okręgu 

 

 

Oś steru (linia odniesienia) 

Środek łuku 

Rozpiętość 
usterzenia 
poziomego, 
wg rysunku 
poglądowego 

76.81” 

18.5” 

4.45” 

Musimy odtworzyć 
ten łuk, wg wymiarów 
z rysunku 

Linia pomocnicza 
(przechodzi przez 
środek łuku) 

2
3
0
.8

8
" 

1. Kliknij w 
środek łuku 

2. Przeciągnij myszkę, 
trzymając wciśnięte 

klawisze Ctrl  i Shift  
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Następnie użyłem pól Rx i Ry z przybornika (por. str. 183) do ustalenia dokładnego promienia tego okręgu 

(Rysunek 8.33.3): 

 

Rysunek 8.33.3 Ustalenie dokładnego promienia okręgu 

Następnie możesz poprawić położenie tego okręgu przeciągając mały znaczek „X”, umieszczony w jego środku. 

(To może być przydatne, na przykład do dopasowania tego okręgu do innych obiektów lub linii pomocniczych). 

Zauważ, że w polach Rx i Ry musiałem zmniejszyć oryginalny promień (18.5”) o połowę szerokości obrysu (0.3” 

/ 2 = 0.15”) tego okręgu. To było zamierzone, gdyż rysując kontury modelu, stosuję konwencje z planów mode-

larskich. Jedna z nich mówi, że prawdziwy kontur obiektu leży na zewnętrznej krawędzi jego obrysu. W Inksca-

pe jest inaczej – prawdziwy kontur leży pośrodku linii obrysu (por. str. 183). 

Na koniec zredukuj ten pełen okrąg do łuku, przeciągając jego okrągłe uchwyty (szczegóły – por. str. 184): 

 

Rysunek 8.33.4 Zredukowanie okręgu do łuku 

 

Promień tego łuku, pomniejszony o połowę 
szerokości konturu (18.5 – 0.15= 18.35) 

Kontur - szerokość: 0.3 

Aby dopasować położenie 
tego okręgu, złap (LPM ) i 

przeciągnij jego środek 

Ta linia zaznacza 
rozpiętość usterzenia  

1.  Przeciągnij te okrągłe 
uchwyty, redukując pełen 
okrąg do odpowiedniego łuku 

2.  Włącz ten tryb 
rysowania łuku 
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8.34 Powielenie obiektu 

W Inkscape istnieją dwie metody powielenia obiektu: w „duplikat” i w „klon”. Duplikat to niezależna kopia (taka, 

która „ma wszystko własne”: wierzchołki, ustawienia barwy wypełnienia i linii, itp). Tworzymy go, zaznaczając 

pierwowzór i wywołując polecenia Edit→Duplicate ( Ctrl - D ).To samo polecenie jest dostępne w menu kontek-

stowym (Rysunek 8.34.1): 

 

Rysunek 8.34.1 Kopiowanie obiektu 

Po stworzeniu duplikatu, to polecenie wyłącza z zaznaczenia oryginalne obiekty i zaznacza ich nowo utworzone 

kopie. Dzięki temu w kolejnym kroku możesz je przesunąć w nowe miejsce, lub na inną warstwę. 

Klon – to kolejna instancja pierwowzoru. Inkscape zamienia zaznaczony obiekt we wzorzec, którego referencje 

zostają umieszczone na rysunku. W przypadku jakiejkolwiek zmiany kształtu czy barwy wzorca, tej samej zmia-

nie ulegają wszystkie jego referencje (klony).  

Zaznaczony obiekt „klonujemy” jednym z poleceń z menu Edit→Clone. Najbardziej popularne, tworzące poje-

dynczy klon – Edit→Clone→Create Clone – ma skrót na klawiaturze: Alt - D . 

 

„Klon” możesz zmienić w „duplikat” poleceniem Edit→Clone→Unlink Clone ( Shift - Alt - D ). Pamiętaj 

tylko, że jest to w zasadzie operacja nieodwracalna – chyba, że wycofasz ją ogólnym poleceniem 

Edit→Undo.  

  
 

 

W Inkscape łatwo jest przypadkowo stworzyć „klon klona” (wystarczy dwa razy nacisnąć Alt - D ). Choć 

takie obiekty są poprawne z technicznego punktu widzenia, w praktyce nie ma żadnej różnicy pomię-

dzy „referencją” a „referencją do referencji”. (To tylko kolejne niepotrzebne obciążenie procesora Two-

jego komputera). Dlatego dobrą praktyką jest stworzenie klona tylko raz ( Alt - D ), a następnie kopio-

wanie go poleceniem Duplicate ( Ctrl - D ). 

  
 

Kliknij PPM  na wybranym 

obiekcie, by otworzyć to menu 

Wybierz to polecenie 
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8.35 Wypełnienie gradientem 

Zaznacz obiekt, który ma być wypełniony. Następnie w panelu Fill and Stroke, zakładce Fill, wybierz opcję wy-

pełnienia gradientem (Rysunek 8.35.1): 

 

 

Rysunek 8.35.1 Włączenie wypełnienia gradientem (liniowym) 

Domyślny gradient jest płynnym przejściem pomiędzy dwoma kolorami: początkowym i końcowym. Gdy go włą-

czysz, Inkscape tworzy nową definicję wypełnienia i pokazuje ją na liście w zakładce Fill (Rysunek 8.35.1). 

Po przełączeniu w tryb edycji linii możesz zmieniać układ geometryczny gradientu (Rysunek 8.35.2a): 

    

Rysunek 8.35.2 Odcinek sterujący położeniem, rozmiarem i orientacją gradientu 

W trybie edycji linii pojawi się, obok punktów sterujących kształtem obiektu, dodatkowy odcinek sterujacy geo-

metrią gradientu (Rysunek 8.35.2a). Zmieniasz ją, przesuwając końce tego odcinka sterującego w nowe miej-

sce. Możesz w ten sposób zmienić rozmiar gradientu (zwężać lub poszerzać), a także zmienić jego orientację, 

oraz położenie (Rysunek 8.35.2b).  

 

1. Wskaż obiekt do wy-
pełnienia gradientem 

2. Wybierz gradient 
liniowy 

Na liście gradientów 
pojawił się nowy    

Tu można zmienić 
jego nazwę 

Włącz tryb 
edycji 

“Odcinek sterujący” 
gradientem 

Zmieniając położenie 
i kierunek odcinka, 
zmieniasz geometrię 
gradientu  

a) b) 
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Zwróć uwagę, że gdy zaznaczysz jeden z końców odcinka sterującego, w zakładce Fill zobaczysz kontrolkę 

sterowania kolorem (Rysunek 8.35.3): 

 

Rysunek 8.35.3 Zmiana barwy węzła gradientu 

Dla bardziej złożonych zmian, przełącz się w tryb Edit gradient (Rysunek 8.35.4): 

 

 

 

Rysunek 8.35.4 Tryb edycji gradientu 

W tym trybie, Inkscape wyświetla pasek narzędzi do zmiany gradientu. Możesz z niego wybrać jeden z gradien-

tów zdefiniowanych w aktualnym rysunku. 

Zaznacz jeden z 
węzłów gradientu… 

… aby zmienić jego barwę 

Dla węzła Inkscape pokazuje tu 
panel „jednolitego koloru” 

Aby powrócić do listy gra-
dientów, kliknij w środek 
odcinka sterującego 

Wybierz 
ten tryb 

Wybierz 
gradient do 
zmiany 

Dodaj/usuń 
węzeł 

Wybierz węzeł 
gradientu (stop) 

stop837 stop835 

Tu można 
utworzyć nowy 
gradient 
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Gdy zawężasz gradient tak, aby był mniejszy od obiektu (np. tak jak to pokazuje Rysunek 8.35.4), możesz włą-

czyć inny efekt: powtórzenie. Rysunek 8.35.5 pokazuje listę rozwijalną Repeat, z której można wybrać dwa 

tryby: Direct i Reflected:  

               

Rysunek 8.35.5 Rodzaje powtórzeń gradientu 

Trzecia opcja z listy Repeat – None – po prostu wyłącza powtarzanie. 

Gradient musi się składać z co najmniej dwóch węzłów: początkowego i końcowego. Oczywiście, może mieć ich 

więcej – wystarczy kliknąć dwukrotnie (LPM) w odpowiednim miejscu odcinka sterującego (Rysunek 8.35.6): 

 

                          

Rysunek 8.35.6 Dodawanie do gradientu nowego węzła 

Alternatywnie, możesz zaznaczyć dwa sąsiednie węzły gradientu i kliknąć w przyborniku przycisk Add stop 

(por. Rysunek 8.35.6a). Aby usunąć węzeł z gradientu – zaznacz go (pojedynczym kliknięciem LPM) i kliknij w 

przyborniku przycisk Remove stop (Rysunek 8.35.6b). 

 

Odcinek 
sterujący 
gradientu 

Kliknij dwukrotnie (LPM ) 

w odpowiednie miejsce… 

… a Inkscape doda 
nowy węzeł gradientu 

Ten przycisk usuwa 
zaznaczony węzeł 

Alternatywnie: 
zaznacz dwa 
węzły i kliknij 
w ten przycisk 

a) b) 
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Możesz zmieniać położenie wybranego węzła gradientu przesuwając go myszka (LPM). Istnieje także bardziej 

precyzyjna metoda: możesz wpisać dokładną wartość (od 0.0 do 1.0) w polu Offset (Rysunek 8.35.7): 

 

 

Rysunek 8.35.7 Dwie metody zmiany węzła gradientu 

Możesz także zmienić kolor wybranego węzła gradientu w panelu Fill and Stroke.  

W Inkscape, oprócz gradientu liniowego, istnieje także gradient kołowy. Wystarczy włączyć inną opcję wypeł-

nienia (Rysunek 8.35.8): 

 

 

           

 

 

 

 

 

 

Rysunek 8.35.8 Gradient kołowy 

Można przesunąć 
ten węzeł myszką 

(LPM ) 

Można także tutaj 
wpisać jego położenie 

Tu można zmienić 
kolor tego węzła 

To jest ten sam 
węzeł gradientu 

Złap i przesuń któryś z okrągłych 
uchwytów, aby obrócić lub zmienić 
rozmiar/proporcje gradientu  

Te dwie osie 
gradientu są 
zawsze 
prostopadłe 

a) 

b) 

Przełącz się na 
gradient kołowy 
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8.36 Łączenie kolejnych skanów ramek mikrofilmu 

W tej sekcji „skleję” ze sobą w Inkscape dwa skany ramek mikrofilmu. Pokażę to na przykładzie rysunku nr. 75-

21-606 z oryginalnej dokumentacji P-36. Ten arkusz przedstawia szkielet kadłuba (Rysunek 8.36.1): 

    

Rysunek 8.36.1 Dwie części (skany sąsiednich ramek mikrofilmu) rysunku 75-21-606 

W pierwszym kroku, stwórz dla każdego z tych skanów odrębną warstwę. Ja stworzyłem dwie, i nazwałem je 

Frame 1 i Frame 2. Następnie wstawiłem pierwszy obraz na warstwę Frame 1. Przygotowałem także dwie linie 

pomocnicze: X=0 i Y=0. Wyrównałem do nich osie skanu z Frame 1. Założyłem, że płaszczyzna przegrody 

silnika to X=0, ponieważ tu leży linia odniesienia dla wielu wymiarów poziomych na tym arkuszu. Podobnie, 

pozioma oś kadłuba leży na linii Y=0 (Rysunek 8.36.2): 

 

 

Rysunek 8.36.2 Importowany obraz, wyrównany i wyskalowany 

Następnie przestawiłem jednostki rysunku na px (w oknie ze str. 152) i założyłem, że 1px = 1” na oryginalnym 

arkuszu. Odczytałem z umieszczonych w nim wymiarów odległość ostatniej widocznej wręgi (9) od przegrody 

silnika: 124”. Następnie umieściłem kolejną pionową linię pomocniczą w X=124px i proporcjonalnie zmniejszy-

łem ten obraz, tak że płaszczyzna wręgi 1 leży na linii X=0, a wręgi 9 – na linii X=124px. (Jak widać na ilustracji 

powyżej, środek tej transformacji leży na przecięciu osi kadłuba z płaszczyzną przegrody silnika). 

Ramka 1 Ramka 2 

X=0 (wręga 1, czyli 
przegroda silnika) 

Y=0: ta linia biegnie 
wzdłuż osi kadłuba 

Obraz wstawiony 
na Frame 1 

Wyświetlane jednostki to px, założyłem, że 1 px = 1 cal 

Linia pomocnicza 
wzdłuż wręgi 9 (124” 
od przegrody silnika)  

Proporcjonalnie zmniejszyłem 
ten obraz, dopasowując wręgę 9 
do niebieskiej linii pomocniczej   

Środek wszystkich 
transformacji 
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Ponieważ kadry z mikrofilmów mogły ulec zniekształceniom (np. beczkowatym) w obiektywie kamery (por. str. 

249), zdecydowałem się sprawdzić to pierwsze przybliżenie skali obrazu. W tym celu dopasowałem dodatkowe 

trzy wręgi ze środka obrazu do ich zwymiarowanych pozycji na rysunku (Rysunek 8.36.3):  

 

Rysunek 8.36.3 Wykorzystanie kolejnych wręg do dokładniejszego wyskalowania obrazu  

Sądziłem, że jeżeli dopasuję kilka dodatkowych wymiarów z (najprawdopodobniej) mniej zdeformowanego 

środka tego obrazu, to jego skala będzie dokładniejsza. I rzeczywiście – po jednoczesnym dopasowaniu wręg 

4, 6 i 8 zobaczyłem, że wręga 9 nieco „odstaje” od swojej linii (Rysunek 8.36.3). Jest małe zniekształcenie! 

W podobny sposób załadowałem, wyrównałem i wyskalowałem obraz drugiej ramki. Umieściłem go na następ-

nej warstwie: Frame 2, i dopasowałem do pozycji wręg 9, 10,12, i 16 (Rysunek 8.36.4):    

 
 

 

Rysunek 8.36.4 Dopasowanie drugiej części mikrofilmu do zwymiarowanych pozycji wręg 

Do tej pory sprawdziłem każdy z tych skanów z ich wymiarami poziomymi. Nie weryfikowałem (jeszcze) żadne-

go wymiaru pionowego, gdyż brakowało ich na skanie pierwszej ramki. 

Dodatkowe linie, ustawione 
wg wymiarów z rysunku  

Teraz linia wręgi 
9 z tego rysunku 
jest minimalnie 
przesunięta 

Linia 
pom. 

4 6 8 9 1 

9 12 16 10 

Środek wszystkich 
transformacji 

Ten obraz jest 
na oddzielnej 
warstwie 

Dopasowałem rozmiar obrazu do 
zwymiarowanych pozycji tych wręg 
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Jednak gdy włączyłem jednocześnie obydwie warstwy, nie spodziewałem się tak wielkiej różnicy pomiędzy tymi 

dwoma ramkami, jaką pokazuje Rysunek 8.36.5 (dla łatwiejszego porównania prawy obraz jest czerwony): 

 

Rysunek 8.36.5 Początkowe różnice pomiędzy dwoma ramkami mikrofilmu tego samego arkusza 

Prawy (czerwony) skan zupełnie nie pasuje do lewego (czarnego) skanu: jest o wiele niższy! Która z tych wyso-

kości kadłuba jest prawdziwa? Może obie są błędne? Odpowiedź znajdziemy sprawdzając wymiary pionowe. 

Pierwszym z nich jest położenie osi steru wysokości: 18 1/8” (ten wymiar widać na czerwonym skanie). Zauważ, 

że jego linia odniesienia jest znacznie poniżej tej wysokości (Rysunek 8.36.6a, niebieska linia):  

                        

Rysunek 8.36.6 Znajdowanie i korygowanie pionowej deformacji prawej ramki 

Duża różnica, pokazana przez Rysunek 8.36.6a) wskazuje, że ten obraz jest „spłaszczony”. Aby to skorygować, 

rozciągnąłem go w tym kierunku. Zrobiłem to tak, aby linia odniesienia na obrazie pasowała do linii pomocniczej 

odpowiadającej temu wymiarowi (Rysunek 8.36.6b). Środek tej transformacji leży na poziomej osi kadłuba (w 

ten sposób pozycja skanu na rysunku pozostała niezmieniona). 

 

Ten przypadek pokazuje, jak duże mogą być ewentualne deformacje mikrofilmów. Zwróć uwagę, że 

najprawdopodobniej te dwie ramki były wykonane jedna po drugiej, tą samą kamerą! 

 
 

Czerwona połowa tego 
rysunku jest dużo niż-
sza od czarnej! 

18 1/8” 

Prawdziwa wysokość 18 1/8” 

16 16 

Rozciągnąłem ten obraz 
w kierunku pionowym 
tak, aby linia odniesienia 
zgadzała się z deklaro-
wanym wymiarem 

Linia odniesienia 
tego wymiaru  

a) b) 
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Wysokość tej osi steru jest dość krótka, gdy porównasz ją z całkowitą długością kadłuba. Bardziej dokładne 

skalowanie można uzyskać używając dłuższych wymiarów. Z rysunku geometrii kadłuba P-36 (por. str. 225) 

byłem w stanie odczytać wysokość kilku kluczowych wręg, i użyć ich do sprawdzania pionowej skali czerwonej 

połowy rysunku. Te pomiary potwierdziły rezultat, który uzyskałem podczas operacji pokazanej przez Rysunek 

8.36.6b. Teraz jestem w stanie zweryfikować lewą, czarną część rysunku (Rysunek 8.36.7): 

 

Rysunek 8.36.7 Analizowanie pionowych odchyleń obrazu z Frame 1 

Nadal są dostrzegalne niewielkie różnice w wysokości pomiędzy czarną i czerwoną połową rysunku. Na ilustra-

cji powyżej widać także trzy granatowe linie. To pomocnicze fragmenty konturu kadłuba, narysowane według 

wymiarów kadłuba z rysunku geometrii P-36. Umieściłem te linie na dodatkowej warstwie o nazwie Sketch. 

Ostatecznie skorygowałem pionową skalę czarnego obrazu. Zrobiłem to w ten sam sposób, w jaki poprawiłem 

czerwony obraz (Rysunek 8.36.6b), dopasowując wysokość kadłuba do granatowych konturów (Rysunek 

8.36.8): 

 

 

 

Rysunek 8.36.8 Nałożone na siebie i wyskalowane skany rysunku 75-21-606 

Jak widzisz, czarny i czerwony obraz nakładają się na siebie wzdłuż stosunkowo szerokiego pasma rysunku, 

obejmującego wręgi kadłuba nr 7, 8 i 9. 

W tym obszarze nadal 
widać małą różnicę  

Te niebieskie kontury 
są wykreślone wg 
wymiarów kadłuba 

Aby lepiej widzieć 
różnice, ustawiłem 
tryb nakładania 
czerwonego obrazu  
z Frame 2 na 
Multiply  

7 8 9 

Nakładające się obrazy z 
Frame 1 i Frame 2 
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Gdy przyjrzysz się uważniej powiększonemu obszarowi wokół wręgi 9, zauważysz dużo różnic pomiędzy czer-

wonymi i czarnymi liniami (Rysunek 8.36.9): 

 

Rysunek 8.36.9 Różnice pomiędzy nałożonymi obrazami  

Aby ukryć te zdeformowane linie, użyłem prostokąta wypełnionego białym gradientem (str. 188), umieszczone-

go na warstwie Frame 1 ponad czarnym obrazem (Rysunek 8.36.10 pokazuje zamiast bieli 50% szarości):  

 

Rysunek 8.36.10 Maskowanie prawej krawędzi lewej części rysunku  

Jak widać, nieprzejrzysta część tego prostokąta przykryła zdeformowane linie wzdłuż prawej krawędzi czarnego 

obrazu. Możesz sterować jej szerokością przeciągając prawy (okrągły) koniec „odcinka gradientu”. 

7 8 9 

Czerwone i czarne 
linie pasują do siebie 
wokół wręg 7 and 8  
 

Czarny obraz jest 
zdeformowany 
przy wrędze 9 

Prawa krawędź 
maskowanego 
obrazu 

Prostokąt maskujący 
(prawą krawędź) 

Koniec gradientu: 
biel, 0% przejrzyste 

Prostokąt maskujący 
(lewą krawędź) 

Początek gradientu: 
biel, 100% przejrzyste 

Ten nieprzejrzysty obszar maskuje 
zdeformowaną część czarnego obrazu 
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Rysunek 8.36.11 pokazuje rezultat tego maskowania (przełączyłem tu kolor gradientu na biały): 

 

Rysunek 8.36.11 Efekt maskowania lewej (czarnej) części rysunku  

W podobny sposób możesz zamaskować lewą krawędź prawej (czerwonej) części rysunku. Umieść taki prosto-

kąt na warstwie Frame 2. Rysunek 8.36.12 pokazuje odtworzony (wyrównany i wyskalowany) arkusz: 

 

Rysunek 8.36.12 Odtworzony rysunek 75-21-606  

Użyłem tu prostokątnych masek wzdłuż obydwu krawędzi nakładających się krawędzi. Po tej zmianie nie było 

już potrzeby wyróżniania prawej strony, więc usunąłem z niej czerwony filtr. Teraz cały arkusz jest w oryginal-

nym, czarnym kolorze. 

 

Używaj tej metody maskowania dla każdego połączenia sąsiednich ramek mikrofilmu. Jest szczególnie 

skuteczna w usuwaniu głębokich, czarnych cieni, jakie czasami występują wzdłuż ich krawędzi. 

Zdeformowane czarne linie 
znikły z tego obszaru  

Aby pozbyć się tej krawędzi, 
użyj podobnej białej maski 
dla czerwonego obrazu 
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Dodatki 

Czytając wcześniejsze rozdziały, zapewne przekonałeś już się, że uwielbiam umieszczać u dołu strony przypisy 

z dodatkowymi informacjami. Ta część książki to właściwie wybór takich "uwag na marginesie", które w trakcie 

pisania urosły do rozmiaru całej sekcji     . 

 

Jak w każdym dodatku, są to informacje, z których nie musisz korzystać, aby stworzyć e-model samolotu. Cza-

sami jednak mogą się przydać, by coś wyjaśnić lub ułatwić. Mam nadzieję, że znajdziesz tu rozwinięcie wielu 

zagadnień, które świadomie skracałem w głównym tekście książki. 
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Rozdział 9. Wykorzystanie oryginalnej dokumentacji samolotu 

W zasadzie oryginalna dokumentacja techniczna powinna zapewnić komplet informacji niezbędnych do odtwo-

rzenia przedstawionego w niej obiektu. Istotnie, zawarte w niej dane są najbardziej wiarygodne. Jednak nie 

oczekuj, że w dokumentacji historycznego samolotu odnajdziesz wszystko, czego potrzeba do budowy modelu. 

Zazwyczaj takie zestawy rysunków są niekompletne i opisują inną wersję (lub wersje) samolotu niż ta, którą 

zamierzasz stworzyć. Dlatego, zanim użyjesz tych arkuszy, powinieneś zapoznać się z historią rozwoju tej ma-

szyny. Ta wiedza jest niezbędna dla poprawnej identyfikacji jej wariantu choćby w oparciu o kilka detali pokaza-

nych na jakimś rysunku. 

W tym rozdziale omówię źródła, z których można uzyskać oryginalne dokumentacje historycznych samolotów. 

Następnie pokażę praktyczny przykład użycia rysunków Curtiss do odtworzenia geometrii kadłuba P-40B (w 

szczególności – jego osłony silnika). 
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9.1 Wprowadzenie 

Odtwarzanie geometrii historycznego samolotu wymaga dokładności i cierpliwości. Można to dostrzec w pierw-

szych rozdziałach tej książki. Podczas długich godzin porównywania zdjęć i różnych planów modelarskich P-40, 

często marzyłem o dostępie do jego oryginalnej dokumentacji! Przez wiele lat taki zestaw rysunków był „świę-

tym Graalem” zaawansowanych modelarzy. (Każdy chciałby mieć takie źródło danych, lecz tylko nieliczni je 

widzieli. I nawet ci, którzy mieli okazję przeglądać te arkusze, często nie wiedzieli, na co patrzą). 

Gdy produkcja samolotu jest już dawno zakończona i wychodzi on z użycia, jego rysunki wędrują do archiwów 

producenta. Po kilku kolejnych dekadach, większość z tych przedsiębiorstw jest sprzedana, a te, które miały 

mniej szczęścia – uległy likwidacji. Ostatecznie, oryginalna dokumentacja techniczna historycznego samolotu 

staje się stertą bezużytecznych zwojów, które znikają w piecach lub koszach na śmieci1.   

Takie kompletne zniszczenie jest możliwe, ponieważ przed „erą komputeryzacji” istniał tylko jeden rysunek 

wzorcowy każdej części, wykonany (jeżeli był na to czas) w tuszu, na pergaminie. (Jeżeli czasu brakowało, 

mógł być to szkic ołówkiem). Dla „codziennego” użycia na warsztatach, fabryka wykonywała tanie (i nietrwałe!) 

kopie tych rysunków. 

 

Rysunek 9.1.1 Kopia profilu P-47, wykonana w technice cyjanotypii 

Najstarszą metodą kopiowania rysunków technicznych była cyjanotypia. Proces wprowadzona przez J. Hershe-

la w 1842r., tworzył z oryginalnego rysunku (czarne linie na przejrzystym papierze) negatyw: białe linie na nie-

bieskim tle (Rysunek 9.1.1). W języku angielskim od tego koloru pochodzi nazwa blueprint, którą możesz napo-

tkać obecnie jako synonim wszelkich rysunków technicznych, także wydruków z plotera. 

Tworzenie cyjanotypu należy do tzw. „metod wilgotnych”. Rysunek wzorcowy jest nakładany na arkusz papieru 

nasączony roztworem błękitu pruskiego. Następnie naświetlenie promieniami UV (chociażby światłem słonecz-

nym) tworzy kopię. To nasączanie i późniejsze suszenie mogą prowadzić do pewnych deformacji odtwarzanego 

kształtu. Rezultat nie jest chemicznie stabilny – jego kolory mogą wyblaknąć pod wpływem kilkumiesięcznej 

ekspozycji na światło dzienne. Co ciekawe, można odwrócić ten proces umieszczając wyblakłe arkusze na po-

dobny czas w ciemni.  

 
1 Zdarzają się wyjątki: gdy w 1988r. North American Aviation zamykał swój oddział w Columbus, jeden z jego inżynierów (Ken Jungeberg) 

poprosił o pozwolenie na zachowanie jego archiwów, zawierających rysunki P-51, B-25 i P-82. (Zob. więcej na ten temat). 

https://www.aircorpsaviation.com/ken-jungeberg-collection/
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 Białe linie na niebieskim tle są mniej czytelne niż na czarno-białym rysunku (por. Rysunek 9.1.1). Dlatego na 

początku XX w. pojawiła się nowa metoda kopiowania: diazotyp. Tak jak w przypadku cyjanotypu, była to świa-

tłoczuła, kontaktowa metoda, tworząca 1:1 duplikaty wzorcowego rysunku. Jednak w odróżnieniu od poprzedni-

ka, tworzyła ciemne (niebieskawe) linie na jasnym tle (Rysunek 9.1.2): 

 

Rysunek 9.1.2 Dizaotyp rysunku kadłuba P-36 

W latach 30. XX w. diazotypy wyparły niebieskie cyjanotypy z większości warsztatów. Na nieszczęście, linie tych 

kopii także blakły po kilku miesiącach użycia (są czułe na światło dzienne, tak jak cyjanotyp). Ten czynnik, połą-

czony z typowym codziennym zużyciem, zmuszał zakłady lotnicze do stałego dostarczania nowych kopii doku-

mentacji technicznej, tak dla utrzymania produkcji, jak i zapewnienia serwisu. W okresie II wojny światowej za-

częto reprodukować takie zestawy w postaci mikrofilmów. W tej zminiaturyzowanej postaci była bardziej trwała i 

łatwiej było ją dostarczać do wszystkich warsztatów, szczególnie do jednostek wojskowych rozproszonych po 

całym świecie. Niektóre z tych mikrofilmów trafiły potem do muzeów. Ten proces kontynuowano także po wojnie, 

więc obecnie w narodowych archiwach można znaleźć rolki mikrofilmów z dokumentacją różnych historycznych 

maszyn. Jednak to „środowisko” jest lepiej znane zawodowym historykom niż modelarzom. (Historycy lepiej 

wiedzą, jak w sposób profesjonalny przygotować kwerendę dla muzeum/biblioteki dotyczącą określonego tema-

tu). Nawet jeżeli uda się otrzymać zamówione kopie takich mikrofilmów, pojawiają się następne pytania:  

1. Jak przekształcić zawartość tych mikrofilmów w użyteczne rysunki? 

2. Jak znaleźć pomiędzy kilkoma tysiącami rysunków ten jeden, którego w danej chwili potrzebujesz? 

Odpowiadając na pierwsze pytanie: istnieją specjalne urządzenia do skanowania kolejnych ramek mikrofilmów i 

zachowywania ich na dysku w postaci cyfrowych obrazów. W sklepach za kilkaset złotych można nawet kupić 

najprostsze wersje takich skanerów (rozdzielczość: 3000dpi). Bardziej zaawansowane urządzenia (o rozdziel-

czości 4500dpi lub więcej) są trzy-cztery razy droższe. (W dalszym tekście zobaczysz, dlaczego rozdzielczość 

skanera jest tak ważna). Istnieją także wyspecjalizowane firmy, oferujące profesjonalne usługi skanowania róż-

nym muzeom i bibliotekom, a także osobom prywatnym. 

Do odpowiedzi na drugie pytanie – jak używać dokumentacji technicznej i się nie pogubić (lub oszaleć) – po-

trzebuję przykładowych skanów rolek mikrofilmu. Na szczęście, obecnie można znaleźć w Internecie kilka por-

tali, które oferują takie skany dokumentacji samolotów. Są to maszyny, o które najczęściej pytają hobbyści: my-

śliwce USA z II wojny światowej, ale można tam także znaleźć samoloty niemieckie (FW-190, Bf-109, Me-262), 

oraz brytyjskie (Avro Lancaster, Supermarine Spitfire, Sopwith Camel). 

 

Przed 2010r. można było znaleźć w Internecie tylko jeden portal, który oferował taką dokumentację. Jej 

ceny były bardzo wysokie: jak pamiętam, kilka tysięcy dolarów za jeden zestaw. Na szczęście, potem 

pojawiła się konkurencja, i koszt takiego zestawu spadł do około 100 dolarów (zależnie od portalu). 
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W przypadku P-40, szeroko dostępne są skany dokumentacji jego późniejszych wersji (P-40E…N). Dlatego, 

gdy w 2019r. zdecydowałem się zaadaptować (uaktualnić) mój model P-40B do nowej wersji Blendera (2.8), 

pomyślałem o zakupie tej dokumentacji. Jednak nie spodziewałem się, że ostatecznie skończy się to nabyciem 

trzech takich zestawów z trzech różnych portali! W tej sekcji omówię, jak to się stało, abyś mógł uniknąć moich 

błędów. W następnej sekcji opiszę, jak uporządkowałem takie skany i przygotowałem na ich podstawie rysunki 

referencyjne dla mojego modelu. 

Początkowo znałem dwa portale z takimi rysunkami: www.plans.aero i www.aircraft-manuals.com. Obydwa ofe-

rowały skany około 7tys. ramek mikrofilmów P-40E..N. Wydaje się, że są to obrazy tego samego zestawu 8 

rolek, oznaczonych od „A” do „H”. 

Zacząłem od zamówienia tańszego zestawu z aircraft-manuals.com: 68.85 USD + 7.85 USD kosztów wysyłki 

(wysyłają je z Włoch). Po dziesięciu dniach otrzymałem CD z tymi rysunkami. Technicznie są to biało-czarne 

(tzn. 1 bit koloru) pliki *.tif, zeskanowane z 2500dpi. (Rozmiar każdego obrazu: 3200x2368px). Obrazy te są 

pogrupowane w 8 folderów, których nazwy odpowiadają rolkom mikrofilmu (od A do H). Pierwsza ramka zawie-

ra stronę tytułową rolki. Możesz ją znaleźć w każdym z tych folderów pod nazwą TIT~*.TIF (na przykład – poni-

żej pokazuję zawartość pliku TIT~2348.TIF z folderu E): 

 

Rysunek 9.1.3 „Strona tytułowa” rolki mikrofilmu z dokumentacją P-40 

Można tu odczytać, że zapisane na tym mikrofilmie rysunki to stan dokumentacji P-40 E, F, K, L, M i N na dzień 

26 sierpnia 1943r. 

Najprostszą metodą przeglądania zawartości tych folderów jest włączenie w Eksploratorze Plików opcji Extra 

large icons (Rysunek 9.1.4). Wszystkie pliki skanów (oprócz tytułu) noszą nazwy <N>_<o>.tif, gdzie <N> jest 

oryginalnym numerem referencyjnym („wybitym” na każdej ramce mikrofilmu). Pojedynczy arkusz z rysunkiem 

złożeniowym, wykonany na dłuższej rolce papieru, mogą zajmować kilka kolejnych ramek mikrofilmu. W takim 

przypadku te ramki są oznaczone tym samym numerem referencyjnym <N>, ale ich skany różnią się przyrost-

kami <o>. (Wydaje się, że <o> jest numerem kolejnym skanowanej ramki). 

http://www.plans.aero/
http://www.aircraft-manuals.com/
http://www.aircraft-manuals.com/
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Rysunek 9.1.4 Przeglądanie skanów ramek mikrofilmu 

Na przykład: na oryginalnej rolce E mikrofilmu znajdują się dwie kolejne ramki z oznaczeniem „E177”. Zawierają 

rysunek złożeniowy szkieletu skrzydła, wykonany na niestandardowo długim arkuszu. Jednak w folderze E 

można znaleźć cztery pliki o nazwach 177_*.TIF (por. Rysunek 9.1.4). Wydaje się, że najpierw wykonano skany 

177_232.TIF i 177_233.TIF. Przypuszczam, że później ktoś przeglądał te pliki i zauważył, że lewa krawędź 

skrzydła na obrazie 177_232.TIF została odcięta. Dlatego wykonano później dodatkowe, poprawne skany tych 

dwóch ramek. Noszą one nazwy 177_751.TIF i 177_752.TIF. 

Docelowo zamierzam uporządkować te rysunki w strukturę „drzewa”. Na pierwszym poziomie stworzę foldery 

dla podstawowych zespołów: Fuselage, Wing, Empennage. Następnie w każdym z tych katalogów stworzę 

podfoldery dla ich podzespołów. I tak, w katalogu Fuselage stworzę foldery Spinner, Egine Cowling, Cockpit i 

Tail Wheel. Przejrzałem źródłowe katalogi (Roll A…H) i skopiowałem wybrane skany w tę nową strukturę. Każ-

demu kopiowanemu plikowi zmieniłem nazwę na opisową, np. General Assembly, Skeleton, STA#1 (czyli wręga 

nr 1) i podobne. W każdym z tych docelowych folderów i podfolderów nie powinno być więcej niż 100 rysunków. 

Jeżeli zgromadzi się ich więcej, wyodrębnię część w odpowiedni podfolder. 

Nie miałem problemu w rozpoznaniu rysunków z głównymi zespołami, takimi jak ten szkielet kadłuba:  

   

Rysunek 9.1.5 Arkusz z rysunkiem złożeniowym szkieletu kadłuba (podzielony na dwie ramki mikrofilmu) 

Skaner odciął tę krawędź rysunku  

Poprawione skany 

Foldery rolek 
mikrofilmu 

Do przeglądania skanów użyj tej opcji 

Dwie części tego 
samego arkusza E177 

Numery pozycji 
wręg kadłuba 

1 2 3 4 5 6 7 7 8 9 10 11 12 13 14 15 16 

Nakładające się 
obszary ramek 

Ramka 1 Ramka 2 
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Rozpoznanie podzespołów wymaga już pewnego wysiłku. Na przykład – obraz poniżej to owiewka skrzydła: 

 

Rysunek 9.1.6 Owiewka skrzydła (część tylna) 

Jednak istnieje także wiele części, których nie można zidentyfikować „jednym rzutem oka”. Na przykład, popatrz 

na skan ramki noszącej oznaczenie E261 (Rysunek 9.1.7): 

 

Rysunek 9.1.7 Problematyczna identyfikacja bardziej szczegółowego rysunku E261 

Nie mogłem rozpoznać tej części po jej kształcie, więc popatrzyłem na opis (znajdują się zawsze w prawym 

dolnym rogu, w tabelce). Tam okazało się, że oryginalny rysunek był tak duży, że szczegóły jego tabelki są nie-

czytelne. (Były zbyt małe dla przyjętej podczas skanowania rozdzielczości ramki mikrofilmu)! 

B’LK’D ASSEM 
STA # 3 (wręga 
nr 3?) 

Tabelka (powiększona) 

Nieczytelny numer 
rysunku 
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Na szczęście, aircraft-manuals.com dostarcza także skan stron indeksu tego mikrofilmu: 

 

 

 

Rysunek 9.1.8 Szukanie w indeksie nazw rysunku dla wręgi nr. 3 

Ten indeks pozwala na wyszukiwanie wg nr rysunku lub nazwy części. Nie znam numeru rysunku, gdyż jego 

ostatnie cyfry w tabelce są nieczytelne. Indeks nazw jest podzielony na siedem sekcji: Wing, Tail, Body (tzn. 

kadłub), Power Plant, Flight Control, Equipment, Armament. Obawiałem się, że wyszukiwanie tutaj nie będzie 

specjalnie efektywne, gdyż nazwy części się powtarzają: pierwsze cztery strony sekcji Wing wypełniają elemen-

ty o identycznej nazwie Angle. Na szczęście w sekcji Body można dostrzec numery wręg. Korzystając z nich, 

ostatecznie potwierdziłem, że „B’LK’D” to skrót używany w Curtiss dla słowa „BULKHEAD” (wręga), i że ramka 

E261 zawiera rysunek złożeniowy wręgi kadłuba nr 3. Z wiersza indeksu mogłem odczytać numer tego rysunku: 

87-21-603. Zwróć uwagę, że nawet tutaj, w kolumnie „FILM INDEX NO.” niektóre numery ramek są nieczytelne, 

z powodu zbyt niskiej rozdzielczości skanowania! 

 

Zła jakość obrazu tych skanów nie jest wyłącznie spowodowana zbyt niską rozdzielczością. Brakuje w 

nich także odcieni szarości, które mogłyby nieco poprawić ich czytelność. (Aby uzyskać jak najmniejszy 

rozmiar plików, aircraft-manuals.com użyło formatu w którym 1 piksel obrazu to 1 bit. Są to czarno-białe 

obrazy o wysokim kontraście, bez żadnych półtonów).  

 
 Gdy zacząłem analizować szczegóły zidentyfikowanych rysunków, niska rozdzielczość ich skanów stała się 

poważnym problemem. Okazało się, że umieszczone na nich odsyłacze do rysunków szczegółowych są nieczy-

telne, podobnie jak wiele kluczowych wymiarów. 

Wręgi osłon silnika 

Sta 3 Bulkhead Assembly 
(rysunek nr: 87-21-603) to 
rzeczywiście ramka E261  
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Na przykład – popatrz na ten środkowy segment owiewki pomiędzy skrzydłem i kadłubem, przedstawiony na 

rysunku poniżej (ramka E201): 

 

Rysunek 9.1.9 Nieczytelne współrzędne geometrii osłony skrzydła (E201) 

Tabelka tego rysunku jest kompletnie nieczytelna, więc musiałem potwierdzić jego numer wyszukując w indek-

sie części kadłuba nazwę „Fillet”. W ten sposób zidentyfikowałem, że jest to 87-06-503. Dziwnym trafem, kolej-

ny segment tej owiewki (nr rysunku 87-06-502, E200) można znaleźć wiele stron dalej, pod nazwą „Skin”. 

Szczegółowe dane geometryczne, opisujące kształt tych owiewek, są umieszczone w lewych górnych narożni-

kach tych rysunków. Jak pokazuje to Rysunek 9.1.9, są tu zupełnie nieczytelne. 

W tym momencie zrozumiałem, że skany z aircraft-manuals.com są mało użyteczne dla mojego projektu, i za-

cząłem szukać lepszych. Przeczytałem więc ponownie opis dokumentacji P-40 oferowanej przez inny portal: 

plans.aero. Napisano tam, że „Oryginalne skany rolki E były prześwietlone. Dlatego przeskanowaliśmy ją po-

nownie w bardzo wysokiej rozdzielczości (4500dpi) i przyciemniliśmy uzyskane obrazy, aby pokazać wszystkie 

szczegóły tego mikrofilmu”. Teraz rozumiem o czym piszą! (Rolka E zawiera większość rysunków złożeniowych, 

więc jest „zasobem krytycznym” tego zestawu mikrofilmów). 

Stąd nabyłem mój drugi zestaw dokumentacji P-40 od plans.aero. Kosztował 119 USD, i tym razem obyło się 

bez opłat transportowych, gdyż mogłem natychmiast pobrać zakupione pliki. Całkowity rozmiar tego zestawu to 

6GB (dziesięć razy większy niż ten z aircraft-manuals.com). Dla łatwiejszego pobierania, jest podzielony na 

cztery części. Za tę wyższą cenę plans.aero dostarcza nie tylko skany mikrofilmów, ale także wszystkie dostęp-

ne instrukcje P-40, w szczególności „Erection and Maintenance” dla P-40N i ilustrowany katalog części. Te 

książki są przydatnym dodatkiem, który przy oddzielnym zakupie kosztowałyby dużo więcej. 

Pliki skanów z plans.aero są pogrupowane w „foldery rolek”, tak jak te z aircraft-manuals.com. Wydaje się, że 

plans.aero dostarcza skany w odcieniach szarości dla rolek A i F (dlatego na niektórych z nich widać białe linie 

na czarnym tle). Znajdują się tu także dwa foldery dla rolki E. Jeden z nich, nazwany „old scanning”, zawiera 

Nieczytelne dane 
geometryczne 

http://www.plans.aero/
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takie same obrazy jak te z aircraft-manuals.com. Drugi, zatytułowany „new scanning”, zawiera pliki PDF. Każdy 

z tych plików jest skanem pojedynczej ramki mikrofilmu:  

 

Rysunek 9.1.10 Ponownie zeskanowane rysunki złożeniowe z rolki E (zestaw dokumentacji P-40 z plans.aero) 

Jak widać na obrazku, wszystkie te pliki mają przedrostek „P-40”, po którym pojawia się pełen numer referen-

cyjny z mikrofilmu (z symbolem rolki „E”). Dla rysunków, które zajmują kilka ramek, użyto kolejnych przyrostków 

(„-a”, „-b”, „-c”, itd.). Wykorzystując tę regułę założyłem, że dla szkieletu skrzydła (E177) powinny w tym zesta-

wie istnieć dwa pliki: P-40 E 177-a.pdf i P-40 E 177-b.pdf. Ku mojemu zdziwieniu, znalazłem tylko jeden: P-40 E 

177.pdf. Zawiera prawą stronę tego rysunku. A gdzie jest lewa? Szybko znalazłem ją w pliku P-40 176-e.pdf. To 

ewidentny błąd operatora skanera, na szczęście łatwy do skorygowania. 

Oczywiście, pierwszą rzeczą, którą sprawdziłem na tych nowych skanach były tabele danych geometrycznych z 

narożników rysunków E200 i E201: 

 

Rysunek 9.1.11 Lepszy skan rysunku E201 (z zestawu plans.aero) 

 

Aby wygodnie przeglądać te 
pliki, włącz panel podglądu 

Ten schemat i tabela 
są teraz czytelne  

Mogę także odczytać 
wymiary i odsyłacze 

do innych rysunków 
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Skan, który pokazuje Rysunek 9.1.11, jest zdecydowanie lepszy: teraz dla tej owiewki skrzydła jestem w stanie 

odczytać umieszczony w narożniku diagram oraz tabelę wymiarów.  

Mógłbym tutaj zakończyć tę sekcję konkluzją, że www.plans.aero oferuje lepsze skany mikrofilmu P-40 (i dodat-

kowe książki). Jednak, gdy opisałem ten przypadek jednemu z moich znajomych, ten zasugerował mi odwiedzi-

ny jeszcze jednego portalu: www.aircorpslibrary.com (Rysunek 9.1.12): 

 

Rysunek 9.1.12 Strona startowa portalu AirCorps Library 

Portal AirCorps Library został założony w 2015r. Za 5 USD/miesiąc (lub 50 USD/rok) zapewnia możliwość prze-

glądania online oryginalnych instrukcji i rysunków fabrycznych różnych samolotów. Obecnie udostępnia doku-

mentacje 29 samolotów. Poza jednym wyjątkiem – Spitfire – są to konstrukcje amerykańskie, głównie z okresu II 

wojny światowej. Wśród nich jest także sekcja „P-40 Warhawk”: 

 

Rysunek 9.1.13 Sekcja AirCorps Library z dokumentacją P-40 

Zamiast numerów referencyjnych z mikrofilmów, ten portal używa oryginalnych numerów rysunków z tabelek 

rysunkowych. Wykorzystując reguły ich numeracji (specyficzne dla każdego producenta samolotów), AirCorps 

Library grupuje rysunki w podzespoły. Na przykład: wydaje się, że numer rysunku w Curtiss składał się z 7 cyfr 

podzielonych na 3 sekcje: TT-AA-NNN. „TT” było oznaczeniem typu samolotu. W szczególności, przedrostek 75 

oznacza „Hawk 75” (tzn. P-36), 81 – YP-37, a 87 to „Hawk 87” (P-40D i późniejsze wersje). Szczerze mówiąc, 

Tutaj możesz wyszukiwać rysunki 
o określonych numerach 

Większość rysunków jest już po-

dzielona na odpowiednie kategorie  

http://www.plans.aero/
http://www.aircorpslibrary.com/
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spodziewałbym się, że 81 oznacza „długonose”, wczesne wersje P-40, oznaczane przez Curtiss jako „Hawk 

81”. Jest jednak inaczej. Środkowa sekcja „AA” (po 1942r także trzy cyfry: „AAA”) określa podzespół samolotu, 

na przykład: 03 – skrzydło, 05 – lotki, 06 – złożenie skrzydła, 08 – klapy, 21 – kadłub, 23 – owiewki, i tak dalej. 

Diagram podzespołów P-40, który pokazuje Rysunek 9.1.13, jest oparty właśnie na tym środkowym segmencie 

numerów rysunków. Ostatecznie przyrostek „NNN” wydaje się być czymś w rodzaju numeru kolejnego. Główne 

rysunki złożeniowe w tym ostatnim segmencie maja jedno lub dwa wiodące zera (na przykład: „001” lub „010”). 

Stąd, patrząc na Rysunek 9.1.13, możesz znaleźć owiewkę połączenia skrzydła z kadłubem w grupie „06 – 

Wing Assembly”, ponieważ numery jej rysunków to 87-06-502 i 87-06-503. (Zupełnie nie wiem, dlaczego na 

indeksie mikrofilmu te części zostały dołączone do sekcji „Body” – czyli kadłuba – zamiast do sekcji „Wing”). W 

tej „erze analogowej” wszędzie możesz napotkać na ślady drobnych ludzkich pomyłek: np. w sekcji „06” można 

znaleźć zapomniany schemat oznaczeń P-36 (gdyż nosi numer 75-06-013).  

Mogę się mylić, ale wydaje mi się, że różne wersje samolotu (np. P-36 i P-36C) można rozpoznać po piątym 

znaku numeru rysunku. Na przykład: podstawowa wersja skrzydła jest ukazana na rysunkach o numerach od 

„75-03-001” do „75-03-3XX”. W P-36C zmieniono krawędź natarcia (dodano 1 km), co jest udokumentowane na 

rysunkach oznaczanych jako „75-03-4XX”. Podobnie – krawędź natarcia eksportowych wersji Hawk 75, z 2 km, 

można znaleźć na rysunkach „75-03-6XX”.  

Gdy klikniesz na grafie w jakiś podzespół samolotu lub wpiszesz początek serii numerów rysunków (np. „75-*-

8*”) w pole wyszukiwań, uzyskasz listę wyników podobną do pokazanej poniżej: 

 

  

 

Rysunek 9.1.14 Lista rysunków 

W sekcjach innych samolotów (np. P-51) możesz także wyszukiwać rysunki po częściach nazwy. Jednak więk-

szość skanów P-40 w AirCorps Library nie jest jeszcze opisana. Gdy klikniesz miniaturę rysunku (po lewej) lub 

jeden z przycisków po prawej stronie wiersza tej listy, otworzysz wybrany obraz do przeglądania. 

Połowa rysunków P-40 nie 
ma (jeszcze) opisów 

Kliknij tutaj, aby zobaczyć wszystkie 
ramki mikrofilmu z tym rysunkiem 

Przypuszczam, że określenia “Early” I 
“Late” dotyczą różnych kopii mikrofilmu? 

Miniatura rysunku 

(pierwszej ramki) 
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Rysunek 9.1.15 pokazuje, jak wygląda okno czytnika rysunków AirCorps Library:  

 

Rysunek 9.1.15 Czytnik rysunków AirCorps Library 

Ta przeglądarka jest szybka i intuicyjna. Pozwala na przełączanie się pomiędzy kolejnymi ramkami mikrofilmu. 

Możesz także podejrzeć ich miniaturki w menu rozwijalnym. Zmiana powiększenia lub przesunięcie rysunku 

odbywa się tak samo jak w Google Maps: po prostu „łapiesz i przeciągasz” myszką. Portal dynamicznie dosto-

sowuje rozdzielczość wyświetlanego fragmentu obrazu do aktualnego powiększenia. 

Dla mnie najbardziej istotną funkcją jest drukowanie obrazu wyświetlonego w tym czytniku. Bez żadnych dodat-

kowych opłat możesz go wysłać na lokalną drukarkę. Rysunek 9.1.16 przedstawia przykład takiego wydruku: 

 

Rysunek 9.1.16 Przykładowy lokalny wydruk rysunku z AirCorps Library 

Intuicyjna podstawowa nawigacja jest jak w Google Maps: kółko myszy zmienia 

powiększenie, „złap i przeciągnij” myszkę (lewy przycisk) aby przesunąć rysunek 

Tu możesz bezpłatnie wydrukować tę ramkę 
(lub jej fragment) na lokalnej drukarce 

Tu można kupić kopię aktualnej 
ramki (w wysokiej rozdzielczości) 

Użyj tych kontrolek aby przełą-
czać się pomiędzy kolejnymi 
ramkami z tym rysunkiem 

~6000px 
px 

~3870px 
px 
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Format papieru wydruku nie ma tu znaczenia – czy A4, czy A3, nie ma to wpływu na szczegółowość obrazu. 

Ten portal po prostu wysyła na lokalną drukarkę rastrowy obraz w odcieniach szarości o szerokości ok. 6000px i 

wysokości 3870px. Ja potrzebowałem tych rysunków w formie elektronicznej, więc użyłem popularnej funkcji 

„wydruku do PDF” aby uzyskać ich lokalne kopie. 

Gdy po raz pierwszy przeglądałem portal AirCorps Library (na początku czerwca 2019) była tam tylko jedna 

opcja zakupu: wielkoformatowego wydruku obrazu, co mnie nie interesowało. Dwa miesiące później wprowa-

dzono jednak zmiany. Teraz można nabyć i pobrać oryginalne pliki ze skanami instrukcji i rysunków udostępnio-

nych online. Gdy w oknie czytnika klikniesz ikonę „koszyka”, zobaczysz dwie opcje: Purchase Hi-Res i 

Download. Wybierając Purchase Hi-Res możesz zamówić papierowy wydruk (na arkuszu 24”, 36”, lub 42”). 

Nowa opcja Download pozwala kupić i pobrać rysunek, który przeglądasz. Rozmiar takiego obrazu to 9888px 

na 6984px. Jednak oznacza to, że w przypadku rysunków złożeniowych podzielonych na kilka ramek trzeba 

każdą z nich nabyć oddzielnie. Dopóki ta sama strona oferuje bezpłatnie możliwość lokalnego wydruku, nie 

jestem zainteresowany zakupem takiej kopii. (Nabyłem dla testu pojedynczy rysunek i stwierdziłem, że rozdziel-

czość lokalnego wydruku jest wystarczająca dla moich potrzeb). 

Poniżej porównuję trzy obrazy testowe. (Jest to tabela i schemat współrzędnych owiewki skrzydła z lewego, 

górnego narożnika rysunku 87-06-503). Uzyskałem te obrazy z aircraft-manuals, plans.aero (PDF z „nowego 

skanowania”) i AirCorps Library (uzyskane poprzez „wydruk do PDF”): 

 

 

Rysunek 9.1.17 Trzy skany tej samej ramki mikrofilmu  

Jak widać, najlepszy obraz pochodzi z AirCorps Library. Przypuszczam, że skanowali ten mikrofilm z rozdziel-

czością 7000dpi, i że oryginalny rozmiar uzyskanego skanu jest podobny do rozmiaru obrazu, który nabyłem: 

około 10 000 x 7000px. Przy lokalnym wydruku jest on zmniejszany do 6000 x 3600px, ale ta operacja tylko 

nieznacznie pogarsza jego jakość. (Obraz po prawej jest fragmentem takiego wydruku do PDF). 

Nie wiem, czy zwróciłeś uwagę, że w tej sekcji wspomniałem także o innej konstrukcji: P-36. To nie jest pomył-

ka: sekcja „P-40” AirCorps Library zawiera 11 tys. rysunków co najmniej trzech (!) różnych (choć powiązanych) 

typów samolotów: 

1. P-36 (wewnętrzna nazwa Curtiss: „Hawk 75”, przedrostek numeru rysunków: „75-*”); 

2. YP-37 (przedrostek numeru rysunków: „81-*”); 

3. P-40-cu/B/C (wczesne wersje P-40: wewnętrzna nazwa Curtiss: „Hawk 81”); 

4. P-40D..N (późne wersje P-40: wewnętrzna nazwa Curtiss: „Hawk 87”, przedrostek numerów rys.:”87-*”). 

W zależności od tego, jak liczyć p. 3 i p. 4, w tej jednej sekcji opublikowano dokumentację trzech lub czterech 

maszyn. Wydaje się, że Curtiss przygotował produkcję P-40 w pośpiechu, ponieważ jest tu bardzo niewiele 

aircraft-manuals.com  plans.aero  aircorpslibrary.com  

2400 dpi  4500 dpi  ~7000 dpi  

http://www.aircraft-manuals.com/
http://www.plans.aero/
https://aircorpslibrary.com/
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rysunków XP-40/P-40-cu, a większość z nich jest bardzo złej jakości. Ich jasne linie znikają w tle – jak gdyby 

były narysowane ołówkiem zamiast tuszu. Dziwnym trafem, wszystkie te arkusze wczesnych P-40 mają przed-

rostek „75-*” i „8” jako piątą cyfrę: „75-XX-8XX” (jakby ten samolot był kolejną wersją P-36). Czy mógł także 

odziedziczyć wewnętrzną nazwę „Hawk 81” po nieudanym projekcie YP-37? 

 

Jeżeli szukasz dokumentacji samolotu produkowanego w USA (lub Spitfire) – zacznij od nabycia mie-

sięcznej subskrypcji zasobów AirCorps Library. Jeżeli nawet zniknie z niej funkcja lokalnego wydruku 

(ten portal wciąż się zmienia!) będzie można użyć go do sprawdzenia, co zawierają zachowane mikro-

filmy. Kompletny zestaw rysunków i instrukcji najlepiej kupić od plans.aero – i ewentualnie używać 

AirCorps Library do sprawdzenia jakiegoś szczegółu w większej rozdzielczości. 

 
 Zwróć jednak uwagę, że zbiory AirCorps Library i plans.aero nie są identyczne. Plans.aero oferuje tylko najbar-

dziej popularne myśliwce produkcji USA: F4U-1, P-40, F4F, F6F, P-51, P-47, i pojedynczy bombowiec: TBF-1. 

Możesz tam jednak znaleźć także dokumentację kilku konstrukcji z innych krajów, których nie ma w AirCorps 

Library: Bf-109, FW-190, Me-262, Avro Lancaster, Sopwith Camel i Pup. 

W ostateczności, jeżeli jakiś samolot znajduje się tylko w ofercie aircraft-manuals.com – można skorzystać z 

tego portalu, lecz najpierw spróbuj poprosić o fragment jakiegoś dużego rysunku złożeniowego z pakietu, który 

chcesz zamówić. Nie wiem, czy odpowiedzą, lecz przynajmniej warto spróbować przed zakupem. Może doku-

mentację innych maszyn zeskanowali w większej rozdzielczości? Możesz także użyć jako pomocniczego 

wskaźnika liczby DVD w zestawie podzielonej przez liczbę rysunków, które zawiera ten zestaw. Im ta wartość 

jest większa, tym lepiej. 

W następnej sekcji opiszę, jak pogrupowałem oryginalne rysunki P-40, przygotowując je do dalszej pracy nad 

rysunkami referencyjnymi dla mojego modelu. W ten sposób będę starał się odpowiedzieć na drugie pytanie z 

tej sekcji: „jak używać dokumentacji technicznej i nie zwariować”. 
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9.2 Organizacja rysunków 

Zanim zaczniesz organizować oryginalne rysunki samolotu, zbierz jak najwięcej jego zdjęć i zapoznaj się ze 

szczegółami jego kształtu, głównymi zespołami i – co ważne – ich połączeniami. Będziesz potrzebował tej wie-

dzy do szybkiego rozpoznania, czy konkretny rysunek jest przydatny do twojego projektu. Około 60% ramek 

oryginalnych mikrofilmów to różne drobne, wewnętrzne detale (rurki, ramki, płytki, itp.), które są potrzebne wy-

łącznie do budowy prawdziwego, latającego samolotu. 

Aby wydzielić użyteczne rysunki, musiałem przejrzeć całą zawartość mikrofilmu i skopiować te, które wybrałem, 

do folderów docelowych (Rysunek 9.2.1): 

 

Rysunek 9.2.1 Docelowa struktura i przykładowa zawartość folderów z rysunkami  

Możesz wykonać taki przegląd używając dwóch okien Eksploratora Plików: jednego dla listy rysunków źródło-

wych (oczywiście, z włączonym panelem podglądu), a drugiego – na folder docelowy. 

Aby podczas dalszej pracy szybko znaleźć jakikolwiek z wybranych rysunków, pogrupowałem ich foldery w hie-

rarchiczną strukturę. Jak widać na rysunku powyżej, każdy z tych folderów reprezentuje jakiś podzespół samo-

lotu. Początkowo stworzyłem tylko trzy: Empennage, Fuselage i Wing. Następnie każdy z tych głównych ze-

społów (folderów) podzieliłem na podzespoły. Na przykład – Empennage zawiera podkatalogi o nazwach Fin, 

Rudder, Stabilizer i Elevator. Skopiowałem do nich wszystkie interesujące rysunki z listy źródłowej. Następnie 

zmieniłem nazwę każdego ze skopiowanych plików na bardziej opisową i dodałem numer kolejny (na przykład: 

Assembly-01). Ten numer jest potrzebny, ponieważ często możesz się natknąć na wiele wariantów tego samego 

rysunku, pochodzących z różnych wersji samolotu. Gdybym napotkał następny rysunek złożeniowy tego sta-

tecznika, skopiowałbym go do tego katalogu i nazwał Assembly-02. Zwróć uwagę, że te nazwy są dość proste, 

gdyż niezbędny kontekst zapewnia im struktura folderów. Np. wiem, że ten plik Assembly-01 zawiera złożenie 

statecznika, ponieważ znajduje się na ścieżce Empennage\Stabilizer\. W katalogu początkowym (Empenna-

ge) umieściłem rysunki związane z całym zespołem, jak np. schemat montażu usterzenia do kadłuba samolotu. 

 

Struktura tych folderów i podfolderów jest odzwierciedleniem struktury konkretnego samolotu. Na przy-

kład, w przypadku radzieckiego myśliwca Ła-5 statecznik pionowy stanowił integralną częścią kadłuba. 

Stąd w jego folderach nie byłoby oddzielnego katalogu Fin. 

Ułożyłem wybrane 
rysunki P-40 w taką 
strukturę folderów 
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Jako źródło rysunków wykorzystuję portal AirCorps Library. Ich skany mikrofilmów są już pogrupowane na kate-

gorie, w oparciu o oryginalne numery rysunków (Rysunek 9.2.2): 

 

Rysunek 9.2.2 Kategorie rysunków z dokumentacji P-40  

 

U większości producentów, numery rysunków zawierają segment związany z kategorią (podzespołem) 

narysowanej części. Oczywiście, każdy producent stosował tu swoje własne reguły. Czasami trudno je 

zidentyfikować. Na przykład, rysunki P-39(/P-63) w AirCorps Library są pogrupowane wg pierwszych 

trzech cyfr ich numerów, ale te kategorie nie są nazwane. Do znalezienia głównego rysunku złożenio-

wego trzeba użyć indeksu nazw z oryginalnego mikrofilmu (także udostępnionego na tej stronie). 

 
 Najgorszym przypadkiem, jaki zdarzyło mi się do tej pory napotkać jest system numeracji Douglasa. A dokład-

niej – jego brak! U tego producenta każdy z wykonywanych rysunków otrzymywał kolejny numer. Rezultat moż-

na zobaczyć w dokumentacji C-47. Kuratorzy AirCorps Library grupują jej skany wg pierwszych trzech cyfr nu-

meru rysunku. Jednak to zupełnie bez sensu! Każda z tych grup to „mieszanka” przypadkowych części. Cza-

sami można napotkać tu sekwencję kilku powiązanych rysunków, ale to raczej przypadkowy rezultat kolejności 

przypisywania ich numerów. Być może było to grupowe „zamówienie na numery” z jednego działu, więc otrzy-

mały je po kolei. Napotkałem podobne problemy, gdy zacząłem analizować skany oryginalnej dokumentacji 

SBD Dauntless (A-24). Aby ją uporządkować, musiałem najpierw poświęcić jakieś sto roboczogodzin na stwo-

rzenie sensownego indeksu dla skanów jego mikrofilmów. (Więcej na ten temat możesz znaleźć w moim blogu). 

Na szczęście, Curtiss używał bardziej zaawansowanego systemu (por. str. 202). W sekcji P-40 AirCorps Library 

zidentyfikowało środkowy segment numeru rysunku jako identyfikator zespołu, i nawet nadało tym kategoriom 

opisy. W większości przypadków ich grupowanie jest bardziej szczegółowe niż moje. Na przykład: użyłem tylko 

jednego rysunku złożeniowego z kategorii Engine Mount Install i pominąłem całą kategorię Engine Starter. Za-

uważ jednak dużą liczbę rysunków w kategorii Uncategorized: 3 403! Tę grupę przejrzałem jako ostatnią. Naj-

pierw próbowałem skompletować podzespoły tego samolotu ze zidentyfikowanych kategorii. Robiąc to dowie-

działem się, jakich rysunków mi brakuje. Dopiero wtedy zacząłem ich szukać w tej grupie „niezidentyfikowa-

nych” skanów.  

Przejrzałem całą dokumentację z AirCorps Library używając ich stron z listami rezultatów wyszukiwań. Wybrane 

rysunki „drukowałem do PDF” (por. str. 210), a potem takie pliki zapisywałem do folderów docelowych. 

Rysunki są już pogrupowane w kategorie, które 
zazwyczaj odpowiadają oryginalnym podzespołom 

Około 30% rysunków jest 
nieskategoryzowanych 

https://aircorpslibrary.com/
https://airplanes3d.wordpress.com/2020/03/27/original-douglas-sbd-blueprints-first-impressions/
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Na ilustracji poniżej pokazuję przykładową zawartość docelowego katalogu z rysunkami statecznika poziomego. 

Jak widać, wybrałem tylko kilka arkuszy, które opisują tę część: oprócz rysunku złożeniowego, pokazanego po 

lewej (Rysunek 9.2.3), jest tu także rysunek żeber: 

 

Rysunek 9.2.3 Żebra statecznika poziomego  

(Ostatnie żebro – to przy końcówce statecznika – jest na innym rysunku, który nazwałem Ribs-02). Zwróć uwa-

gę na duży numer rysunku umieszczony na każdym z wydruków z AirCorps Library. Używałem ich często do 

ponownego sprawdzania danych źródłowych. Były m.in. pomocne przy eliminacji duplikatów. 

Inny rysunek z tego samego folderu – Webs-01 – opisuje dźwigary statecznika: 

 

Rysunek 9.2.4 Dźwigar i podłużnice statecznika poziomego  

Jak widać na liście plików z tego katalogu (Rysunek 9.2.4, lewy górny narożnik), dodałem tutaj także dwa waż-

ne szczegóły: zawiasy steru wysokości. W P-40 widać je w małych wycięciach w krawędzi natarcia steru. 

Dzięki temu numerowi nadal mogę odnaleźć 
oryginalny rysunek w AirCorps Library 
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Pewne pojedyncze arkusze są częścią kilku dokumentacji różnych samolotów. Na przykład – szczegółowy ry-

sunek zaokrąglonej krawędzi końcówki statecznika znajduje się w równoległym folderze z rysunkami P-36: 

 

Rysunek 9.2.5 Łuk końcówki statecznika poziomego  

Ta krawędź to wygięta w łuk duraluminiowa kształtka o przekroju „V”, użyta i w P-36, i w P-40. 

 

Jak wspomniałem w poprzedniej sekcji, mikrofilm Curtiss zeskanowany przez AirCorps Library zawiera 

dokumentację trzech samolotów: P-40, YP-37 i P-36. YP-37 pominąłem, ale dla P-36 przygotowałem 

oddzielne docelowe katalogi, o takiej samej strukturze jak dla P-40. Na szczęście można łatwo określić 

typ samolotu po początku numeru rysunku: „75” to P-36, „81” to YP-37, „87” to P-40. 

 
 Oczywiście, foldery docelowe większych zespołów, jak Fuselage, zawierają więcej rysunków: 

 

Rysunek 9.2.6 Zawartość folderu Fuselage  

Niektóre z folderów podzespołów (np. Antenna) stworzyłem tylko dlatego, że liczba ich rysunków przekroczyła 

siedem. (Było wiele różnych odmian masztu anteny). Zwróć także uwagę na dużą liczbę rysunków złożenio-

wych (Assembly-02, Assembly-03, itd.). Dla każdej nowej wersji P-40 (D, E, F, K, L, M, N) inżynierowie Curtiss 

To rysunek z zestawu P-36 („Hawk 75”) 

Ten arkusz jest 
podzielony na 
trzy ramki: a,b,c 

Foldery podzespołów 
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musieli przerysowywać nowy arkusz złożeniowy. Stworzyłem nawet oddzielny podfolder dla wariantów z wydłu-

żonym ogonem (późne P-40F, K, M, L, i wszystkie odmiany P-40N). 

Gdy pojedynczy arkusz zajmuje kilka ramek mikrofilmu, dodaję do nazw jego plików końcówki „a”, „b”, „c”: 

 
 

  

Rysunek 9.2.7 Dwie ramki arkusza z rysunkiem szkieletu kadłuba 

Ogólnie rzecz biorąc, w folderze Fuselage umieściłem rysunki złożeniowe, szkieletu, i rysunki każdej wręgi 

kadłuba. Zazwyczaj taka wręga składa się z wielu części, i w oryginalnej dokumentacji wymagają własnych 

rysunków złożeniowych. Niektóre wręgi mają więcej niż jeden rysunek złożeniowy (szczególnie te najbardziej 

skomplikowane, jak przegroda silnika). Pominąłem tu podłużnice, ponieważ są to proste kształtki o przekroju 

„L”, lekko wygięte pomiędzy kolejnymi wręgami. Z podobnego powodu nie skopiowałem też rysunków głównej 

podłużnicy kadłuba. Wybrałem natomiast kilka ważnych detali – na przykład listwy mocujące kadłub do skrzy-

dła. (Choć ukryte pod owiewkami skrzydeł, były widoczne ze środka kabiny pilota). Są tu także oddzielne pod-

katalogi dla kołpaka śmigła, okapotowania silnika, kabiny pilota, i zespołu kółka ogonowego. Osłona silnika ma 

kilka wariantów, więc stworzyłem oddzielne foldery: dla wczesnych („długonosych”) P-40-cu/B/C, dla później-

szych („krótkonosych”) P-40D i następnych. Ten ostatni jest dodatkowo podzielony na osłony dla wersji z silni-

kiem Allison (D, E, K, M, N) i Merlin (F, M). 

Podobnie w folderze Wing umieściłem rysunki złożeniowe, szkieletu oraz żeber i dźwigarów. Są tu oddzielne 

podfoldery dla klap, lotek, końcówki skrzydła, owiewki kadłuba, „kila” (to specyficzna dla P-40 „kontynuacja ka-

dłuba”, ciągnąca się pod skrzydłem), karabinów maszynowych, podwozia głównego i jego owiewek. 

 

 

 

 

Skeleton-01a Skeleton-01b 
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9.3 Identyfikacja brakujących rysunków 

Wykorzystujące metody opisane w poprzedniej sekcji, ostatecznie wybrałem z zestawu AirCorps około 900 ry-

sunków P-40, podzielonych na 36 folderów i podfolderów. Dodatkowo skopiowałem także 450 rysunków P-36, 

pogrupowanych w 26 folderów. Podczas tej pracy zauważyłem, że dokumentacja z tych mikrofilmów jest nie-

kompletna. Nie mogłem znaleźć skanów różnych arkuszy, które były wymienione na rysunkach złożeniowych. 

Co więcej, znalazłem tylko kilka rysunków „długonosych” wersji P-40 (-cu/B/C). Na przykład: największym pod-

zespołem P-40/B/C jaki udało mi się zidentyfikować jest łoże silnika Allison-1710 C15: 

  

Rysunek 9.3.1 Łoże silnika Allison V-1710 C15 (rysunek nr 87-22-001) 

Pozostałe odnalezione rysunki „długonosych” P-40 pochodzą z dokumentacji prototypu (XP-40). Oceniając na 

podstawie numerów tych arkuszy, XP-40 był traktowany jako nowy wariant P-36: wszystkie mają prefiks „75” i 

„8” jako piątą cyfrę. Na przykład – w zbiorach AirCorps Library możesz znaleźć rysunek mocowania chłodnic 

cieczy w XP-40 (rysunek nr 75-50-858): 

 

Rysunek 9.3.2 Rysunek zamocowań chłodnic cieczy w XP-40 

Zwróć uwagę jak mało widoczne i cienkie są linie na tym skanie. W niektórych jego częściach zupełnie rozmy-

wają się w tle. To niestety reguła, a nie wyjątek: większość rysunków XP-40 jest jeszcze mniej czytelna! 

Znikające 
linie 
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Na wielu arkuszach XP-40 jedynym elementem, który można dostrzec, jest tabelka rysunku: 

 

Rysunek 9.3.3 Przykład nieczytelnego rysunku XP-40 

W sumie, to 25% rysunków XP-40 jest nieczytelnych! Wygląda na to, że z powodu złego kontrastu oryginalnych 

rysunków i niewłaściwych ustawień kamery mikrofilmu te informacje zostały utracone na zawsze. 

To poważny problem. Zamierzałem użyć tej dokumentacji do udoskonalenia mojego modelu P-40B. Z P-36 mo-

gę wykorzystać „eksportową” wersję skrzydeł (z 2 km) i kadłub (od przegrody silnika) jako pierwsze przybliżenie 

płatowca P-40B. Mogę potem je uzupełnić pewnymi szczegółami z rysunków P-40D/E: „kilem” pod skrzydłem, 

płaskimi pokrywami kółka ogonowego, większym podwoziem głównym i jego uproszczonymi owiewkami. Jed-

nak bardzo potrzebuję danych geometrycznych unikalnej osłony silnika P-40/B/C! 

Wygląda na to, że nie jest to tylko mój problem. W 80. numerze magazynu „Classic Wings” znalazłem artykuł o 

odbudowie egzemplarza P-40B, zakończonej w 2011r. przez zespół AvSpecs. Z powodu braku jakiejkolwiek 

dokumentacji, musiano w nim odtworzyć całą sekcję silnika wyłącznie na podstawie zdjęć innego, odrestauro-

wanego wcześniej P-40! Załączam poniżej fragment ze str. 18 tego magazynu: 

 

Rysunek 9.3.4 Problemy w odbudowie prawdziwego P-40B 

W takim przypadku istnieje możliwość, że w tej maszynie powielono także ewentualne błędy popełnione przy 

odbudowie tego wcześniejszego P-40B (był to samolot z Flying Heritage Collection). 

W tym rysunku możesz 
tylko przeczytać tabelkę!  

https://www.classicwings.com/classicwings-sample-issue-80_sm.pdf
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Pamiętając o tym wszystkim, zacząłem przeglądać 3 400 nieskategoryzowanych rysunków z AirCorps Library. 

Najpierw natknąłem się na dodatkową grupę rysunków P-36, pominiętą zapewne przez pomyłkę: arkusze 75-

28-XXX opisują osłonę NACA dla silnika Double Wasp. Oczywiście, to pozwoliło mi uzupełnić tę lukę w doku-

mentacji P-36, lecz nie było to moim głównym celem. Inne rysunki z grupy Uncategorized wydawały się nale-

żeć do Y1P-36 (numery przedrostków: 85-* i 99-*), XP-37 (przedrostki: 84-* i 90-*), i P-40F (przedrostek: 96-*). 

Są tu także dane geometryczne (ang. „layout” – rysunki o numerach z przedrostkiem „L”), szkice robocze 

(przedrostek „SK”), oraz propozycje projektowe (przedrostek: „P”). 

Wśród tych rysunków znalazłem trochę takich szkiców XP-40, jak przedstawiony poniżej SK-2698: 

 

Rysunek 9.3.5 Czy to wylot powietrza z chłodnicy XP-40? 

W tabelce znamionowej tego szkicu mogłem odczytać: „Cooler Duct – Rear”. Śledząc te cienkie, zanikające 

linie, byłem w stanie zidentyfikować widoki z tyłu i z boku. Jednak pomiędzy październikiem 1938r. i lutym 

1940r. chłodnice XP-40 były modyfikowane cztery razy, i tylko ostatnia z tych modyfikacji, wprowadzona po 

grudniu 1939r., odpowiada kształtowi chłodnicy użytej w P-40/B/C. Nie byłem w stanie określić, czy ten rysunek 

przedstawia tę ostatnią zmianę, czy może jeden z wcześniejszych wariantów. 

Natknąłem się także na szkic geometrii (numer: L-10202). W jego tabelce można odczytać: „Basic Cowl Lines”. 

Jednak typ samolotu jest w niej nieczytelny, podobnie jak daty (pierwsza z nich może być „1/6/39”, a ostatnia 

„6/7/..”, lecz nie jestem tego pewien): 

 

Rysunek 9.3.6 Geometria osłony silnika XP-40 (rysunek nr: L-10202) 

Widok z 
tyłu 

Widok z 
boku 

Współrzędne 
(wciąż czytelne) 

Brak wylotu 
z chłodnicy 

Thrust 
line 

 

Firewall 

 

Kształt tego wlotu 
wygląda jak ten z 
P-40/B/C 
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Patrząc na rzut z boku (Rysunek 9.3.6), z jego relatywnie małym chwytem powietrza do chłodnicy i brakującym 

wylotem, myślałem że L-10202 przedstawia „środkowy” wariant XP-40, ze stycznia 1939. Jednak później zau-

ważyłem, że na rzucie z przodu ten chwyt powietrza jest dość duży, i wygląda znajomo – tak jak ten z P-40/B/C! 

(Żadna z wcześniejszych odmian XP-40 nie miała chwytu powietrza podzielonego na trzy części, jakie widać na 

tym rysunku). Ten szkic zawiera także częściowo czytelne współrzędne, opisujące kształt osłony silnika. Są 

wyrażone w układzie cylindrycznym, o osi biegnącej wzdłuż osi śmigła: 

 

 

Rysunek 9.3.7 Szczegóły szkicu L-10202 

Położenie płaszczyzny śmigła i inne wymiary są mierzone od płaszczyzny przegrody silnika. Wszystkie wartości 

są podane w calach. Patrząc na umieszczoną poniżej sylwetek tabelę współrzędnych zauważyłem, że jej lewa 

strona opisuje „czystą” wersję kształtu osłony silnika (taką, jak w pierwszej konfiguracji XP-40, w której „pudeł-

kowatą” chłodnicę umieszczono za skrzydłem). Dołączona po prawej stronie druga część tabeli opisuje modyfi-

kację (może ostatnią?), w której tunel chłodnic jest umieszczony pod silnikiem. Ten rysunek po prostu pomija 

kształt wylotu z tego tunelu (może dlatego, że przedstawia go inny szkic?). Brakuje tu także chwytu powietrza 

do gaźnika i osłon km, umieszczonych na szczycie osłony silnika. Jednak może jest to „rysunek koncepcyjny”, 

który po prostu mógł nie uwzględniać tych detali? 

Zdecydowałem się dopasować kształt opisany w tym szkicu do kadłuba P-36, i sprawdzić czy taka kombinacja 

odpowiada zdjęciom P-40. Może to jest prawdziwa geometria osłony silnika P-40/B/C? Szczegóły tego porów-

nania opiszę w sekcjach 9.6 i 9.7.  

 

Poprawka: kształt 
osłony chłodnicy 

Położenie na 
osi śmigła 

Kierunki 
(co 15º) 
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9.4 Kompozycja podstawowego widoku z boku 

Jak napisałem w poprzedniej sekcji, nie można znaleźć kompletnej dokumentacji wczesnych wariantów P-40 

(tak zwanych „długonosych”: P-40-cu, P-40B i P-40C). Zebrałem wszystko, co jest obecnie dostępne w Interne-

cie: rysunki bezpośredniego „przodka” tego myśliwca (P-36) i jego późniejszych wersji („krótkonosych” P-

40D..P-40N). Wykorzystując skany ramek ich mikrofilmów, archiwalne zdjęcia i opisy techniczne można odtwo-

rzyć skrzydła, usterzenie i kadłub (od ogona do przegrody silnika) tych wczesnych P-40. 

Rozpocząłem od najbardziej oczywistej części widoku z boku: kadłuba. Za wręgą nr 1 (przegrodą silnika) był w 

zasadzie taki sam jak w P-36, z wyjątkiem osłony kółka ogonowego: 

 
 

 

Rysunek 9.4.1 Kadłub P-36 (od przegrody silnika) z osłoną kółka ogonowego jak w P-40 

Połączyłem tu dwie ramki mikrofilmu (Frame 1 i Frame 2 z ilustracji powyżej) rysunku szkieletu P-36 (numer 

rysunku: 75-21-606). Szczegóły „klejenia” tych dwóch obrazów znajdziesz na str. 192. Na tym widoku z boku 

umieściłem oś kadłuba w Y=0, a płaszczyznę przegrody silnika w X=0. Zmniejszyłem obydwa skany do skali 

1:1, czyli 1 jednostka rysunku (1 piksel) = 1 cal. 

Dopasowując te dwa skany, zaobserwowałem niewielkie różnice pomiędzy zwymiarowanymi położeniami wręg 

a ich liniami na tym rysunku. Co więcej, podobne odchylenia wystąpiły w obszarze, w którym prawy i lewy obraz 

nakładają się na siebie. Dla porównania, Rysunek 9.4.2 przedstawia prawą ramkę w kolorze czerwonym: 

 

Rysunek 9.4.2 Nakładające się obszary dwóch sąsiednich ramek mikrofilmu 

Wręga 1 (przegroda) 
X=0 (linia odniesienia) 

Oś kadłuba 
Y=0 

Wręga 16 
X=226.5 

 

Wręga 8 
X=106 

 

Nakładające 
się obszary 

W P-40 znikło to 
“wybrzuszenie” 

Frame 1 

 
Frame 2 

 

Frame 1 

 
Frame 2 

 

Widoczne różnice 
pomiędzy czarnymi i 
czerwonymi liniami 
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Jak widać powyżej, te dwa obrazy są nieco „niezsynchronizowane”. Obydwie ramki przedstawiają ten sam, 

pojedynczy arkusz. Rezultat, jaki pokazuje Rysunek 9.4.2 oznacza, że co najmniej jedno z tych zdjęć jest lekko 

zniekształcone (szczególnie wzdłuż zewnętrznych krawędzi). 

Napotkane deformacje korygowałem rozciągając każdy ze skanów, tak by narysowane na nich linie odniesienia 

odpowiadały podanym wymiarom (por. str. 192-194). Jednak niektóre zniekształcenia (np. beczkowate) są nieli-

niowe, i dlatego nie mogłem poprawić „niezsynchronizowanych” linii pokazywanych przez Rysunek 9.4.2. W 

takim przypadku jedynym wyjściem było określenie, który z obrazów jest mniej zdeformowany, i zamaskowanie 

linii tego drugiego. Wykorzystałem w tym celu prostokąty wypełnione białym gradientem (szczegóły – str. 196). 

 

Jak wspomniałem już w sekcji 5.3 (str. 102): gdy tylko to możliwe, wykorzystuj jawnie podane wymiary. 

Używaj narysowanych na odbitkach konturów tylko wtedy, gdy nie masz żadnej lepszej alternatywy. 

 
 Wykorzystując wymiary podane w rysunkach złożeniowych (położenie osi steru kierunku, wysokość tego steru – 

por. str. 104) mogłem dodać do tego kadłuba rysunki usterzenia pionowego (Rysunek 9.4.3): 

 

Rysunek 9.4.3 Dopasowywanie rysunków usterzenia pionowego P-36 (we wczesnych P-40 było identyczne) 

Statecznik pionowy i ster kierunku we wczesnych P-40 były takie same jak w P-36. W późniejszych wersjach 

jedyną zmianą był wprowadzony w P-40D popychacz klapki trymera, w miejsce dotychczasowych cięgien. 

 

W P-40K-1 powiększono statecznik pionowy i dodano mu z przodu płetwę grzbietową, aby przeciw-

działać problemom ze statecznością podłużną „krótkonosych” P-40. Jednak w sierpniu 1942r. Curtiss 

zdecydował się rozwiązać ten problem w inny sposób: wydłużając kadłub. Przesunięto oryginalny („jak 

z P-36”) statecznik i ster kierunku do tyłu o około 20 cali. Ta modyfikacja została wprowadzona w P-

40K-10 z silnikami Allison i P-40F-20 z silnikami Merlin (zakłady Curtiss produkowały obydwa warianty 

tych maszyn równolegle). 

 
 W tym rzucie z boku użyłem rysunku statecznika pionowego z P-36 (75-12-001) i odpowiadającego mu rysunku 

steru kierunku (75-14-001). Zweryfikowałem dokładną skalę i pozycję w pionie tych dwóch obrazów wykorzystu-

jąc zwymiarowane płaszczyzny zawiasów steru kierunku. 

Te zwymiarowane płaszczyzny 
zawiasów steru wykorzystałem do 
określenia rozmiarów i położenia 
w pionie obrazów statecznika i 
steru kierunku 

Statecznik pionowy 

 
Ster kierunku 

 

Oś steru kierunku 
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Linie rysunków usterzenia są dużo cieńsze od linii na arkuszach ze szkieletem kadłuba. Aby stały się bardziej 

widoczne, zdecydowałem się obrysować ich kontury w Inkscape. Na rysunkach P-36 znalazłem promienie i 

środki pięciu łuków, z których jest złożona krzywa krawędzi spływu steru kierunku. Te wymiary pomogły mi od-

tworzyć ten kształt, pomimo deformacji dolnej części skanu tego arkusza (Rysunek 9.4.4a): 

        

Rysunek 9.4.4 Obrysowanie konturów usterzenia 

Do weryfikacji tego kształtu użyłem steru kierunku z P-40N (Rysunek 9.4.4b). Jak widać, czerwony obrys, który 

naniosłem w Inkscape, pasuje do obydwu obrazów. Do tego niezdeformowanego skanu z P-40N pasuje nawet 

lepiej niż do oryginalnego, lekko zniekształconego arkusza z P-36. Wydaje mi się, że wiele krzywych w P-40 

było opisanych za pomocą kilku stycznych łuków (tak jak ten ster). Dla pozostałych przypadków Curtiss używał 

klasycznych tablic współrzędnych, które opisywały kilka punktów krzywej. Pomiędzy tymi punktami musisz sam 

dobrać kształt konturu. Wykorzystaj potem zdjęcia, aby sprawdzić, czy rezultat wygląda prawidłowo. 

Zakładając, że osłony otworu kółka ogonowego we wszystkich wersjach P-40 były takie same, skopiowałem ich 

kontury z rysunku kadłuba P-40E (nr. 87-21-401):  

 

Rysunek 9.4.5 Kopiowanie konturu wycięcia na kółko ogonowe z rysunku złożeniowego P-40E 

Jednak z publikacji Dany Bella „P-40 Warhawk” (Aircraft Pictorial #5) dowiedziałem się, że oryginalnie to wycię-

cie było mniejsze. Jesienią 1941 Curtiss wysłał do wszystkich jednostek USAAC zestawy do modyfikacji, które 

Ster kierunku 
z P-40N 

Deformacja 
arkusza 

Kontur steru 
jest złożony 

z 5 łuków  

Taki sam 
kontur jak 
w P-36  

a) 

 

b) 

 

Ster kierunku 
z P-36 

Oryginalne wycięcie w P-40-cu/B/C 
było mniejsze.  (Narysowałem ten 
niebieski kontur na podstawie zdjęć) 

We wrześniu 1941 wprowadzono modyfikację polową, wydłużającą 
to wycięcie (przynajmniej w P-40 należących do USAAC). 
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wydłużały goleń kółka ogonowego. Ta modyfikacja miała zmniejszyć tendencję do kapotowania, która prześla-

dowała P-40. Zmodyfikowane osłony miały wycięcie na wystającą z kadłuba dolną część kółka. Wydaje się, że 

ta modyfikacja nie była stosowana w eksportowych Tomahawkach, w tym w maszynach z AVG. Rysunek 9.4.5 

pokazuje także kontur tego oryginalnego wycięcia. Naniosłem go wyłącznie w oparciu o zdjęcia, więc jest w 

kolorze niebieskim (oznacza to, że ta linia nie jest potwierdzona przez żaden oryginalny rysunek lub wymiar). 

Znalazłem dwie wersje rysunku struktury kadłuba P-36/wczesnych P-40, zawierające kluczowe wymiary. Poni-

żej pokazuję pierwszą wersję (rysunek nr 75-21-140) z dokumentacji P-36: 

 

Rysunek 9.4.6 Geometria kadłuba P-36 (rysunek nr 75-21-140, skan ramki 1/2) 

Istnieje także jeszcze inny wariant (rysunek nr 75-21-836), przygotowany dla prototypu XP-40: 

 

Rysunek 9.4.7 Geometria kadłuba wczesnego wariantu XP-40 (rysunek nr 75-21-836, skan ramki 1/2) 

Linie na tym rysunku są szersze i ciemniejsze niż na skanach P-36, co może być przydatne do sprawdzania 

mniej czytelnych wymiarów. Zwróć uwagę na czarny obszar na kadłubie za skrzydłem. Wydaje się, że użyto tu 

odbitki arkusza P-36, zamazując obszary, które miały ulec zmianie. Sądzę, że ten rysunek dotyczy pierwszego 

wariantu XP-40, w którym chłodnicę cieczy umieszczono za skrzydłem. 
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Wykorzystując wymiary z tych dwóch schematów, narysowałem dokładny górny kontur kadłuba P-40B 

(Rysunek 9.4.8): 

 

 Rysunek 9.4.8 Górny kontur kadłuba P-36/P-40 (wg wymiarów) 

 

Rysując te wszystkie kontury, korzystam z konwencji planów modelarskich: dokładny kontur obiektu 

leży na zewnętrznej krawędzi jego obrysu. Na ilustracji powyżej to górna krawędź czerwonej linii. 

 
 Jak widać, rysunek szkieletu P-36 bardzo dobrze pasuje do tego zwymiarowanego konturu: ewentualne różnice 

nie przekraczają grubości oryginalnych linii. 

Zrobiłem to samo porównanie dla dolnej części kadłuba (Rysunek 9.4.9): 

 

Rysunek 9.4.9 Dolny kontur kadłuba P-40B (wg wymiarów) 

Wymiary (głębokości kolejnych wręg) ujawniły, że jest to długi odcinek linii prostej, ciągnący się od krawędzi 

spływu skrzydła do steru kierunku. Zwróć uwagę na zniekształcenie kształtu tego konturu na oryginalnym ry-

sunku, przy krawędzi spływu centralnego żebra skrzydła (por. Rysunek 9.4.9, zaznaczona okręgiem czarna 

linia). To efekt drobnej deformacji oryginalnego obrazu z mikrofilmu. Mógłby być mylący, gdybym nie zweryfiko-

wał go z wymiarami kadłuba! 

Kontur obiektu leży na zewnętrznej 
krawędzi tego obrysu 

W zasadzie, odchylenia nie 
przekraczają grubości tej linii  

Narysowałem ten kontur korzystając z 
wysokości wręg kadłuba podanych na 
schemacie geometrii P-36 

Według wymiarów, to jeden 
długi odcinek linii prostej  

Takie niewielkie zniekształ-
cenia oryginalnego rysunku 
mogą być mylące 

Czerwona linia to 
dokładny kontur 
kadłuba  
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W P-36 i w P-40 występuje dodatkowa owiewka pod środkiem skrzydła, wyglądająca jak kontynuacja kadłuba. 

W dokumentacji Curtiss określa ją jako „kil” (to analogia do stępki statku): 

 

Rysunek 9.4.10 „Kil” pod skrzydłem „Tomahawk” IA (technicznie to P-40B) 

To osłona kryzy, łączącej prawe i lewe skrzydło oraz biegnących wzdłuż niej przewodów z olejem i paliwem1. 

Znalazłem rysunki tych osłon w dokumentacjach P-36 i P-40E..N. W P-36 była szersza i krótsza, więc na razie 

założyłem, że kształt tego „kila” we wszystkich wersjach P-40 był taki sam. (Potem to założenie sprawdzę). 

Zgodnie z dokumentacją P-40E, ten kil był podzielony na trzy części (rysunki nr: 87-23-502, 87-23-503, 87-23-

504). Geometria każdego z tych segmentów jest opisana przez odpowiednią tabelę współrzędnych.  

  

Rysunek 9.4.11 Współrzędne środkowej sekcji „kila” P-40 (z rysunku nr 87-23-503) 

Do tworzenia widoku z boku, potrzebuję z tej tabeli tylko wartości V i W. Dla przykładu: z wiersza, który opisuje 

przekrój dla X = 83 (to odległość od przegrody silnika) mogę odczytać, że H = 4.17. Oznacza to, że górna kra-

wędź tej osłony jest na głębokości Y = 4.17+20 = 24.17 (to odległość mierzona w dół od osi kadłuba). Podobnie, 

gdy V = 9.93 to współrzędna Y dolnego konturu jest na głębokości 29.93. Naniosłem na mój rysunek w Inksca-

pe wszystkie kolejne głębokości V i H, i połączyłem je dwoma liniami. 

 
1 W tych „długonosych” P-40 zbiornik oleju znajdował się w ogonie, za kabiną i zbiornikiem paliwa 
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Rezultat pokazuje Rysunek 9.4.12 (matematyczny kontur leży na zewnętrznych krawędziach linii tego obrysu): 

 

Rysunek 9.4.12 Kontur „kila” P-40 

Na tym etapie, mój widok z boku wygląda jak poniżej: 

 

Rysunek 9.4.13 Aktualny stan mojego rysunku P-40B 

W następnej sekcji wykonam kilka podstawowych porównań ze zdjęciami, aby odtworzyć na tym rysunku parę 

specyficznych szczegółów z P-40-cu/B/C. Następnie będę pracował na odtworzeniem konturu najtrudniejszej (z 

powodu braku dokumentacji) części tego samolotu: osłony silnika, wraz z chłodnicą cieczy i kołpakiem śmigła. 

 

Podczas dalszej pracy nad tym rysunkiem będę korzystał z konwencji jaką pokazuje Rysunek 9.4.5: 

szczegóły odtworzone wg zdjęć są w kolorze niebieskim. Kształty obrysowane czerwonymi liniami to 

szczegóły potwierdzone (wymiarami). Czasami mogę także narysować elementy oparte pośrednio na 

innych wymiarach. W takim przypadku użyję połączenia kolorów: niebieskiego i czerwonego. Stąd, 

udział barwy niebieskiej w kolorze linii to % hipotez opartych na zdjęciach. 

 
  

 

Ten segment to 
linia prosta 

Ta krawędź wydaje się 
dobrze pasować do 
dolnej powierzchni płata 

Profil centralnego żebra 
skrzydła (NACA-2215) 
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9.5 Sprawdzanie z wykorzystaniem zdjęć 

W poprzedniej sekcji do odtworzenia konturu „kila” pod skrzydłem P-40 użyłem dokumentacji P-40E. Zrobiłem 

tak, gdyż rysunki wcześniejszych wersji tego samolotu (P-40B, P-40C) są niezwykle rzadkie, i często rozpro-

szone wśród mniej istotnych arkuszy (takich jak szkice czy propozycje konstrukcyjne). Teraz wykorzystam zdję-

cia do zweryfikowania mojego założenia, że ten „kil” miał taki sam kształt w „długonosych” wariantach P-40. 

Obraz samolotu na większości zdjęć jest zdeformowany przez zniekształcenie perspektywiczne (które zależy od 

ogniskowej obiektywu) i zniekształcenie beczkowate (wynik niedoskonałości systemu optycznego). Możesz 

szybko oszacować skalę tych (połączonych) deformacji na zdjęciach samolotu z boku. Popatrz tylko na linie 

połączeń poszycia, biegnące wzdłuż wręg kadłuba. Zazwyczaj są wypukłe. Jeżeli na nosie samolotu te wypu-

kłości są zwrócone w przeciwną stronę niż na ogonie – oznacza to znaczne zniekształcenie, takie jak na przed-

stawionym poniżej zdjęciu „Tomahawk” IA: 

 

Rysunek 9.5.1 Zniekształcenie obrazu samolotu na typowym zdjęciu 

Intensywność deformacji jest proporcjonalna do wypukłości przeciwległych wręg. Można także ją ocenić po 

przybliżonym kierunku osi steru wysokości. (Ta oś jest zazwyczaj prostopadła do osi kadłuba). Mógłbyś użyć 

różnych programów do „spłaszczenia” takich zniekształceń na zdjęciach, lecz w trakcie takiej poprawek łatwo 

jest stworzyć inne deformacje. (Szczególnie w przypadku historycznych fotografii, tak jak ta powyżej). 

O wiele łatwiej jest znaleźć jakieś współczesne zdjęcie odrestaurowanego samolotu, wykonane teleobiektywem. 

Są to zazwyczaj ujęcia w locie, wykonane z dużej odległości. Na takich zdjęciach pionowe linie szwów poszycia 

„wyginają” się w tę samą stronę. Poniżej pokazuję, jako przykład takiego obrazu, fotografię P-40C z pokazu w 

Duxford: 

 

Rysunek 9.5.2 Współczesne zdjęcie o wysokiej rozdzielczości, z minimalnym zniekształceniem  

Zazwyczaj taki obraz jest niemal ortogonalny i wystarczy tylko nieco rozciągnąć takie zdjęcie wzdłuż osi kadłu-

ba, by dopasować je do rzutu z boku. Pamiętaj tylko, że na tak poprawionej fotografii pionowe linie wręg pozo-

Przeciwna orientacja wypukłości linii 
wręg na nosie i ogonie samolotu 

Punkt neutralny 

Źródło: NSAM 

 

Oś steru wysokości “Kil” 
 

Źródło: Wikimedia 

 

Wszystkie wręgi wydają się być 
skierowane w tę samą stronę 

Oś steru 
wysokości 



230 Dodatki 

 

 

Wirtualne modelarstwo – Tom I: Przygotowania 

www.samoloty3d.pl 

staną wypukłe. Stąd, jeżeli chcesz użyć jej do odtworzenia jakiegoś szczegółu z boku kadłuba (obramowania 

kabiny pilota, luku na bagaż, itp.) nadal musisz uwzględnić odpowiednie przesunięcie. 

Poniżej pokazuję, jak dopasowałem to zdjęcie do mojego rzutu z boku. Najpierw przerzuciłem je w pionie, aby 

odpowiadało widokowi z lewej. Następnie rozciągnąłem je nieznacznie w poziomie, dopasowując kluczowe 

krawędzie do konturów rysunku (tutaj były to: wiatrochron i krawędź natarcia statecznika pionowego): 

 

Rysunek 9.5.3 To samo zdjęcie, dopasowane do rzutu z boku  

Następnie sprawdziłem, czy czerwone linie konturu kadłuba (te narysowane wg wymiarów) pasują do sylwetki 

samolotu ze zdjęcia. Jak widać, dopasowanie jest całkiem przyzwoite, także linii kila. Dostrzegłem tylko jeden 

szczegół: przednie i tylne krawędzie otworu kółka ogonowego niezbyt pasują do krawędzi ze zdjęcia. Gdy jed-

nak napotkasz taką różnicę, lepiej jest ją sprawdzić jeszcze na innej fotografii. 

 

Czasami szczegóły odrestaurowanych samolotów różnią się od oryginałów. W szczególności dotyczy 

to maszyn odbudowanych przed 1990r. 

 
 Na szczęście znalazłem kolejne zdjęcie, wykonane teleobiektywem. To inny P-40B (także z Duxford): 

 

Rysunek 9.5.4 Dopasowanie kolejnego zdjęcia  

Krawędź natarcia skrzydła samolotu ze zdjęcia pokazuje, że jest on odwrócony około 10º do kamery. Stąd 

wszystkie szczegóły z prawej strony, odsunięte od płaszczyzny symetrii samolotu, wydają się być przesunięte 

do tyłu. Możesz dostrzec ten efekt na ramce wiatrochronu lub otwartych osłonach kółka ogonowego. Ten sam 

efekt może być także przyczyną niewielkiej różnicy kształtu na końcu „kila”. W każdym razie, to porównanie 

“Kil” z P-40E pasuje do tego P-40C 

Muszę jeszcze zweryfikować położenie 
przedniej i tylnej krawędzi tego otworu 

Rozciągnąłem to zdjęcie, 
dopasowując je do tych 
dwóch linii konturu 

Drobna różnica? 
 

Najbardziej prawdopodobne położenia 
przedniej i tylnej krawędzi tego otworu 

Ten kształt ramki oszklenia kabiny 
występował tylko w P-40-cu/B/C 
 

Źródło: airliners.net 
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także potwierdza, że P-40B/C używał takiego samego „kila” jak ten z P-40E, gdyż czerwony kontur kila z P-40E 

pasuje do obydwu analizowanych zdjęć. 

 

Porównaniu takich szczegółów w odrestaurowanych maszynach wciąż towarzyszy znaczny margines 

błędu. Jak wyjaśniałem w poprzednich sekcjach, nie zachowała się dokumentacja P-40B/C (por. str. 

227), i wykonujący te prace mogli odtworzyć osłony kila wykorzystując te same rysunki P-40E, co ja. 

Jednak jego kształt wydaje się także pasować do historycznych zdjęć. Tym niemniej, do dokładniej-

szych porównań z tymi fotografiami potrzebuję modelu 3D. (Dlatego zrobię to później – por. Tom II). 

 
 Wykorzystałem także te dopasowane zdjęcia o wysokiej rozdzielczości do odtworzenia pewnych szczegółów 

wokół kokpitu, które występowały wyłącznie w „długonosych” P-40. Rysunek 9.5.5 pokazuje je w kolorze niebie-

skim: 

 

Rysunek 9.5.5 Szczegóły wokół kabiny pilota (czarne linie to rysunek szkieletu P-36)  

Nie znalazłem żadnych rysunków tylnych ramek kabiny z wczesnych wersji P-40. Jednak wykorzystując kontury 

odpowiednich ramek z P-36 (widoczne na rysunku szkieletu kadłuba) oraz zdjęcia, mogłem uzyskać całkiem 

dokładne przybliżenie tej części. Na rysunku powyżej naniosłem także różnice pomiędzy pierwszą serią 200 P-

40 (oznaczoną także jako P-40-cu) i późniejszymi wariantami „długonosych” P-40 („Tomahawk II” i P-40B/C). 

W następnej sekcji zmierzę się z najmniej udokumentowanym zespołem P-40B: osłoną silnika. 

 

Wlew oleju 
(P-40B/C) 

Wlew paliwa 
(P-40B/C) 

W P-40-cu tu był wlew 
do zbiornika oleju 

W P-40B/C poszycie kadłuba 
zachodziło na wiatrochron 

W P-40-cu wlew paliwa 
znajdował się za uchwytem 
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9.6  Identyfikacja odnalezionego szkicu osłony silnika 

Wczesne P-40 (-cu, B, C) były pośpieszną adaptacją płatowca P-36 do silnika rzędowego. Stąd przedział silnika 

był jedynym dużym zespołem specyficznym dla tych wersji samolotu. Niestety, ich dokumentacja zaginęła. Jed-

nak w sekcji 9.3 (str. 220, 221) opisałem niezauważony wcześniej szkic geometrii, który znalazłem wśród „nie-

skategoryzowanych” rysunków Curtissa w dziale „P-40” AirCorps Library: 

 

Rysunek 9.6.1 Szkic osłony silnika (L-10202)  

Ten szkic może opisywać geometrię osłony silnika „długonosych” P-40. W tym samym zbiorze nieskategoryzo-

wanych materiałów znalazłem kilka regularnych arkuszy XP-40 (łoże silnika, uchwyty chłodnic). Jednak linie na 

tych rysunkach są wyblakłe, czyniąc je niemal nieczytelnymi. Szkic L-10202 jest najbardziej obiecującym obra-

zem, który znalazłem. Teraz spróbuję dopasować ten skan do kadłuba P-40B, który przygotowałem w poprzed-

nich sekcjach. Użyję także zdjęć do sprawdzenia, czy ta osłona pasuje do prawdziwego samolotu. 

Ponieważ skany ramek mikrofilmów mogą mieć różne zniekształcenia, użyłem współrzędnych z tabeli umiesz-

czonej na L-10202 do narysowania konturu tej osłony. Rezultat widać poniżej: 

 

Rysunek 9.6.2 Kontury kołpaka śmigła i osłony silnika wg tabeli współrzędnych ze szkicu L-10202 

Granice konturu doskonale pasują do przegrody silnika. Jednak nie można na tym szkicu znaleźć linii podziału z 

kołpakiem śmigła. Co gorsza, całkowita długość tego zespołu to 116.5” – brakuje 1.688” do długości nosa P-40. 

Tabela współrzędnych 
(częściowo czytelna) 

Brak wylotu powie-
trza z chłodnicy (?) 

Thrust 
line 

 

Firewall 

 

Kształt tego wlotu 
wygląda jak we 
wczesnych P-40 

Fuselage 
reference line 

 

Brakuje chwytu powietrza 
do gaźnika i osłon km 

Oś śmigła była 1” 
powyżej osi kadłuba  

Górna krawędź 
pasuje do prze-
grody silnika P-36 

Kontury 
chłodnic  

Te linie opisują 
pierwszy wariant 
XP-40 

Ten kołpak jest za krótki (a 
jego czubek – za szeroki)! 

Płaszczyzna śmigła 

Tylna krawędź kołpaka śmigła 
powinna być gdzieś tutaj 



Rozdział 9 Wykorzystanie oryginalnej dokumentacji samolotu 233 

 

 
 (CC) Witold Jaworski, 2009 – 2020. 

(Według wymiarów z rysunków poglądowych, odległość od czubka kołpaka śmigła do płaszczyzny przegrody 

silnika to 118.188”). Porównajmy jeszcze ten obrys ze zdjęciami: 

 

Rysunek 9.6.3 Sprawdzanie kontury z rysunku L-10202 ze zdjęciem odrestaurowanego P-40C 

Samolot na zdjęciu to odrestaurowany P-40C z Duxford. Jak widać, czubek jego kołpaka ma mniejszy promień i 

jest także dłuższy o około 1.5”. Czyli przyczyną różnic w długości całkowitej jest różnica w kształcie kołpaka 

śmigła. Samolot na tym zdjęciu jest znacznie odchylony od kamery, co sprawia, że więc kontury jego wręg są 

odpowiednio „wypukłe”. Trudno jest więc jednoznacznie stwierdzić, czy położenie wlot powietrza do chłodnicy 

jest zgodne z rysunkiem. To zdjęcie ujawnia jednak kolejną niezgodność: osłona chłodnicy tego P-40C jest nie-

co głębsza (o około 1”) od konturu ze szkicu L-10202. 

Oczywiście, gdy znalazłem takie różnice na jednym zdjęciu, musiałem także sprawdzić, czy występują na in-

nych. Poniżej widać rezultat kolejnego porównania (to jest inna maszyna, w tym przypadku – P-40B, także z 

Duxford): 

 

Rysunek 9.6.4 Sprawdzanie tego samego kontury z innym zdjęciem 

Ten kołpak 
jest dłuższy 

Osłona chłodnic 
jest nieco głębsza 

Chwyt powietrza 
chyba się zgadza 

Źródło: Wikimedia 

 

Osłona chłodnic jest nieco głębsza 
(jednak to część odtworzona na podstawie zdjęć!) 

Ten kołpak 
jest dłuższy 

Położenie wlotu 
powietrza pasuje 
do zdjęcia  

Source: airliners.net 
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Obydwa zdjęcia z poprzedniej strony to współczesne fotografie odrestaurowanych samolotów. Aby się upewnić 

co do uzyskanego wyniku, sprawdziłem dodatkowo jedno z archiwalnych zdjęć Curtissa: 

 

Rysunek 9.6.5 Porównanie konturu z archiwalnym zdjęciem (to przód „Tomahawk” IA) 

Po tych trzech porównaniach, mogę potwierdzić obydwie różnice: w długości kołpaka śmigła i głębokości osłon 

chłodnic. Różnica w kształcie osłony przed chłodnicą (por. Rysunek 9.6.5) wymaga dalszej weryfikacji, ponie-

waż widać ją wyraźnie tylko na tym ostatnim, archiwalnym zdjęciu. 

Odmienny kształt kołpaka śmigła można wyjaśnić porównując jeden z pierwszych rysunków poglądowych XP-

40 z podobnym rysunkiem seryjnego P-40: 

 

Rysunek 9.6.6 Różnica w długości całkowitej pomiędzy pierwszym wariantem XP-40 a seryjnym P-40 

Pierwszy wariant XP-40 miał długość całkowitą 31’ 6.875”, podczas gdy długość seryjnego P-40 to 31 8.5625”. 

Różnica – 1.6875” – odpowiada dokładnie różnicy pomiędzy szkicem L-10202 i zdjęciami P-40. 

Ten kołpak 
jest dłuższy 

Osłona chłodnic jest nieco głębsza 
(jednak wcześniej wydłużyłem trochę to 

zdjęcie, dopasowując je do widoku z boku) 

Położenie wlotu 
zgodne z rysunkiem 

Głębszy kontur? 

Źródło: NSAM 

 

Rysunek poglądowy 
pierwszego wariantu 
XP-40 (1938) 

Rysunek poglądowy 
seryjnego P-40-cu 
(1941) 
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W istocie, na zachowanych zdjęciach kołpak śmigła XP-40 wydaje się być bardziej zaokrąglony (na nieszczę-

ście, mam tylko jedną taką fotografię, w stosunkowo niskiej rozdzielczości): 

 

Rysunek 9.6.7 Finalna konfiguracja prototypu XP-40 

Co więcej, gdy dopasowałem obraz z tego zdjęcia do tylnej krawędzi kołpaka i płaszczyzny przegrody silnika, 

okazało się, że pasuje do konturu z rysunku L-10202: 

 

Rysunek 9.6.8 Porównanie sylwetki prototypu XP-40 z konturem ze szkicu L-10202 

Wygląda to na drobne różnice pomiędzy prototypem i wersją seryjną samolotu! Jednak miałem pewne wątpli-

wości co do dokładności takiego prostego „rozciągania” zniekształconej (mniej lub więcej) fotografii ponad orto-

graficznym rzutem z boku. Bardziej złożona kompensacja deformacji perspektywicznej także może okazać się 

błędna, szczególnie w przypadku zdjęć archiwalnych (wspomniałem o tym w poprzedniej sekcji). Wówczas po-

jawiła się idea wykorzystania nawyków fotografów Curtissa: w ujęciach XP-40 i „Tomahawka” ustawili samolot 

niemal w takiej samej pozycji. Na obydwu fotografiach lewa goleń podwozia zasłania prawą, i jedna z łopat śmi-

gła jest skierowana prosto w dół. Nałożenie jednego z tych zdęć na drugie i dopasowanie sylwetek obydwu 

samolotów wymaga tylko minimalnych zmian skali jednego z tych obrazów. Co więcej, zniekształcenie optyczne 

(perspektywiczne i beczkowate) każdego z tych zdjęć jest podobne (mogły być wykonane tą samą kamerą), 

więc nie muszę go kompensować. Oznacza to, że taka metoda może być całkiem precyzyjna w ujawnieniu 

ewentualnych różnic w kształcie kołpaka śmigła i osłony silnika. 

Źródło: World War Photos 

 

Curtiss XP-40 
w lutym 1940r. 

Ten czubek wydaje się 
większy niż w seryjnym 
“Tomahawku” 
 

Ta osłona pasuje do 
narysowanego konturu! 

Ten obraz pasuje 

do konturu kołpaka 

Rozciągnąłem to zdjęcie, wpasowując je 
pomiędzy kołpak śmigła i przegrodę silnika  
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Rysunek 9.6.9 przedstawia takie nałożenie: 

                                      

 

Rysunek 9.6.9 Porównanie sylwetek ze zdjęć XP-40 i wczesnego P-40 („Tomahawk” IA) 

By ten test był poprawny, musiałem dopasować do siebie inne elementy niż w poprzednim porównaniu. O dzi-

wo, dolna łopata śmigła okazała się idealnym wzorcem do uzgodnienia nosa samolotu. Wykorzystując ją jako 

punkt zaczepienia, obróciłem i odrobinę rozciągnąłem obraz P-40, dopasowując kontur jego statecznika do 

konturu statecznika XP-40 (wg dokumentacji były identyczne). Na ilustracji powyżej zaznaczyłem te „wzorcowe” 

kontury białą, przerywaną linią. Dla łatwiejszego odróżnienia, pokolorowałem także zdjęcie XP-40 na czerwono. 

Rysunek 9.6.9 pokazuje większość różnic kształtu jako obszary jaśniejsze (na przykład – przy końcu skrzydła), 

albo ciemniejsze (na przykład – za kołami podwozia). Jaśniejszy obszar wokół skrzydła ujawnia niewielką różni-

cę w orientacji kamery i każdego z samolotów. Ta różnica przejawia się także w odchyleniu pionowych kontu-

rów, proporcjonalnym do ich odległości od płaszczyzny symetrii samolotu. Są one szczególnie widoczne na 

ramkach osłony kabiny i w „cieniach” za kołami podwozia. Aby lepiej uwidocznić znalezione różnice, Rysunek 

9.6.10 pokazuje obraz XP-40 i odpowiednie kontury P-40 narysowane białą, przerywaną linią:       

 

Rysunek 9.6.10 Kontury osłony silnika i kołpaka śmigła P-40, naniesione na obraz XP-40 

Różnice w 
orientacji 
kamery 

Różne kontury 
osłony chłodnicy 

Kółko ogonowe w XP-40 
było mniejsze niż w P-40 

Jaśniejsze obszary 
to zdjęcie P-40B 

XP-40, luty 1940 
 

P-40, listopad 1940 
 

Wzorzec1 

 
Wzorzec 2 

 

Górne osłony i rury wydechowe są 
takie same na obydwu zdjęciach 

Górne krawędzie 
pasują do siebie 

Kołpak P-40B był dłuższy 
i miał ostrzejszy czubek 

Ta osłona także 
była niżej 

Ten dolny kontur był głębszy o 
około 0.5” przy wlocie do chłod-
nicy i około 1” przy wylocie  
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Jak pokazuje Rysunek 9.6.10, sylwetki (kontury na płaszczyźnie symetrii) tych dwóch samolotów pasują do 

siebie oprócz dolnej krawędzi osłony chłodnicy. To ostatecznie potwierdza moją hipotezę, przedstawioną przez 

Rysunek 9.6.5. Widać tu także różnice w kształcie kołpaka śmigła pomiędzy XP-40 i P-40. 

Konkluzja: szkic L-10202 opisuje geometrię ostatniego wariantu XP-40, z lutego 1940r. W seryjnych P-40 koł-

pak śmigła był dłuższy o 1.688”, a osłona chłodnicy nieco głębsza (o około 1”). Współrzędne z tabeli z L-10202 

pasują do górnej części osłony silnika P-40 (górnych 180º każdego z jej przekrojów ponad osią śmigła). Różni-

ce w kształcie osłon bocznych (do 60º poniżej osi śmigła) są najprawdopodobniej minimalne. No cóż, zawsze 

lepiej jest mieć przynajmniej takie częściowe współrzędne niż nic. 

Rysunek 9.6.11 przedstawia obydwa kontury kołpaków śmigła i osłon silnika (części potwierdzone przez orygi-

nalne rysunki/współrzędne są w kolorze czerwonym, a odtworzone według zdjęć – niebieskim): 

 

Rysunek 9.6.11 Kontury osłony silnika i kołpaka śmigła XP-40 i P-40 

Na rysunku L-10202 można także dostrzec osie i rozmiary cylindrycznych chłodnic płynu (Prestone) i oleju z 

XP-40. Przypuszczam, że w P-40 te chłodnice były zamontowane nieco niżej. 

Po tych doświadczeniach z identyfikacją „nieskategoryzowanego” rysunku założyłem, że wszystkie szkice z 

zestawu „P-40” z AirCorps Library bez opisu typu samolotu w tabelce (jak w L-10202), dotyczą XP-40. 

W następnej sekcji dokończę kreślenie tego rzutu z boku P-40. 

Elementy odtworzone ze 
zdjęć są niebieskie 

Kontury chłodnic cieczy 
i oleju (z XP-40) 

Czerwony kontur: XP-40, 
niebieski kontur: P-40 
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9.7 Odtworzenie osłony silnika P-40B 

W poprzedniej sekcji ostatecznie zidentyfikowałem szkic L-10202 jako część dokumentacji XP-40, opisującą 

ostatnią, przedprodukcyjną wersję tego prototypu z lutego 1940. W tym czasie Curtiss kończył przygotowania 

do produkcji seryjnej P-40. Pierwsze kilkadziesiąt maszyn zostało przyjęte przez USAAC w kwietniu 1940r. W 

swoim ostatnim „wcieleniu”, XP-40 bardzo przypominał seryjnego P-40-cu, z wyjątkiem wypukłej osłony kółka 

ogonowego i ramek kabiny, „odziedziczonych” po P-36. Jednak porównanie zdjęć ujawniło inne drobne różnice 

kształtu pomiędzy tymi samolotami: P-40-cu miał głębszą osłonę chłodnicy i dłuższy kołpak śmigła. 

Wydaje mi się, że wszystkie oryginalne rysunki i szkice zebrane z AirCorps Library, dotyczące wczesnych P-40, 

to dokumentacja XP-40. Dlatego najpierw przygotuję rzut z boku XP-40, wykorzystując te oryginalne materiały. 

Potem narysuję kontury P-40B, wykorzystując rzut z boku XP-40 i dostępne zdjęcia P-40-cu/B/C. 

Jak pokazuję w sekcji 9.3, szkice XP-40 są nie tylko rzadkie, ale także w złym stanie. Dla przykładu – poniżej 

przedstawiam szkic chwytu powietrza do chłodnicy cieczy (Rysunek 9.7.1): 

 

Rysunek 9.7.1 Oryginalny szkic wlotu powietrza do chłodnicy (rysunek L-10276: dwie nałożone ramki mikrofilmu) 

Linie tych skanów nikną w białym tle, na którym widać tylko fragmenty oryginalnego rysunku. Szczerze mówiąc, 

często było mi trudno zidentyfikować, jaką część samolotu przedstawia taki szkic. Dlatego na początek wczyta-

łem te obrazy do oddzielnego rysunku Inkscape i obrysowałem kluczowe kontury oraz osie przedstawionych na 

nich obiektów. W ten sposób stały się bardziej czytelne (Rysunek 9.7.2): 

 

Rysunek 9.7.2 Ten sam rysunek z podkreślonymi konturami i osiami rzutu z boku 

Kolejne sekcje tunelu 

Oś chłodnicy płynu Prestone 

Oś chłodnicy oleju 

Przekrój krawędzi natarcia 
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Następnie dopasowałem tak poprawione obrazy do mojego głównego rysunku. Pozwoliły mi odtworzyć we-

wnętrzne kontury tuneli chłodnicy. Rezultaty przedstawiam na ilustracji poniżej: 

 

Rysunek 9.7.3 Szczegóły osłony chłodnicy (XP-40) 

Intensywność barwy niebieskiej w kolorze tych linii określa, na ile ich kształt jest oparty na informacji ze zdjęć. 

(Czerwone linie są w pełni potwierdzone przez oryginalne odbitki z mikrofilmów, fioletowe – częściowo potwier-

dzone, a niebieskie linie są odwzorowane wyłącznie z fotografii). 

Na rysunku L-10202 brakuje informacji o konturach chwytu powietrza do gaźnika i osłonach km, umieszczonych 

na szczycie osłony silnika P-40. Na szczęście wśród „nieskategoryzowanych” rysunków z AirCorps Libary zna-

lazłem szkice ich kluczowych elementów: 

      

Rysunek 9.7.4 Kluczowe detale z górnej osłony silnika 

Są to odlewane, przednie części chwytu powietrza i osłon km. Obydwie odbitki zawierają nie tylko kluczowe 

wymiary, ale także odległości od płaszczyzn przekrojów osłony silnika, co pozwoliło mi określić ich współrzędne 

X w rzucie z boku. Dodatkowo, na rysunku chwytu powietrza jest podana jego odległość od górnego konturu 

osłony, co pozwala wyznaczyć jej współrzędną Y. (Mogłem ją znaleźć, wykorzystując współrzędne osłony ze 

szkicu L-10202). Aby w podobny sposób umiejscowić osłonę karabinu, musiałem najpierw określić położenie osi 

jego lufy. Wykorzystałem w tym celu rysunki P-36/Hawk 751. 

 
1 Za przegrodą silnika, kadłuby P-36 i wczesnych P-40 były niemal identyczne. Oznacza to także identyczne osie karabinów kadłubowych, 

nawet wtedy, gdy różniły się kalibrem! Curtiss zaprojektował uniwersalne łoża km, dostosowane do karabinów kalibru 7.7/12.7mm, stąd w 

P-40-cu użyto 2 nkm kalibru 12.7mm, w P-36 – jeden nkm 12.7mm i jeden km 7.7mm, podczas gdy w eksportowym H75 były to dwa kara-

biny kalibru 7.7mm (lub 7.5mm, w maszynach sprzedanych do Francji). 

Ważna informacja: 
osie chłodnic 

Ta “fala” jest 
także widoczna 
na zdjęciach 

L-10276 

SK-2698 

Osłona km (SK-2605) 
 

Chwyt powietrza (SK-2603) 
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Rysunek 9.7.5 przedstawia szczegóły montażu uzbrojenia w kadłubie Hawk 75. Na podobnym rysunku dla P-

36, znalazłem potwierdzenie, że osie karabinów 12.7mm i 7.7mm były symetryczne. Jednak jego linie były mało 

czytelne, dlatego spośród tych dwóch skanów pokazuję tu ten bardziej wyraźny:   

 

Rysunek 9.7.5 Karabiny w kadłubie Hawk 75 (rysunek nr 75-69-902) 

Położenie karabinów jest podane na rzucie z przodu. Z tego rysunku odczytałem, że osie ich luf znajdowały się 

22” ponad osią kadłuba (i 9” od płaszczyzny symetrii samolotu). Wykorzystując tę informację, mogłem precyzyj-

nie umieścić na głównym rysunku wzmocnienie osłony km ze szkicu SK-2605.  

Na ilustracji powyżej zwróć uwagę na zaznaczony na różowo obszar pomiędzy dźwigarami 1 i 2 oraz wręgami 

przy kadłubie. W P-36 i H75 był wykorzystywany jako pojemnik na zużyte łuski km (do odzysku). Podobny po-

jemnik występował jeszcze w P-40-cu, ale usunięto go z późniejszych wersji (P-40B/C). 

Rysunek 9.7.6 przedstawia szczegóły górnej części osłony silnika, narysowane w wykorzystaniem informacji ze 

szkiców SK-2603 i SK-2605: 

 

Rysunek 9.7.6 Szczegóły na górnej części osłony silnika 

Jak widać, naniosłem tu także domniemany kształt tunelu dla łusek wewnątrz skrzydeł P-40B/C. 

Położenie 
osi luf 
karabinów 

Ta sekcja skrzydła służyła 
jako pojemnik zużytych 
łusek (także w P-40-cu) 
 

Ten “skręcony” tunel obracał 
wyrzucane z zamka łuski o 90⁰ 
 

Wyrzutnik łusek 

Osie chwytu powietrza i km 
są na tym samym poziomie 

Ten segment tunelu dla 
łusek jest czystą spekulacją 

Linie proste 



Rozdział 9 Wykorzystanie oryginalnej dokumentacji samolotu 241 

 

 
 (CC) Witold Jaworski, 2009 – 2020. 

Następnym brakującym elementem były rury wydechowe silnika i ich otwór. Z oczywistych przyczyn płaszczy-

zna zdjęcia nigdy nie będzie idealnie równoległa do osi kadłuba. Dlatego na moich fotografiach ten szczegół jest 

zawsze przesunięty w poziomie i pionie w ślad za położeniem kamery. Stąd, do dokładniejszego określenia 

położenia tego otworu wykorzystałem rysunek łoża silnika P-40-cu (nr 87-22-001): 

 

Rysunek 9.7.7 Określanie położenia i rozmiaru otworu na rury wydechowe silnika 

Nie znalazłem żadnego przyzwoitego rysunku silnika Allison V-1710-C, który był montowany we wczesnych P-

40. Zamiast tego użyłem konturów jego późniejszego wariantu (V-1710-F) z P-40D (różniły się przekładniami, 

ale założyłem, że ich korpusy nie uległy zmianie). Starannie „przymocowałem” sylwetkę tego silnika do śrub 

widocznych na rysunku łoża z P-40-cu (z rysunku 87-22-01, pokazanego na str. 218). 

Odkryłem także, że na szkicu L-10202 rzut z przodu zawiera pewne mało widoczne linie. Po porównaniu ze 

zdjęciami okazało się, że są to linie podziału paneli osłony silnika: 

 

Rysunek 9.7.8 Naniesienie linii podziału paneli osłon silnika 

L-10202 pokazuje, że te linie układają się wzdłuż promieni biegnących od osi śmigła, jak to zaznaczyłem na 

rzucie z przodu. Co ciekawe, pasują do zdjęć produkcyjnych P-40-cu/B/C. W XP-40 linia podziału ponad rurami 

wydechowymi biegnie nieco wyżej niż na tym rysunku. Czy to jakiś drobny problem z wykonaniem prototypu? 

Łoże silnika 
(87-22-001) 

Silnik 
Allison  

Rury wydechowe  

Te linie biegną 
wzdłuż promieni 
od osi śmigła  
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Na zdjęciach zauważyłem także kilka interesujących szczegółów wokół kołpaka śmigła. Zaznaczyłem je na ilu-

stracji poniżej, na której porównuję wcześniejsze i późniejsze warianty „długonosych” P-40: 

 

Rysunek 9.7.9 Szczegóły osłony silnika i kołpaka śmigła  

Zwróć uwagę, że tylna krawędź kołpaka śmigła zasłania przednie krawędzie paneli osłony silnika. To rozwiąza-

nie występuje w wszystkich wersjach P-40. Przypuszczam, że mogło minimalnie zmniejszać opór samolotu. Na 

ilustracji powyżej można także dostrzec różnicę w kształtach wycięć w kołpaku wokół łopat śmigła. W P-40-cu 

przekrój łopaty w tym miejscu był okrągły, więc ten otwór miał kształt koła. Z kolei na zdjęciu „Tomahawka” IIA z 

AVG przekrój łopaty śmigła i jej otwór mają kształt przypominający elipsę1. 

NA zdjęciu P-40-cu można zauważyć długie „rury” osłon karabinów maszynowych. Ich zadaniem była ochrona 

reszty konstrukcji przed falami uderzeniowymi wystrzałów. Okazało się, że były za długie: drgania silnika i inne 

przypadkowe obciążenia mogły zmieniać ich kształt podczas lotu. W pewnych ekstremalnych przypadkach wy-

strzelone pociski „półcalówek” były w stanie zniszczyć końce tych rur. W rezultacie Curtiss zdecydował się skró-

cić długość osłon km i na obszarze bezpośrednio przed ich wylotami wzmocnić panele okapotowania silnika. Ta 

zmiana była także wprowadzona do wyprodukowanych wcześniej P-40-cu. 

 
1 W „Aircraft Pictorial #5” Dany Bella znalazłem wzmiankę, że w śmigłach P-40-cu wykorzystano wydrążone, stalowe łopaty śmigieł. Braki 

tych łopat podczas produkcji późniejszych serii P-40B i „Tomahawków” zmusiły zakłady Curtiss do wykorzystania substytutu: litych łopat 

śmigieł wykonanych z aluminium, które były nieco cięższe. Może ten samolot z AVG używał właśnie takich łopat?  

Kołpak “zachodzi” 
na osłonę silnika 

Różne kształty 
tego otworu 

Długie osłony km 
(używane w 1940r.)  
 

Krótkie osłony km (modyfikacja 
wprowadzona pod koniec 1940r.) 

Tomahawk IIA (z AVG) 

 

P-40-cu 

 

Chłodnica płynu 
Prestone 

Chłodnica 
oleju 
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 (CC) Witold Jaworski, 2009 – 2020. 

Rysunek 9.7.10 przedstawia szczegóły kołpaka śmigła: 

 

Rysunek 9.7.10 Szczegóły kołpaka śmigła (XP-40) 

Na rysunku L-10202 zaznaczono, że płaszczyzna osi łopat śmigieł leży 99 11/16” od przegrody silnika. Co praw-

da pierwsze rysunki poglądowe XP-40 z 1938r. umieszczają tę płaszczyznę nieco bliżej (99”), ale w tym pierw-

szym wariancie kołpak śmigła także był krótszy. Znalazłem także rysunek przedniej wręgi osłony silnika (75-29-

834). Ten skan jest mało czytelny, ale pozwolił mi określić dokładne położenie i rozmiar tego dysku. Jednak 

żaden z tych rysunków nie podaje położenia tylnej krawędzi kołpaka śmigła. Musiałem to zrobić wykorzystując 

zdjęcia (dlatego ten fragment rysunku jest w kolorze niebieskim). 

Zwróć uwagę, że Rysunek 9.7.8 pokazuje także rury osłon km, których nie było w tym prototypie (na zdjęciu z 

lutego 1940 XP-40 nie jest uzbrojony). Rysunek 9.7.10 koryguje ten błąd. 

Znalazłem także wyblakłe odbitki kołpaka śmigła i pierwszej wręgi (rysunki 75-42-803 i 75-42-823). Ten rysunek 

złożeniowy, pochodzący z 1939r., wydaje się opisywać krótszą wersję kołpaka. Widać na nim szeroką na 5/8” 

szczelinę pomiędzy tylną wręgą kołpaka i osłoną silnika. Przypuszczam, że w późniejszej wersji poszycie koł-

paka wydłużono o około 1” za krawędź tylnej wręgi, tak że zasłoniło tę szczelinę i przód okapotowania silnika. Z 

rysunku złożeniowego skopiowałem także okrągły kontur otworu na łopatę śmigła. 

Rysunek poniżej przedstawia uzyskany rzut z boku XP-40 (tu jest wersja w wysokiej rozdzielczości): 

 

Rysunek 9.7.11 Rzut z boku XP-40 (wariant z lutego 1940) 

Gdy kontury osłony silnika prototypu są już na miejscu, możemy teraz na ten rysunek nanieść różnice występu-

jące w seryjnych P-40. 

Otwór na łopatę śmigła 
(wariant kołowy) 

Pierwsza wręga osłony była przy-
mocowana do przekładni redukcyj-
nej silnika Allison V-1710 

Wręgi kołpaka 
(stożki ścięte) 

Oś łopaty śmigła (99 11/16” 
od przegrody silnika) 

http://wjaworski.pl/blog/p-40/102-XP-40.jpg
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Jak opisuje to sekcja 9.6, seryjne P-40 miały dłuższy kołpak śmigła i głębszą osłonę chłodnicy cieczy. W warian-

tach z silnikiem Allison znajdowały się tam dwa cylindryczne wymienniki ciepła płynu chłodzącego (Prestone) i 

pojedyncza chłodnica oleju, o podobnym kształcie. Widać je na zdjęciach szczegółów silnika (na przykład – por. 

Rysunek 9.7.9). Znalazłem dwa rysunki ramek, do których były przymocowane te chłodnice: jeden dla XP-40 

(75-50-858) i drugi z „krótkonosego” P-40E (87-50-012). Wynika z nich, że podczas gdy średnica chłodnicy 

oleju była taka sama w obydwu wersjach (11.12”), to chłodnice płynu Prestone w XP-40 były mniejsze (13.12” 

średnicy), niż ich odpowiedniki w P-40E (14.63”). Porównałem proporcje średnic chłodnic oleju i Prestone na 

różnych zdjęciach silników P-40-cu/B/C. Ostatecznie doszedłem do wniosku, że prawdopodobnie użyte w nich 

chłodnice Prestone miały taki sam rozmiar jak te z P-40E. Wydaje mi się, że osłona z L-10202 miała jeszcze 

dostateczną szerokość, by (tak „na styk”) pomieścić te większe cylindry. Porównałem odpowiednie wymiary 

ramek chłodnic przedstawionych na obydwu analizowanych odbitkach. Odległość w pionie pomiędzy osiami 

chłodnicy oleju i płynu Prestone zwiększyła się z 9.5” w XP-40 do 10” w P-40. Założyłem, że kształt górnej czę-

ści wewnętrznych tuneli doprowadzających powietrze do chłodnicy pozostała bez zmian. Sądzę bowiem, że 

korpusy silników użytych w XP-40 i wczesnych P-40 były takie same i w związku z tym nie było już przestrzeni 

na rozbudowę chłodnicy w górę. Stąd, na rysunku P-40 obniżyłem oś chłodnicy Prestone o 0.755”, tak aby pa-

sowała do ramek z P-40E. W rezultacie oś chłodnicy oleju znalazła się o 1.25” (0.755”+0.5”) niżej niż w XP-40. 

Taka konfiguracja pasuje do archiwalnych zdjęć. Na rysunku poniżej zaznaczyłem osie chłodnic XP-40 na czar-

no, a osi chłodnic P-40 – na biało: 

 

Rysunek 9.7.12 Dopasowanie osłony chłodnic cieczy P-40 do archiwalnego zdjęcia 

Dopasowanie konturu samolotu z ortograficznego rzutu z boku do perspektywicznej projekcji na zdjęciu nigdy 

nie jest łatwe i wolne od błędów, szczególnie dla zdjęć wykonanych z typową ogniskową (około 35mm). W przy-

padku „Tomahawka” IA z fotografii powyżej, szczegóły górnej części osłony silnika są się przesunięte w górę, a 

kołpak śmigła odrobinę dłuższy niż w rzeczywistości. Jednak obszar wokół klap chłodnicy i goleni podwozia 

wydaje się niezdeformowany (były w centrum obiektywu – por. str. 90). W oparciu o te założenia i szkic tuneli 

powietrza chłodnicy XP-40 narysowałem kontury osłony silnika P-40. Linie niebieskie to kształty odwzorowane 

wyłącznie na podstawie zdjęć. Zwróć uwagę, że sam wlot powietrza jest nadal w kolorze czerwonym, ponieważ 

był zamontowany około 0.5” niżej niż w XP-40, ale pozostał w tej samej odległości od przegrody silnika (74”). 

Wylot z chłodnicy P-40, razem z łukiem jego klap sterujących przepływem, został obniżony o 1.2”.  

 

Oczywiście, tutaj porównuję się tylko z jednym zdjęciem. Jednak aby zmniejszyć granice błędów, nieu-

niknionych w takich porównaniach, sprawdziłem te kontury także z kilkoma innymi fotografiami P-40. 

 
 

Chłodnica oleju 
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Obniżony łuk z klapami 
sterującymi przepływem 

Inny 
kołpak 

Zmieniony kontur 
tylnej osłony  
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 (CC) Witold Jaworski, 2009 – 2020. 

Porównałem także ten kontur ze współczesnym zdjęciem P-40B, wykonanym teleobiektywem: 

 

Rysunek 9.7.13 Porównanie konturu P-40 z odrestaurowanym samolotem 

Wygląda na to, że te kontury pasują do siebie. Jednak przypuszczam, że zespół odtwarzający ten samolot nie 

dysponował dokumentacją osłony silnika. Te prace były wykonane nawet wcześniej niż przypadek opisany na 

str. 219. W zasadzie ostateczny rezultat jest całkiem dokładny, oprócz fragmentu osłony za wylotem z chłodnicy 

cieczy (por. Rysunek 9.7.13, różowy obszar): ten ze zdjęcia ma zdecydowanie zbyt płaski kształt. 

Rysunek 9.7.14 pokazuje uzyskane kontury osłony silnika P-40-cu/B/C: 

 

Rysunek 9.7.14 Osłona silnika wczesnych P-40 

Poniżej umieściłem widok rezultatu – widok z boku P-40B, złożony z fragmentów oryginalnych rysunków: 

 

Rysunek 9.7.15 Kompletny kontur wczesnych P-40 

Błędny kształt tej osłony w 

odrestaurowanym P-40B 
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„Duży” Rysunek 9.7.15 (tzn. wersję o wysokiej rozdzielczości) znajdziesz w materiałach towarzyszą-

cych (por. str. 18). Pełna ścieżka do tego pliku to: source/reference/drawings/P-40B_side.png. Wyko-

rzystaj go przy budowie modelu jako dodatkowy rysunek referencyjny (por. str. 112). 

 
 Oczywiście, to nie jest kompletny widok z boku. Jednak jest to użyteczny rysunek referencyjny, który wykorzy-

stam przy tworzeniu mojego modelu. Ta praca pozwoliła mi także określić, które z zebranych rysunków Curtiss 

są użyteczne, oraz dowiedzieć się czegoś o brakach w tej dokumentacji. 

Rozważając dalsze kroki, uświadomiłem sobie, że „klasyczna” metoda: 

1. stworzenie z oryginalnych rysunków złożeniowych nowego rysunku referencyjnego (zrobiłem to w tym 

rozdziale); 

2. stworzenie na podstawie takiego płaskiego rysunku trójwymiarowego modelu (co zamierzam zrobić). 

nie jest optymalna. 

Na przykład: kontury rzeczywistego obiektu są matematyczną abstrakcją: to nieskończenie cienkie linie. Z dru-

giej strony, na rysunku zawsze muszę je rysować liniami o jakiejś szerokości. Mogę „obejść” ten problem zakła-

dając, że dokładny kontur leży na zewnętrznej krawędzi ich obrysu. Jednak rysując te linie mogę nieświadomie 

popełnić jakieś niewielkie, lecz istotne przesunięcia (lub inne błędy). 

Jak dotąd, wykorzystałem tylko ułamek informacji dostępnej w tej dokumentacji: większość jej schematów geo-

metrii podaje kompletne współrzędne wszystkich kolejnych przekrojów obiektu. W moim widoku z boku użyłem 

tylko dwóch wierszy z tabeli współrzędnych osłony silnika (wierszy dotyczących jego górnego i dolnego kontu-

ru). W widoku z góry/z dołu wykorzystam tylko jeden, kolejny wiersz z tej tabeli! (Ten, który opisuje max. szero-

kość kadłuba). Oczywiście, mogę także nakreślić na rysunkach referencyjnych dodatkowe linie pomiędzy kontu-

rami z góry i z boku. Jednak obawiam się, że będą one mniej dokładne od źródłowych współrzędnych, gdyż 

będę musiał narysować tę samą linię dwa razy, na każdym z tych dwóch rzutów. Trudno jest znaleźć ewentual-

ne pomyłki w liniach, których projekcje są podzielone na dwa dwuwymiarowe obrazy. O wiele lepszym pomy-

słem jest użyć współrzędnych z dokumentacji P-40 do stworzenia czegoś w rodzaju trójwymiarowej „wzorcowej 

siatki” w Blenderze. Następnie użyć jej do budowy właściwego modelu. Taka „siatka” dla kadłuba składałaby się 

z konturów kolejnych wręg. Podobna siatka dla skrzydła zawierałaby kontury kluczowych żeber, dźwigarów oraz 

kontur obrysu końcówki płata. 
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 (CC) Witold Jaworski, 2009 – 2020. 

Rozdział 10. Dodatkowe wyjaśnienia 

W tym rozdziale umieściłem informacje "dla dociekliwych". Znajdują się tu szczegółowe wyjaśnienia wybranych 

zagadnień, nad którymi nie chciałem się rozwodzić w części głównej (aby nie zbaczać z tematu).  
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10.1 Zniekształcenia obiektu na zdjęciach 

Najbardziej oczywiste zniekształcenie obiektu odwzorowanego na zdjęciu jest spowodowane przez projekcję 

perspektywiczną. Przedstawię ją na przykładzie prostego „domku” (złożony kształt samolotu utrudniłby dostrze-

żenie kluczowych zagadnień, które przedstawiam poniżej): 

 

Rysunek 10.1.1 Przykład zniekształcenia perspektywicznego 

Jednak płaszczyzny prostopadłe do kierunku kamery to specjalny przypadek (Rysunek 10.1.2):  

 

Rysunek 10.1.2 Własności płaszczyzn prostopadłych do kierunku kamery 

Projekcja perspektywiczna konturu, który leży na płaszczyźnie prostopadłej do kamery, zachowuje także jego 

kąty. Oznacza to, że ściany, które pokazuje Rysunek 10.1.2, zachowały swój oryginalny kształt (w szczególności 

– proste kąty narożników). Jednak zwróć uwagę na względne rozmiary tych ścian: zależą od odległości od ka-

Wszystkie linie proste 
pozostają proste 

Jednak nie są już do siebie 
równoległe I prostopadłe  

Kontury leżące na płaszczyznach pro-
stopadłych do kamery zachowują ory-
ginalne kąty (i wewnętrzne proporcje)  

Względne rozmiary kształtów 
zależą od odległości od kamery  

B 

A 
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mery. W przestrzeni trójwymiarowej krawędzie A i B (Rysunek 10.1.2) mają identyczną długość, ale w tej pro-

jekcji A wydaje się być dłuższe od B, gdyż jest bliżej obserwatora (tj. kamery) .  

 

To oznacza, że sylwetka samolotu na zdjęciu z boku wykonanym prostopadle do płaszczyzny symetrii 

samolotu powinna odpowiadać jego konturowi z rzutu z boku (o ile zdjęcie nie jest zniekształcone). 

 
 Jednak w prawdziwych obiektywach na projekcję perspektywiczną nakłada się jeszcze inne zniekształcenie. 

Poniżej pokazuję przykład typowego zniekształcenia ujemnego („beczkowatego”)  (Rysunek 10.1.3): 

 

Rysunek 10.1.3 Przykład negatywnego zniekształcenia („beczkowatego”) w obiektywie kamery 

Gdybym usunął z powyższego obrazka pomocniczą siatkę i odciął zaokrąglone brzegi, trudno byłoby dostrzec 

to zniekształcenie. Możesz wykryć jego obecność sprawdzając długie linie, które w czystej projekcji perspekty-

wicznej powinny pozostać proste. Jeżeli są zakrzywione jak te na ilustracji powyżej, to obraz jest zdeformowa-

ny. Silne zniekształcenie beczkowate można łatwiej zauważyć dla bardzo krótkich ogniskowych kamery (gdy 

zaczyna przypominać obrazy z obiektywu typu „rybie oko”). 

Starsze teleobiektywy (o długich ogniskowych) mogą tworzyć zniekształcenia dodatnie („poduszkowe”):  

 

 Rysunek 10.1.4 Przykład dodatniego zniekształcenia („poduszkowego”)  

Tak jak w zniekształceniu beczkowatym, możesz wykryć tę deformację zdjęcia poprzez sprawdzenie wygięcia 

na obrazie długich, prostych linii (lub krawędzi). 

Bez tej pomocniczej siatki 
trudno byłoby dostrzec 
„beczkowate” zniekształ-
cenie tego obrazu – krót-
sze linie wydają się nadal 
być proste 

Jednak tę deformację 
można wykryć szukając 
wygięcia długich prostych 
linii lub krawędzi  

Proste linie 

Te proste linie znów 
są wygięte (ale w 
przeciwną stronę) 

Takie zniekształcenie może się pojawić 
w starszych teleobiektywach 
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Ostatnim przypadkiem jest złożenie zniekształceń negatywnych i pozytywnych  (Rysunek 10.1.5): 

 

Rysunek 10.1.5 Przykład deformacji złożonej („w wąsy”)  

Na ilustracji powyżej zniekształcenie ujemne („beczkowate”) dominuje w środku obrazu, podczas gdy znie-

kształcenie dodatnie („poduszkowate”) – w narożnikach. W tym przypadku ogólne zniekształcenie jest mniejsze, 

ponieważ te dwie deformacje się częściowo kompensują. Linie, które są proste w przestrzeni trójwymiarowej, tu 

są wygięte wzdłuż złożonych krzywych, których kształt przypomina spłaszczone wąsy. Stąd ten rodzaj deforma-

cji jest także określany jako zniekształcenie „w wąsy”. 

Czasami można wykryć zniekształcenie zdjęcia sprawdzając pewne elementy otoczenia samolotu. Rysunek 

10.1.6 pokazuje, jak wykorzystałem krawędzie betonowych płyt jako „długie, proste linie” : 

 

Rysunek 10.1.6 Identyfikacji zniekształcenia beczkowatego za pomocą linii krawędzi płyt lotniska (samolot: Douglas SBD-5)   

Obraz tych prostych linii jest wygięty wzdłuż 
złożonej krzywej o kształcie „wąsów” 

Ten obraz jest zniekształcony wzdłuż krzywych, 
których kształt przypomina (spłaszczone) wąsy 

Zdjęcie: Pacific Aviation Museum Pearl Harbor 

Prosta linia, styczna do 
linii podziału płyt po 
prawej stronie zdjęcia 

Linie podziału betonowych 
płyt, widoczne na zdjęciu 
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Gdy znajdziesz taki „wskaźnik”, możesz skompensować to zniekształcenie. Robi się to na przykład w GIMP, 

wykorzystując filtr Lens Distortion. Wywołaj okno Filters→Distorts→Lens Distortion (Rysunek 10.1.7): 

 

Rysunek 10.1.7 Kompensacja zniekształcenia beczkowatego (GIMP)  

W tym oknie wystarczy zmniejszać zniekształcenie Main, aż krawędzie płyt nie staną się proste. Powoduje to 

zmiany ich kątów pochylenia, przez co nie można tego sprawdzać za pomocą linii pomocniczych. Mówiąc 

szczerze, użyłem w tym celu fizycznej linijki, przyłożonej do ekranu (odkąd współczesne monitory LCD są zu-

pełnie płaskie, nie ma nic złego w takim niekonwencjonalnym narzędziu). Dla kompensacji zniekształcenia „z 

wąsami” używaj złożenia deformacji Main i Edge. Parametry Shift X i Shift Y to przesunięcie środka zniekształ-

cenia (od centrum obrazu). Parametr Zoom nie jest praktyczny (proporcjonalnie zmienia rozmiar obrazu).   

Te korekty pozwoliły mi poprawnie dopasować mój modelu 3D SBD-5 do zdjęć (Rysunek 10.1.8): 

 

Rysunek 10.1.8 Dopasowanie modelu 3D do zniekształconego („przed korektą”) i skorygowanego zdjęcia  

Zmieniaj zniekształcenie 
Main dopóki krawędzie 
płyt nie staną się proste   
 

 

Do kompensacji deformacji “w wąsy” używaj 
złożenia zniekształceń Main i Edge. 
 

 

Zdjęcie: Pacific Aviation Museum Pearl Harbor 

Ta długa, prosta krawędź dachu była 
znakomitą linią do sprawdzania korekty 
 

 

Dopasowanie 
osłony silnika 
 

 

Przed korektą Przed korektą 

Dopasowanie statecznika 
i krawędzi kadłuba 
 

 

a) 

b) 

Po korekcie 

Za tym zdjęciem jest mój 
model. Można dostrzec czę-
ści jego siatki oraz elementy 
zabarwione na czerwono   

Zdjęcie: Pacific Aviation Museum Pearl Harbor 
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Rysunek 10.1.8a) i b) pokazuje problemy z dopasowaniem modelu do oryginalnego zdjęcia, które znikły po 

skorygowaniu zniekształcenia beczkowatego. Po takich korektach, te szczegółowe zdjęcia stały się dokładnymi 

obrazami wzorcowymi dla mojego modelu SBD-5. 

 

Dopasowanie modelu 3D do zdjęć samolotu opisuje Tom II. 

 
 Jednak dla większości zdjęć nie będziesz w stanie ocenić, jak intensywne jest ich zniekształcenie. Dlatego do 

bezpośredniego sprawdzania rysunków referencyjnych (lub gotowego modelu 3D) sugeruję używać współcze-

snych zdjęć wykonanych teleobiektywem (np. w ten sposób fotografuje się samoloty w locie). Ich ewentualne 

zniekształcenia są minimalne. 

 

Środek obrazu jest zawsze najmniej zniekształcony. Największych deformacji możesz oczekiwać w 

pobliżu krawędzi. (Zakładając, że zdjęcie nie jest fragmentem wyciętym z większej całości). 

 
 Gdy używasz zeskanowanych zdjęć z książki lub magazynu, staraj się sprawdzić, czy wydawca zachował ich 

oryginalne proporcje. Podczas składu publikacji całkiem często zdarza się, że ilustracja nie pasująca do układu 

strony nie jest przycinana, a nieznacznie skalowana wzdłuż jednej z osi. Takie nieproporcjonalne skalowanie 

czyni ją bezużyteczną dla jakichkolwiek dokładnych porównań.  

 

W przypadku zdjęć z książek lub magazynów, zawsze staram się znaleźć tę samą ilustrację w innej 

publikacji i porównać ich proporcje. Jeżeli nie pasują do siebie idealnie – jedna z nich musiała zostać 

przeskalowana. 

 
 W większości takich przypadków nie jesteś w stanie określić, która ze fotografii została przeskalowana. W rezul-

tacie, obydwie są bezużyteczne. (Z drugiej strony – nie stracisz czasu na bezowocne próby dopasowania two-

jego modelu do takiego zdjęcia). 
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10.2 Odwzorowanie kształtów profili lotniczych 

Wśród konstruktorów lotniczych funkcjonuje powiedzenie "the wing is the king". Ma to znaczyć, że geometria 

płata ma decydujący wpływ na wszelkie charakterystyki samolotu. Na przykład – P-40E "Warhawk" i P-51A 

"Mustang" miały niemal identyczną powierzchnię płata. Używały takich samych silników Allison, miały bardzo 

podobną powierzchnię czołową – chłodnic, kadłuba, skrzydeł. Różniły się jednak drastycznie oporem, jaki sta-

wiały podczas lotu. Współczynnik oporu P-40E wynosił 0.02421. Ten sam współczynnik dla P-51A wynosił 

0.0176. Co powodowało tę różnicę? Przede wszystkim profil płata! W wyniku zastosowania skrzydła o profilu 

laminarnym pierwsze "Mustangi" był o 45 km/h szybsze od "Warhawków"2. (Inna sprawa, że swój udział miała w 

tym także specjalna chłodnica cieczy Mustanga, o dużo mniejszym oporze3).   

Profil płata jest odwzorowywany w lotnictwie bardzo dokładnie – nawet nieznaczne różnice kształtu mogą w 

znaczny sposób zmienić np. charakterystyki przeciągnięcia. Rysunek 10.2.1 wyjaśnia podstawowe pojęcia, 

używane w opisie geometrii profili lotniczych: 

 

 

Rysunek 10.2.1 Geometria profilu lotniczego 

Tradycyjnie profile lotnicze rysuje się w płaszczyźnie XY. Z lewej strony, w punkcie (X=0, Y=0), znajduje się 

zawsze tzw. nosek profilu, określający kształt krawędzi natarcia płata. Nosek jest zazwyczaj zaokrąglony. Cza-

sami jest podawany promień tego zaokrąglenia. Profil jest zawsze zakończony w punkcie (X=100, Y=0) – to 

krawędź spływu. Linia profilu jest często dzielona na dwie części: obrys górny i obrys dolny. Obrysy łączą się 

na krańcach profilu (w X = 0 i X=100). 

Prosty odcinek, łączący krawędź natarcia z krawędzią spływu nazywamy cięciwą. Drugą linią charakterystycz-

ną jest szkieletowa. Punkty tej linii leżą w równej odległości od górnego i dolnego obrysu profilu. Można ją so-

bie wyobrazić jako linię przechodzącą przez środki okręgów, wpisanych w ten kontur (Rysunek 10.2.1). 

Dla profilu podawana jest często także: 

• maksymalną grubość (informacyjnie – chodzi tu o wysokość, mierzoną wzdłuż osi Y); 

• punkt maksymalnego ugięcia linii szkieletowej (Rysunek 10.2.1). 

 
1 Współczynnik "czystego oporu" Cx, mierzony w sytuacji, gdy płat nie wytwarza siły nośnej (samolot jest wówczas pochylony o 2–3º do 

dołu). Nie porównuj go z podobnym Cx dla samochodów. W lotnictwie, w obliczaniu oporu powierzchnią odniesienia jest powierzchnia płata 

(w rzucie z góry). Dla samochodów jest to powierzchnia czołowa. Stąd Cx w lotnictwie są niższe, dla takiej samej prędkości i siły oporu! 

2 Z prędkością wznoszenia już nie było tak dobrze: obydwa samoloty nie były pod tym względem najlepsze. Przy praktycznie takiej samej 

masie całkowitej (porównywany "Warhawk" był nieznacznie – o 120 kg – lżejszy) "Mustang" osiągał 610 m/min, a "Warhawk" – 670 m/min. 

Część tej różnicy wynika z większej masy, a część – z niższej siły nośnej profilu płata P-51. Dla porównania – Messerschmitt Bf 109E miał 

prędkość wznoszenia 1020 m/min, a Bf 109F – 1260 m/min (ta ostatnia była jedną z najlepszych w ciągu całej wojny). 

3 Wewnętrzna powierzchnia chłodnicy P-51 była kilka razy większa od stosunkowo małych chłodnic P-40. W ten sposób wykorzystano tzw. 

„efekt Mereditha”: duża chłodnica o małym oporze przy większych prędkościach generowała dodatkowy ciąg (jak mały silnik strumieniowy). 

y 

x 
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glenia noska profilu Maksymalna 

grubość 

100 0 
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Gdzieś tak do lat dwudziestych XX wieku profile skrzydeł opracowywali sami konstruktorzy, dla swoich własnych 

potrzeb. Robili to metodą „prób i błędów”. Na przykład popularny profil Clark Y powstał właśnie w tym czasie 

(opracował go w 1922 r. Virginius A. Clark).  Użyto go w dziesiątkach samolotów z lat dwudziestych. Aby inży-

nierowie na całym świecie byli w stanie poprawnie odtworzyć kształt profili, zaczęto publikować współrzędne ich 

obrysów (Tabela 10.2.1, Rysunek 10.2.2): 

 
X 0 1.25 2.5 5 7.5 10 20 30 40 50 60 70 80 90 100 

Yg 3.49 5.53 6.50 7.87 8.86 9.63 11.35 11.73 11.40 10.52 9.18 7.72 5.54 3.32 0.25 

Yd 3.49 1.94 1.46 0.94 0.61 0.40 0.04 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 

Tabela 10.2.1 Współrzędne profilu Clark Y 

 

 

Rysunek 10.2.2 Profil Clark Y, wykreślony na podstawie współrzędnych z Tabela 10.2.1  

Gdzieś w latach dwudziestych coraz szerzej zaczęto używać profili, opracowanych przez placówki naukowe. Na 

przykład publikował je niemiecki uniwersytet w Getyndze. Jego profile były oznaczane np. "Götingen - 623", 

albo "Götingen - 543". Określane są często jako „profile Götingen”. W 1933 r. finansowana przez rząd USA 

agencja doradcza NACA opublikowała ważny raport, zawierający geometrię i charakterystyki aerodynamiczne 

78 profili lotniczych. Był to opis tak zwanych „4-cyfrowych profili NACA”. Od tamtej pory profile te były szeroko 

wykorzystywane w wielu konstrukcjach lotniczych, nie tylko amerykańskich1. Dwa z nich zostały także użyte w 

skrzydłach P-36 i P-40. Są to: NACA 2215 (w osi samolotu) i NACA 2209 (końcówka) . 

Czy wiesz, że numer profilu NACA nie jest wcale numerem kolejnym? Tak naprawdę ten symbol zawiera opis 

jego kluczowych parametrów geometrycznych: 

1 cyfra: największe ugięcie szkieletowej (czyli wartość Y max. ugięcia w %); 

2 cyfra: odległość punktu o największym ugięciu szkieletowej od nosa profilu, podzielona przez 10. Na przy-

kład – "2" oznacza, że max. ugięcie szkieletowej znajduje się 20% od krawędzi natarcia; 

3 i 4 cyfra: grubość profilu (%). 

Tak więc symbol profilu P-40 – „NACA 2215” – oznacza profil o grubości 15% i maksymalnym ugięciu szkiele-

towej 2%, w X = 20% cięciwy. W istocie kształty NACA 2215 i NACA 2209 różnią się tylko grubością.  

 

 

W załączniku do tego raportu „78 profili” NACA opublikowało wzory matematyczne, które pozwalają 

odwzorować ich kształt z dowolną dokładnością. (Trzydzieści punktów, jakie podaje Tabela 10.2.1 dla 

profilu Clark Y, pozostawia jeszcze pole do pewnej dowolności). 

 
  

 
1 Skąd tak wielka popularność? Sekret kryje się w sposobie pomiaru. NACA dysponowało wówczas jedynym w świecie pełnowymiarowym 

tunelem ciśnieniowym. Charakterystyki opublikowanych profili były zmierzone, w warunkach zbliżonych do rzeczywistego lotu. Wcześniej 

wszyscy „dmuchali płaty” (tak to się mówi w lotnictwie) o rozmiarze niewielkiego modelu w małych tunelikach aerodynamicznych. Potem 

starano się te "modelarskie" charakterystyki przeliczyć na prawdziwe warunki lotu. Zdradzę tu wszystkim tym, którzy nie zetknęli się z prak-

tyką inżynierską, mały sekret: obliczenia aerodynamiczne, szczególnie bez użycia komputerów, są strasznie niedokładne! Profile NACA były 

więc w oczach konstruktorów o wiele bardziej „pewne” niż wszystkie inne. 

y 

x 

100 90 80 70 60 50 40 30 20 10 5 0 

Krawędź natarcia umieszczona ponad cięciwą 
jest specjalną konwencją dla profili płasko-
wypukłych, takich jak Clark Y 
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Kilka lat później NACA opublikowała kolejny raport, z opisem tzw. „5-cyfrowych profili NACA”, ale nie będziemy 

się nią tu zajmować. Poza tym istnieją także profile NACA, noszące inne oznaczenia. Na przykład – laminarny 

profil płata „Mustanga” to NACA 45-100. A Messerschmitt Bf 109 używał jeszcze innego profilu1. (Tak! Profile 

NACA były używane podczas 2 Wojny Światowej przez wszystkie strony konfliktu!) 

Jak uzyskać dane wzorcowego kształtu profili użytych w skrzydle P-40: NACA 2215 i NACA 2209? Gdy za-

czniesz szukać w Internecie hasła „NACA, airfoil”, znajdziesz szybko kilka stron podających współrzędne wielu 

różnych profili lotniczych. Użyjmy wyświetlonego w jednym z górnych wyników portalu airfoiltools.com.  Na jego 

głównej stronie kliknij w NACA 4 digit airfoil generator. Początkowo ten generator pokazuje profil NACA 2412 

(Rysunek 10.2.3): 

 

Rysunek 10.2.3 Serwis internetowy – generator współrzędnych 4-cyfrowych profili NACA 

Aby wygenerować profil NACA 2215, ustaw następujące parametry: 

Max. Camber (%):  2  (pierwsza cyfra z symbol profile NACA); 

Max. camber position (%):  20  (druga cyfra z symbolu profilu, z dołączonym „0”); 

(max.) Thickness (%):  15  (trzecia i czwarta cyfra symbolu profilu); 

Number of points:  100  (tę wartość wyjaśnię na następnej stronie); 

Cosine spacing:  zaznacz; 

Close Trailing edge:  zaznacz; 

i naciśniesz przycisk Plot, zobaczysz kontur NACA 2215 narysowany ponad polem parametrów, a w polu Dat 

file po lewej stronie ekranu zobaczysz współrzędne profilu. Wygenerowano je dla profilu o długości cięciwy = 

1.0. (100 pkt na obrys). 

Co można zrobić z takimi współrzędnymi? Czy będzie trzeba je pracowicie nanosić w Inkscape, „punkt po 

punkcie” odtwarzając kontur tego profilu?  

Na szczęście, jest lepszy sposób: zaznacz całą zawartość pola Dat file (tylko uważaj, aby przy okazji nie zazna-

czyć żadnego z pozostałych elementów tej strony) i skopiuj ją do schowka ( Ctrl - C ).  

 
1 W Bf-109 niemieccy inżynierowie zaadaptowali profil NACA 2R114.2. To specjalny przypadek, ze stałym punktem przyłożenia siły nośnej. 

(Jego szkieletowa ma kształt spłaszczonego „S”). Był opisany jako ostatni z 78 „4-cyfrowych” profili NACA. Fokce-Wulf FW-190 używał „5-

cyfrowych” profili NACA 230xx (dokładniej: NACA 23015.3 u podstawy i NACA 23009 na końcu skrzydła). 

1. Tu wprowadź 
parametry profilu 

2. Kliknij 
ten przycisk 

3. Skopiuj całą 
zawartość tego 
pola do schowka 

http://airfoiltools.com/
http://airfoiltools.com/airfoil/naca4digit
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Przygotowałem specjalny skoroszyt Excela dla danych skopiowanych z  airfoiltools.com (source\tools\airfoil.xlsx 

z pliku source.zip, por. str. 18). Otwórz go i wklej zawartość schowka w żółte komórki. Zrób to z opcją „użyj for-

matowania docelowego”      (Rysunek 10.2.4): 

 

Rysunek 10.2.4 Arkusz kalkulacyjny, przekształcający współrzędne profilu na sekwencję poleceń SVG 

Teraz przełącz się do Inkscape, i: narysuj w nim dowolną linię prostą. Następnie otwórz okno edytora XML 

(Edit→XML Editor...): 

 

Rysunek 10.2.5 Linia na rysunku i jej definicja w edytorze XML (SVG) 

2. Skopiuj to wyrażenie 
SVG z obramowanych 
komórek do schowka 

1. Wklej tutaj zawartość skopiowaną z Dat file. 
Podczas wklejania do Excela wybierz opcję „użyj 
formatowania docelowego”. (To wstawia każdą 
linię tych danych do odrębnego wiersza) 

Przygotowałem 100 wierszy na współrzędne 
profilu, i dlatego na poprzedniej stronie suge-
rowałem Number of points = 100 

1. Otwórz nowy rysunek, 
i narysuj w nim jedną 

poziomą linię 

Atrybuty podświe-
tlonego elementu  

Wewnątrz <svg:g> (grupa Layer 1) 
znajduje się pojedynczy element 
<svg:path>, opisujący tę linię 

Atrybut d zawiera polecenia 
rysunkowe. Kliknij w to pole, aby 
zmienić jego zawartość 
 

2. Otwórz okno XML Editor 
(Edit→XML Editor) 

http://airfoiltools.com/
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Wklej zawartość schowka (kopię obszaru SVG z arkusza airfoil.xlsx – por. Rysunek 10.2.4) jako nową wartość 

atrybutu d1(Rysunek 10.2.6): 

  

Rysunek 10.2.6 Wartość atrybutu d (wierzchołki linii) przeniesiona z arkusza airfoil.xlsx 

Gdy opuścisz to pole (na przykład klawiszem Enter ), Inkscape uaktualni rysunek (Rysunek 10.2.7): 

 

Rysunek 10.2.7 Uzyskany w Inkscape profil NACA 2215 

W ten sposób nasza linia nagle zmieniła się w gotowy rysunek profilu NACA 2215! Zwróć uwagę, że jej punkty 

krańcowe zostały przesunięte do (0,0) i (100,0) – i teraz znajdują się na górnej krawędzi strony rysunku. Do-

kładny kontur tego profilu leży pośrodku linii Inkscape. Jeżeli więc chcesz dokładnego wzorca, wypełnij ten 

kształt półprzeźroczystym kolorem i ukryj linię konturu ustawiając Stroke paint na None (Rysunek 10.2.8): 

 

Rysunek 10.2.8 Uzyskanie dokładnego wzorca kształtu  

Teraz możesz skopiować ten obiekt i wkleić do głównego rysunku, w gdzie dopasujesz go do płata (skalując). 

 
1 Inkscape zapisuje dokumenty w standardzie SVG (Scalable Vector Graphics). Są to w istocie pliki tekstowe, przypominające trochę spo-

sobem zapisu strony HTML. Możesz je nawet otworzyć w zwykłym Notatniku (notepad.exe) i coś w nich zmienić – pod warunkiem, że 

wiesz, co robisz. Do tego także służy okno XML Editor. Za jego pomocą możesz zmieniać w Inkscape "surową" zawartość aktualnego 

dokumentu. Jest to o tyle prostsze od użycia notatnika, że przed zapisem jest sprawdzana poprawność danych. 

Wklej polecenia SVG z arkusza 
Excela w ten atrybut d z elemen-
tu <svg:path> 
 

Nie przejmuj się tymi dziwnymi znaczkami 

pomiędzy wklejonymi poleceniami 

A straight line changed 
into airfoil drawing! 

Ustaw kolor Stroke 
paint na None 

Wypełnij ten kształt 
półprzeźroczystą barwą 
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Aby uzyskać cieńszą wersję profile NACA, wystarczy przeskalować go wzdłuż osi Y. Na przykład profil 

NACA 2209 uzyskasz zmniejszając NACA 2215 wzdłuż osi Y do 60% oryginalnej wysokości.  

 
 Nigdzie nie znalazłem opisu, jaki przekrój miało usterzenie P-40. Jednak na dostępnych rysunkach fabrycznych 

można dostrzec zarys kształtu tych profili. Jednym z nich jest rysunek owiewki podstawy usterzenia, który zna-

lazłem na portalu p40warhawk.com (Rysunek 10.2.9):   

 

Rysunek 10.2.9 Oryginalny rysunek oprofilowania usterzenia P-40 

Próbowałem do tych zarysów dopasować wiele różnych profili. Ostatecznie doszedłem do wniosku, że była to 

właśnie rodzina NACA 00xxT (Rysunek 10.2.10): 

• usterzenie pionowe, u nasady: NACA 0010T; 

• usterzenie poziome, u nasady: NACA 0010T; 

• usterzenie poziome, u końca: NACA 0009T. 

To specjalny wariant profili NACA, opisany w Notach Technicznych z 1931r. Wersje z końcówką „T” mają 

zmniejszony promień noska do 25% oryginalnego promienia, użytego w 4-cyfrowych profilach NACA 00xx. Od-

powiednio do tej zmiany jest także zmodyfikowany cały kształt przedniej sekcji – na "ostrzejszą". "T" w zamyśle 

twórców mogło to znaczyć tyle, co angielskie "thin", czyli "cieńszy". Przykładem profilu "T" jest NACA 0018T 

(Rysunek 10.2.10):  

 

Rysunek 10.2.10 Profil NACA 0018T ("T" oznacza zmieniony przód – zmniejszony promień noska) 

Profil podstawy 
statecznika 
pionowego 
(rzut z góry) 

Profil podstawy statecznika 
poziomego (rzut z boku) 

Zwróć uwagę na 
ostre noski profili 

Źródło: p40warhawk.com 

http://www.p40warhawk.com/Models/Technical/Technical.htm
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Wybór „ostrej” krawędzi natarcia dla usterzenia P-40 można tłumaczyć specyficznymi właściwościami aerody-

namicznymi takich profili1. Tabela 10.2.2 określa współrzędne obrysu profilu NACA 0020T2: 

 
X 0 1.25 2.5 5 7.5 10 15 20 30 40 50 60 70 80 90 95 100 

Yg 0.00 2.08 3.14 4.76 6.01 7.02 8.49 9.40 10 9.58 8.52 7.15 5.65 4.05 2.28 1.30 0.20 

Yd 0.00 -2.08 -3.14 -4.76 -6.01 -7.02 -8.49 -9.40 -10 -9.58 -8.52 -7.15 -5.65 -4.05 -2.28 -1.30 -0.20 

Tabela 10.2.2 Współrzędne profilu NACA 0020T (cieńsze wersje tego profilu są używane w usterzeniach). 

Aby uzyskać z tych współrzędnych profil NACA 0010T, wystarczy zmniejszyć wartości Yg i Yd o 50%. 

 

 

 

 

 
1 Te „ostronose” profile były opisane w nocie NACA z 1931. Przy dużych kątach natarcia, jakie występują w lecącym powoli samolocie, te 

profile wytwarzają stabilną siłę nośną. To je odróżnia od siły nośnej generowanej przez profile z „normalnym” promieniem krawędzi natarcia, 

która raptownie spada po przekroczeniu tzw. krytycznego kąta natarcia (około 10-17º, w zależności od kształtu profilu). To zjawisko nazy-

wane jest „przeciągnięciem”. Takie przeciągnięcie na usterzeniu poziomym lądującego samolotu może prowadzić do katastrofy. Dlatego 

projektanci stosowali tę sugestię NACA, pomimo nieco większego oporu generowanego w innych warunkach lotu przez cienką krawędź 

natarcia. Dostrzegłem takie „ostronose” profile w wielu innych samolotach z tej ery, na przykład – w Douglas SBD „Dauntless” i Grumman 

F4F „Wildcat”. Co interesujące – ostre krawędzie natarcia znikają z usterzeń samolotów następnej generacji, zaprojektowanych po 1938r. 

Jedynym myśliwcem z tej ery z „ostronosym” profilem usterzenia jest Republic P-47 „Thunderbolt”. Być może kilka lat później NACA opubli-

kowała kolejną notę techniczną, z nowymi (innymi) ustaleniami.  

2 Współrzędne z tabeli pochodzą z Noty Technicznej Nr. 386, który opisuje wpływ cienkich i grubych krawędzi natarcia na charakterystyki 

aerodynamiczne profili symetrycznych. Możesz ją znaleźć w Google Books, szukając hasła “Technical Note - National Advisory Committee 

for Aeronautics”, vol. 381-400. Ta nota techniczna także podaje matematycznej formułę, za pomocą której można uzyskać więcej punktów 

tego konturu. 
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10.3 Arytmetyka barw 

Każdy z wykorzystywanych w tej książce programów używa barw wyrażonych poprzez intensywność trzech 

niezależnych składników (kanałów): czerwonego (R), zielonego (G) i niebieskiego (B). Taki model często okre-

śla się jako „RGB”, i jest niezwykle popularny w grafice komputerowej. 

Intensywność każdego ze składników barwy jest wyrażona liczbą od 0.0 (brak) do 1.0 („najjaśniejszy”). Rysunek 

10.3.1 pokazuje, jak z wartości R, G, B jest tworzona barwa: 

 
 

 

 

 

  

 

Rysunek 10.3.1 Przykład zakodowania barwy za pomocą składników RGB – różne odcienie czerwieni 

Czasami wraz z trójką R, G, B występuje czwarty składnik – nieprzejrzystość. Oznaczany jest jako „alfa” (A) i 

używany jako dodatkowy czynnik przy łączeniu barw. Steruje udziałem każdego ze składników. A = 1.0 oznacza 

kompletną nieprzejrzystość, A = 0.0 – zupełną przejrzystość. 

Aby przyśpieszyć obliczenia i zmniejszyć ilość pamięci potrzebnej do przechowywania obrazu, składniki R, G, 

B, A zapisuje się w obrazie jako 8-bitowe liczby całkowite o wartościach od 0 do 255. W takim przypadku 255 

odpowiada oryginalnej wartości 1.0. Z zapisu barw na liczbach całkowitych wziął się, występujący w GIMP i 

Inkscape, zwyczaj podawania intensywności składnika barwy w skali od 0 do 255. 

We wszystkich programach, opisywanych w tej książce, pojawiają się nazwy operacji, przeprowadzanych na 

barwie (lub intensywności) pikseli: Add, Multiply, Substract,.... W przypadku Blendera może to być tryb łącze-

nia dwóch obrazów w węźle Color:Mix. W przypadku Inkscape to Blend Mode (str. 161, Rysunek 8.18.1), a w 

Gimp – to tryb Mode. W przypadku programów 2D tryby te sterują nałożeniem obrazu z aktualnej warstwy na 

warstwy poprzednie (czyli sumę warstw leżących „poniżej”). Postaram się w tej sekcji wyjaśnić efekty każdego z 

tych trybów, gdyż czasami nie są intuicyjne.  

Zacznijmy od zwykłego złożenia dwóch warstw – w Blenderze to nazywa się Mix, a w Gimpie i Inkscape – 

Normal. Rysunek 10.3.2 pokazuje przykład prostego nałożenia czerwonej, kompletnie nieprzejrzystej warstwy 

P, na niebieskie tło t. Rysunek 10.3.3 przedstawia tę samą sytuację, ale z częściową przejrzystością warstwy P. 

Jak programy obliczają kolor złożenia tych dwóch warstw (obszaru rezultatu – c)? 

 

 

Rysunek 10.3.2 Złożenie podłoża t i warstwy P w trybie 

Mix/Normal. P zupełnie nieprzejrzysta 

 

Rysunek 10.3.3 Złożenie podłoża t i warstwy P w trybie 

Mix/Normal. P o nieprzejrzystości = 0.4 

 

R: 1.0 

 

 

 G: 0.5 

B: 0.0  

 

R: 1.0 

 

 

 G: 0.0 

B: 0.0  

   

t (0.0, 0.0, 

1.0) 

t (0.0, 0.0, 

1.0) 

P (1.0, 0.0, 0.0, 1.0) P (1.0, 0.0, 0.0, 0.4) 

A = 1.0 A = 0.4 

 
 
 
 

c 

(rezultat) 

 
 
 
 

c 

(rezultat) 
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Przyjrzyjmy się dokładniej przypadkowi, który pokazuje Rysunek 10.3.3. W metodzie Mix/Normal składniki 

R,G,B barwy wynikowej c są wyznaczane jako  tzw. „średnia ważona”  składników barw t i P. „Wagą” tej śred-

niej jest nieprzejrzystość A warstwy leżącej „na wierzchu” – P1: 

 

APtAc +−= )1(  

gdzie:  c –    rezultat nałożenia barw (por. Rysunek 10.3.3); 

t –  barwa tła (por. Rysunek 10.3.3); 

P –  barwa warstwy nakładanej (por. Rysunek 10.3.3); 

A –  nieprzejrzystość (składnik Alfa) warstwy P; 

Wyr.  10-1 Wyznaczanie rezultatu „zwykłego” mieszania barw (operacja nazywana Mix lub Normal)  

Jak „działa” Wyr.  10-1? Podstawmy do niego takie wartości, jakie podaje Rysunek 10.3.3. Na niebieskie (R = 0, 

G = 0, B = 1) tło t została nałożona półprzejrzysta (A = 0.4) warstwa P, w kolorze czerwonym (R = 1, G = 0, B = 

0). Komponenty R, G, B barwy c wyznaczamy, podstawiając do Wyr.  10-1 odpowiednie komponenty barw t i P 

(Rysunek 10.3.4): 

 

 

 

 

 

 

Rysunek 10.3.4 Wyznaczenie nałożenia barw warstwy t i P (A = 0.4 – por. Rysunek 10.3.3) w trybie Mix/Normal. 

Rysunek 10.3.4 pokazuje, że każdy z komponentów barwy można traktować jako intensywność – czyli odcień 

szarości. Komponenty rezultatu c są wyznaczane niezależnie, poprzez podstawienie do odpowiedniego wzoru. 

Dlatego w dalszej części tej sekcji każdą z operacji na barwach omówię, przedstawiając jej ogólny wzór (taki, 

jak ten z Wyr.  10-1), oraz rezultat – w postaci złożenia dwóch prostopadłych gradientów szarości (Rysunek 

10.3.5a): 

 

 

                               

 

Rysunek 10.3.5 Sposób prezentacji wyników nałożenia dwóch warstw, z różnymi kierunkami gradientu szarości. 

Rezultat nałożenia – z odpowiednim operatorem – warstwy P na t (Rysunek 10.3.5a) będę pokazywać na 

schematycznym kwadracie (Rysunek 10.3.5b). Możesz na nim zobaczyć wynik połączenia każdego odcienia 

szarości P z każdym odcieniem szarości tła t. Z góry i z lewej strony kwadratu są pokazane oryginalne kolory 

pikseli z warstw P i t. To jakby osie układu współrzędnych, z których możesz wybrać interesujący Cię odcień 

 
1 Uwaga: węzeł Color:Mix w Blenderze operuje wyłącznie na składnikach R,G,B, podłączanych do wejść Color1 i Color2. Przejrzystość A 

obrazu musisz uwzględnić w sposób „jawny”, podłączając ten kanał do gniazda Fac. 

P 

t 

a) b) 

t 

P 
P1 

t1 
c1 

Oryginalny 
gradient t 

Oryginalny 
gradient P 

R: (1.0 - 0.4) 0.0 + 0.4 1.0 = 0.4 

        
G: (1.0 - 0.4) 0.0 + 0.4 0.0 = 0.0 

        
B: (1.0 - 0.4) 1.0 + 0.4 0.0 = 0.6 

   

 

   

 

  

 
sumarycznie: (1.0 - 0.4) t + 0.4 P = c 

 

0 1 0.
5 

0 

1 

0.
5 

Barwa rezultatu po 
podstawieniu do 
wzoru odcieni P1 i t1 
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pikseli wejściowych. Na przecięciu prostopadłych do osi P i t widzisz barwę rezultatu operacji (por. Rysunek 

10.3.5b).  

 

Domyślną operację – Mix / Normal – już omówiliśmy. Rysunek 10.3.6 przedstawia operację dodawania:  

 

 

Dodawanie: 

 

)( APtClipc +=  

 

 
gdzie:  c –    rezultat nałożenia barw; 

t –  barwa tła; 

P –  barwa warstwy nakładanej; 

A –  nieprzejrzystość (składnik Alfa) warstwy 

P; 

Clip: funkcja „obcinająca” do 1.0 wartości > 1.0.  

 

Wyr.  10-2 Dodawanie wartości pikseli (Add lub Addition) 

 
 

 

 

 

Rysunek 10.3.6 Przykład dodawania pikseli 

Dodawanie wartości pikseli rozjaśnia obraz. Charakterystyczne dla dodawania jest „obcinanie” rezultatu do 1.0 

(nie ma nic „bielszego od bieli”). Tę operację zapisaliśmy w Wyr.  10-2 jako funkcję Clip. Rysunek 10.3.6 poka-

zuje efekt jej „załączenia” – pół testowego kwadratu jest białe. To obszar, gdzie suma składników barwy t i P 

była > 1.0. 

 

A teraz odwrotność dodawania: – Substract. Rysunek 10.3.7 przedstawia rezultaty tej operacji:  

 

 

Odejmowanie: 

 

)( APtClipc −=  

 

 
gdzie:  c –    rezultat nałożenia barw; 

t –  barwa tła; 

P –  barwa warstwy nakładanej; 

A –  nieprzejrzystość (składnik Alfa) warstwy 

P; 

Clip: funkcja „obcinająca” do 0.0 wartości < 0.0.  

 

Wyr.  10-3 Odejmowanie wartości pikseli (Substract lub 

Substraction) 

 

 

 

 

 

Rysunek 10.3.7 Przykład odejmowania pikseli 

Odejmowanie wartości pikseli ściemnia obraz. Charakterystyczne dla odejmowania jest „odrzucanie” rezultatów 

< 0 (nie ma nic „czarniejszego od czerni”). Tę operację zapisaliśmy w Wyr.  10-3 jako funkcję Clip. Rysunek 

10.3.7 pokazuje efekt jej „załączenia” – pół testowego kwadratu jest całkowicie czarne. To obszar, gdzie różnica 

składników barwy t i P była < 0. 

Efekt „obcięcia” 
intensywności 
do 1.0 t 

P 

Efekt „odrzucenia” 
intensywności < 0.0 

t 

P 

0 1 0.
5 

0 

1 

0.
5 

0 1 0.
5 

0 

1 

0.
5 
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Kolejną typową operacją jest mnożenie – Multiply. Rysunek 10.3.8 przedstawia rezultaty tej operacji: 

 

 

Mnożenie: 

 

tAPc =  

 

 
gdzie:  c –    rezultat nałożenia barw; 

t –  barwa tła; 

P –  barwa warstwy nakładanej; 

A –  nieprzejrzystość (składnik Alfa) warstwy 

P; 

 

 
 

Wyr.  10-4 Mnożenie wartości pikseli (Multiply) 

 

 

 

 

 

Rysunek 10.3.8 Przykład mnożenia pikseli 

Mnożenie wartości pikseli ściemnia obraz (gdyż mnożysz przez wartości poniżej 1.0). W odróżnieniu od odej-

mowania, żadna część testowego kwadratu, który przedstawia Rysunek 10.3.7, nie jest czarna. To są obszary 

zabarwione na bardzo ciemny kolor szary. 

 

Kolejną typową operacją jest dzielenie – Divide. Rysunek 10.3.9 przedstawia rezultaty tej operacji:  

 

 

Dzielenie: 

 









=

AP

t
Clipc  

 

 
gdzie:  c –    rezultat nałożenia barw; 

t –  barwa tła; 

P –  barwa warstwy nakładanej; 

A –  nieprzejrzystość (składnik Alfa) warstwy 

P; 

Clip:  funkcja „obcinająca” do 1.0 wartości > 1.0, w 

tym także nieskończoność (gdy AP = 0) 

Wyr.  10-5 Dzielenie wartości pikseli (Divide) 

 

 

 

 

 
 

Rysunek 10.3.9 Przykład dzielenia pikseli 

Dzielenie wartości pikseli rozjaśnia obraz (gdyż dzielisz przez wartości poniżej 1.0). Charakterystyczne dla dzie-

lenia jest „obcinanie” rezultatu do 1.0 (w tym także nieskończoności, występującej dla A= 0 lub P = 0). Tę ope-

rację zapisaliśmy w Wyr.  10-5 jako funkcję Clip. Rysunek 10.3.9 pokazuje efekt jej „załączenia” – pół testowego 

kwadratu jest białe. To obszar, gdzie suma składników barwy t i P była > 1.0. Zwróć uwagę, że rozkład szarości 

na przeciwległej połowie jest inny, niż w przypadku dodawania (por. Rysunek 10.3.6) 

 

Ten obszar jest ciem-
noszary, ale nie czarny! 
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Kolejną typową operacją jest przyciemnienie – Darken. Rysunek 10.3.10 przedstawia rezultaty tej operacji: 

 

 

Zaciemnienie: 

 

( )APtMinc ,=  

 

 
gdzie:  c –    rezultat nałożenia barw; 

t –  barwa tła; 

P –  barwa warstwy nakładanej; 

A –  nieprzejrzystość (składnik Alfa) warstwy 

P; 

Min:  funkcja, zwracająca wartość mniejszego z 

dwóch argumentów 

 

Wyr.  10-6 Ściemnianie wartości pikseli (Darken) 

 

 

 

 

 

Rysunek 10.3.10 Przykład ściemniania pikseli 

Ściemnianie obrazu jest operacją dość intuicyjną. Z każdej pary pikseli (jeden należy do tła, drugi – do nakłada-

nej warstwy) wybiera ten ciemniejszy. 

 

Operacją odwrotną do ściemnienia jest rozjaśnienie – Lighten. Rysunek 10.3.11 przedstawia rezultaty tej ope-

racji: 

 

 

Rozjaśnienie: 

 

( )APtMaxc ,=  

 

 
gdzie:  c –    rezultat nałożenia barw; 

t –  barwa tła; 

P –  barwa warstwy nakładanej; 

A –  nieprzejrzystość (składnik Alfa) warstwy 

P; 

Max:  funkcja, zwracająca wartość większego z 

dwóch argumentów 

Wyr.  10-7 Rozjaśnianie wartości pikseli (Lighten) 

 

 

 
 

 

Rysunek 10.3.11 Przykład rozjaśniania pikseli 

Rozjaśnianie obrazu jest operacją dość intuicyjną. Z każdej pary pikseli (jeden należy do tła, drugi – do nakła-

danej warstwy) wybiera ten jaśniejszy. 

 

Na listach rozwijalnych Blendera i Gimpa znajdziesz więcej operacji niż jest omówionych w tym dodatku. Mó-

wiąc szczerze, nie miałem okazji ich do tej pory używać. Jeżeli jednak chciałbyś sprawdzić, jak każda z nich 

działa – możesz skorzystać z pliku optional\pixel_operations.xcf (por. str. 18). To obraz Gimpa, zawierający dwie 

warstwy, odpowiadające gradientom t i P. Wykorzystywałem go do wygenerowania ilustracji dla tej sekcji. Mo-

żesz go otworzyć i wybrać w Gimpie, z zakładki Layers jakiś inny tryb mieszania barw. Sam się wtedy przeko-

nasz, jak działa. 

Jedyny biały punkt! 
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czarny 
punkt! 

t 

P 

0 1 0.
5 

0 

1 

0.
5 

0 1 0.
5 

0 

1 

0.
5 



Rozdział 10 Dodatkowe wyjaśnienia 265 

 

 
 (CC) Witold Jaworski, 2009 – 2020. 

Słownik 

GPL, licencja – General Public Licence, udostępniająca produkt za darmo wszystkim odbiorcom. Licencja ta 

jest sformułowana w ten sposób, aby uniemożliwić komercyjne rozpowszechnianie produktu. 

 
rastrowy, obraz – popularna metoda reprezentacji, polegająca na zapisie obrazu jako zbioru kolorowych lub 

czarno-białych punktów (pikseli). Tak jest np. wyświetlany obraz na ekran telewizyjnym, monitorze komputera. 

Wadą reprezentacji rastrowej jest pogorszenie jakości obrazu w dużych powiększeniach – gdy zaczynają być 

wyraźnie widoczne pojedyncze piksele. Zaletą jest stosunkowo prosty algorytm wyświetlania. Istnieje wiele róż-

norodnych sposobów zapisu (formatów) przechowywania obrazów rastrowych w plikach. Najpopularniejsze to 

*.jpg, *.png, *.bmp, *.tif. 

 
shear (ang.) – przekoszenie (określane także jako "ścinanie"). Transformacja obrazu w GIMP. Przekształca 

kształt prostokąta w rąb (przeciwległe boki zachowują równoległość). 

 
wektorowy, obraz – metoda reprezentacji, polegająca na zapisie obrazu jako zbioru kolorowych linii i obszarów. 

Każdy element obrazu ma określone współrzędne i kształt (prosta, łuk, koło, krzywa Beziera, ...). W ten sposób 

są zapisywane stworzone na komputerze rysunki techniczne. Zaletą reprezentacji wektorowej jest zachowanie 

dokładności przy dowolnym powiększeniu. Wadą jest złożony algorytm wyświetlania (dla ekranu lub drukarki 

wymaga przekształcenia na postać rastrową). Jednym ze sposobów zapisu danych wektorowych jest format 

*.svg, stosowany m.in. przez Inkscape. 

 
wireframe (pol.: siatka?) – oznacza sposób reprezentacji modelu w którym nie są rysowane żadne ściany, tylko 

krawędzie łączące poszczególne wierzchołki. Jest ich zazwyczaj dużo i są cienkimi liniami. Stąd obrazowo w 

literaturze anglojęzycznej taka reprezentacja jest nazywana "drucianą siatką" czyli "wireframe". 

 

 

 

 



Podziękowania 

Napisanie pierwszej edycji tej książki zajęło mi 6 lat (licząc od wprowadzenia, napisanego w listopadzie 2007, 

do tłumaczenia na angielski ostatniego tomu, zakończonego w listopadzie 2013). Potem była jeszcze edycja 

„uzupełniająca”, opublikowana w 2015, i ostatecznie – edycja obecna. Chciałbym podziękować mojej rodzinie 

za ten cały czas, w szczególności mojej najdroższej Żonie. 

Jestem wdzięczny Jackowi Jackiewiczowi, Mariuszowi Łukasikowi i Jumpei Temmie za plany, których używam 

w tej książce. Dziękuję także autorom zdjęć, które wykorzystuję. W szczególności dotyczy to zdjęć wysokiej 

rozdzielczości używanych jako tła, które pochodzą od: Tomo Yuna (yunphoto.net) i Chrisa Archera 

(archerbravo.com). Chciałbym także podziękować Hume Bates za komentarze i materiały dotyczące wczesnych 

P-40. 

 

Alex Stewart – recenzent wszystkich czterech tomów angielskiej edycji „Wirtualnego modelarstwa”. Zdjęcie przedstawia go pod-

czas pierwszego samodzielnego lotu na dwupłacie Tiger Moth. Alex interesuje się szczególnie samolotami z okresu I Wojny Świa-

towej. Życzę mu, aby kiedyś mógł się na którymś z nich przelecieć!  

Przemek Wysoczyński dokładnie przejrzał niniejsze wydanie w języku polskim, za co jestem Mu bardzo 

wdzięczny. Jego uwagi, w połączeniu z informacją zwrotną, którą dostarczali: Alex Stewart, David Payne, Rich 

Conclikn, Andrzej Borysewicz, Richard Deleu, Carlos Lopez i Daniel Wentzell, pomogły mi nadać „Wirtualnemu 

modelarstwu” ostateczny kształt i uczynić je jak najbardziej czytelnym. 
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rozłożenie grupy (rozłożenie) grupy (Inkscape), 173 

wybór obszarem (Inkscape), 146 

wybór pojedynczy (Inkscape), 145 

wybór wielokrotny (Inkscape), 145 

wyłączenie wypełnienia (Inkscape), 176 

wypełnienie — zmiana (Inkscape), 176 

zmiana kolejności (Inkscape), 170 

zmiana obrotu (Inkscape), 154, 167 

zmiana przekoszenia (Inkscape), 157 

zmiana skali (Inkscape), 155 

zmiana warstwy (Inkscape), 165 

zmiana zawartości grupy (Inkscape), 172 

obraz 

deformacje podczas skanowania, 41 

domyślne parametry eksportu (GIMP), 133 

eksport do pliku (Inkscape), 159 

eliminacja zniekształceń, 42, 44 

grupowanie (Inkscape), 51 

JPEG, poziom kompresji (GIMP), 132 

koloryzacja linii (Inkscape), 39 

odcinanie wzdłuż konturu (Inkscape), 148 

optymalne rozmiary tekstury, 160 

otwórz (rastrowy w Inkscape), 143 

PNG, poziom kompresji (GIMP), 133 

pomocnicze kontrolki (GIMP), 126 

przyłączanie do rysunku (Inkscape), 143 

ramka strony (Inkscape), 152 

TIFF, metoda kompresji (GIMP), 132 

usunięcie przejrzystych obszarów (GIMP), 132 

wiele różnych widoków (GIMP), 126 

wybór rozmiaru do eksportu (Inkscape), 159 

wycinanie (Inkscape), 30, 38, 43, 47, 50, 63 

wyświetlane jednostki (Inkscape), 152 

zabarwianie linii (Inkscape), 168 

zmiana rozmiaru strony (Inkscape), 152 

obrót 

linii pomocniczych (Inkscape), 149 

o dany kąt (Inksacpe), 154 

obiektu (Inksacpe), 154, 167 

oś (Inkscape), 151, 154, 157 

precyzyjny (Inksacpe), 154 

obrys 

profilu lotniczego, 253 

odbicie 

lustrzane, obiektu (Inkscape), 167 

odcinanie 

obiektów wzdłuż konturu (Inkscape), 148 

obrazu rastrowego (Inkscape), 30, 38, 43, 47, 50, 63 

odrestaurowane samoloty 

niedokładności, 88, 89 

Offset 

pole z przybornika gradientu (Inkscape), 191 

okno 

dla wielu obrazów (GIMP), 126 

główne (GIMP), 123 

główne (Inkscape), 139 

obszar obrazu (GIMP), 126 

panele (Inkscape), 140, 141 

powielenie (Inkscape), 154, 155, 157 

zapisywania obrazu (GIMP), 131 

zarządzanie (GIMP), 125 

okrąg 

edycja (Inkscape), 183 

przykład edycji (Inkscape), 186 

rysowanie (Inkscape), 182, 185 

zmiana długości promienia (Inkscape), 183 

Opacity 

suwak z panelu Layer (Inkscape), 162 

Open 

polecenie z menu File (GIMP), 130 

polecenie z menu File (Inkscape), 142 

organizacja 

kolekcji zdjęć referencyjnych, 89 

ostry 

węzeł (Inkscape), 179 
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oś 

obrotu (Inksacpe), 151, 154, 157 

przekoszenia (Inksacpe), 151 

otwarcie 

obrazu w GIMP, 130 

obrazu w Inkscape, 142 

Overwrite 

polecenie z menu File (GIMP), 131 

P 

paleta 

narzędzi (GIMP), 124 

panele 

obszar dla (Inkscape), 140 

położenie na ekranie (Inkscape), 141 

panele dialogowe 

zarządzanie (GIMP), 125 

perspektywiczna 

projekcja, właściwości, 248, 249 

Picture type 

lista z okna Advvanced Properties (GIMP), 129 

plany 

unifikacja rozmiarów, 66 

poduszkowe 

zniekształcenie zdjęcia, 249 

podwarstwa 

tworzenie (Inkscape), 162, 164 

położenie 

określanie dla obiektu Inkscape, 158, 183 

pomocnicze 

linie (Inkscape), 30 

porównanie 

profili usterzenia poziomego, 74 

rysunków referencyjnych (Inkscape), 40, 45, 50, 51, 

53, 55, 56, 63, 64, 71, 72, 74, 75 

rzutu z góry i z dołu, 50, 51, 55 

rzutu z lewej, 112 

rzutu z lewej i dołu, 53 

rzutu z lewej i góry, 56 

rzutu z lewej i prawej, 40, 45 

rzutu z lewej i przekrojów kadłuba, 75 

rzutu z przodu i przekrojów kadłuba, 74 

rzutu z przodu i z lewej, 72 

rzutu z przodu i z tyłu, 63, 64 

rzutu z tyłu i z lewej, 71 

powiększanie 

widoku (Inkscape), 144 

Preferences 

polecenie z menu Edit (GIMP), 121, 122 

polecenie z menu Edit (Inkscape), 137, 138 

Preview 

przycisk z okna ustawień skanowania (GIMP), 128 

profil (lotniczy) 

cięciwa, 253 

Clark Y, 254 

geometria, 73, 253 

Götingen University, 254 

NACA, 73, 254 

NACA 2215, 254 

obrys górny i dolny, 253 

rysowanie, 255 

szkieletowa, 253 

projekcja 

perspektywiczna, 248, 249 

prostokąt 

rysowanie (Inkscape), 181 

przejrzystość 

warstwy (Inkscape), 162 

przekoszenie 

obiektu (Inksacpe), 157 

oś (Inkscape), 151 

przesunięcie 

linii pomocniczych (Inkscape), 149 

obiektu (Inkscape), 153 

osi obrotu (Inkscape), 151, 154, 157 

osi przekoszenia (Inkscape), 151 

widoku (Inkscape), 144 

przybornik 

grupowanie poleceń (GIMP), 121, 122 

ikon narzędzi (GIMP), 123 

menu (GIMP), 124 

narzędzi (Inkscape), 139 

okno (GIMP), 124 

przestawienie na ekranie (Inkscape), 137 

punktów 

tryb edycji (Inkscape), 177, 178, 188 

Q 

Quality 

parametr eksportu obrazu JPEG (GMP), 132, 133 

R 

R 

składnik barwy, 260 

ramka 

selekcji (Inksacpe), 151 

wokół wybranego obiektu (Inksacpe), 151 

ramki 
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eksportowanych rysunków (Inkscape), 65 

referencja 

do obrazu rastrowego (Inkscape), 143 

Release 

polecenie z menu Clip (Inkscape), 148 

Repeat 

direct 

powtarzanie gradientu (tryb Inkscape), 190 

reflected 

powtarzanie gradientu (tryb Inkscape), 190 

Rotate 90° 

polecenia z menu Object (Inkscape), 167 

rozmiar 

określanie dla obiektu Inkscape, 158, 183 

tekstury, 160 

rozmycie 

zawartości warstwy (Inkscape), 162 

rysowanie 

elipsy (Inkscape), 182 

linii (Inkscape), 147 

łuku (Inkscape), 184, 185, 186 

obrysów otwartych (Inkscape), 147 

obrysów zamkniętych (Inkscape), 147 

okręgu (Inkscape), 182, 185 

profilu lotniczego, 255 

prostokąta (Inkscape), 181 

tryby dla łuku (Inkscape), 184 

rysunek 

deformacje podczas skanowania, 41 

eksportowanie rzutu z góry (Inkscape), 67 

eksportowanie rzutu z lewej (Inkscape), 65, 66 

Jacka Jackiewicza (porównanie), 77, 78, 79, 80, 81, 

82, 91, 106 

jakość, 31, 32 

jednostki (Inkscape), 35 

Jumpei Temmy (omówienie), 109 

Jumpei Temmy (porównanie), 110, 111 

Jumpei Temmy (różnice), 112, 113, 114 

Jumpei Temmy (skalowanie), 109 

Mariusza Łukasika (porównanie), 81, 82, 83 

nazwy plików wzorcowych, 67 

opracowany w programie rysunkowym, 32 

Paula Matta (omówienie), 76, 77, 78 

Paula Matta (porównanie), 77, 78, 79, 80, 106 

Paula Matta (przekroje kadłuba), 87 

plik drawing.svg, 33 

poglądowy, samolotu, 34, 59, 93, 94, 95, 96 

porównanie dwóch rzutów, 40, 45, 50, 51, 53, 55, 56, 

63, 64, 71, 72, 74, 75 

profil usterzenia poziomego, 74 

przejrzyste obszary (Inkscape), 65 

przekroje kadłuba, 74, 75, 86, 87 

ramki (Inkscape), 65, 67 

rzut z boku wg Curtiss, 111, 112 

skalowanie 1 do 1 (Inkscape), 35, 36 

składanie z dwóch wersji, 42, 44 

sprawdzanie, 30, 31, 32, 40, 45, 50, 51, 52, 53, 55, 56, 

63, 64, 71, 72, 74, 75, 86, 87 

sprawdzanie skrzydeł, 52 

techniczny (tradycyjny), 32 

tło (Inkscape), 65 

unifikacja rysunków wzorcowych (Inkscape), 66 

rysunki 

diagram pozycji, 96 

dopasowanie do wzorca, 102, 104, 192, 193, 194 

oryginalne, linie odniesienia, 100, 101 

oryginalne, struktury skrzydła, 100, 102 

oryginalne, szkieletu kadłuba, 192 

porównanie z oryginalną dokumentacją, 105 

przerysowanie oryginalnej dokumentacji, 106 

usterzenie poziome, 103 

użycie gradientów jako masek, 196, 197 

Williama Wylama (P-40D), 97, 98 

S 

samolot 

oryginalna dokumentacja, 100, 102, 192 

Save As 

polecenie z menu File (GIMP), 131 

polecenie z menu File (Inkscape), 142 

Save Defaults 

przycisk z okna eksportu obrazu (GMP), 133 

Scan 

przycisk z okna ustawień skanowania (GIMP), 129 

Scanner/Camera 

polecenie z menu Create (GIMP), 28, 128 

Select Source 

okno wyboru skanera (GIMP), 128 

Set 

polecenie z menu Clip (Inkscape), 148 

Shift-Ctrl-M (Inkscape), Patrz Transform 

Show page border 

pole z okna Document Properties (Inkscape), 152 

Show preview in image window 

opcja eksportu obrazu JPEG (GMP), 132 

skalowanie 

1 do 1 (Inkscape), 35, 36 

obiektu (Inksacpe), 155 
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precyzyjne (Inksacpe), 155 

skanowanie 

deformacje obrazu, 41 

intrfejsy (GIMP), 128 

okno ustawień(GIMP), 128 

planów samolotu (GIMP), 28, 128 

podgląd strony (GIMP), 128 

rezultaty (GIMP), 28, 129 

ustawienia szczegółowe (GIMP), 129 

zalecane ustawienia (GIMP), 129 

skrzydło 

kształt końcówki, 102 

sprawdzanie 

prostopadłości skrzydeł, 52 

rysunku, 30, 31, 32, 40, 45, 50, 51, 53, 55, 56, 63, 64, 

71, 72, 74, 75, 86, 87 

statecznik pionowy 

rzut z boku, 105, 106 

statecznik, pionowy 

rysunek złożeniowy, 104 

rzut z boku, 106 

statecznik, poziomy 

kontur, 103 

ster kierunku 

rysunek złożeniowy, 104 

rzut z boku, 105, 106 

ster wysokości 

rysunek złożeniowy, 102 

rzut z boku, 104 

rzut z przodu, 104 

stroke 

linia obrysu (Inkscape), 175 

strona 

wyłączenie ramki (Inkscape), 152 

styczne 

do krzywej (Inkscape), 178, 179 

Substract 

sposób nakładania barw, 262 

symetryczny 

węzeł (Inkscape), 178 

System 

motyw barwy okien (GIMP), 121 

szkieletowa 

profilu lotniczego, 253 

Ś 

śmigło 

kształt kołpaka, 88 

średnia ważona 

sposób nakładania barw, 261 

T 

tekstura 

optymalne proporcje obrazu, 160 

Temma, Jumpei 

omówienie rysunków, 109 

porównanie rysunków, 110, 111 

różnice, 112, 113, 114 

skalowanie rysunków, 109 

tło 

rysunków referencyjnych (Inkscape), 65 

Tools 

menu (GIMP), 127 

tradycyjny 

rysunek (techniczny), 32 

Transform 

polecenie z menu Object (Inkscape), 154, 155, 157 

U 

ukrywanie 

zawartości warstwy (Inkscape), 161 

Ungroup 

polecenie z menu Object (Inkscape), 173 

unifikacja 

rysunków wzorcowych (Inkscape), 66 

Use dark theme 

opcja (Inkscape), 138 

Use default colors for icons 

opcja (Inkscape), 138 

Use symbolic icons 

opcja (Inkscape), 138 

Use tool groups 

opcja (GIMP), 122 

ustawienia 

GIMP (program), 121, 122 

usterzenie 

oprofilowanie, rzut z boku, 106 

poziome, kontur, 103 

usuwanie 

linii pomocniczych (Inkscape), 149 

warstwy (Inkscape), 166 

W 

warstwa 

blokowanie (Inkscape), 161 

dla rysunków referencyjnych (Inkscape), 38 

dodanie podwarstwy (Inkscape), 164 

efekt rozmycia (Inkscape), 162 
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nowa (Inkscape), 164 

podwarstwy (Inkscape), 162 

problem z grupowaniem (Inkscape), 171 

tryb łączenia pikseli (Inkscape), 163 

ukrywanie (Inkscape), 161 

uproszczona kontrolka (Inkscape), 163 

usuwanie (Inkscape), 166 

zarządzanie (Inkscape), 161 

zmiana dla obiektów (Inkscape), 165 

zmiana hierarchii (Inkscape), 162 

zmiana kolejności (Inkscape), 161 

zmiana nazwy (Inkscape), 161 

zmiana przejrzystości (Inkscape), 162 

warstwy 

dla rysunków referencyjnych (Inkscape), 39, 50, 63 

wąsy 

zniekształcenie zdjęcia, 250 

wczytanie 

obrazu rastrowego (Inkscape), 143 

weryfikacja 

usterzenia z rysunku Kagero, 95 

węzeł 

dodawanie (Inkscape), 179 

gradientu (Inkscape), 190 

ostry (Inkscape), 179 

położenie w gradiencie (Inkscape), 191 

symetryczny (Inkscape), 178 

usuwanie (Inkscape), 179 

widok 

powiększanie (Inkscape), 144 

przesuwanie (Inkscape), 144 

wielokrotność 

obiektu (Inkscape), 173, 174, 187 

wierzchołek, Patrz węzeł (w Inkscape) 

wybór 

obiektu (Inksacpe), 151 

obszarem prostokątnym (Inkscape), 146 

pojedynczego obiektu (Inkscape), 145 

wielu obiektów (Inkscape), 145 

wyłączenie (Inkscape), 145 

Wylam, William 

rysunek P-40D, 97, 98 

wyłączenie 

wypełnienia (Inkscape), 176 

wymiary 

cięciwy usterzenia, 94 

długość całkowita, 34, 93 

położenia osi sterów, 93 

rozstaw kół, 72 

skrzydło i usterzenie, 59 

trapez skrzydła, 59, 61 

wznios skrzydeł, 72 

wypełnienie 

konturu obiektu (Inkscape), 188 

obiektu (Inkscape), 175, 176 

Z 

zapisywanie 

obrazu (GIMP), 131 

obrazu (Inkscape), 142 

zarządzanie 

warstwami (Inkscape), 38, 39, 50, 63, 161 

zaznaczanie 

obiektu (Inksacpe), 151 

zdjęcia 

korekta zniekształceń, 251 

najprostsze użycie, 86, 87 

organizowanie kolekcji, 89 

pojedynczego szczegółu, 88, 89 

porównanie z rysunkami, 91 

projekcja perspektywiczna, 248 

samolotu, wyszukiwanie w Internecie, 86 

wykrywanie zniekształceń, 250 

zniekształcenia, unikanie, 91 

zniekształcenie ‘w wąsy’, 250 

zniekształcenie beczkowate, 249 

zniekształcenie poduszkowe, 249 

złożenie 

rzutu z lewej, 111 

zmiana 

obrotu obiektu (Inkscape), 154 

przekoszenia obiektu (Inkscape), 157 

skali obiektu (Inkscape), 155 

zniekształcenie 

korygowanie na zdjęciach, 251 

wykrywanie na zdjęciu, 250 

zdjęcia, 249, 250 

zdjęć, unikanie, 91 
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O autorze 

Nazywam się Witold Jaworski i odkąd skończyłem 10 lat jestem fa-

nem lotnictwa oraz modelarzem. Zaczynałem od plastikowych zesta-

wów do sklejania (1:72), potem wycinanek z „Małego Modelarza” 

(1:33), by skończyć na budowie modeli od podstaw (1:24). Te zainte-

resowania zaprowadziły mnie na Wydział Mechaniczny Energetyki i 

Lotnictwa Politechniki Warszawskiej, który ukończyłem w 1994r. W 

1987r. przerysowywałem w tuszu plany samolotów, m.in. do książki 

„Samoloty bombowe września” (te prace zlecał Andrzej Glass). Potem 

p. Andrzej zaproponował mi samodzielne opracowanie rysunku prze-

krojowego i kilku arkuszy planów do nowo powstającego magazynu. 

Mogłem wybrać dowolny samolot. W ten sposób powstały dokładne 

rysunki myśliwca F-4 Phantom II, opublikowane w 1990r. w pierw-

szym numerze miesięcznika „Aero HOBBY”. Nadal można znaleźć ich 

kopie w Internecie, na różnych portalach z planami. Podczas studiów 

na MEiL zainteresowałem się także grafika komputerową i systemami 

CAD. W 1991r. miałem okazję po raz pierwszy wykorzystać tę wie-

dzę, pomagając w budowie prototypu szybowca PW-5 (zwycięzcy 

konkursu na tzw. szybowiec światowy w 1992r.). 

 
Obecnie pracuję jako specjalista IT. Mieszkam wraz z żoną i trójką dzieci w Poznaniu. Od czasu do czasu piszę 

artykuły dla czasopism lotniczych. W tej książce połączyłem swoje dwie pasje: grafikę komputerową i lotnictwo, 

w nowy rodzaj modelarstwa: budowę realistycznych, cyfrowych modeli historycznych samolotów. 

 

 

 



 

W XX wieku można było robić miniatury samolotów z 

kartonu lub z plastiku. Na początku wieku XXI przyszedł 

czas na jeszcze jedną odmianę tego hobby: modele 

komputerowe. Ta nowa gałąź modelarstwa redukcyjnego 

rodziła się „po cichutku”. Dwadzieścia lat temu mało kto 

mógł wydać (prywatnie!) parę tysięcy dolarów na 

odpowiedni program. A tymi „nieodpowiednimi” nie było 

się co chwalić… Nieliczni zapaleńcy siedzieli więc przy 

monitorach i tworzyli pierwsze modele, ucząc się na 

własnych błędach.  

 
Obecnie niezbędne oprogramowanie jest dostępne za 

darmo (na licencji Open Source). Jeżeli jeszcze Twój 

komputer ma mniej niż 6 lat, to masz już wszystko, czego 

potrzeba, by zacząć! Ta książka dostarcza niezbędnego 

know how. Pokazuje krok po kroku, jak zrobić takie 

modele, jak na ilustracjach obok. I, podobnie jak 

oprogramowanie które opisuje, także jest bezpłatna!  

 
„Wirtualne modelarstwo” jest kierowane nie tylko do 

modelarzy. Może zainteresować wszystkich tych, którzy 

chcą się poznać takie ogólnodostępne programy, jak 

Blender, GIMP, czy Inkscape.   

 

ISBN:  978-83-941952-3-6           Bezpłatna publikacja elektroniczna, udostępniana na licencji Creative Commons 

 

Samolot z 3-go dywizjonu AVG („Hell’s Angels”), Kunming 1942, wg opracowania Janusza Światłonia. (Tło: © Tomo Yun, www.yunphpto.net) 
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